
IBM Kenexa® LCMS Premier
Version 9.4

User's Guide
August 2015

IBM





IBM Kenexa® LCMS Premier
Version 9.4

User's Guide
August 2015

IBM



Note
Before using this information and the product it supports, read the information in “Notices” on page 321.

This edition applies to the August 2015 release of IBM Kenexa LCMS Premier, and to all subsequent releases and
modifications until otherwise indicated in new editions.

© Copyright IBM Corporation 2015.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract
with IBM Corp.



Terms and conditions for product documentation

Permissions for the use of these publications are granted subject to the following terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM® website.

Personal use

You may reproduce these publications for your personal, noncommercial use provided that all
proprietary notices are preserved. You may not distribute, display or make derivative work of these
publications, or any portion thereof, without the express consent of IBM.

Commercial use

You may reproduce, distribute and display these publications solely within your enterprise provided that
all proprietary notices are preserved. You may not make derivative works of these publications, or
reproduce, distribute or display these publications or any portion thereof outside your enterprise, without
the express consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the publications or any information, data, software or other intellectual property
contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of
the publications is detrimental to its interest or, as determined by IBM, the above instructions are not
being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE
PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.

© Copyright IBM Corp. 2015 iii



iv IBM Kenexa® LCMS Premier Version 9.4: User's Guide August 2015



Contents

Terms and conditions for product
documentation . . . . . . . . . .. iii

Introduction . . . . . . . . . . . .. 1
LCMS Premier Features. . . . . . . . . .. 1
The LCMS Premier Platform . . . . . . . .. 1
LCMS Premier as a Multi-Modal Development
Platform . . . . . . . . . . . . . . .. 2

Multi-modal Options . . . . . . . . .. 2
The LCMS Premier Learning Portal . . . . . .. 3

Logging in to the Learning Portal . . . . .. 3
Learning Portal: Main Page . . . . . . .. 3
Learning Content Viewer . . . . . . . .. 4
Viewers and Themes. . . . . . . . . .. 5
The LCMS Premier Content Manager . . . .. 5

Content Development . . . . . . . . . .. 6
Course Creation Tasks . . . . . . . . .. 6
Author Assessment Elements . . . . . .. 30
Author Assessments . . . . . . . . .. 70
Author Extended Elements . . . . . . .. 81
Author Interactive Elements . . . . . . .. 88
Author a Reference Object . . . . . . .. 106
Author Rich Media Elements . . . . . .. 108
Author Survey Elements . . . . . . .. 120
Author a Survey . . . . . . . . . .. 124
Authoring Textual Elements . . . . . .. 126
Reusing Content . . . . . . . . . .. 148
Authoring Tools and Settings . . . . . .. 155
Content Search . . . . . . . . . . .. 168
HTML Editor . . . . . . . . . . .. 175
Publish Content . . . . . . . . . .. 179

Work with Media, External Content, and Metadata 184
Using Media . . . . . . . . . . .. 184
Using External Content . . . . . . . .. 193
Using Metadata . . . . . . . . . .. 195

Learning Portal: General Information . . . .. 207
Welcome and News Categories . . . . .. 207
Member Links and System Links Categories .. 209

Learning Portal: Delivery . . . . . . . .. 211
Table of Contents Category . . . . . . .. 211

Slide Presentation Category . . . . . .. 221
Print Category . . . . . . . . . . .. 223
Surveys Category . . . . . . . . . .. 223
Direct Content Access Options Category . .. 224

Learning Portal: Developer Tools . . . . . .. 224
Search in the Learning Portal . . . . . .. 224
Preview Content . . . . . . . . . .. 228
Reporting Category . . . . . . . . .. 228
Discussion Forums Category . . . . . .. 231

Learning Portal: Export Generators . . . . .. 231
Export Generator Category . . . . . . .. 231

Learning Portal: Data Movement . . . . . .. 260
Process Monitor Category . . . . . . .. 260
Import Category . . . . . . . . . .. 263
Export Category . . . . . . . . . .. 269

Media Cache Category . . . . . . . . .. 273
Caching Media and External Content . . .. 273

Server Configurations . . . . . . . . .. 274
Servers Category . . . . . . . . . .. 274
Configure a Data Distribution Network . .. 274
Configure Synchronization . . . . . . .. 278

Learning Portal: Administration Tools . . . .. 280
Administration Manager Category . . . .. 280
Theme Management Category . . . . . .. 287
Site Manager Category . . . . . . . .. 289
Partition Administration Category . . . .. 292
Task Management . . . . . . . . . .. 296

Learning Portal: Learning Management. . . .. 299
Learning Paths . . . . . . . . . . .. 299
Member Management Category . . . . .. 301
SuccessFactors Target Configuration Category 309
Role Administration Category . . . . . .. 312
Personalization . . . . . . . . . . .. 315

Learning Portal: Bulk User Import . . . . .. 319
Schedule the Bulk User Import . . . . .. 319
Email Notification . . . . . . . . . .. 320

Notices . . . . . . . . . . . . .. 321
Trademarks . . . . . . . . . . . . .. 322

© Copyright IBM Corp. 2015 v



vi IBM Kenexa® LCMS Premier Version 9.4: User's Guide August 2015



Introduction

LCMS Premier is a state-of-the-art platform for implementing a successful learning solution.

The combination of LCMS's collaborative development, dynamic delivery, and learning management
capabilities is designed for the rapid creation of interactive, adaptive content. The LCMS Premier
platform consists of multiple components that provide increased productivity and efficiencies in the
development, maintenance, management, and delivery of reusable learning objects.

LCMS Premier Features
Describes features that are available in LCMS Premier.

You can use the features that are available in LCMS Premier to do these tasks:
v Develop reusable content in a collaborative environment for multi-modal delivery.
v Manage and reuse content with extensive searching, client-based metadata, dynamic taxonomy, object

tracking, and reporting capabilities.
v Import, tag, track, and manage external, or legacy, content.
v Author content for single-sourcing, because content is dynamically formatted at the time of delivery to

meet the needs of the audience and the medium in which it is delivered.
v Deliver dynamic, individualized, and adaptive learning with prescriptive assessment capabilities.
v Manage learner access to content and provide performance tracking and testing.

The LCMS Premier Platform
LCMS Premier brings the vision of rapid education development and delivery to reality.

With its powerful delivery engines and intuitive authoring tool, LCMS Premier provides you with the
platform for unleashing your creativity and developing the most interactive and effective learning
programs. The LCMS Premier platform provides you with everything you need to develop, manage, and
deploy content. It consists of three main components:
v The LCMS Premier Content Manager enables all of the development functions within the platform.
v The LCMS Premier Repository is the storehouse for all content.
v The LCMS Premier Learning Portal is the portal through which members, depending upon their role,

access content and do administrative functions.

The following figure demonstrates the process by which content is maneuvered through the LCMS
Premier platform.

© Copyright IBM Corp. 2015 1



LCMS Premier as a Multi-Modal Development Platform
A major strength of LCMS Premier is its use as a multi-modal authoring and delivery platform. You can
create content once, tagged the content for multiple-delivery outputs and audiences, and then export the
content to themes, viewers, and templates as applicable.

Multi-modal Options
The sample figure illustrates the ability of exporting the same content to multiple delivery outputs,
presentation styles, and audiences.
1. Content Manager: Content is tagged for output types and audience demographic.
2. Export Generators: Themes, viewers, personalization (audience) profiles, and/or print templates are

selected at the time of export.
3. Delivery Options: Content is generated according to the output, presentation, and audience profile

preferences selected in the Content Manager and Export Generators.

Example
Jessica created learning content for her organization's new software product. While developing the
content, she tagged content elements for various outputs, including:
v E-learning (WBT)

Figure 1. IBM Kenexa LCMS Premier Platform

Figure 2. Multimodal Options for Delivery
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v Mobile e-learning
v Instructor-Led Training (ILT) Guides
v User Guide
v Job Aids
v Online Help
v Presentations

At the same time, Jessica applied personalization metadata so that on export, content could be filtered for
audience type, such as:
v E-learning based on skill level
v Basic skill level
v Advanced skill level
v ILT Guides according to role
v Student Guide
v Instructor Guide (includes instructor notes)
v User Guides depending on organizational relationship
v Internal
v External

Finally, at the time of export, Jessica applied viewers and themes to e-learning, and templates to print
material. This ensured:
v E-learning is launched with the appropriate logos, formatting, and navigation, depending on

department and external customers.
v ILT and User Guides are presented with different templates and styles, depending on department and

external customers.

The LCMS Premier Learning Portal
Access to the Learning Portal enables members to start the Content Manager, view learning-related
content, and do many administrative functions.

Note: “Member” is the general term that is used to refer to anyone who uses the Learning Portal.

Logging in to the Learning Portal
To log in through the Learning Portal, type your Member ID and Password in the appropriate fields of
the Member Log In category and select Log In

If you do not have a Member ID and Password and your site has a Not a Member Yet? hyperlink, select
the hyperlink and complete the appropriate fields. Otherwise, see your administrator for access
privileges.

Tip: Select the Remember Me check box so that you do not have to retype your Member ID each time
you log in to the Learning Portal.

Learning Portal: Main Page
The Main Page is the default window that members see upon entry to the site, and includes all categories
that define the functions of the site. Administrators are able to customize the categories and their
locations on the Main Page.
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Learning Content Viewer
The learning content viewer contains information that members need to navigate and explore course
materials.

Members can launch the viewer by selecting an item in the Table of Contentscategory. The default Web
Viewer on new installations of the LCMS is named Reflection.

The Viewer consists of four areas:
v Header
v Sidebar Navigation
v Content Frame
v Navigation and Media Controls

Figure 3. Learning Portal Main Page with Tab Interface
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Viewers and Themes
Delivery viewers and themes can be changed by an administrator for specific organizational standards
and needs. Changes can include different navigational options, styles, colors, frame changes, and many
more.

The LCMS Premier Content Manager
The Content Manager is the LCMS Premier authoring tool. The Content Manager is where all aspects of
content creation and content management occur.

Access to the Content Manager takes place from the Learning Portal Authoring tab. Select the Web
Authoring icon to open the Content Manager.

Note: Based on decisions made in your organization, you may also have access to Stand-Alone
authoring. See your system administrator for more information.

Figure 4. Learning Content Viewer
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v Utilities Pane - Search and apply content, media, external content, templates, and layouts. Assign
metadata properties, make media requests, sort and apply review comments, and display the Parent
Tree-view.

v Structure Pane - Displays all developed content relevant to your role, or can be changed to display the
metadata dictionary, templates, or your own personal workspace. Most commonly used for navigation
and creating and editing structural components.

v Details Pane: Top - Displays any views relevant to the developer task. The most common views for
development are the General and Source views, in which content objects in the Structure pane have
taxonomy properties set, and settings and display properties configured.

v Details Pane: Bottom - Displays any views relevant to the developer task. The most common view for
development is the Preview. The Preview enables developers to view content changes as they occur in
the Source view, and can be used to make quick changes directly within the Preview.

v Status Pane: Displays the status of the item in focus in the Structure pane. This includes the item label,
the Global Unique Identifier (GUID), and the last modified date.

Note: The Content Manager panes and views can be changed to apply to individual work preferences.
Panes can be closed and opened, resized, and even cloned as required.

Content Development
The following topics describe how to develop content in the LCMS.

Course Creation Tasks
The following topics describe general tasks that are used when creating a course and configuring content.

Creating a Course Hierarchy
LCMS Premier is designed to organize your course information in hierarchical levels using the treeview
concept. The treeview is similar to the outline of a book, allowing you to create a course with sections,
lessons, activities, text, media, and Assessment elements.

Figure 5. LCMS Content Manager
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About this task

Using this analogy, a module is equivalent to a chapter, a learning object (LO) to a lesson, a topic to a
section, a group to concepts and activities, and elements to text, media, and assessments.

Table 1. Explanation of course hierarchy. The table below provides a visual representation of the book analogy and
the LCMS Premier hierarchy of content.

Icon Component Analogy Description

Course Book
Highest level in the hierarchy. Consists of modules,
learning objects, topics, groups, and elements.

Module Chapter
Consists of learning objects, topics, groups, and related
elements.

Learning Object Lesson
Consists of a collection of topics that combine to
accomplish the objective of the lesson.

Topic Section
Consists of a collection of groups that combine to
accomplish the objective of the section.

Group
Concepts and
Activities

Consists of a collection of elements that lend themselves to
a specific purpose within a topic.

Element
Text, Media, or
Assessments

Lowest level in the hierarchy. Consists of the facts that
make up the concepts and activities within a group.

Course structure is authored in the Structure pane, which displays the LCMS Premier hierarchy as it is
developed.

The modules, learning objects, topics, and groups serve a navigational purpose, while elements house all
text and media used in your learning content.

Content objects and elements are easy to add to the Structure pane. These can be selected and dragged
from the Object Palette. Objects can only be dragged to parent or same-level objects in the Structure pane.
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Content objects can also be inserted using the right-select menu in the Structure pane. The right-select
menu displays applicable objects to insert according to the object in focus. For example, the following
image displays the right-select menu for a group object. In this instance, another group can be added, or
any elements.

Viewers:

Administrators can set default viewers for different output types, such as web and print. However, you
can override the default viewer for any object in a course by selecting any viewer from the Viewer
drop-down list. This option is available at all hierarchal object levels.

For detailed information on customizing viewers, please see the technical document Theme and Viewer
Administration.

Authoring in Different Contexts
The default Objects view of the Structure pane displays entire courses. However, you can author content
in different contexts, where only objects of the same level of the hierarchy are visible.

You can change the view by selecting Change Context from the Options menu while in the Objects view
and selecting the object type.

When you are working in a different context, you can use the Parent Treeview to show the context.

Tip: The Objects view displays only some objects. When you are changing context to a lower hierarchical
level (for example, the element level), there might be too many objects for the Objects view to display. In
this event, you must create and apply a filter to reduce the result set.

Unassigned Content:

Unassigned content is content that does not belong to any parent object. Any context except for the
Course context can contain unassigned content.
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Although unassigned content does not belong to any parent, it can contain any number of child objects,
even objects that are being reused in other content. Unassigned content is indicated by a red "X".

The following are facts about unassigned content:
v An object is automatically unassigned if it is authored at the level of the current context (excluding

courses).
v An object becomes unassigned if it is deleted with the Remove this object from this parent option and

it is not being reused anywhere else.
v If an object contains children and is deleted with the Remove this object option, any immediate

children that are not reused elsewhere becomes unassigned.
v Unassigned content is not accessible in delivery.

For detailed information on customizing viewers, see the technical document Theme and Viewer
Administration.

Multi-select LCMS Content
LCMS Premier provides the capability to do certain concepts to multiple objects at the same time, as
follows:
v Cut, Copy, and Paste
v Delete
v Lock
v Hide
v General view properties
v Metadata tagging

Multiple content objects can also be relocated by using the drag-and-drop action with the multi-select
feature.

When multi-selected objects have form properties in common, such as fields or check boxes, these objects
appear in the General view. If the properties have the same values, then the value displays. However, if
the objects have different values, the user sees: [multiple values].

Check boxes appear grayed out if the values are different. Any changes that are made in the General or
Data views are applied to all of the multi-selected objects.

Hiding Content
LCMS gives you the option to hide content in the Structure pane.

About this task

Content can be hidden in the Structure pane for several reasons.
v Content that is accessed only by interactive means should not appear inline. In this instance, the

content is hidden.
v You may need to add to content that is available to learners. In this instance, the content object is

hidden until complete.
v Content is applicable to you for some reason, but it is currently unused.

Hidden content does not display to learners, and is not exported to print. There are two ways to hide
content.

Procedure
1. Right-select on the content and select More > Hide.
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2. Select the parent of the object in the Structure pane and select Hidden from the Display Type
drop-down list (elements) or the Hide check box associated with the content in the List view.
Hidden content displays as "faded" in the Structure pane.

Note: When content is hidden, all of its subordinate content is hidden. For example, if a learning
object is hidden, all of the topics, groups, and elements within that learning object is also hidden.

Lock Content
Locking provides security for your content when developing in a collaborative environment. You can lock
content at any level in the hierarchy to prevent unauthorized edits. Locked content is indicated by a pad
lock icon.

Change Status:

Whether or not a user can change status for locked objects, and what happens when a status is changed,
depends on the user's privileges. There are two role actions that affect this:
1. Modify Status - This action must be set in order to change any object's status.
2. Override Content Locking - If the user does not have this action set, deep status change operations

skips objects where the user does not own the object lock (for example, they did not lock the object).
If the user has this action set, along with Modify Status, deep status change operations change the
status for all objects even if the user does not own the locks for all the children in the object. The
Override Content Locking action also permits users to edit objects that have been locked by other
users.

Locking and Unlocking Rules:

User privileges determine whether a user can lock or unlock objects.

About this task

Whether a user can lock or unlock objects, and what happens when a lock status is changed, depends on
the user's privileges. If a user has the Override Lock Ownership role action set, that user can change the
lock status of objects that are owned by another user, even in a deep-lock operation.

There are two ways to lock content.

Procedure

1. Right-select on the content and select More > Lock from the menu.
2. Select the content in the Structure pane and select the Lock check box in the General view of the

Details pane.

Note: After content is locked, it can be edited or unlocked only by the course developer who
implemented the lock, or by anyone whose role enables them to override locks.

Remove Content
To ensure that content is not accidentally lost from the repository, it is vital to understand the effect that
deleting content has on the collaborative environment.

It is important to confirm that content that is selected for deletion has not been reused in other objects. If
you delete content that previously was linked to other objects, you might also be deleting the linked
content. Therefore, it is imperative that you thoroughly understand the options for deleting content.

Important: Content that is removed from the Repository cannot be restored.

There are two methods of removing content from a course:
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1. Delete the content
2. Remove the content link

Deleting Content:

The deletion of content permanently removes it from the database. There are two ways to begin the
deletion of content.

Procedure

1. Select the Delete button on the Toolbar.
2. Right-select and select Delete.

These same deletion methods can be used for search results in the Utilities pane.
When you choose a deletion option, the Author Confirmation - Webpage Dialog displays with the
name of the selected content. You can select one of two deletion options:
v Remove this object - Removes content from the location where you selected it in the Structure

pane, as well as any locations where it is linked. This method of deleting completely removes only
this content from the repository. Any subordinate content within the deleted content is now
unassigned, unless linked elsewhere.

v Remove this object and all of its children - Removes content from the location where you selected
it in the Structure pane, as well as any locations where it is linked. This method of deleting
completely removes the selected content and all its unlinked subordinate content from the
repository. If subordinate content is reused elsewhere, those other instances are not deleted.
The Delete dialog box warns you if the object you are deleting is linked elsewhere. Whenever you
delete content, the Delete dialog displays the message: This object has __ relationships. If the
number of relationships is more than one, you know that other content might be deleted too. The
Delete dialog box does not warn you of relationships if you are deleting an object that contains
linked content.
The Delete dialog box informs you if the object you are deleting has references. For example, the
object might contain a hyperlink that targets the content you are trying to delete. You cannot delete
content that is referenced by other content.

Remove the Content Link:

Removing a content link removes content from the location where you selected it in the Structure pane.

If the content is not linked elsewhere, it becomes unassigned content. This method of deleting does not
completely remove any content from the repository.

A content link can be removed by right-clicking on the content and selecting Remove Link.

Tip: If you are concerned with losing content from the Repository, use the Remove Link option.

Lock and Status Changes:

Whether a user can change the lock and status for locked objects, and what happens when a status is
changed, depends on the user's privileges. There are two role actions in Role Administration in the
Learning Portal that affect this behavior:
1. Modify Status - This action must be set in order to change any object's status.
2. Override Content Locking - If the user does not have this action set, deep status change operations

skips objects where the user does not own the object lock (for example, they did not lock the object).
If the user has this action set, along with Modify Status, deep status change operations changes the
status for all objects; even if the user does not own the locks for all the children in the object.
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The Override Content Locking action also permits users to edit objects that were by other users.

Note: Whether a user can lock or unlock objects, and what happens when a lock status is changed,
depends on the user's privileges. If a user has the Override Lock Ownership role action set, that user can
change the lock status of objects that are owned by another user, even in a deep-lock operation.

Moving Content
Use this procedure to move content from one location to another.

About this task

It is often necessary to relocate (move) content. There are no restrictions to moving content; you can
move any content to anywhere else in the Structure pane, so long as object level logic is maintained.

There are two ways to move content. Moving any content is as easy as selecting it, and then dragging it
to the required location. There are some simple rules to moving content.

Procedure
1. Drag the object to a target location. When you release the object on top of a sibling, it appears just

after the sibling. If you drag the object on top of another parent container, the object appears at the
bottom of the container. You can then drag the object to the appropriate location inside of the
container object.

2. Content can be relocated by using Cut and Paste. The same rules apply as for moving content. The
Cut and Paste functions are available on the content right-select menu.

Restore Content Versions
Creating a log for new and updated content provides storage, documentation, and management of
content versions.

As course content is being developed and updated, a log of previous version is automatically stored in
the element History view. You can roll back to any of these previous versions through the History view
within the Details pane.

Restoring a Version of Content:

Use this procedure to restore a version of content.

Procedure

1. Select the content in the Structure pane.
2. Select the History view in the Details pane.
3. Select the appropriate content version.
4. From the right-select menu, select Restore.

Using the Parent Treeview
Use the Parent Treeview to determine the locations of specific content reuse.

About this task

When content or metadata is selected in the Structure pane, it appears at the top of an inverted treeview
in the Parent Treeview. The subsequent levels in the treeview show where the content is used.

Procedure
1. Select the content in your course treeview.
2. In the Utilities pane, select Parent Treeview.
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Tip: You can locate to an object in its course by right-clicking on the object in the parent treeview and
selecting Find. This method is helpful when an object is used in multiple locations.

Create Sequencing Rules
The Sequencing view in the Details pane enables developers to create and modify sequencing rules for
LCMS Premier objects. These rules determine certain behaviors, such as navigation and scoring, when
SCORM 2004 content is exported from LCMS Premier and launched through an LMS.

For detailed information on sequencing, see the technical document Sequencing and Scoring for SCORM
and AICC.

Previewing Content
The Preview in the Details pane enables developers to view content dynamically as it is created, with
different viewers, themes, and contexts. These preferences are selected from the Details pane Options
menu.

Choose a Viewer:

The following image shows a learning object as it would appear in the Mobility viewer for a mobile
device. The navigation links and buttons are functional, the same as in the selected delivery type.

Choose a Theme:

You can change the theme for a selected viewer to modify the look of the viewer without changing the
general layout and navigation.

Selection of a theme affects the look of the Classic-LO and Classic-CBT viewers. For custom viewers,
selection of a theme affects only the icons and labels that are used in the Message Box, Note, Tip, and
Glossary elements.

Choose a Context:

LCMS Premier provides the ability for you to change context in the Preview, meaning that you can view
the same content at different hierarchical levels.

The following image shows a topic that displays in a learning object context. Because a topic is selected
in the Structure pane, you cannot select a context below the topic level.

Figure 6. Learning Object Mobility Viewer for a Mobile Device
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If you select a content of Automatic (default), content displays in its own context. For example, if an
element is selected in the Structure pane, then only the element displays in thePreview.

Edit and Insert Content in the Preview
Content can be edited and inserted directly within the Preview. By selecting anywhere within the
Preview, you can edit text and add paragraphs.

You can also do many other functions by right-clicking on an element within the Preview. You can then
cut, copy, and paste elements, insert new elements, and open the element Properties dialog box. The
Properties dialog box is the same as the Details pane, and you can access any of the element views in this
way.

Finding and Implementing Review Comments
Review comments submitted through the Learning Portal by editorial and content reviewers are
implemented within the Review Comments view in the Utilities pane. The Review Comments view lists
all comments in the LCMS by default. Course developers may still conduct searches to find and sort
review comments to be implemented.

Note: Comments that appear in red text belong to content that no longer exists in the repository.

Find Content:

After you find a review comment, you might need to find the content that is attached to the comment to
provide context.

To do so, right-select on the content and select Find. The system navigates to the content in the Structure
pane and the contents populate the Details panes that are open. If you are in the Workspace and the
content is not there, you need to switch to theObjects view.

After you find your content, you can access the review comment properties by selecting Properties from
the review comment right-select menu. Here, you can view and update the review comment details.

After the content is loaded, you can edit it as needed. You can also access all review comments for this
element by selecting the Review Comments view in the Details pane.

Even container objects up to the course level contain a Review Comments view - each view displays all
of the review comments for all of the elements inside each container. You can easily access all review
comments within a course or course object without searching for review comments.

Figure 7. Choosing a Context
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Approve Suggestions:

When reviewers leave comments, they can make edits directly in the delivery window. These edits
displays as suggestions to the content owner in the Content Manager.

If you select Show Review Comments from the Options menu in the Preview, the date of each review
comment displays as a link. Selecting the link shows the deleted text (pink) and the suggested changes
(green).

Note: You can also view suggestions in the review comment Properties.

If you are satisfied with the suggested changes, you can implement them automatically by taking one of
the following actions:
v Right-select on the review comment in the Review Comments view (Utility pane) and select Approve

Suggestion.
v Right-select on the review comment in the Review Comments view (Details pane) and select Approve

Suggestion.
v Select the Approve Suggestions button in the review comments Properties.

Create and Apply Layouts
Layouts are templates that determine the way content is arranged on the delivery page. They are
accessed in the Layouts view of the Utilities pane. LCMS Premier ships with many pre-configured
layouts for use.

You can take the following actions on a listed layout by right-clicking on it:
v Copy the layout.
v Paste the layout.
v Delete the layout.
v Access the layout properties.

Note: Copying, pasting, and renaming layouts are a good way of modifying a layout without
compromising the integrity of the original.

Layout Properties:

Layouts can be modified, previewed, and associated with metadata by accessing the layout properties.
Right-clicking on a layout and selecting Properties launches the Layouts Properties dialog box, which
contains the following five views:
1. General - Configure general properties.
2. Design - Configure and preview the layout.
3. Animation - Apply effects and transitions to the layout elements.
4. Data - Apply metadata to the layout.
5. Preview - View the layout as it appears in delivery, including animations.

Design View:

Design view is where you edit an existing layout. In this view you can add, delete, or change the
elements within the layout, and edit the properties and CSS attributes of each element.

Layouts are applied at the group level, and applies only to elements specified in the layout. For example,
the following layout includes the first Multiple Choice-Single Answer element and first Media element in
the group. If, for example, a List element is placed in the group, that List element is ignored.
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Note: New layouts can be created by selecting Create in Layout Concepts at the bottom of the Utilities
pane. When a layout is created, only the General and Data properties are configured initially; the Design
and Animation portions of the layout must be done in editing mode.

Basic Tab:

On the Basic tab, users can configure the positioning, dimensions, and Z-index of each element. You can
do general layout configuration for an element without extensive knowledge of CSS properties.

Table 2. Layout attributes. The following table describes the basic properties of layouts.

Property Description

Width
The width of the element stage, as a percentage of the entire layout, or as a selected unit of
measurement.

Height
The height of the element stage, as a percentage of the entire layout, or as a selected unit of
measurement.

Position

Determines the behavior of the element's position.

v Static - Default position, which enables the element to flow with the rest of the content.

v Absolute - Places an element in an exact position within the layout, and is not affected by the
positioning of other elements.

v Fixed - Places an element in a position in the browser window.

v Relative - Places the element relative to the positioning attributes.

Left
The distance from the left of the layout where the element starts, as a percentage of the entire layout,
or as a selected unit of measurement.

Right
The distance from the right of the layout where the element ends, as a percentage of the entire
layout, or as a selected unit of measurement.

Top
The distance from the top of the layout where the element starts, as a percentage of the entire layout,
or as a selected unit of measurement.

Bottom
The distance from the bottom of the layout where the element ends, as a percentage of the entire
layout, or as a selected unit of measurement.

Z-index
When layout elements overlap, the Z-index property determines the front-to-back order of the
elements. A value of "1" places an element on the bottom, and the layers continue with subsequent
numbering (for example, 2, 3, 4).

Advanced Tab:

The Advanced tab enables users to customize the CSS used for layouts, and is intended for those users
with extensive knowledge of CSS.

In addition to the default basic and system properties that are provided, user-defined properties can be
added by selecting the Add Property link and selecting one of the many attributes from the drop-down
list. The user should be educated on the values available for each attribute.

For more information about cascading stylesheets, see http://www.w3.org/TR/CSS21/cover.html.

Table 3. Commonly used CSS properties. The following are some of the most commonly used CCS properties, with
examples.

CSS Property Description Examples

Width
Width specifies how much space an element takes on a page -
can be set in percentage or exact amount

width: 49%; or width: 500px;
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Table 3. Commonly used CSS properties (continued). The following are some of the most commonly used CCS
properties, with examples.

Margin

Margin is the distance between the element and the edge of a
page, usually defined in pixels or ems, which is spacing relative
to font size.

Margins can be specified as margin-left, margin-right,
margin-top, margin-bottom, or by using the shorthand margin:
top right bottom left.

margin-top: 20px; or margin:
20px 4px 0px 20px;

Padding

Padding is the amount of space around an element, which is
typically defined in pixels.

Padding can be further specified as padding-left, padding-right,
padding-top, padding-bottom, or by using the shorthand
padding: top right bottom left.

padding-bottom: 20px; or
padding: 5px 2px 20px 0px;

Position

Position is used to define the position of an element on a page.
Position can be further defined by specifying absolute or relative
positioning.

Absolute is used to specify absolute positioning relative to the
top-left corner of the content area of the page.

Relative is used to specify positioning relative to the default
placement of the element on the page.

position: absolute; top: 10px;
left: 20px;

Float
Float enables elements to be positioned side by side, and is
relative to the element before it.

float: left;

Clear Clear clears one or more float properties for the element. clear: both;

Z-Index

Z-Index defines whether an element appears in front or behind
one or more other elements. The higher the value, the more
likely it is that an element is on top of others. The position style
must also be used for Z-index to function.

z-index: 5;

Display
The display property defines the way that the element displays
in the window.

See http://
www.quirksmode.org/css/
display.html

Animations:

Users can apply animation to the elements in a layout. Animations can be created by selecting Animation
from the Properties dialog box menu.

Tip: Animations can be previewed by selecting Preview in the layout Properties.

Use the Animation dialog box to add animations by selecting Add and configuring the order and manner
in which animation items enter or exit the element. Each element in the layout is an animation item.

You can do the following actions:
v Select the item to animate from the Item drop-down list (transitions occur in the order in which they

appear in this list).
v Apply entrance and exit transitions to any item.
v Choose a time delay for each transition.
v Choose when the time delay begins for entrance and exit transitions. The following options are

available:
v With Previous - The time delay starts when the previous transition's delay starts.
v After Previous - The time delay starts when the previous transition ends.
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v After Select - The time delay starts after the user selects inside the element area.
v Choose the type of transition.
v Choose a Slow, Medium, or Fast speed for the transition.
v Select an audio file to play with the transition.
v Use the Up and Down arrows to resequence a transition.

Users can also apply a single animation to the entire group of elements by applying an animation to the
Group image.

Note: The Group item refers to the entire page. Any transition that is applied to the Group item is
applied to all items, as a group, that do not have a transition that is defined. The first item in the list
after the Group item can be started only After Previous (it cannot begin with the Group item). Transition
speed is measured in milliseconds. The speed can be changed to meet your exact needs with the
following theme parameters, available in the DELIVERY-RULES theme parm group in the Theme
Management category:
v Animation Speed - Fast (default = 200 milliseconds)
v Animation Speed - Medium (default = 400 milliseconds)
v Animation Speed - Slow (default = 600 milliseconds)

Apply a Layout:

Layouts can be applied in one of several ways:
v Drag a layout from the Layouts view in the Utilities pane to the Layout field in the group General

view in the Details pane.
v Select the Search button next to the Layout field in the group List view in the Details pane to find a

layout.

View References
A reference is an instance in which an object links to, or contains, another object. The following are
examples of references.
v An embedded link to another LCMS Premier object
v Links in a Reference element
v A Media element that uses a Media Object
v A review comment that has a Media Object attached

Objects that can be referenced contain a Reference view, which is accessed either in the Details pane or in
the Properties dialog box.

Figure 8. Applying a Layout
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By right-clicking on each reference, you can access the Properties of each reference or find the content in
your course structure, as shown in the following image:

Note: You cannot delete an object that is referenced by other objects.

View Dependencies
A dependency is an object that is referenced and is required for an element to maintain its integrity. For
example, in a Slideshow element with five images, those images would be dependencies.

Dependencies can be accessed in the Dependencies view of the Details pane or in the Properties dialog
box for an element.

You can access the Properties of each dependency or find the content in your course structure by
right-clicking on each dependency,

Note: Dependencies exist only for elements.

Override Personalization Settings
If personalization is enabled, developers can override personalization settings for single objects. This is
done in the Personalization view in theDetails pane of the Content Manager. The Personalization view is
available for the following objects:
v Course
v Module
v Learning Object
v Topic
v Group

The following image displays the Personalization view for a course object in which the child modules are
personalized. The System column displays the preconfigured personalization settings, and cannot be
changed. Clearing the Enable Personalization check box disables personalization completely for the
object.

To override the system settings, the Object radio button must be selected, and then the appropriate check
boxes in the Object column can be selected. To revert to the original system settings, the System radio
button must be selected.

Overriding Personalization Settings for an Object:

In your course treeview in the Structure pane of the Content Manager, select the course, module,
learning object, topic, or group for which you want to change the settings.

Procedure

1. Select the Personalization view in the Details pane.
2. At the bottom of the view, select the Object radio button.
3. Select or clear the check box for each metadata tag that you want to enable or disable for the children

of this object.

Figure 9. Reference Properties
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4. Save your work.

Import MS Word Documents
Word documents can be imported into the LCMS Premier Repository that uses the Microsoft Office
Conversion Utility.

This method converts the file to LCMS Premier content that can be used in the Content Manager. This
content becomes part of the LCMS Premier hierarchy where updates and modifications can be made to it
immediately.

MS Word import is accessible from the right-select menu in the Objects view at the course, module,
learning object, and topic levels.

Options for Word import are selected from the Object Import dialog box.

Note: MS Office 2007 or 2010 must be installed locally in order for Word import to function properly.

Content Mapping:

A mapping file, word_mapping.xml, can be downloaded from the Object Import dialog box for use when
importing a Word document. The mapping file can be modified to indicate the relationship between the
styles used in the Word document and the LCMS Premier hierarchy levels to which they is mapped.

The following image shows the default Word import section of the mapping file. Levels one through four
make up the hierarchy from the group to the module level. The "elementtitle" tag maps Word styles to
element titles, while level five is used for element text.

Additional Word styles can be added to the mapping file to be converted to the appropriate hierarchal
level in LCMS Premier. For example, if the entry "General Title" is added within the "elementtitle" tag,
then any text in Word with the General Title style will become an element title in LCMS Premier.

The following table describes the mapping properties available for Word import.

Table 4. Word import mapping properties. The following table describes the available Word Import mapping
properties.

Mapping Property Description Possible Values

<PPTSlideImage>

<slidedpi>

<slideheight>

<slidewidth>

<slidedpi> - Sets the dpi (dots per inch)
for all the slide images (default is 92)

<slideheight> - Sets the height (in pixels)
of all the slide images (default is 540)

<slidewidth> - Sets the width (in pixels)
of all the slide images (default is 720)

Any valid DPI value
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Table 4. Word import mapping properties (continued). The following table describes the available Word Import
mapping properties.

<PPTImport>
Determines how PPT slides embedded in
Word are imported

0 - Each PPT slide is converted to a Media
Object (default).

1 - Each PPT slide becomes a group in the
current topic. Objects on the slide is
converted to LCMS Premier elements
within that group.

<SlideAsImage>
Determines if slide is imported as a single
image

0 - Each image/media in PPT slide is
imported as a Media Element (default)

1 - Each PPT slide is converted to a Media
Object

<extension>
Contains the image types that is
converted (this only applies if = 1)

Specify the image type which the slides is
converted. Possible values are bmp, png,
gif, jpg, tif, and wmf (default is png).

<background>
Determines if slide background is
imported (this only applies if = 1)

0 - Slide background is not imported
(default).

1 - Slide background is imported.

<PPTGroupAsImage>
Determines if grouped PPT objects is
imported as individual elements or a
single image

false - Grouped items are converted to
individual LCMS Premier elements
(default).

true - Grouped items are imported as a
single Media Object.

<ShapeToAnimation>
Determines if PPT shapes is converted to
individual LCMS Premier elements or as a
single Animation element

false - PPT shapes is converted to
individual LCMS Premier elements
(default).

true - The PPT slide will become an
Animation element and the slide objects
will become objects in the Animation
element.

<PPTSlideNotes> Determines if slide notes is imported

0 - Slide notes are not imported.

1 - Slide notes are imported (default). The
slide notes is imported as an LCMS
Premier element in its own group.

<PersistFormatting>
Determines if HTML formatting is
imported

0 - All formatting is ignored, plain text is
imported(default)

1 - All formatting is preserved.

Important: An irregularly constructed mapping file will cause an import or export to fail. Adhering to
the format found in the default mapping file will help insure successful imports and exports.

Hierarchy Creation:

When a Word document is imported, the hierarchy that is created depends on the level at which the
document was imported. The following tables show the mapping between the mapping.xml file levels
and the LCMS Premier course hierarchy objects.

Note: "Import level" refers to the object on which you have focus when you import the Word document.
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Course Level Import:

When a Word document is imported into a course object, the Word headings are mapped specifically for
that level.

Table 5. Course Level Mapping

Mapping File Levels Object

Level 1 Learning Object

Level 2 Learning Object

Level 3 Topic

Level 4 Group

Module Level Import:

When a Word document is imported into a module object, the Word headings are mapped specifically for
that level.

Table 6. Module Level Mapping

Mapping File Levels Object

Level 1 Topic

Level 2 Topic

Level 3 Topic

Level 4 Group

Learning Object Level Import:

When a Word document is imported into a learning object, the Word headings are mapped specifically
for that level.

Table 7. Learning Object Level Mapping

Mapping File Levels Object

Level 1 Group

Level 2 Group

Level 3 Group

Level 4 Group

Topic Level Import:

When a Word document is imported into a topic, the Word headings are mapped specifically for that
level.

Table 8. Topic Level Mapping. The following table shows the mapping for a topic level import.

Mapping File Levels Object

Levels 1-4 At this level, all headings and text are embedded in a
Description element. When an image is encountered, a
Media element is created.
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PowerPoint Support:

Word import supports PowerPoint slides embedded in Word documents. The mapping file provides
properties that allow you to configure how those slides are imported.

Table 9. PPT Mapping Properties. The following table describes the mapping properties available for import PPT
slides embedded in Word documents.

Mapping Property Description Possible Values

<PPTImport>
Determines how PPT slides
embedded in Word are imported

0 - Each PPT slide is converted to a Media Object
(default).

1 - Each PPT slide becomes a group in the current
topic. Objects on the slide are converted to LCMS
Premier elements within that group.

<extension>
Sub-property of <SlideAsImage> (this
only applies if <SlideAsImage> = 1)

Specify the image type which the slides is
converted. Possible values are bmp, png, gif, jpg,
tif, and wmf (default is png).

<background>
Sub-property of <SlideAsImage> (this
only applies if <SlideAsImage> = 1)

0 - Slide background is not imported (default).

1 - Slide background is imported.

List Support:

When you import Word content that contains lists, the following list characteristics are maintained:
v Multi-level lists are supported and are imported as List elements that contain multiple levels.
v Multiple-level lists within a table are supported and are imported as Table elements that contain

multi-level lists within the table cells.

Image Support:

When you import Word content that contains images, the following image characteristics are maintained:
v All images are imported with their object attributes (width, height) maintained. Object attributes are

the values that are assigned when the object was created - not their rendering size.
v Inline (embedded) media are implemented as MediaServer=[GUID] when an embedded image is found

to be inline with text. This applies not only to simple paragraphs but to table cells and List elements as
well.

v Images are imported in both JPG (Web media type) and PNG (Print media type) format.

Table Support:

When you import Word content that contains tables, the following table characteristics are maintained:
v Paragraphs in a table cell maintain their alignment.
v Embedded images and multiple-level lists are supported for the import.
v Column widths are maintained based on ratio.
v If the firstrowisheader attribute for the Table element in the mapping file is set to "true", the first row

of the table is set as the header in LCMS Premier.

Example:

A Word table is 10 inches wide and contains three columns with the following characteristics:
v Column A is 2 inches.
v Column B is 4 inches.
v Column C is 4 inches.
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When the table is imported into LCMS Premier, the widths would be defined as a percentage that uses
the following formula:

Column Width (in inches) x 100 Total Inches

Using the formula for this example, the column widths would be as follows:
v Column A = 20%
v Column B = 40%
v Column C = 40%

Element Titles:

The default mapping file contains the tag elementtitle, which controls the title of the elements that are
created during the Word import.

Creating a corresponding elementtitle style within Word and applying it to text in the document gives
you the ability to indicate the text to be used as element titles. If one of the designated elementtitle styles
is not applied to text in the Word document, then the element label is "New: Content" by default.

Element Introductory Text:

When content is developed in LCMS Premier, authors can apply introductory text to many elements such
as List, Media, and Table.

When Word documents are imported into LCMS Premier, developers can apply mapping that includes
introductory paragraph text with elements during import. This process keeps relevant introductory text
with the body of the element, and reduces the number of Description elements that are created during
the import. The property <ELEMENTTEXT> in the Word mapping.xml file serves this purpose.

The behaviors of this property are as follows:
v When an "elementtext" style is encountered, that text will become the text field for the next element

that is created during import.
v Any "elementtext" mapped text followed by a"level5" style is combined with that text.
v If "elementtext" mapped text is not preceded by another "elementtext" mapped text instance, a new

content element is created.

The following rules apply to text that is not mapped to the property.
v MS Word Lists that contain "level5" mapped text are mapped to LCMS Premier List elements.
v MS Word Tables that contain "level5" mapped text are mapped to LCMS Premier Table elements.
v Other level5 mapped text becomes Description elements.
v Unmapped paragraphs of text are ignored.

Theme Parameters:

The MS OFFICE parameter group within the Theme Management category contains parameters for
configuring how images and text are imported into the Content Manager.

The Theme Management category is available to administrators through the Learning Portal. The
parameters are configured by changing values that are associated with them. The following parameters
control aspects of the Word import functions:
v Bulk Import - Creates a container object that contains a copy of all the images within the imported

document
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v Contiguous - Groups multiple paragraphs into one element until a different level tag or element title is
encountered (default is "true")

v File extensions to exclude during bulk import - Indicates the file extensions of images to exclude in
the import

v File extensions to include during bulk import - Indicates the file extensions of images to include in
the import

v User four words - If set to "true", inserts the first four words from an element as the title if a title is not
included. If set to "false" (default) and no title is included, the element title reads "New Content".

Importing a Word Document:

Right-select on a course, module, learning object, or topic and select Import > Import Word.

Procedure

1. Select Browse next to the Import File field to select the Word document to import.
2. Select a Mapping File to apply to the import.
3. From the Media Category drop-down list, select the media category to which you would like to

assign any imported images. Also, enter a DPI to apply to the images.
4. Select Submit.
5. The content that you are importing appears in a Task Status window as requested. When the status

changes to "running," your content is importing. When the status changes to "completed," close the
window and refresh the Structure pane in the Content Manager to view your content.

Import MS PowerPoint Presentations
LCMS Premier enables users to import MS PowerPoint presentations. MS PowerPoint import is accessible
from the right-select menu in the Objects view at the module and learning object level.

About this task

There are two methods available for importing PPT presentations:
1. Import slides as Media Objects.
2. Import slide content as LCMS Premier objects within a course hierarchy.

Import Slides as Media Objects:

PowerPoint slides can be imported as individual Media Objects.

This import method is for those authors who want to maintain the exact look of the PowerPoint slides.
You must select the Import slides as images box during import. When this check box is selected, the
following options are also selected:
v Template File - You can select a PPT template to apply to the slides.
v Extension - You can select the type of image format in which you would like the slides that are

imported.
v Import with Background - Select this check box to include slide backgrounds with each image.

Import Slides as LCMS Premier Content:

PowerPoint presentation can be imported as LCMS Premier content.

This import method is for those authors who want to modify, reorganize, and repurpose the PowerPoint
content. Each area on each slide is converted to an LCMS Premier element. If the Import slides as images
check box is not selected on the PowerPoint Import Files dialog box, each slide is imported as a
Description, Image, List, or Table element. The PowerPoint template or background is not imported.
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Table 10. PPT import mapping

Content PowerPoint Equivalent

Learning Object Title File name of presentation

Topic Title
Slide title - If there is no title, the slide is named after the slide number, for
example, Slide24.

Group No title - used as a container for elements

Element No title - An individual element is created from each area on a slide.

When imported at the learning object level, the topic title is the presentation name, and the group title is
the slide title.

Mapping File:

A mapping file, ppt_mapping.xml, can be downloaded from the Object Import dialog box.

The mapping file contains properties that can be modified to change the way PPT content is imported.
After you rename the modified mapping file and select it during import, the file is uploaded and stored
so that you can select it from the drop-down list in the future. The PPT import options are contained
within the <general> tag.

Table 11. PPT Import Mapping Properties

Mapping Property Description Possible Values

<PPTSlideImage>

<slidedpi>

<slideheight>

<slidewidth>

<slidedpi> - Sets the dpi (dots per inch) for all
the slide images (default is 92)

<slideheight> - Sets the height (in pixels) of all
the slide images (default is 540)

<slidewidth> - Sets the width (in pixels) of all
the slide images (default is 720)

Any valid DPI value

<PPTGroupAsImage> Determines whether grouped PPT objects are
imported as individual elements or a single
image

v false - Grouped items are converted
to individual LCMS Premier elements
(default).

v true - Grouped items are imported as
a single Media Object.

<ShapeToAnimation> Determines whether PPT shapes are
converted to individual LCMS Premier
elements or as a single Animation element

v false - PPT shapes are converted to
individual LCMS Premier elements
(default).

v true - The PPT slide becomes an
Animation element and the slide
objects become objects in the
Animation element.

<PPTSlideNotes> Determines whether slide notes are imported v 0 - Slide notes are not imported.

v 1 - Slide notes are imported (default).
The slide notes are imported as an
LCMS Premier element in its own
group.

<PersistFormatting> Determines whether HTML formatting is
imported

v 0 - All formatting is ignored. Plain
text is imported (default)

v 1 - All formatting is preserved.
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Note: If your PowerPoint presentation includes notes on any of the slides, a separate group is created
upon import. This group includes the note text in the form of Description or List elements.

Audio Support:

PowerPoint import supports audio files. Any audio files that are embedded in PPT are imported as a
Media Object, and a Media element is created.

Importing a PowerPoint Presentation:

To import a PPT presentation:

Procedure

1. Right-select on a module or learning object and select Import > Import PowerPoint.
2. Select Browse next to the Import File field to select the PPT presentation to import.
3. Select a Mapping File to apply to the import.
4. From the Media Category drop-down list, select the media category to which you would like to

assign any imported images.
5. If you would like each slide to be imported as a single image, select the Import slides as images

check box and continue with Step 6. Otherwise, proceed to Step 9.
6. Select the file extension that you would like to use for the imported images from the Extension

drop-down list.
7. To include each slides own background with each slide (instead of using a template), select the

Import with background check box and proceed to Step 9.
8. Select a Template File to apply to the slides.
9. Select Submit.

10. The content that you are importing appears in a Task Status window as requested. When the status
changes to running, your content is importing. When the status changes to "completed," close the
window and refresh the Structure pane in the Content Manager to view your content.

Substitution Variables and Profiles Usage
Substitution variables allow developers to dynamically insert and update text throughout content, and
personalize content by using variations of words in content without having to duplicate the content.

Creating Substitution Variables:

Developers must create substitution variables and values for the variables. Substitution variables are
created through the Substitution Variables utility in the Utilities pane by selecting Create New Variable.

About this task

A default value must be entered for the variable. This value is the value that is used if a substitution
profile is not activated, or if a variable value is not specified for the active profile. For more information,
see “Substitution Profiles” on page 29.
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To create a substitution variable:

Procedure

1. Select the Substitution Variable view in the Utilities pane.
2. Select Create New Variable.
3. Enter a label for the profile in the Label field. This label is the name that appears in the Utilities pane.
4. Enter the name of the variable in the Variable field. This variable is the name that is inserted into

content.
5. Enter a default value for the variable in the Default field. This value is used for a profile if no value

is entered for this variable within that profile.
6. Select Next.
7. This screen displays all of the substitution profiles that are currently available. You can enter a Value

for each substitution profile. If no value is entered for a profile, the default variable value is used.
8. Select Next.
9. Apply metadata as needed and select Finish.

If the purpose of the substitution variable is to replace a routinely changing value in the content, then
changing the default value of the variable is sufficient, and a profile is not required.

Example:

A developer is creating a course for a software product that is updated and released annually.

The developer creates the variable "version" to insert into the content wherever the product version
number is mentioned. When the developer updates the course for an upcoming release, they change the
default value of the "version" variable to reflect the new release version number throughout the content.

Inserting a Substitution Variable:

Substitution variables are inserted in the Source view of an element (either in a text field or through the
HTML Editor) or in the Design view, where available. To insert the variable, select the Insert
Substitution Variable icon, or select the drop-down arrow next to the icon and select Insert Substitution
Variable from the list. You can then search for the variable to insert.

After you insert the variable, the variable displays as shown in the following image. Variables can also be
manually entered in the text field or HTML Editor in this same format. In preview and delivery, the
variable displays as the actual variable value.

Figure 10. Entering a Substitution Variable
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Note: You can also create substitution variables at the time of insertion in the HTML Editor by selecting
the Insert Substitution Variable menu and selecting Create New Substitution Variable.

Substitution Profiles:

Developers can create substitution profiles to which they assign substitution variables. These profiles are
activated for users for online delivery and can also be selected during publishing, where the assigned
substitution variables are used.

Profiles are helpful when variations of words must be used for delivery to different audiences.

Example:

A developer creates a substitution profile called "U.K. English" and creates/assigns a substitution variable
called "organize/organise".

A value of "organise" is given to the U.K. English profile. The developer also creates a substitution profile
called "U.S. English" and creates/assigns the same substitution variable called "organize/organise".

A value of "organize" is given to the U.S. English profile. When either profile is assigned to a user, they
see the corresponding value of that variable in online delivery wherever the variable appears in the
content.

Creating a Substitution Profile:

Developers can create substitution profiles, to which they assign substitution variables. These profiles are
activated for users for online delivery and can also be selected during publishing, where the assigned
substitution variables are used.

About this task

Substitution profiles are created through the Substitution Profiles utility in the Utilities pane by selecting
Create New Profile.

Existing variables are presented in the Values view, which displays the variable name, default value, and
value that is assigned to this profile. The Profile Value is blank for a new profile; you must enter the
values here for each substitution variable you are using for this profile. If no value is entered for a
variable, the default value is used.

The variable name and default value cannot be modified in this view.

Figure 11. Inserting a Substitution Variable
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Procedure

1. Select the Substitution Profile view in the Utilities pane.
2. Select Create New Profile.
3. Enter a name for the profile in the Label field.
4. Select Next.
5. This screen displays all of the substitution variables that are currently available. You can enter a

Profile Value for any substitution variables that apply to this profile. If no value is entered for a
variable, the default value is used.

6. Select Next.
7. Apply metadata as needed and select Finish.

Assign and Activate a Substitution Profile for Dynamic Delivery:

To activate substitution variables for dynamic delivery, a substitution profile must be assigned to a
member account.

Multiple profiles can be assigned, but a profile must be selected from the Active Profile drop-down list
to be activated. When that member accesses content, that profile is applied. Substitution profiles are
assigned within a member account in the Member Management category.

When two or more substitution profiles are assigned to a member account, that member can activate a
profile through a drop-down list in the Personal Information category.

Preview Content with Substitution Variables:

Developers can preview different values for substitution variables in theDetails Pane preview.

Selecting Choose Substitution Profile from the Options menu in the preview, and then choosing a
substitution profile, refreshes the Preview to display the appropriate substitution variable values. In
editable preview or inline review, the substitution variable displays as the actual variable (not the
variable value) so that the editor is aware that a variable is present. If the variable is edited, it is treated
as follows:
v If the edit results in a different variable, that new variable is represented.
v If the edit results in a non-existent variable, it is treated as plain text.

Manage Substitution Profiles and Variables:

The Substitution Profiles utility and Substitution Variables utilities are used to search for and manage
profiles and variables. You can copy, paste, delete, and modify variables and profiles in these views.

Note: You cannot delete substitution variables if they are currently being used within content. To learn
more about using the search utilities, see Content Search.

Author Assessment Elements
The following topics describe how to create and configure Assessment elements that can be used both as
practice questions and in scored assessments.

Author a DragDrop Assessment Element
The DragDrop Assessment element provides you with options for creating visually interactive
assessments that test learner knowledge. Learners are required to drag answer choices and drop them
onto appropriate areas of a base image.
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How the DragDrop Assessment Element Functions:

The learner is provided with a base image of mapped areas, and instructions for completing the
interaction.

Procedure

1. Smaller images appear to the right of the base image. Learners drag these smaller images to the base
image and drop them onto the appropriate mapped area.

2. If the Assessment element is a practice item, learners can check to see whether they answered
correctly, and are provided with associated feedback and remediation.

3. If the Assessment element is part of an Assessment, learners who answered incorrectly are provided
with a prescription for review.

Note: DragDrops have a one-to-many relationship. This means that you can specify more than one
drag image per drop area on the base image.

Rendering of the DragDrop Assessment Element in the Learning Portal:

The following image depicts what the learner sees through the Learning Portal.

Source View:

The Source view of the DragDrop Assessment element is where the content of the element is configured.

Drop Areas Dialog Box:

The Drop Areas dialog box provides a way for you to do the following tasks:
v Define the drop areas of the base image
v Indicate drag images
v Match drop areas and drag images
v Provide individual answer feedback.

For details on using shapes to create map areas, see Creating Shapes for Map Areas.

Authoring a New DragDrop Assessment Element:

Use this procedure to author a new DragDrop Assessment element.

Figure 12. Rendering of the DragDrop Assessment Element in the Learning Portal

Introduction 31



Procedure

1. Create a DragDrop element by dragging and dropping from the Object Palette or by using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. You can also select the label in the Objects view
to edit the text.

3. In the Source view, enter a title for the element in the Title field, and enter the question, statement,
or instructions in the Text field.

4. Select a Shuffle option as follows:
v Not Shuffled if you do not want the drag images to ever be shuffled
v Shuffle All Answers if you would like drag images to be randomly shuffled each time that the

question is taken
v Shuffle Distractors Only if you would like incorrect drag images to be randomly shuffled each

time that the question is taken
5. Select the number of times that a learner can attempt to answer the question from the Number of

Tries drop-down list.
6. For drag images, select the:
v Show Drag Border check box to display a border around each drag image.
v Show Drag Zone check box to display a border around the group of drag images.
v Show Target Areas check box to display the designated drop areas on the base image.

7. If you like, you can provide remediation for the Assessment element.
8. You can also provide hints for the Assessment element.
9. Enter the label of the base image in the Label field of the Media frame, or search for the Media

Object.
10. In the Alt Text field, enter a description of the image - this description is used in place of the image

in a 508 compliant environment.
11. Select the Map areas button in the Media frame. The Drop Areas dialog box appears.
12. The first map area shape is a rectangle, by default. Select and drag the red indicator box to the

preferred drop area on the base image. You can resize the box by clicking the pointer on a corner of
the box and dragging the pointer.

Note: If you want the first mapped area to be a shape other than a rectangle, you must create the
new shape first, then delete the original rectangle. New shapes are created by selecting the shape
type from the toolbar, clicking once to begin the map area, then clicking again to complete the map
area. For complete details on using shapes to create map areas, see Creating Shapes for Map Areas.

13. To add a drop area, select the Add button and repeat Step 12. To delete the current drop area, select
the Delete button .

14. Enter an image label in the Label field of the Drag Image frame, or browse for the Media Object.
15. To add a drag image, select the Add button and repeat Step 14. To delete the current drag image,

select the Delete button.

Note: You can add more drop images than drop areas.
16. Select a drop area from the Area drop-down list of the Matches frame, and select the drag image for

that drop area. If you would like to provide feedback for the answer, enter it in the Feedback field.
17. To add a match, select the Add button and repeat Step 16. To delete the current match, select the

Delete button. To view all match areas at once, select the Summary button . You can add, edit, and
delete match areas in this view.

Note: You can assign more than one image to the same drop area, and you can assign the same
image to more than one drop area.

18. Save your work.
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Authoring a Fill in the Blank Assessment Element
The Fill in the Blank Assessment element is used to test learner recall of memorized information. You can
use a direct question format or an incomplete statement format, whereby learners supply words, phrases,
numbers, or symbols.

How the Fill in the Blank Assessment Element Functions:

The Fill in the Blank Assessment element provides a means for assessing a learner's ability to complete a
phrase or short answer about:
v Recall of facts.
v Comprehension of the subject.
v The application of specific process or procedural information.

The learner reads the statement or question and type the answers in the provided fields.

If the Assessment element is a practice item, learners can check to see whether they answered correctly,
and be provided with associated feedback and remediation. If the Assessment element is part of an
Assessment, learners who answered incorrectly are provided with a prescription for review.

How the Fill in the Blank Assessment Element Renders:

The following image depicts what the learner sees through the Learning Portal.

Source View:

The Source view of the Fill in the Blank Assessment element is where the content of the element is
configured.

Tip: If the blanks to the question or statement are ordered, learner responses must match the order of the
answers. To require that learner responses match the specific order of the answers, select the Ordered
check box in the Question field in the Source view.

Answers Dialog Box:

The Answers dialog box is launched with the Alternates button. The Alternates button is located in the
Answer frame on the Fill in the Blank Assessment element Source view.

The Answers dialog box enables the indication of acceptable alternate correct answers from the learner.

Alternate Renderings:

LCMS Premier provides the capability to create and apply renderings to elements.

Renderings are alternate ways to display an element to students. Renderings are implemented as java
classes (and resource files) and can be placed on the application's classpath. They can be deployed as
.class files or in a jar file, and must be referenced in the content_render.xml file on the application server.

Figure 13. Fill in the Blank Assessment Element Rendering in the Learning Portal
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Developers can select a rendering in the General view.

Authoring a New Fill in the Blank Assessment Element:

To create a Fill in the Blank Assessment element.

Procedure

1. Create a Fill in the Blank element by dragging and dropping from the Object Palette or by using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. You can also select the label in the Objects view
to edit the text.

3. In the Source view, enter a title for the element in the Title field.
4. Enter the “fill in the blank question or statement” in the Text field. Create the answer blanks by

typing at least three consecutive underscores (___).
5. Select the Ordered check box if answers must be given by the learner in a certain order.
6. Select the number of times that a learner can attempt to answer this question from the Number of

Tries drop-down list.
7. If you like, you can provide hints for the Assessment element.
8. You can also provide remediation for the Assessment element.
9. If you would like to display an image, enter the image label in the Label field of the Media frame,

or search for the Media Object. To display the image as a link, select the Display as Link check box
and enter a label in the Link Text field.

10. In the Alt Text field, enter a description of the image - this description is used in place of the image
in a 508 compliant environment.

11. In the Answer frame, select Text or Number from the Type drop-down list, depending on the type
of answer that is represented by the blank.

12. Enter the number of characters to which you would like to limit the length of the response in the
Length field.

13. Assign a weight to the answer for partial scoring purposes.
14. For a textual answer, enter an answer in the Answer field of the Answer frame. If you would like to

create other acceptable answers, select the Alternates button 
 

to open the Anticipated Answers
dialog box. Enter an "alternate" answer in the Answer field. You can add as many alternate answers
as needed. When finished, select Close.

15. For a textual answer, select a requirement for the answer from the Format drop-down list, and select
the Case Sensitive check box if the answer must match the upper and lower cases that are specified.

16. For a numeric answer, you can choose to require that the student input the exact number by
selecting the Exact radio button, or you can allow the student to answer within a certain range by
selecting the Range radio button. Use the Include check boxes to specify the requirements. For
example, if the Min Include check box is cleared, but the Max Include check box is selected, then
the student can enter any value not to exceed the specified maximum. For number answers, you can
also select an option from the Rounding drop-down list that rounds the answer to the chosen
decimal point.

17. If you would like to provide feedback for the answer, enter it in the Feedback field. Enter the
number or characters to which you would like to limit the length of the response in the Length field.

18. To add an answer, select the Add button and repeat Steps 11 - 17. To delete the current answer, select
the Delete button.
Note: To view all answers at the same time, select the Summary button . You can add, edit, and
delete answers in this view.

19. Save your work.
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Authoring a HotSpot Assessment Element
The HotSpot Assessment element makes it possible to create an image-based interaction that tests learner
knowledge.

About this task

Learners are required to answer specific questions by selecting areas of a particular image. In addition,
the HotSpot Assessment element conserves screen space by combining several questions or a series of
questions within one assessment item.

How the HotSpot Assessment Element Functions:

The learner is provided with a base image of mapped areas, and instructions for completing the
interaction.

Procedure

1. The learner is prompted to mouse select on certain portions of the provided image as indicated by the
introductory text.

2. If the Assessment element is a practice item, learners can check to see whether they answered
correctly and be provided with associated feedback and remediation.

3. If the Assessment element is part of an Assessment, learners who answered incorrectly are provided
with a prescription for review.

How the HotSpot Assessment Element Renders:

The following image depicts the relationship between what the learner sees through the Learning Portal.

Source View:

The Source view of the HotSpot Assessment element is where the content of the element is configured.

Map Areas Dialog Box:

The Map Areas dialog box provides a way for you to define the hotspot areas of the base image, indicate
correct and incorrect answers, and provide individual answer feedback.

For details on using shapes to create map areas, see Creating Shapes for Map Areas

Figure 14. HotSpot Assessment Element in the Learning Portal
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HotSpot Scoring:

HotSpot elements are scored with a combination of mapped and unmapped answer weights. These
weights are configured as follows:
v Mapped weights - The weight for each mapped area is entered in the Weight field on the Map Areas

dialog box. If a correct or incorrect mapped area is selected, this value is applied to the answer.
v Unmapped weights - The weight for unmapped elements is entered in the Unmapped Weight field on

the Source view. If an unmapped area is selected, this value is applied to the answer.

Scoring for HotSpot elements is calculated with the following formula:

(Weight of correct selections - Weight of incorrect selections) / Weight of available correct answers

Example

An ordered HotSpot element contains six areas, with the correct order 1, 2, 3, 4, 5, 6. Correct and
incorrect mapped areas are all assigned a weight of 1, while unmapped areas are assigned a weight of 2.
The learner makes the following selections: 1,2, incorrect, 4, unmapped, 6. The score for the question is:
(4-(1+2))/6= .17

Authoring a New HotSpot Assessment Element:

Perform the following steps to create a HotSpot Assessment element.

Procedure

1. Create a HotSpot element by dragging and dropping from the Object Palette or by using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. You can also select the label in the Objects view
to edit the text.

3. In the Source view, enter a title for the element in the Title field, and enter an introduction in the
Text field.

4. Select the Ordered check box if answers must be given by the learner in a certain order.
5. Select the number of times that a learner can attempt to answer this question from the Number of

Tries drop-down list.
6. Enter a weight for unmapped areas in the Unmapped Weight field. If selected, these areas count

against the final score for the question.
7. If you like, you can provide hints for the Assessment element.
8. You can also provide remediation for the Assessment element.
9. To limit the number of selects a learner can make in the question, select the Limit check box, then

type the number of selects in the Max Selects field.
10. Enter the label of the base image in the Label field of the Media frame, or search for the Media

Object.
11. In the Alt Text field, enter a description of the image - this description is used in place of the image

in a 508 compliant environment.
12. Select the Map areas button . The Map Areas dialog box appears.
13. The first map area shape is a rectangle, by default. Select on and drag the red indicator box to the

preferred drop area on the base image. You can resize the box by selecting the pointer on a corner of
the box and dragging the pointer.

Note: If you would like the first mapped area to be a shape other than a rectangle, you must create
the new shape first, then delete the original rectangle. New shapes are created by selecting the shape

36 IBM Kenexa® LCMS Premier Version 9.4: User's Guide August 2015



type from the toolbar, first selecting to begin the map area, then selecting again to complete the map
area. For complete details on using shapes to create map areas, see Creating Shapes for Map Areas.

14. Select the Correct check box for the correct drop area. If you would like to provide feedback for the
answer, enter it in the Feedback field.

15. To add a map area, select the Add button and repeat Steps 13 and 14. To delete the current map
area, select the Delete button.

Note: To view all answers at the same time, select the Summary button. You can add, edit, and
delete answers in this view.

16. Select OK.
17. Save your work.

Create Shapes for Map Areas
During the creation of map areas, you are given the ability to create different shapes for each map area.
The Map Areas toolbar supports the creation, management, and deletion of shapes that are used for map
areas.

Map Areas are used for the following elements:
v Image Map
v Mouseover
v HotSpot
v DragDrop

Table 12. Toolbar Button Functions. The following table describes each button on the toolbar.

Item Description

 
Select

Selecting the Select button makes it possible for you to select a map area to do any of
the following concepts:

v Select and drag to reposition the map area. You must select inside the border to
reposition.

v Delete the map area.

v Resize the map area.

You must select the squares on the border to resize.

 
Rectangle

Select the Rectangle button to draw a rectangular map area. The shape is inserted by
selecting the base image and dragging the mouse to properly resize the shape. When
you resize a rectangle, the original aspect ratio is not maintained.

 
Circle

Select the Circle button to draw a circular map area. The shape is inserted by selecting
the base image and dragging the mouse to properly resize the shape. When you resize
a rectangle, the circular shape is maintained.

 
Polygon

Select the Polygon button to draw a freeform polygon map area. You can now create
your own shape with as many edges as desired. See “Creating a Polygon Map Area”
on page 38 for further instructions on creating the Polygon shape.

 
Delete

Select the Delete button to delete a shape and its corresponding popup text or media.
The shape must first be selected before you delete it. After deletion, the remaining
shapes are numbered.

 
Move Base Image Select the Move Base Image button to select and drag the base image to reposition it.

Note: When the Map Areas dialog box is opened for a new object, the first map area defaults to a
rectangle shape. To change the shape for the first area, you must first create a new shape, and then delete
the default rectangle.
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Creating a Polygon Map Area:

The process of creating polygon shapes is different from the process to create a rectangle or circle,
because you create your own custom shape.

About this task

When you insert a polygon, select the Polygon button, then select on the base image and release the
mouse button. You see a line between your cursor and the insertion point. Select and release again where
you want the second point of the polygon to be. Continue this process until you have one more line to
draw, between your existing point and the insertion point, to complete the polygon. Double-select to
complete the polygon.

The following series of images show the creation of a sample polygon.

The insertion point is made and the initial line is drawn.

The mouse button is selected and another line is drawn.

The mouse button is selected and another line is drawn.

Figure 15. Creating a Polygon Map Area - Step 1

Figure 16. Creating a Polygon Map Area - Step 2

Figure 17. Creating a Polygon Map Area - Step 3
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The mouse button is double selected and the polygon is completed. The border is rectangular - when
resizing, the aspect ratio is not maintained.

Authoring a Matching Assessment Element
You can use the Matching Assessment element to create interactions that test learners on identifying,
organizing, and categorizing relationships between items and answers. Learners read the basis for
matching in the directions, select their match responses, and submit answers.

How the Matching Assessment Element Functions:

The learner is provided with instructions for completing the interaction.

Procedure

1. The learner sees a numbered list that contains match items with the answer choices next to each
match item. The method of answering (check box, radio button, drop-down list) depends on the
configuration and the number of answers allowed.

2. To complete the assessment, the learner selects the answer that represents the best match about the
answer options and match item provided.

3. If the Assessment element is a practice item, learners can check to see whether they answered
correctly and be provided with associated feedback and remediation.

4. If the Assessment element is a part of an Assessment, learners who answered incorrectly are provided
with a prescription for review.

How the Matching Assessment Element Renders:

The following image depicts what the learner sees through the Learning Portal.

Source View:

The Source view of the Matching Assessment element is where the content of the element is configured.

Figure 18. Creating a Polygon Map Area - Step 4

Figure 19. Rendering of the Matching Assessment Element in the Learning Portal
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Note: Individual answer weights cannot be manually assigned on the Matching element Source view.
The default value of each answer weight is 1. This value prevents a learner from getting full credit by
choosing all the responses, including the incorrect ones.

Summary Dialog Box:

To view all items, answers, and matches at the same time, select the Summary button in the Matches
frame. You can add, edit, and delete items and matches within the launched Summary dialog box.

Alternate Renderings:

You can create and apply renderings to elements.

Renderings are alternate ways to display an element to students. Renderings are implemented as java
classes (and resource files) and can be placed on the application's classpath. They can be deployed as
.class files or in a "jar" file, and must be referenced in the content_render.xml file on the application
server.

The Matching Assessment element provides the following alternate renderings:
v Connection
v Dropdown List
v Dropdown List (multi-select)

The Connection rendering enables users to draw lines to connect the matching objects. This rendering can
be used for answers with single or multiple matches.

Dropdown List Rendering:

The Dropdown List rendering enables learners to select the correct matches from drop-down lists. The
Dropdown List rendering can be used for answers with single matches.

Figure 20. Connection Rendering
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Dropdown List (multi-select) Rendering:

The Dropdown List (multi-select) rendering enables users to select multiple matches from drop-down
lists. This rendering can be used for answers with single or multiple matches.

Authoring a New Matching Assessment Element:

Perform the following steps to create a Matching Assessment element.

Figure 21. Dropdown List Rendering

Figure 22. Dropdown List (multi-select) Rendering
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Procedure

1. Create a new Matching element by dragging and dropping from the Object Palette or by using the
right-select menu in the Objects view.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field, and enter an introduction in the
Text field.

4. Select a Shuffle option as follows:
v Not Shuffled if you do not want answers to ever be shuffled
v Shuffle All Answers if you would like answers to be randomly shuffled each time that the

question is taken
v Shuffle Distractors Only if you would like incorrect answers to be randomly shuffled each time

that the question is taken
5. Select the number of times that a learner can attempt to answer this question from the Number of

Tries drop-down list.
6. You can also provide remediation for the Assessment element.
7. You can also provide hints for the Assessment element.
8. If you would like to display an image, enter the image label in the Label field of the Media frame,

or search for the Media Object. To display the image as a link, select the Display as Link check box
and enter a label in the Link Text field.

9. In the Alt Text field, enter a description of the image - this description is used in place of the image
in a 508 compliant environment.

10. Enter a question, word, or phrase in the Text field of the Item frame. You can use a Media Object as
a question by entering a valid media label in the Media field, or browse for the Media Object.

11. Enter the answer in the Text field of the Answer frame. You can use a Media Object as an answer by
entering a valid media label in the Media field, or browse for the Media Object.

12. To add a question and answer, select the corresponding Add button 
 

and repeat Steps 10 and 11.
To delete the current question or answer, select the corresponding Delete button 

 
.

13. Select an item from the Item drop-down list in the Matches frame and select its correct answer from
the Answer drop-down list. If you would like to provide feedback for the answer, enter it in the
Feedback field.

14. To add a match, select the Add button and repeat Step 13. To delete the current match, select the
Delete button.

Note: To view all items and matches at the same time, select the Summary button . You can add,
edit, and delete items and matches in this view.

15. Save your work.

Authoring a Multiple Choice - Multiple Answer Assessment Element
The Multiple Choice-Multiple Answer Assessment element is used to create question with multiple
choices that has more than one correct answer.

About this task

You can use this element to provide learners with distractors by creating more than one possible answer
to the question. Learners read the question or statement choices, select answers from the list of choices,
and submit the answers for evaluation.

42 IBM Kenexa® LCMS Premier Version 9.4: User's Guide August 2015



How the Multiple Choice-Multiple Answer Assessment Element Functions:

The Multiple Choice-Multiple Answer Assessment element provides testing items for learners to discern
correct information from a number of closely related alternatives. The learner reads the statement or
question and choose from multiple answer options by selecting the appropriate check boxes.

If the Assessment element is a practice item, learners can check to see whether they answered correctly
and be provided with associated feedback and remediation. If the Assessment element is a part of an
Assessment, learners who answered incorrectly are provided with a prescription for review.

How the Multiple Choice-Multiple Answer Assessment Element Renders:

The following image depicts what the learner sees through the Learning Portal.

Source View:

The following image depicts the Source view of the Multiple Choice - Multiple Answer Assessment
element, where the content of the element is configured.

Alternate Renderings:

You can create and apply renderings to elements. Renderings are alternate ways to display an element to
students.

Renderings are implemented as java classes (and resource files) and can be placed on the application's
classpath. They can be deployed as .class files or in a "jar" file, and must be referenced in the
content_render.xml file on the application server.
v Multiple Choice - Buttons 1
v Multiple Choice - Buttons 2

Figure 23. Multiple Choice-Multiple Answer Assessment Element Rendering

Figure 24. Multiple Choice - Multiple Answer Assessment Element in Source View
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The same alternate renderings apply to both the Multiple Choice - Multiple Answer Assessment element
and the Multiple Choice - Single Answer Assessment element. The following alternate renderings are
provided:

The Buttons 1 alternate rendering provides a button for each answer you want to select.

The Buttons 2 alternate rendering provides larger check boxes for each answer you want to select.

Authoring a New Multiple Choice - Multiple Answer Assessment Element:

Perform the following steps to create a Multiple Choice - Multiple Answer Assessment element.

Procedure

1. Create a new Multiple Choice-Multiple Answer element by dragging and dropping from the Object
Palette or by using the right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field, and enter an introduction in the
Text field.

4. Select a Shuffle option as follows:
v Not Shuffled if you do not want answers to ever be shuffled
v Shuffle All Answers if you would like answers to be randomly shuffled each time that the

question is taken
v Shuffle Distractors Only if you would like incorrect answers to be randomly shuffled each time

that the question is taken
5. Select the number of times that a learner can attempt to answer this question from the Number of

Tries drop-down list.
6. You can also provide remediation for the Assessment element.
7. You can also provide hints for the Assessment element.
8. If you would like to display an image, enter the image label in the Label field of the Media frame,

or search for the Media Object. To display the image as a link, select the Display as Link check box
and enter a label in the Link Text field.

9. In the Alt Text field, enter a description of the image - this description is used in place of the image
in a 508 compliant environment.

10. Enter an answer in the Answer field of the Answer frame. You can also use a Media Object as an
answer by entering a valid media label in the Media field, or search for the Media Object. If you
would like to provide feedback for the answer, enter it in the Feedback field.

11. Select the Correct check box if this answer is correct.
12. To add an answer, select the Add button and repeat Steps 10 and 11. To delete the current answer,

select the Delete button.
Note: To view all answers at the same time, select the Summary button. You can add, edit, and
delete answers in this view.

13. Save your work.

Authoring a Multiple Choice - Single Answer Assessment Element
The Multiple Choice-Single Answer Assessment element is used to create a question with closely related
choices from which a learner is to select the correct or best answer.
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How the Multiple Choice-Single Answer Assessment Element Functions:

The Multiple Choice-Single Answer Assessment element provides testing items for learners to discern
correct information from a number of closely related alternatives. The learner reads the statement or
question and choose the best answer by selecting the appropriate radio button.

If the Assessment element is a practice item, learners can check to see whether they answered correctly
and be provided with associated feedback and remediation. If the Assessment element is part of an
Assessment, learners who answered incorrectly are provided with a prescription for review.

How the Multiple Choice-Single Answer Assessment Element Renders:

The following image depicts what the learner sees through the Learning Portal.

Source View:

The following image depicts the Source view of the Multiple Choice-Single Answer Assessment element,
where the content of the element is configured.

Note: Authoring a Multiple Choice-Single Answer Assessment element is identical to authoring a
Multiple Choice-Multiple Answer Assessment element. The only difference is that the Correct check box
is selected for one answer choice.

Alternate Renderings:

You can create and apply renderings to elements. Renderings are alternate ways to display an element to
students.

Renderings are implemented as java classes (and resource files) and can be placed on the application's
classpath. They can be deployed as .class files or in a "jar" file, and must be referenced in the
content_render.xml file on the application server.

Figure 25. Assessment Element Rendering

Figure 26. Multiple Choice-Single Answer Assessment Element
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The same alternate renderings apply to both the Multiple Choice - Multiple Answer Assessment element
and the Multiple Choice - Single Answer Assessment element. The following alternate renderings are
provided:
v Multiple Choice - Buttons 1
v Multiple Choice - Buttons 2

The Buttons 1 alternate rendering provides the capability to select a button for each answer you want to
select.

The Buttons 2 alternate rendering provides larger radio buttons for each answer you want to select.

Authoring a New Multiple Choice - Single Answer Assessment Element:

Perform the following steps to create a Multiple Choice - Single Answer Assessment element.

Procedure

1. Create a new Multiple Choice-Single Answer element by dragging and dropping from the Object
Palette or by using the right-select menu in your course treeview.

2. In the General view, type a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field, and enter an introduction in the
Text field.

4. Select a Shuffle option as follows:
v Not Shuffled if you do not want answers to ever be shuffled
v Shuffle All Answers if you would like answers to be randomly shuffled each time that the

question is taken
v Shuffle Distractors Only if you would like incorrect answers to be randomly shuffled each time

that the question is taken
5. Select the number of times that a learner can attempt to answer this question from the Number of

Tries drop-down list.
6. If you like, you can provide remediation for the Assessment element.
7. You can also provide hints for the Assessment element.
8. If you would like to display an image, type the image label in the Label field of the Media frame, or

search for the Media Object. To display the image as a link, select the Display as Link check box
and type a label in the Link Text field.

9. In the Alt Text field, enter a description of the image - this description is used in place of the image
in a 508 compliant environment.

10. Enter an answer in the Answer field of the Answer frame. You can also use a Media Object as an
answer by entering a valid media label in the Media field, or search for the Media Object. If you
would like to provide feedback for the answer, enter it in the Feedback field.

11. Select the Correct check box if this answer is correct. For this Assessment element, you can select this
check box only for one answer.

12. Select Remediation next to the answer choice to add answer-level remediation. See Adding
Remediation to an Assessment Element for more details.

13. To add an answer, select the Add button and repeat steps 10-12. To delete the current answer, select
the Delete button.
Note: To view all answers at the same time, select the Summary button. You can add, edit, and
delete answers in this view.

14. Save your work.
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Authoring an Ordering Assessment Element
You can create interactions that test learners on ordering events, lists, or the steps of a procedure.
Learners read the basis for ordering in the directions and use numbered drop-down lists to submit
answers.

How the Ordering Assessment Element Functions:

The learner is provided with instructions for completing the interaction.

Procedure

1. The learner sees a list of answers. Next to each answer is a numbered drop-down list.
2. To complete the assessment, the learner selects a number from the drop-down list next to the answer

selection that best matches the order about the instructions provided.
3. If the Assessment element is a practice item, learners can check to see whether they answered

correctly and be provided with associated feedback and remediation.
4. If the Assessment element is part of an Assessment, learners who answered incorrectly are provided

with a prescription for review.

How the Ordering Assessment Element Renders:

The following image depicts what the learner sees through the Learning Portal.

Source View:

The following image depicts the Source view of the Ordering Assessment element, where the content of
the element is configured.

Figure 27. Order Assessment Element Rendering

Figure 28. Source View if an Ordering Assessment Element
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Summary Dialog Box:

To view all ordered answers at the same time, select the Summary button. You can add, edit, and delete
answers within the launched Summary dialog box.

Alternate Renderings:

You can create and apply renderings to elements. Renderings are alternate ways to display an element to
students.

Renderings are implemented as java classes (and resource files) and can be placed on the application's
classpath. They can be deployed as .class files or in a "jar" file, and must be referenced in the
content_render.xml file on the application server.

The Ordering Assessment element provides the following alternate renderings:
v List-to-List
v List-Reorder

The List-to-List rendering enables the user to move items from an unordered list on the left to an ordered
list on the right. Items can be reorganized as necessary.

The List-Reorder rendering enables the user to reorganize a list of items by dragging and dropping the
items.

Authoring a New Ordering Assessment Element:

Perform the following steps to create an Ordering Assessment element.

Procedure

1. Create a new Ordering element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, type a label in the Label field. After you save the content, this label displays in
the Development TreeView.

3. In the Source view, enter a title for the element in the Title field, and enter an introduction in the
Text field.

4. Select a Shuffle option as follows:
v Not Shuffled if you do not want answers to ever be shuffled
v Shuffle All Answers if you would like answers to be randomly shuffled each time that the

question is taken
v Shuffle Distractors Only if you would like incorrect answers to be randomly shuffled each time

that the question is taken

Figure 29. Summary Dialog Box
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5. Select the number of times that a learner can attempt to answer this question from the Number of
Tries drop-down list.

6. If you like, you can provide hints for the Assessment element.
7. You can also provide remediation for the Assessment element.
8. If you would like to display an image, type the image label in the Label field of the Media frame, or

search for the Media Object. To display the image as a link, select the Display as Link check box
and type a label in the Link Text field.

9. In the Alt Text field, enter a description of the image - this description is used in place of the image
in a 508 compliant environment.

10. Enter an answer in the Answer field of the Answer frame. You can also use a Media Object as an
answer by entering a valid media label in the Media field, or search for the Media Object. If you
would like to provide feedback for the answer, enter it in the Feedback field.

11. To add an answer, select the Add button and repeat step 10. To delete the current answer, select the
Delete button.

Note: To view all answers at the same time, select the Summary button. You can add, edit, and
delete answers in this view.

Authoring an Extended Media Assessment Element
With the Extended Media Assessment element, you can embed a Shockwave or Flash file as an
Assessment element. The element contains an API that a developer can use to set the values that are
required to communicate scoring information between the Shockwave or Flash file and LCMS Premier.

How the Extended Media Assessment Element Renders:

The following image depicts what the learner sees through the Learning Portal.

Source View:

The following image depicts the Source view of the Extended Media Assessment element, where the
content of the element is configured.

Figure 30. Extended Media Assessment Element Rendering in the Learning Portal
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Assessment Settings Dialog Box:

Developers of Extended Media Assessment elements can configure how the answers and scores are
communicated between LCMS Premier and the Shockwave/Flash file. These values are entered in the
Assessment Settings dialog box, which is opened by selecting Settings in the Source view.

Table 13. Assessment Settings Dialog Box Components. The following table described the components of the
Assessment Settings dialog box.

Authoring Field Description

Practice Settings
The Reset Function field defaults to "reset()". Use this setting if you would like to
reset the practice question after each try (where the number of tries available is
greater than one).

Start Settings

The start settings determine how the answers and scores are stored. By default, the
Object reads settings from LCMS Premier radio button is selected. If the LCMS
Premier will write settings to object radio button is selected, then the developer can
replace the default values with a custom function, or enter custom JavaScript.

End Settings

The end settings determine how the answers and scores are retrieved. By default, the
Object will write settings to LCMS Premier radio button is selected. If the LCMS
Premier will read settings from object radio button is selected, then the developer
can enter custom values to communicate the answers and scores to LCMS Premier.

End Settings - Id Function

This field is enabled only if the Object reads settings from LCMS Premier or Object
writes settings to LCMS Premier radio button is selected. The developer must enter
JavaScript that is called by LCMS Premier to pass the element GUID to the
Shockwave/Flash file. The Shockwave/Flash file must pass this GUID back to LCMS
Premier in the JavaScript API calls. An example would be as follows:
$EVO_plugin_object$.SetVariable("EVO_guid", $EVO_guid$)

Authoring a New Extended Media Assessment Element:

Perform the following steps to create an Extended Media Assessment element.

Procedure

1. Create a new Extended Media element by dragging and dropping from the Object Palette or by
using the right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field.

Figure 31. Source View of an Extended Media Assessment Element
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4. Select the number of times that a learner can attempt to answer this question from the Number of
Tries drop-down list.

5. You can also provide remediation for the Assessment element.
6. You can also provide hints for the Assessment element.
7. Enter the media label in the Label field of the Extended Media Assessment frame, or browse for the

Shockwave/Flash file.
8. To configure launch and scoring settings, select Settings to open the Assessment Settings dialog box.
9. Configure practice, start, and end settings, and select OK.

10. To configure the media player options, select the Advanced Media Parameters button and open the
Parameters window.

11. Select from the available media players in the Player drop-down list.
12. The default parameters available for the player you selected populate the Default frame. Select the

Use check box next to each parameter that you would like to enable, then select a value from the
Value drop-down list.

13. If you have built custom parameters into the selected media player, you can enter these parameters
in the Name and Value field of the Custom frame. You can add or delete custom parameter fields by
selecting the Add and Delete buttons.

14. Select OK.
15. In the Alt Text field of the Media frame, enter a description of the image - the description is used in

place of the media in a 508 compliant environment.
16. You can specify the dimensions (in pixels) of the media in the Height and Width fields. To keep the

dimensions consistent when you are making a change, select the Maintain Ratio check box.
17. Enter a short description of the image in the Caption field of the Media frame, and select the

preferred image alignment from the Alignment drop-down list.
18. Enter a title for the text area in the Title field of the Text Area frame.
19. Enter the text in the Text field. Use the drop-down lists in the Position and Alignment frames to

position the text area next to the image.
20. To add another text area, select the Add button and repeat Steps 18 and 19. You can add multiple

text areas to this element. To delete the current text area, select the Delete button.

Note: To view all text areas at the same time, select the Summary button. You can add, edit, and
delete text areas in this view.

21. Save your work.

Authoring a SoftSim Assessment Element
You can use the SoftSim Assessment element to embed a SoftSim file as an Assessment element. The
element contains an API that communicates scoring information between the SoftSim file and LCMS
Premier.

About this task

Only simulations that were published from SoftSim to LCMS Premier are available for use in this
element. After the simulations are published to LCMS Premier, they are stored in the
SoftSim_Media_Category.
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How the SoftSim Assessment Element Renders:

The following image depicts what the learner sees through the Learning Portal.

Source View:

The following image depicts the Source view of the SoftSim Assessment element, where the content of
the element is configured.

Parameters Dialog Box:

Developers of SoftSim Assessment elements can configure display settings and assessment settings for the
element. These values are entered in the Parameters dialog box, which is opened by selecting SoftSim
Playback Options in the Source view.

Table 14. Parameters Dialog Box Parameters. The following table describes the components of the Parameters
dialog box.

Authoring Field Description

Figure 32. SoftSim Assessment Element Rendering

Figure 33. Source View of the SoftSim Assessment Element
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Table 14. Parameters Dialog Box Parameters (continued). The following table describes the components of the
Parameters dialog box.

Section drop-down list

There are two selections available:

1. general - The dialog box contains fields for simulation settings, as shown in the
image.

2. assessment - The dialog box contains an Attempts Per Step field, allowing the
developer to specify the number of times that a user can attempt any step of a
simulation.

Player Height Height of the simulation player, in pixels.

Player Width Height of the simulation width, in pixels.

Screen Location X
Location of the upper-left corner of the player (in pixels) from the left side of the
screen.

Screen Location Y Location of the upper-left corner of the player (in pixels) from the top of the screen.

Screen Review Mode Determines whether the simulation starts in review mode.

Layout Step Pane Determines whether the SoftSim Step Pane displays with the simulation

Layout Text Pane Determines whether the SoftSim Text Pane displays with the simulation

Layout Description Determines whether the step description text displays with the simulation

Layout Position

Determines the position of the following panes:

v Step

v Text

v Narration

Restart Determines whether the simulation will automatically restart after it finishes playing.

Audio Determines whether the simulation contains audio

Starting Step Allows the developer to specify the ID of the step at which the simulation begins.

Bookmarking
Allows the developer to enable bookmarking, which enables the user to start a
simulation where they last left off before closing. A value of 1 enables bookmarking.

Authoring a New SoftSim Assessment Element:

Perform the following steps to create a new SoftSim Assessment element.

Procedure

1. Create a SoftSim element by dragging and dropping from the Object Palette or by using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field.
4. Select Browse in the Simulation frame to find a SoftSim object.
5. To configure launch settings, select SoftSim Playback Options to open the Assessment Settings

dialog box.
6. In the Alt Text field of the Simulation frame, enter a description of the simulation - this description

is used in place of the simulation in a 508 compliant environment.
7. If you would like to add a thumbnail image next to the simulation link, enter the media label in the

label field, or search for the Media Object. Select a position of Left or Right for the thumbnail.
8. In the Alt Text field of the Thumbnail frame, enter a description of the thumbnail - this description

is used in place of the simulation in a 508 compliant environment.
9. In the Mode frame, select the preferred playback mode for the simulation.
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10. Save your work.

Authoring a TrueFalse Assessment Element
Use the TrueFalse Assessment element to assess the understanding of learners by asking them to identify
the validity of a statement that relates to the content that is being covered. Learners read the statement
and respond by choosing one of the two available answers.

How the TrueFalse Assessment Element Functions:

The learner is provided with a statement and two binary answer choices.

Procedure

1. To complete the assessment, the learner selects the radio button that corresponds to the correct
answer.

2. If the Assessment element is a practice item, learners can check to see whether they answered
correctly and be provided with associated feedback and remediation.

3. If the Assessment element is part of an Assessment, learners who answered incorrectly are provided
with a prescription for review.

Note: The TrueFalse Assessment element enables two answer choices only. These answer choices
default to "true" and "false"; however, any binary relationship labels, such as "yes" and "no", can be
used in their place.

How the TrueFalse Assessment Element Renders:

The following image depicts the relationship between what the learner sees through the Learning Portal,
and how the same information looks as entered in the Source view.

Source View:

The following image depicts the Source view of the TrueFalse Assessment element, where the content of
the element is configured.

Figure 34. Rendering of the TrueFalse Assessment Element in the Learning Portal
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Note: The Number of Tries drop-down list, Add button, and Delete button are inactive in the TrueFalse
Assessment element Source view.

Alternate Renderings:

LCMS Premier provides the capability to create and apply renderings to elements. Renderings are
alternate ways to display an element to students. Renderings are implemented as java classes (and
resource files) and can be placed on the application's classpath. They can be deployed as .class files or in
a jar file, and must be referenced in the content_render.xml file on the application server.

About this task

The TrueFalse Assessment element provides the following alternate renderings:
v True False - Buttons 1
v True False - Buttons 2

The Buttons 1 rendering provides standard buttons select to make your answer selection.

TrueFalse - Buttons 2:

The Buttons 2 rendering provides radio buttons to make your answer selection.
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About this task

Authoring a New TrueFalse Assessment Element:

Perform the following steps to create a TrueFalse Assessment element.

Procedure

1. Create a new TrueFalse element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview. Select the General view and continue with the steps
below:

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field, and enter the question in the Text
field.

4. You can also provide remediation for the Assessment element.
5. You can also provide hints for the Assessment element.
6. If you would like to display an image, enter the image label in the Label field of the Media frame,

or search for the Media Object. To display the image as a link, select the Display as Link check box
and enter a label in the Link Text field.

7. In the Alt Text field, enter a description of the image - this is used in place of the image in a 508
compliant environment.

8. If you would like to use an answer other than True, enter the answer in the Answer field of the
Answer frame. You can also use a Media Object as an answer by entering a valid media label in the
Media field, or search for the Media Object.

9. To provide additional feedback for the answer, enter it in the Feedback field. If True is the correct
answer, select the Correct check box.

10. Select the Next button. If you would like to use an answer other than False for answer 2, enter the
answer in the Answer field. You can also use a Media Object as an answer by entering a valid media
label in the Media field, or search for the Media Object.

11. If you would like to provide feedback for the answer, enter it in the Feedback field. If False is the
correct answer, select the Correct check box.
Note: To view all answers at once, select the Summary button 

 
. You may add, edit, and delete

answers in this view.
12. Save your work.

Assigning Weights to Assessment Elements
Learn how to assign weights to individual answer choices of an Assessment element.

About this task

You can assign weights to individual answer choices of an Assessment element to:
v Give learners partial credit for the correct answers they chose in an Assessment element with multiple

correct answers.
v Penalize learners for selecting an answer which is obviously incorrect.
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The Source view of each Assessment element provides a field to set the weight of individual answers.
Depending upon the Assessment element, this field will either be in the Answer, Matches, or Area frame.

Assessment element weights can also be configured in the List view of an Assessment section, where you
can view all weights at once.

You can indicate the weight for each Assessment element contained within an Assessment Section in the
Source view of the section. Weights for Assessment objects and sections must be a number between 0 and
1, not to exceed two decimal places (for example, 0.75).

Partial or complete weighting is possible for different Assessment elements. With complete weighting, the
learner earns the full number of points for the Assessment element or no points. With partial weighting,
the learner can receive points for a response that is only partially correct.

Weights for individual Assessment answers must be a positive whole number. Only those answers,
correct or incorrect, defined by the course developer can be assigned weights. Keeping this in mind,
answer weights for Assessment elements fall into three groups:
1. Full or no credit
2. Partial credit for both correct and incorrect answers
3. Partial credit for correct answers only

Full or No Credit:

Assessment elements providing full or no credit have defined correct and incorrect answers. Assessment
elements that have only one correct response fall into this category, where only complete weighting is
possible. The correct answer is worth full credit and the incorrect answer(s) is worth none. Credit is given
using the following formula:
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About this task

weight of answers completed correctly / weight of available correct answers

Assessment elements in this category are:
v Multiple Choice-Single Answer
v TrueFalse

Note: The Multiple Choice-Single Answer and TrueFalse Assessment elements are worth full credit or
no credit at all; therefore, changing the individual answer weights will have no effect on the outcome.

Partial Credit for Both Correct and Incorrect Answers:

With partial weighting, the learner can receive points for a response that is only partially correct.
Assessment elements in this category provide partial credit for defined correct and incorrect answers.
This means that answer weights can be assigned to both correct and incorrect answers. All answers must
be identified correctly by the learner to receive full credit. Correct answers add to credit and incorrect
answers subtract from credit. Credit is given using the following formula:

About this task

)weight of answers completed correctly - weight of answers completed incorrectly) / weight of available
correct answers

Assessment elements in this category are:
v Matching
v Multiple Choice-Multiple Answer
v HotSpot (unordered)

Note: Individual answer weights cannot be manually assigned in the Matching element Source view.
The default value of each answer weight is 1. This prevents a learner from getting full credit by
choosing all the responses including the incorrect ones.

Partial Credit for Correct Answers Only:

Some Assessment elements cannot have weights for incorrect answers. For example, Fill in the Blank
questions may have incorrect responses not presented in the question, so incorrect answers cannot be
weighted. Similarly, learners cannot be penalized for incorrect responses in Ordering elements.

About this task

Assessment elements in this category provide partial credit for defined correct answers only. This means
that answer weights can be assigned to the correct answers. All answers must be identified correctly by
the learner to receive full credit. Correct answers add to credit. Incorrect answers do not affect credit.
Credit is given using the following formula:

weight of answers completed correctly / weight of available correct answers

Assessment elements in this category are:
v DragDrop
v Fill in the Blank
v HotSpot (ordered)
v Ordering
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Determining Assessment Element Values:

The answer weight feature enables certain answer choices in a question to count more than others.
Correct answer(s) in some types of assessment questions can have weights attached to them.

About this task

Example:

In a Multiple Choice - Multiple Answer question, correct answer #1 might have a weight of 1 and correct
answer #2 a weight of 0.5, so the learner is rewarded more for choosing correct answer #1.

About this task

Similarly, each incorrect answer stated in an Assessment element can be weighted so that one incorrect
answer penalizes the learner more than another.

Example:

In a Multiple Choice - Multiple Answer question, incorrect answer #1 might have a weight of 3 and
incorrect answer #2 a weight of 2, so the learner is penalized more for choosing incorrect answer #1.

About this task

The total answer score of a question is the sum of the points earned for the correct response(s), minus the
sum of the points earned for the incorrect response(s), divided by the number of points possible:

(sum of correct answer points - sum of incorrect answer points) / total answer points available

Example:

Consider Question #1 below:

About this task

Question #1: Which of the following are citrus fruits?

Table 15. Breakdown of question weights. A 
 

marks a correct response, and an 
 

marks an incorrect response.

Answers Correct
Answer

Weight for
Correct

Weight for
Incorrect

Learner 1 Learner 2

Banana no 0.3
 

(1 incorrect pt.)

Orange yes 0.6
 

(2 correct pts.)
 

(2 correct pts.)

Lemon yes 0.6
 

(2 correct pts.)
 

(2 correct pts.)

Squash no 0.9
 

(3 incorrect pts.)

Total Points 4 - 1 = 3 out of 4 4 - 3 = 1 out of 4

On Question #1, Learner 1 earned 3 points (out of the possible 4), and Learner 2 earned 1 point.

Add Hints to an Assessment Element
Learn how to add hints to an assessment element.

You can add hints to Assessment elements that provide learners with some assistance in answering the
question correctly. Hints can be as general or specific as you make them. Select the Hints button in the
Source view of all Assessment elements to launch the Hints dialog box. You can add one or more hints in
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this dialog box.

Tip: If you include more than one hint for an Assessment element, you can order and reorder how you
would like for them to appear to the learner by changing the number in the Order field in the Hints
dialog box.

How Hints Appear through the Learning Portal:

When question hints have been developed in the Content Manager, they appears through the Learning
Portal by way of a Hint button.

About this task

When the learner clicks on the Hint button, it launches a window that displays the hint.

If there is more than one hint associated with the Assessment element, each time the Hint button is
selected, a new hint appears.

Note: The Hint button will only appear to the learner if the Assessment element is used as a practice
item, or appears inline with the content. The Hint button does not appear in Assessments.

Providing Hints for an Assessment Element:

Perform the following steps to add hints to an Assessment element.

Procedure

1. In the Source view of the Assessment element, select the Hints button 
 

. The Hints dialog box
appears.

2. Enter your text in the Hint field of the Hint frame.
3. To add an additional hint, select the Add button 

 
and repeat Step 2. To delete the current hint,

select the Delete button .
4. Select Close.

Add Feedback to an Assessment Element
Learn how to add feedback to an assessment element.

Figure 35. Add Hints to an Assessment Element
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Individual answer feedback can be made available to learners for both correct and incorrect answers.
Through feedback, you can provide your learners with positive reinforcement, as well as additional
information that supports the content within the question.

If feedback is available, it appears in the launched Answer Feedback window through the Learning Portal
when the learner selects the Check button for the Assessment element.

Note: The Check button only displays to the learner if the Assessment element is used as a practice item,
or appears inline with the content. The Check button does display in assessments.

Incorrect Answer Feedback:

When a learner answers all or part of an Assessment element incorrectly, if feedback is available, the
learner will see it in the Answer Feedback window.

About this task

Correct Answer Feedback:

When a learner answers all or part of an Assessment element correctly, if feedback is available, the
learner will see it in the Answer Feedback window.
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About this task

Adding Remediation to an Assessment Element
Remediation is used to provide final feedback to the learner, or to provide optional or mandatory
additional content for review. While individual answer feedback can be made available for each answer
submittal by a learner, remediation is not offered until all available tries are exhausted.

About this task

There are two types of remediation that can be applied to content.
1. Question-level remediation
2. Answer-level remediation

Note: Remediation is only available to the learner if the Assessment element is used as a practice item,
or appears inline with the content. Remediation does not appear in Assessments.

Question-Level Remediation:

With question-level remediation, one instance of remediation is configured for the entire question.

About this task

Clicking the Remediation button 
 

in the Question frame of the Source view of all Assessment elements
launches the Question Remediation dialog box.

The Question Remediation dialog box contains two tabs.

Procedure

1. Feedback tab
2. Remediation tab

Feedback Tab:

On the Feedback Tab, users can enter the final feedback to be delivered to the learner. You can add as
many feedback items as needed, and you can choose to display each item for correct answers, incorrect
answers, or always.
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About this task

Remediation Tab:

On the Remediation Tab, users can add links to remediation content. These links navigate the learner to a
URL or course content for related information. There are two ways in which remediation can be
delivered:

About this task

1. Manually
2. Automatically

With manual remediation, the learner has the option of clicking or not clicking the links provided. You
can create as many URLs/content links as needed, and you can choose to display each item for correct
answers, incorrect answers, or always. With manual remediation, feedback is always displayed. Manual
remediation is configured on the Link tab.

Note: Should you choose to not customize the final answer remediation for the Assessment elements
that you author, note that the default for Correct remediation is "Correct!" The default for Incorrect
remediation is "Incorrect!"

With automatic remediation, the remediation is mandatory. It can be used for branching; based on the
answer given to a question, you can redirect the learner to specific content. Automatic remediation is
configured on the Navigation tab.

You can configure two URLs/content links - one for the correct answer, and one for the incorrect answer.
If the Show Feedback check box is selected, the feedback window will display the feedback, and the
feedback target launches when the feedback window is closed. If the Show Feedback check box is not
selected, the remediation launches as soon as the question is answered.
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Configuring Links:

Regardless of whether you choose manual or automatic remediation, you must configure the links and
the manner in which the links are launched.

About this task

Links are configured by clicking the Edit Links button 
 

on the Remediation tab. Targets can be a web
URL or LCMS Premier content.

When configuring a link, you can configure the window used to deliver the target content. There are
three types of windows that can be used:
1. Dialog
2. Current
3. New

If Current is chosen as the Window type, the content will load in the content window. If the Window
type is New or Dialog, content launches in a separate window, and you can customize the window by

clicking the Properties button 
 

next to the Window drop-down list. The configuration options depend
on the type of window selected.

A Dialog is a window that is contained within the content window and cannot be resized once it is
launched. If you scroll in the main content window, the Floating window will remain visible. The
following can be configured for a Floating window:
v Title - The title that displays at the top of the window
v Top - The vertical distance (in pixels) that the top-left corner of the window is positioned from the

top-left of the element
v Left - The horizontal distance (in pixels) that the left of the window is positioned from the left of the

element
v Height - Height of the window (in pixels)
v Width - Width of the window (in pixels)
v Modal - When set to "true" (default), the user must interact with the Floating window before returning

to the main delivery window
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v Fixed Center - When set to "true" (default), the window will return to its original position if the user
drags the window to another position

A New window is a completely separate browser window with the following properties that can be
configured.
v Top - The vertical distance (in pixels) that the top-left corner of the window is positioned from the

top-left of the main delivery window
v Left - The horizontal distance (in pixels) that the left of the window is positioned from the left of the

main delivery window
v Height - Height of the window (in pixels)
v Width - Width of the window (in pixels)
v Resizable - When set to "true" (default), the resizing controls in the browser window are active
v Location - When set to "false" (default), the browser address bar will not appear at the top of the

browser window
v Menu - When set to "false" (default), the browser menu will not appear at the top of the browser

window
v Scrollbars - When set to "true" (default), the vertical and horizontal scroll bars are visible
v Status - When set to "false" (default), the status bar will not appear at the bottom of the browser

window
v Toolbar - When set to "false" (default), the command bar will not appear at the top of the browser

window
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Answer-Level Remediation:

With answer-level remediation, remediation is configured for each answer choice, rather than for the
entire question.

About this task

Note: Answer-level remediation is only available for the Multiple Choice-Single Answer element.

Answer-level remediation is configured much like question-level remediation, with a couple of key
differences.

First, when configuring manual remediation links, there is no Display drop-down list from which to
select Always, Correct, or Incorrect.

Like question-level remediation, answer-level remediation can be used for branching; you can redirect the
learner to specific content. However, when automatic links are configured, the branching is based on the
answer choice selected, rather than whether the answer is correct or incorrect. Therefore, there is only one
link to configure, and there is no option to Show Feedback, since the remediation is not based on Correct
and Incorrect answers.

Question-Level vs. Answer-Level Remediation:

When multiple types of remediation are configured for a question, not all of the remediation will always
be displayed; depending on the combination, certain remediation will take precedence. The following
table outlines possible scenarios and their outcomes.

About this task

Table 16. Remediation scenarios. The following table displays some different remediation scenarios.

Scenario Result
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Table 16. Remediation scenarios (continued). The following table displays some different remediation scenarios.

1. For the Correct answer, the following is configured:

v Feedback

v Question-level remediation - Manual link

v Answer-level remediation - Manual link

For the Incorrect answer, the following is configured:

v Feedback

v Question-level remediation - Manual link

v Answer-level remediation - Manual link

For the Correct answer, the following displays:

v Feedback

v Question-level link

v Answer-level link

For the Incorrect answer, the following displays:

v Feedback

v Question-level link

v Answer-level link

2. For the Correct answer, the following is configured:

v Feedback

v Question-level remediation - Automatic link

v Answer-level remediation - Automatic link

For the Incorrect answer, the following is configured:

v Feedback

v Question-level remediation - Automatic link

v Answer-level remediation - Automatic link

For the Correct answer, the answer-level automatic
link is launched.

For the Incorrect answer, the answer-level
automatic link is launched.

3. For the Correct answer, the following is configured:

v Feedback

v Question-level remediation - Automatic link

v Answer-level remediation - Manual link

For the Incorrect answer, the following is configured:

v Feedback

v Question-level remediation - Automatic link

v Answer-level remediation - Manual link

For the Correct answer, the question-level
automatic link is launched.

For the Incorrect answer, the question-level
automatic link is launched.

4. For the Correct answer, the following is configured:

v Feedback

v Question-level remediation - Automatic link

v Answer-level remediation - Manual link

For the Incorrect answer, the following is configured:

v Feedback

v Question-level remediation - Automatic link

v Answer-level remediation - Automatic link

For the Correct answer, the question-level
automatic link is launched.

For the Incorrect answer, the answer-level
automatic link is launched.

5. For the Correct answer, the following is configured:

v Feedback

v Question-level remediation - Automatic link

v Answer-level remediation - Automatic link

For the Incorrect answer, the following is configured:

v Feedback

v Question-level remediation - Automatic link

v Answer-level remediation - Manual link

For the Correct answer, the answer-level automatic
link is launched.

For the Incorrect answer, the question-level
automatic link is launched.
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Table 16. Remediation scenarios (continued). The following table displays some different remediation scenarios.

6. For the Correct answer, the following is configured:

v Feedback

v Question-level remediation - Manual link

v Answer-level remediation - Manual link

For the Incorrect answer, the following is configured:

v Feedback

v Question-level remediation - Automatic link

v Answer-level remediation - Automatic link

For the Correct answer, the following displays:

v Feedback

v Question-level link

v Answer-level link

For the Incorrect answer, the answer-level
automatic link is launched.

How Remediation Appears through the Learning Portal:

Final answer remediation appears through the Learning Portal when the learner clicks on the Check
button during the last try in submitting an answer to the question, or when the answer is answered
correctly.

About this task

When the learner clicks on the Check button, it launches an Answer Feedback window that displays the
final remediation and any associated feedback and remediation links that are available.

The following image contains feedback with a manual remediation link.

Providing Question-Level Remediation for an Assessment Element:

Perform the following steps to create question-level remediation.

Procedure

1. In the Question frame of the Source view of the Assessment element, select the Remediation button
. The Question Remediation dialog box appears.

2. On the Feedback tab, type your feedback in the Text fields. With feedback, you can add as many
items as you like. For each item, select Always, Correct, or Incorrect from the Display drop-down list
to determine when to display the feedback.

3. Select on the Remediation tab to configure remediation links.
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4. To configure manual remediation, select on the Link tab. Select Add 
 

; then, select Edit links 
 

.
Enter a label in the Label field. Select the type of link from the Type drop-down list. If you select
URL, enter a Web address in the Target field and proceed to Step 6. Otherwise, continue with Step 5.

5. Enter a content ID in the Target field or browse for a content ID.
6. Select the type of window to use for remediation from the Window drop-down list. For Dialog and

New, select the Properties button 
 

to configure the window properties. Select OK to exit the
Properties dialog box.

7. Select OK and select Always, Correct, or Incorrect from the Display Link drop-down list to
determine when to display the remediation link.

8. To add another remediation link, repeat Steps 4 through 7. To delete the current link, select Delete

.
9. To configure automatic remediation, select Navigation.

10. Select the Show Feedback check box if you would like to display feedback before the user is directed
to the remediation target.

11. Select Edit links 
 

for the Correct answer remediation. Enter a label in the Label field. Select the
type of link from the Type drop-down list. If you select URL, enter a Web address in the Target field
and proceed to Step 12. For content, enter a content ID in the Target field or browse for a content ID.

12. Select the type of window to use for remediation from the Window drop-down list. For Dialog and

New, select the Properties button 
 

to configure the window properties. Select OK to exit the
Properties dialog box.

13. Select OK.
14. Repeat Steps 11-13 for the Incorrect answer remediation link.
15. Select OK.

Note: The type of remediation used (manual or automatic) used depends on which button (Link or
Navigation) is selected when you select OK.

Providing Answer-Level Remediation for an Assessment Element:

Perform the following steps to create answer-level remediation.

Procedure

1. In the Answer frame of the Source view of the Multiple Choice-Single Answer element, select the
Remediation button . The Question Remediation dialog box appears.

2. To configure manual remediation, select on the Link tab. Select Add 
 

; then, select Edit links 
 

.
Enter a label in the Label field. Select the type of link from the Type drop-down list. If you select
URL, enter a Web address in the Target field and proceed to Step 4. Otherwise, continue with Step 3.

3. Enter a content ID in the Target field or browse for a content ID.
4. Select the type of window to use for remediation from the Window drop-down list. For Dialog and

New, select the Properties button 
 

to configure the window properties. Select OK to exit the
Properties dialog box.

5. Select OK and select Always, Correct, or Incorrect from the Display Link drop-down list to
determine when to display the remediation link.

6. To add another remediation link, repeat Steps 2 through 5. To delete the current link, select the
Delete button .

7. To configure automatic remediation, select Navigation.

8. Select Edit links 
 

. Enter a label in the Label field. Select the type of link from the Type
drop-down list. If you select URL, enter a Web address in the Target field and proceed to Step 9. For
content, enter a content ID in the Target field or browse for a content ID.
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9. Select the type of window to use for remediation from the Window drop-down list. For Dialog and

New, select the Properties button
 

to configure the window properties. Select OK to exit the
Properties dialog box.

10. Select OK.
11. Select OK.
12. Note: The type of remediation used (manual or automatic) used depends on which button (Link or

Navigation) is selected when you select OK.

Author Assessments
The following topics describe how to create and configure assessments and prescription.

Authoring and Configuring the Assessment Hierarchy
Assessments measure how learners comprehend content and provide them with a prescription for further
content review, if needed, based upon how they scored. Assessment Objects can be created at the
following LCMS Premier hierarchy levels:

About this task
v Module
v Learning Object
v Topic
v Group

An assessment is comprised of an Assessment Object, Assessment Section(s), and Assessment elements.
All of the hierarchal components of an assessment are configured separately, but work together to
provide the desired scoring and prescription.

Assessment Object:

The Assessment Object is the container for all components of the assessment. Most of the properties of
the assessment that control delivery and scoring behavior are configured at this level.

About this task

Assessment Object Rules View:

In addition to many of the common views in the Details pane available to course objects, Assessment
Objects contain a Rules view. This view contains several properties that affect the way the assessment is
presented to the learner.
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About this task

Assessment Object List View:

The Assessment List view provides the capability to view and hide the sections within the Assessment
Object, as well as access properties of the sections.

About this task

Note: The columns available in the List view represent properties of Assessment Sections within an
Assessment Object. You can access the Properties of each Assessment Section by double-clicking on them.

Authoring a New Assessment Object:

Use this procedure to author a new assessment object.

Procedure

1. Create a new Assessment Object by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. This displays in the course treeview.
3. Select the Rules view.
4. Enter a Passing Score. This is the percentage of questions that must be answered correctly to pass the

assessment, accounting for Assessment element weighting and Assessment Section weighting.
5. The value in the Weight field determines how much value the Assessment results will have in

relation to other Assessment scores. Weights must be a number between 0 and 1, not to exceed 2
decimal places (for example, 0.75).

6. The # of Tries field indicates the number of times a learner may retake the Assessment. This number
displays on the Assessment Launch Window seen by the learner before beginning the Assessment. A
value of zero will result in unlimited retries.

7. Enter the maximum time allowed (in minutes) in the Duration field.
8. Select the Available for Prescription check box if you would like this assessment to be used in the

prescription available in the Table of Contents category.
9. Enter the number of Questions Per Page you would like for the assessment.

10. Select the Ignore Sections check box if you would like to eliminate the Assessment Sections in
assessment delivery and place all questions in the same group.

11. Select an option from the Shuffling drop-down list as follows:
v Not Shuffled (default) to never shuffle Assessment Sections
v Shuffle Every Build to randomly shuffle Assessment Sections each time the assessment is taken
v Shuffle First Build to randomly shuffle Assessment Sections only the first time the assessment is

taken
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12. For assessments that select random questions, select an option from the Question Pool drop-down
list as follows:
v Build Always to build a new question pool each time the assessment is taken
v Build After to build a question pool only the first time the assessment is taken

13. Select an option from the Answer Shuffling drop-down list as follows:
v Defer to Question (default) to follow the rules established in the Assessment element General view
v Shuffle all Answers to shuffle all answers for questions
v Shuffle Distractors to shuffle only wrong answers
v Do Not Shuffle to not shuffle any answers

14. Select an option from the Allow Skipped Questions drop-down list as follows:
v Use Default (default) to use the value in the "Indicates server must ask if any incomplete

question(true/false)" Assessment theme parameter. According to the default value of the parm, if
the learner tries to score without answering all questions, the system will ask if they want to score
without finishing all questions.

v Yes to allow learners to score the assessment without answering all questions
v No to forbid learners to score the assessment until all questions are answered

15. Select the Allow Backwards Navigation check box to allow the learner to go backward in the
assessment to answer questions.

16. Save your work.

Assessment Sections:

Assessment Objects must include at least one Assessment Section. Sections are made up of Assessment
elements. Several sections can be placed in an Assessment Object.

About this task

The benefit of having multiple sections in an Assessment Object is the ability to:
v Weigh sections differently within the Assessment Object.
v Shuffle sections to create a dynamically different Assessment for each learner, which is especially

relevant when learners retake an Assessment.
v Group questions and/or interactions of similar content together.

Rules View:

When creating an Assessment Section, there are several properties that affect presentation and scoring.
These properties are entered in the fields of the Rules view in the Details pane.

About this task

Assessment Section Weight:

Assigning weights to Assessment Sections is an effective way of attaching different levels of importance
to different sets of questions. Sections that are deemed more valuable can contribute more to the overall
score.
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Example:

The following is an example of an Assessment Object.

About this task

An Assessment Object contains four Assessment Sections. One of the sections is worth twice as much as
the other three and is assigned a weight of 1. The other three sections are each assigned a weight of 0.5.
Because the sum of the percentages in a section will always equal 100, the percentage worth of each
section looks like this:

Section 1 (weight = 1): 40%⌂Section 2 (weight = 0.5): 20%⌂Section 3 (weight = 0.5): 20%⌂Section 4
(weight = 0.5): 20%⌂Assessment Object:  100%

Authoring a New Assessment Section:

Procedure

1. Create a new Assessment Section by dragging and dropping from the Object Palette onto the
Assessment Object or using the right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. This displays in the course treeview.
3. Switch to the Rules view. Select the Shuffle check box in you want to randomly reorder the

Assessment elements within the Assessment Section each time the Assessment is taken by a learner
through the Learning Portal.

4. In the Section Weight field, enter the scoring weight for this section relative to other sections within
the Assessment Object. Weights must be a number between 0 and 1, not to exceed 2 decimal places
(for example, 0.75).

5. Save your work.
For More Information: For details on populating an Assessment Section, see *.

Add Assessment Elements to an Assessment Section
Learn how to add assessment elements to an assessment.
1. Author them inline within the Assessment Section.
2. Add them dynamically to the Assessment Section.

Adding Assessment Elements Manually to an Assessment Section:

You can add Assessment elements to an Assessment Section in the same way you add elements to a
group. You can author them directly in the section, or insert existing Assessment elements.

Note: If you plan to use context-based prescription, you must insert Assessment elements into your
section by Pasting as Link.

Dynamically Inserting Assessment Elements:

Developers can insert Assessment elements into a section dynamically, without actually linking or
copying Assessment elements into the section. Each Assessment Section contains a Criteria view. Using
the filter interface in this view, you can create rules. Assessment elements from anywhere in the
Repository that meet the criteria established in the rules are included in the Assessment Section.
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About this task

Note: Dynamically inserted Assessment elements are not visible in the Assessment Section.

Number of Items:

After you have added Assessment elements to the section, you must specify the number of questions you
want to actually appear in the assessment in delivery. This is entered in the Rules view of the Assessment
Section.

About this task

The number entered cannot exceed the number of Assessment elements in the section, including
dynamically inserted elements.

Note: You may have more Assessment elements within an Assessment Section than the number
indicated in the Number of Items field; however, you cannot indicate a number greater than the
Assessment elements contained within the section.

Mandatory Versus Random Assessment Elements:

After indicating the number of items, you can determine whether an Assessment element will always be
included in an Assessment, or whether the element is part of a randomly generated group.

About this task

The Mandatory check box in the List view of an Assessment Section is used for this purpose. When the
Mandatory check box is cleared, those Assessment elements is randomly used within the section
depending upon the number of items indicated in the Rules view.

The number of mandatory questions cannot exceed the number of items indicated in the Rules view.

Example:

An Assessment Object can be created with three Assessment Sections that utilize random and mandatory
Assessment elements:
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About this task

v Assessment Section #1 includes five Assessment elements that are always presented to the learner in
the same way.

v Assessment Section #2 provides the learner with 10 randomly chosen Assessment elements from a pool
of 25.

Assessment Section #3 provides the learner with 10 Assessment elements from a pool of 15, in which six
are mandatory and shuffled each time the Assessment is taken, and four are randomly generated each
time.

Configure Context-Based Prescription
Learn how to configure context-based prescription.

With context-based prescription, Assessment elements throughout a course are linked into an Assessment
Section within that same course. And if the learner answers a question incorrectly, the parent topic of the
linked Assessment element is delivered as prescriptive content.

The Assessment elements can be inline practice items, or part of a hidden group, as shown in the
following image.

After taking and scoring the assessment, context-based prescription is delivered on the Prescription tab of
the Assessment Reports window. The topic displayed in the following image is the parent topic of the
incorrectly answered question. The topic link launches the topic, while the 1 of 1 link launches the
question.

Figure 36. Assessment Elements
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Note: Context-based prescription can be used in conjunction with metadata-based prescription.

Configuring Metadata-Based Prescription
Metadata-based prescription delivers content for prescription based on matching metadata values. This
approach provides the capability to deliver remediation content from anywhere in the Repository. It also
provides the capability to group questions for remediation without have to place them in the same group
object.

About this task

Each Assessment Object has a Remediation view where you can select metadata tag(s) to use for
prescription and specify a passing threshold. Assessment elements included in the assessment can then be
tagged with this metadata. If the cumulative score of all Assessment elements tagged with the same
metadata value do not meet the specified threshold, then prescriptive content is delivered after the
assessment is scored.

Note: When linking a metadata tag into other groups, the selection of the Remediation Tag check box is
unique to each instance. If you link a tag that has this check box selected and you would like the check
box to be selected in the new context, you must go to the new context and select the check box.

For prescriptive content to be delivered for an Assessment element, the content must be tagged with the
same metadata value as the Assessment element. You can tag any of the following to be delivered as
remediation:
v Learning object
v Topic
v Group
v Reference Object

After the assessment is scored, each metadata group and the metadata value(s) used for tagging displays
on the Exam Results tab of the Assessment Reports window if the threshold for that tag is not met. Each
metadata tag value displays as a link, and the total correct for that group of questions is also displayed.

Figure 37. Context-Based Prescription
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Note: The Exam Results link is not enabled by default. It must be turned on with the "Show Metadata
Diagnostics" theme parm in the ASSESSMENT-RULES parm group of the Theme Management category.

Clicking a link on the Exam Results tab opens the Review Materials tab, which displays the prescriptive
content (review materials) for the group of questions.

Note: The Review Materials link is not enabled by default. It must be turned on with the "Show
Metadata Diagnostic Summary" theme parm in the ASSESSMENT-RULES parm group of the Theme
Management category.

Setting up Metadata-Based Prescription:

In the Metadata Dictionary, for each metadata tag you are using for prescription, select the Remediation
check box in the List view.

Procedure

1. In your assessment, tag the Assessment elements for which you are providing the prescription with
the desired values. This can include dynamically inserted Assessment elements.

2. In the Remediation view of the Assessment Object in the Details pane, select the check box next to the
tag(s) you are using for prescription.

3. Enter the cumulative scoring Threshold for the group of questions belonging to each tag.
4. Assign metadata values to the content being used for remediation as desired, using the same

metadata tag(s) with which you tagged the Assessment elements.

Note: Metadata-based prescription can be used in conjunction with context-based prescription.

Configuring Proctoring
Some organizations have strict security requirements around online assessments, and/or require
additional assurances around academic integrity, especially in cases where the assessment is worth a large
proportion of the final grade. To support these standards, LCMS Premier 2012 SP2 introduces proctoring
for assessments. This functionality enables the following:
v Developers can assign one or more members as available proctors for an assessment. The proctor is

responsible for signing a student into or out of an assessment, or both.
v Prompts for both the proctor and student can be configured per assessment.
v Users can generate Proctoring activity reports.

The following image displays the launch page for an assessment with login proctoring enabled. The
proctor must log in with their LCMS Premier Member ID and Password before the student can begin the
assessment.
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Note: You cannot serve as proctor for yourself. That is, you cannot perform proctor duties while logged
into your own account.

Proctoring is configured per assessment. In the Content Manager, the Details pane for Assessment Objects
contains two views that are used for configuring proctoring:
1. Proctoring
2. Assign Proctors

The Proctoring view is where developers can configure prompts for the proctor and student.

Below are descriptions of the options available:
v Proctor at Start – This determines when a proctor is used to log students into an assessment. Options

are:
– Never
– Always

v Proctor Start Message – These are the proctor instructions displayed on the Assessment Launch Page. If
no message is entered, the default message configured in the “Assessment Prescription Proctor Start
Message” TEXTUAL theme parameter is used.
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Figure: Proctor Start Message
v Student Start Message – These are the student instructions displayed on the Assessment Launch Page.

If no message is entered, the default message configured in the “Assessment Prescription Student Start
Message” TEXTUAL theme parameter is used.

Figure: Student Start Message
v Proctor at End - This determines when a proctor is used to log students out of an assessment. Options

are:
– Never
– Always
– Pass Only
– Fail Only

v Proctor End Message – These are the proctor instructions given after an assessment is scored. If no
message is entered, the default message configured in the “Assessment Prescription Proctor End
Message” TEXTUAL theme parameter is used.

Figure: Proctor End Message
v Student End Message - These are the student instructions given after an assessment is scored. If no

message is entered, the default message configured in the “Assessment Prescription Student End
Message” TEXTUAL theme parameter is used.
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Figure: Student End Message

Proctoring Access:

In order to act as a proctor, you must have proctoring privileges enabled for your role or be assigned as a
proctor.

The proctoring privilege is assigned on the Action tab of each role in the Role Administration category.
Selecting the Proctor Assessments check box enables proctors assigned to that role to perform
login/logout duties for assessments in the Learning Portal.

Proctors for an assessment are assigned in the Assign Proctors view of an Assessment Object by selecting
Add Proctor from the Options menu.

Users can then search for a member account, select the account, and select OK.

The proctor is added to the Assign Proctors view. An expiration date can be added to the proctor by
clicking the calendar icon and selecting a date. If the Allow Global Proctoring check box is selected, all
users assigned to roles that have proctoring enabled become proctors.

Users can add another proctor or delete the selected proctor by right-clicking on the proctor and selecting
the appropriate action.

\
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Proctoring Reports:

The following proctoring reports are available in the Reporting category of the Learning Portal.

About this task

v Proctoring Activity by Course Report - This report contains proctoring activity for one or more courses.
v Proctoring Activity by Proctor Report - This report contains proctoring activity for one or more

proctors.

Author Extended Elements
The following topics describe how to create the Aggregate, HTML, and Reference elements.

Authoring an Aggregate Element
The Aggregate element gathers existing information, or metadata, from designated fields in the Data view
and displays it in list format. This element is commonly used to list titles, outlines, objectives, and
summaries within a learning object and/or topic.

About this task

How the Aggregate Element Functions:

Metadata groups and tags can be developed at every level in the LCMS Premier hierarchy. This means
that the Data view may display differing metadata fields at each object level. When creating an Aggregate
element, there are two selections that must be made in the Source view in order to create aggregated lists:

About this task

1. Level - you must choose an object level for Data view aggregation. Available levels are:
v Module
v Learning object
v Topic
v Group
v Element

2. Group/Tag - you must choose the appropriate metadata tag in the Data view for aggregating
associated entries.

It is important to note that data can only be aggregated from within the object where the Aggregate
element resides.

For More Information: Metadata must be made available for use with the Aggregate element in order for
the metadata to display in the Group/Tag drop-down list in the Source view of the Aggregate element.
See Assigning Metadata for Use in LCMS Premier.

Example:

When you author an Aggregate element within a learning object containing three topics, selected
information can be aggregated from the Data view of the three topics within that learning object. In this
example, you would not be able to aggregate information from topics that reside within other learning
objects.
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About this task

How the Aggregate Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Source view of the Aggregate element, where the content of the element
is configured.

About this task

Suppress Blanks Check Box:

If an Aggregate element is moved out of context with the metadata selected for aggregation, it can appear
through the Learning Portal in one of two ways, depending on whether or not the Suppress Blanks check
box is selected in the Source view.

About this task

1. If the Suppress Blanks check box is not checked, the following default message will appear in the
aggregated list when an Aggregate element is launched out of context: (Information in this list is not
available in this view).

2. If the Suppress Blanks check box is checked, neither a message nor content will appear in the
aggregated list.

Animations:

Users can apply animation to list items in an Aggregate element. Animations can be created by clicking

the Animation button 
 

in the Source view and opening the Animation dialog box.

About this task

Only one item is presented in the Animation dialog box; this animation is applied to all aggregate list
items. An entrance transition can be applied at Fast, Medium, or Slow speed. You can require that the
user manually load each list item, or you can configure the items to load automatically, with each item
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loading after a delay of 1 to 10 seconds.

Note: Transition speed is measured in milliseconds. The speed can be changed to meet your exact needs
with the following theme parameters, available in the DELIVERY-RULES theme parm group in the
Theme Management category:
v Animation Speed - Fast (default = 200 milliseconds)
v Animation Speed - Medium (default = 400 milliseconds)
v Animation Speed - Slow (default = 600 milliseconds)

Authoring a New Aggregate Element:

Perform the following steps to create an Aggregate element.

Procedure

1. Create a new Aggregate element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field of the Content frame.
4. Enter an introduction in the Text field of the Content frame.
5. Select the object level at which you are aggregating from the Level drop-down list in the Content

frame.
6. Select the metadata tag you wish to aggregate from the Group/Tag drop-down list in the Content

frame. The metadata group appears in parentheses.
7. Select the Bullets, Numbers, Letters, or Blank radio button, depending on how you would like your

aggregated list to appear.
8. Select the Suppress Blanks check box to display neither a message nor content in the aggregated list,

should the element be launched out of context.
9. Enter closing text in the Text field of the Bottom frame.

10. To add transitions to your list items and to configure transition settings, select the Animation button 
to open the Animation dialog box.

11. Select one of the following:
v The No Animation radio button to cancel any animation and load the Aggregate element normally

(default).
v The Advance on select radio button to require the user to load each list item manually by clicking

a button in the delivery viewer.
v The Advance automatically every ___ seconds radio button to load the list items automatically.

Select the number of seconds of delay between each list item from the drop-down list.
12. Select a Transition and the Speed for the transition. A transitions is not required.
13. Select OK.
14. Save your work.
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Authoring an HTML Element
The HTML element works as a full HTML page to give you more capabilities in generating interactivity
within your course. If you are experienced in using a client-based scripting language like JavaScript to
create functions, you can take full advantage of the HTML element.

About this task

Note: You must be familiar with HTML code to successfully author an HTML element.

How the HTML Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Source view of the HTML element, where the content of the element is
configured.

About this task

Authoring a New HTML Element:

Perform the following steps to create an HTML element.

Procedure

1. Create a new HTML element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.
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2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field of the Content frame.
4. Enter the head tag information in the Head field of the HTML frame.
5. Enter functions in the On Load field of the HTML frame.
6. Enter the HTML body text in the Body field of the HTML frame.
7. Save your work.

Important: The HTML element utilizes your proprietary code. Be aware that future releases of LCMS
Premier may have functionality built in that overwrites or is incompatible with this code.

Authoring a Reference Element
The Reference element provides the capability to reuse relevant course material or use outside sources of
material by creating links to existing content within the Repository or to External Objects and URLs.

About this task

How the Reference Element Functions:

The Reference element enables providing multiple links to supporting information for learner enrichment.
The following targets can be included as links in a Reference element:

About this task

v Learning object
v Topic
v Group
v Element
v URL
v Assessment Object
v External Object
v Reference Object
v Media Object
v Survey Object

Example:

When authoring a topic on travel to Japan, you may notice that:

About this task

There is a Table element within another course in the Repository that contains an overview of business
hours in Japan.

There is a public domain Web site that contains general information on travel to Japan.

There is a document available for public distribution in .pdf format that details the history of Japanese
holidays.

You can author one Reference element within your course to point to all three of these examples.

How the Reference Element Renders:

The following image depicts what the learner sees through the Learning Portal.
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About this task

Source View:

The following image depicts the Source view of the Reference element, where the content of the element
is configured.

About this task

When configuring a link, you can configure the window used to deliver the target content. There are
three types of windows that can be used:
1. Dialog
2. Current
3. New

If Current is chosen as the Window type, the content will load in the content window. If the Window
type is New or Dialog, content launches in a separate window, and you can customize the window by

clicking the Properties button 
 

next to the Window drop-down list. The configuration options depend
on the type of window selected.

A Dialog is a window that is contained within the content window and cannot be resized once it is
launched. If you scroll in the main content window, the Floating window will remain visible. The
following can be configured for a Floating window:
v Title - The title that displays at the top of the window
v Top - The vertical distance (in pixels) that the top-left corner of the window is positioned from the

top-left of the element
v Left - The horizontal distance (in pixels) that the left of the window is positioned from the left of the

element
v Height - Height of the window (in pixels)
v Width - Width of the window (in pixels)
v Modal - When set to "true" (default), the user must interact with the Floating window before returning

to the main delivery window
v Fixed Center - When set to "true" (default), the window will return to its original position if the user

drags the window to another position
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A New window is a completely separate browser window with the following properties that can be
configured.
v Top - The vertical distance (in pixels) that the top-left corner of the window is positioned from the

top-left of the main delivery window
v Left - The horizontal distance (in pixels) that the left of the window is positioned from the left of the

main delivery window
v Height - Height of the window (in pixels)
v Width - Width of the window (in pixels)
v Resizable - When set to "true" (default), the resizing controls in the browser window are active
v Location - When set to "false" (default), the browser address bar will not appear at the top of the

browser window
v Menu - When set to "false" (default), the browser menu will not appear at the top of the browser

window
v Scrollbars - When set to "true" (default), the vertical and horizontal scroll bars are visible
v Status - When set to "false" (default), the status bar will not appear at the bottom of the browser

window
v Toolbar - When set to "false" (default), the command bar will not appear at the top of the browser

window

Authoring a New Reference Element:

Perform the following steps to create a Reference element.
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Procedure

1. Create a new Reference element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field, and enter an introduction in the
Text field of the Content frame.

4. Select the location of your text from the Alignment and Position drop-down lists in the Content
frame.

5. If you wish to display a thumbnail image, enter the image label in the Label field of the Thumbnail
frame, or search for the Media Object. Select the image location from the Position drop-down list in
the Thumbnail frame.

6. In the Alt Text field, enter a description of the image - this is used in place of the image in a 508
compliant environment.

7. Enter a label in the Label field of the Link frame.
8. Select the type of link from the Type drop-down list. If you select URL, enter a Web address in the

Target field. If you select an LCMS Premier object type, browse for the content.
9. Select the type of delivery window from the Window drop-down list. If you select Floating or New

Window, you can configure the window by clicking the Properties button
 

.
10. To add an additional reference link, select the Add button 

 
and repeat Steps 7 through 9. You may

add multiple reference links to this element. To delete the current reference link, select the Delete
button 

 
.

Note: To view all list items at once, select the Summary button 
 

. You may add, edit, and delete
items in this view.

11. Save your work.

Author Interactive Elements
The following topics describe how to create elements that require input or interaction by the learner.

Authoring an Animation Element
The Animation element enables developers to stage text and media, and enables transitions to be applied
to those staged items. This creates a visual experience by allowing text and media to enter and exit the
page at timed intervals.

How the Animation Element Renders:

The following image depicts what the learner sees through the Learning Portal. However, this is the final
product of the animations, and does not reflect how the separate components of the element come
together.
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About this task

For example, the following image shows the first stage of the animation, which appears when the
element is launched.

The next animation occurs when the first image is clicked. In this Animation element, the next paragraph
of text appears immediately. Then, the next three items (with the phone numbers) appear from the top,
one at a time, with a delay in between. The next paragraph then sweeps in from the right, following by
the bottom image.

After clicking the bottom image, the last paragraph sweeps from the right, completing the Animation
element.
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Animation Element Source View:

In the Source view, users can specify the dimensions of the overall element. Each text or media stage for
the element can be added here, but they can also be added in the Map Areas dialog box.

About this task

Map Areas Dialog Box:

The Map Areas dialog box provides a way for you to define the individual stages and their final
positioning. You can define exact coordinates for text/media areas, specify the size of the text/media
areas, and define the z-order for overlapping stages.
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About this task

Animations:

Users can apply animations to the staged areas in an Animation element. Animations can be created by

clicking the Animation button 
 

in the Map Areas dialog box and opening the Animation dialog box.

About this task

Note: You are not required to create animations. If no animations are created, then all text/media areas
appears immediately when the element loads.

The Animation dialog box presents you with a main timeline where you can add animations by clicking
Add 

 
and configuring the order and manner in which animation items enter or exit the element. You

can do the following:
v Select the item to animate from the Item drop-down list (transitions occur in the order in which they

appear in this list).
v Apply entrance and exit transitions to any item.
v Choose a time delay for each transition.
v Choose when the time delay begins for entrance and exit transitions. The following options are

available:
v With Previous - The time delays starts when the previous transition's delay starts.
v After Previous - The time delays starts when the previous transition ends.
v After Select - The time delay starts after the user clicks inside the element area.
v Choose the type of transition.
v Choose a Slow, Medium, or Fast speed for the transition.
v Select an audio file to play with the transition. The audio file must be in mp3 format only.
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v Use the Up and Down arrows to resequence a transition.

Alternate Timelines:

Developers can create alternate timelines in an Animation element. An alternate timeline is a timeline
separate from the main timeline that begins when the user clicks an object in the previous timeline. When
that alternate timeline completes, the animation sequence returns to the prior timeline. Multiple alternate
timelines can be created.

About this task

For example, the following image shows an animation element with two alternate timelines (note that the
alternate timelines are named after the item that must be clicked to launch that timeline). "Timeline 1"
will begin when the user clicks Item 1 in the Main timeline. When the user clicks Item 7 in the alternate
timeline, "Timeline 7" will begin. When Timeline 7 completes, the Main timeline will continue with Item 2
(if there is an Item 2).

Note: Transition speed is measured in milliseconds. The speed can be changed to meet your exact needs
with the following theme parameters, available in the DELIVERY-RULES theme parm group in the
Theme Management category:
v Animation Speed - Fast (default = 200 milliseconds)
v Animation Speed - Medium (default = 400 milliseconds)
v Animation Speed - Slow (default = 600 milliseconds)

Authoring a New Animation Element:

Perform the following steps to create an Animation element.

Procedure

1. Create a new Animation element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field of the Main frame.
4. Enter an introduction in the Text field of the Main frame.
5. Enter a Width and Height (in pixels) for the element stage size.
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6. Select the Map Areas button 
 

to create define the items and animations for the element. The Map
Areas dialog box appears.

7. To create a text stage, select the Text radio button and enter the text in the Text field. To create a
media stage, select the Media radio button, and enter a media label in the Label field, or search for
the Media Object. Enter text in the Alt Text field if this displays in a 508 compliant environment.

8. Select inside the selected indicator box and drag to the desired position in the window where the
item appears in the animation. You can resize the area with any of the handles around the edges.
You can also position and resize the area with exact pixel coordinates and dimensions by using the
X, Y, W, and H fields in the Area frame. You can also specify the Z-order of each animation item
(0,1,2, etc.) for instances when items overlap. The item with lowest Z-order number is on the bottom,
while the item with the highest Z-order number is on top. If two items have the same Z-order
number, then the item with higher item number is on top.

9. To add an additional item, select the Add button 
 

and repeat Steps 7-8. To delete the current map
area, select the Delete button .

10. Select the Animation button 
 

to add transitions to the animation items.
11. Select the item that is appearing first from the Item drop-down list. Select an Entrance or Exit

Transition, specify the Delay (in seconds), and specify when the delay will begin - when the previous
transition begins (With Previous), or when the previous transition ends (After Previous). Select a
Speed for the transition. To play an audio file with the mouseover area, enter a media label in the
Audio Label field, or search for the Media Object.

12. To add an additional transition, repeat Step 11. To create an Alternate Timeline, select the plus sign
(+) to the right of the Main tab. You can create multiple Alternate Timelines as needed.

13. Select OK. Then, select OK again.
14. Save your work.

Authoring a Command Element
The Command element will help you to design multi-step simulations that assess learner knowledge of a
command-based operating system or application. The command simulation enables learners to input
commands and receive immediate feedback.

About this task

Command Application Types:

The Command element enables the simulation of three different application types:

About this task

Table 17. Application types for Command element. The following table describes the three available application
types.

DOS Telnet HyperTerminal

Acronym for Disk Operating System.
DOS was the first operating system
for the PC and is still the underlying
control program for earlier versions
of Windows. Windows NT and 2000
emulate DOS in order to support
existing DOS applications.

Originally developed for ARPAnet, it
enables a user at a terminal or
computer to log onto a remote device
and run a program. It is commonly
used on the Internet and
TCP/IP-based networks.

A communications software
developed by Hilgraeve that is
included in all versions of Microsoft
Windows. Allows the user to connect
and transfer files between two
computers.

How the Command Element Functions:

The following describes the process of using the Command element.
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Procedure

1. The learner is provided with an initial prompt.
2. After entering a response to this prompt, the learner will receive feedback corresponding to the

correct or incorrect answer:
v If the learner answers correctly, applicable output is given and the command simulation displays

the next prompt.
v If the learner answers incorrectly, related remediation is given.

3. When all tries are exhausted, the learner will receive a final remediation that indicates if they
answered correctly, and at this point the correct answer is provided.

How the Command Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Source view of the Command element, where the content of the element
is configured.

About this task

Summary Dialog Box:

The Summary button is located in the Command frame in the Source view. It launches the Summary
dialog box which displays all created commands and prompts for more simplified editing.
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About this task

Authoring a New Command Element:

Perform the following steps to create a Command element.

Procedure

1. Create a new Command element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field, and enter an introduction in the
Text field of the Main frame.

4. Select an interface from the Type drop-down list.
5. Enter a command prompt in the Prompt field, and enter a label for the remediation button in the

Button Label field of the Main frame.
6. Enter the final feedback for each command into the Correct and Incorrect fields of the Final

Feedback frame. If you leave these fields blank, the defaults is "Correct!" and "Incorrect!"
7. Enter the command in the Command field, and enter the output in the Output field of the

Command frame. Enter the prompt for the next command in the Next Prompt field.
8. To add an additional command, select the Add button 

 
and repeat Step 7. You may add multiple

commands to this element. To delete the current command, select the Delete button .
Note: To view all commands at once, select the Summary button 

 
. You may add, edit, and delete

commands in this view.
9. Enter the incorrect feedback for the try in the Feedback field of the Try frame.

10. To add an additional try, select the Add button and repeat Step 9. You may add multiple tries to this
element. To delete the current try, select the Delete button.

Note: To view all tries and their feedback at once, select the Summary button. You may add, edit,
and delete tries in this view.

11. Save your work.

Authoring a Mouseover Element
The Mouseover element provides the capability to describe different parts of a complex image by
sectioning the image into multiple information sections. This offers the learner an engaging way to
actively participate in the learning process. In addition, the Mouseover element conserves screen space by
containing a relatively large amount of information within the defined areas of the image.
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About this task

How the Mouseover Element Functions:

This element is similar to the Image Map element in that it responds to a mouse select. However, instead
of sending the learner to another piece of content or URL, mouseover images are mapped so that when a
learner rolls over or clicks a particular area of the image, information appears about that area of the
image.

About this task

How the Mouseover Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Mouseover element Source view, where the content of the element is
configured.

About this task

Tip: The Mouseover element contains a Summary button for launching the Summary dialog box in the
Area frame on the Map Areas dialog box.

Map Areas Dialog Box:

The Map Areas dialog box provides a way for you to define the interactive hot spot areas of the base
image. You can define coordinates for both the base image and the popup text/media areas, and you can
also specify the size of the text/media areas. You can also select an audio file to play for each mouseover
stage.
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About this task

Mapping is done over the image so that a specific area can be set to display associated text upon learner
action.

For More Information: For details on using shapes to create map areas, see Creating Shapes for Map
Areas.

Animations:

Users can apply animations to mapped areas in a Mouseover element. Animations can be created by

clicking the Animation button 
 

in the Map Areas dialog box and opening the Animation dialog box.

About this task

All mapped areas are listed in the Animation dialog box. Entrance and exit transitions can be applied to
any mapped area at Fast, Medium, or Slow speeds.
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Note: Transition speed is measured in milliseconds. The speed can be changed to meet your exact needs
with the following theme parameters, available in the DELIVERY-RULES theme parm group in the
Theme Management category:
v Animation Speed - Fast (default = 200 milliseconds)
v Animation Speed - Medium (default = 400 milliseconds)
v Animation Speed - Slow (default = 600 milliseconds)

Authoring a New Mouseover Element:

Perform the following steps to create a Mouseover element.

Procedure

1. Create a new Mouseover element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field of the Main frame.
4. Enter an introduction in the Text field of the Main frame.
5. Select the On Mouseover or On Select radio button, depending on how you want the user to trigger

the mouseover areas.
6. Select the Persist Text radio button if you would like the text staging areas to remain permanently

visible once they are opened.
7. Enter the image label in the Label field of the Media frame, or search for the Media Object.
8. In the Alt Text field, enter a description of the image - this is used in place of the image in a 508

compliant environment.
9. Select the Map Areas button 

 
in the Media frame. The Map Areas dialog box appears.

10. The first map area shape is a rectangle, by default. Select on and drag the red indicator box to the
preferred drop area on the base image. You can resize the box by clicking the pointer on a corner of
the box and dragging the pointer.

Note: If you would like the first mapped area to be a shape other than a rectangle, you must create
the new shape first, then delete the original rectangle. New shapes are created by selecting the shape
type from the toolbar, clicking once to begin the map area, then clicking again to complete the map
area. For complete details on using shapes to create map areas, see Creating Shapes for Map Areas.

11. Now you can create the popup that appears for this mapped area. If you would like to configure a
custom size and position for the popup (rather than use the default), select the Used Fixed Position
and Size check box. By default, the coordinates and dimensions for the mapped area will populate
the X, Y, W, and H fields. You can change these values to suit your needs.

98 IBM Kenexa® LCMS Premier Version 9.4: User's Guide August 2015



12. To create a text popup, select the Text radio button and enter the text in the Text field. To create a
media popup, select the Media radio button, and enter a media label in the Label field, or search for
the Media Object. Enter text in the Alt Text field if this displays in a 508 compliant environment.

13. To play an audio file with the mouseover area, enter a media label in the Audio Label field, or
search for the Media Object.

14. To add an additional map area, select the Add button 
 

and repeat Steps 10-13. You may add
multiple map areas to this element. To delete the current map area, select the Delete button 

 
.

Note: To view all map areas at once, select the Summary button 
 

. You may add, edit, and delete
map areas in this view.

15. You can add entrance and exit animations for all popups. To add these transitions, select the

Animation button 
 

to open the Animation dialog box.
16. For each popup, select an Entrance Transition and Exit Transition, and select the Speed for both.

Transitions are not required. To apply one popup's transitions to all slides, select that popup and
select Apply to All.

17. Select OK. Then, select OK again.
18. Save your work.

Authoring a Simulation Element
Making use of media, the Simulation element will help you design a single response prompt to assess
learner ability to recall information. The simulation enables learners to submit responses and receive
immediate feedback.

About this task

How the Simulation Element Functions:

The following describes the process of using the Simulation element.

Procedure

1. The learner is provided with a base image and a prompt.
2. After entering a one-word or short answer response to this prompt, the learner will receive feedback

corresponding to the correct or incorrect answer:
v If the learner answers correctly, the base image is replaced with the resulting correct image.
v If the learner answers incorrectly, related remediation is given.

3. When all tries are exhausted and the response is still incorrect, the learner will receive a final
remediation and at this point the correct answer and image is provided.

How the Simulation Element Renders:

The following image depicts what the learner sees through the Learning Portal.
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About this task

Source View:

The following image depicts the Simulation element Source view, where the content of the element is
configured.

About this task

The following image depicts the Simulation element Source view, where the content of the element is
configured.

Anticipated Response Dialog Box:

The Anticipated Response dialog box provides a way for you to design feedback and/or remediation
based upon expected learner response(s) to a simulation prompt. When the learner enters an anticipated
response in the response field through the Learning Portal, a dialog box appears with the comments you
provide.

About this task

The dialog box enables the inclusion of multiple anticipated responses, both correct and incorrect. For
each response you create, you can include associated feedback.
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Unanticipated Response Dialog Box:

The Unanticipated Response dialog box provides a way for you to design feedback and/or remediation
for unexpected or incorrect learner response(s) to a simulation prompt. When the learner enters an
unanticipated response in the response field through the Learning Portal, a dialog box appears with the
comments you provide.

About this task

The dialog box enables the inclusion of diverse comments to the learner for each incorrect response.

Note: The Media Label fields of both the Anticipated and Unanticipated dialog boxes must be
completed with either the base media, or new media. If you do not indicate a Media Label for each
anticipated and unanticipated response in the respective dialog boxes, the base image through the
Learning Portal is replaced with an empty or broken image, depending on your browser.

Authoring a New Simulation Element:

Perform the following steps to create a Simulation element.

Procedure

1. Create a new Simulation element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field, and enter an introduction in the
Text field of the Main frame.

4. Enter the image label in the Label field of the Image frame, or search for the Media Object.
5. In the Alt Text field, enter a description of the media - this is used in place of the media in a 508

compliant environment.
6. Enter the width and height (in pixels) of the media in the Width and Height fields.
7. Enter a question or prompt in the Label field of the Responses frame, and enter a label for the

remediation button in the Button Label field.
8. Enter the amount of tries in the # of Tries field in the Responses frame, and select the Anticipated

Responses button to open the Anticipated Responses dialog box.
9. Enter the response in the Response field, and enter feedback for the response in the Feedback field.

Select the Correct check box for the correct response.
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10. To present an image for a response, enter the media label in the Label field, or search for the Media
Object.

11. In the Alt Text field, enter a description of the media - this is used in place of the media in a 508
compliant environment.

12. To add an additional anticipated response, select the Add button 
 

and repeat Steps 9 through 11.
You may add multiple anticipated responses to this element. To delete the current anticipated
response, select the Delete button 

 
.

Note: To view all anticipated responses at once, select the Summary button 
 

. You may add, edit,
and delete anticipated responses in this view.

13. Select Close.
14. Select the Unanticipated Responses button in the Responses frame to open the Unanticipated

Responses dialog box.
15. To present an image for an incorrect response, enter the media label in the Label field, or search for

the Media Object.
16. In the Alt Text field, enter a description of the media - this is used in place of the media in a 508

compliant environment.
17. Enter feedback for an incorrect response in the Feedback field.
18. Select Close.
19. Enter the final response in the Response field of the Final Response frame.
20. To present an image for the final response, enter the media label in the Media Label field, or search

for the Media Object.
21. In the Alt Text field, enter a description of the media - this is used in place of the media in a 508

compliant environment.
22. Enter the final feedback for incorrect responses in the Feedback field of the Final Response frame.
23. Save your work.

Authoring a Slideshow Element
The Slideshow element provides the capability to present various media with corresponding text for the
purpose of demonstrating a process, showing a build, or presenting comparisons and contrasts.

About this task

How the Slideshow Element Functions:

The slideshow appears to learners with the first slide and its associated text. To aid the learner in
navigating the slideshow, the slide number, number of slides in the presentation, and four navigation
arrows are provided just beneath the slide. The text that accompanies each slide displays on a shaded
background.

About this task

How the Slideshow Element Renders:

The following image depicts what the learner sees through the Learning Portal.
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About this task

Source View:

The following image depicts the Slideshow element Source view, where the content of the element is
configured.

About this task

Note: After the text stage size is indicated, it is set for the entire slideshow interaction, regardless of
media size and the number of media items in the slideshow. Replacing media in a slideshow will have no
effect on the text stage size; however, you may wish to change it if the image sizes are altered.

The Slideshow element only supports images.

Summary Dialog Box:

In the Slide frame in the Source view, the Summary button launches the Summary dialog box. This dialog
box displays all created slides and associated text for more simplified editing.
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About this task

Alternate Renderings:

LCMS Premier provides the capability to create and apply renderings to elements. Renderings are
alternate ways to display an element to students. Renderings are implemented as java classes (and
resource files) and can be placed on the application's classpath. They can be deployed as .class files or in
a jar file, and must be referenced in the content_render.xml file on the application server.

About this task

The Slideshow element provides the following alternate renderings:
v Carousel
v Shifter - Vertical
v Shifter - Horizontal

The Carousel rendering includes the slide text inside of the slide frame, so that the text and image
transition smoothly together. The navigation arrows are located to the left and right of the image frame.
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Animations:

Users can apply animation to slides in a slideshow. Animations can be created by clicking the Animation

button 
 

in the Source view and opening the Animation dialog box.

About this task

All slides are listed in the Animation dialog box. Entrance transitions can be applied to any slide at Fast,
Medium, or Slow speeds. You can require that the user manually advance each slide, or you can
configure the slideshow to play automatically, with each slide loading after a delay of 1 to 10 seconds.

Note: Transition speed is measured in milliseconds. The speed can be changed to meet your exact needs
with the following theme parameters, available in the DELIVERY-RULES theme parm group in the
Theme Management category:
v Animation Speed - Fast (default = 200 milliseconds)
v Animation Speed - Medium (default = 400 milliseconds)
v Animation Speed - Slow (default = 600 milliseconds)

Authoring a New Slideshow Element:

Perform the following steps to create a Slideshow element.
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Procedure

1. Create a new Slideshow element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field, and enter an introduction in the
Text field of the Main frame.

4. In the Media Stage frame, enter the desired width and height for the media, and select the
Transparency check box if you want to give slides a transparent effect.

5. In the Text Stage frame, enter the desired width and height for the text fields, and select the location
of the text fields from the Position drop-down list.

6. In the Controls frame, select the location of the controls from the Position drop-down list.
7. Enter a media label for a slide in the Media Label field of the Slide frame, or search for the Media

Object.
8. In the Alt Text field, enter a description of the image - this is used in place of the image in a 508

compliant environment.
9. To include audio that is played while the slide displays, enter the label for the Media Object in the

Audio Label field, or search for the Media Object.
10. Enter the text for the slide in the Text field of the Slide frame.
11. To add an additional slide, select the Add button 

 
and repeat Steps 7 through 10. You may add

multiple slides to this element. To delete the current slide, select the Delete button 
 

.
Note: To view all slides at once, select the Summary button 

 
. You may add, edit, and delete

slides in this view.

12. To add transitions to your slides and to configure player settings, select the Animation button 
 

to
open the Animation dialog box.

13. Select one of the following:
v The Advance on user action radio button to require the user to advance slides manually with

navigation controls (default).
v The Advance automatically every ___ seconds radio button to autoplay the slideshow. Select the

number of seconds of delay between each slide from the drop-down list.
14. For each slide, select a Transition and the Speed for the transition. Transitions are not required for all

slides. To apply a transition to all slides, select that slide transition and select Apply to All.
15. Select OK.
16. Save your work.

Author a Reference Object
The Reference Object provides the capability to embed or link to an External Object, or provide a link to
a URL within your course. The Reference Object appears to the learner as a separate object on the
module, learning object, topic, or group levels.

Reference Objects versus Reference Elements
While the Reference element is created at the element level only, the Reference Object can be authored at
the module to group levels. It is important to have an understanding about the differences between
Reference elements and Reference Objects so that you is able to determine which to use within any given
situation.
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About this task

The following table provides you with an overview of the functional differences.

Table 18. Reference element vs. Reference Object. The following table provides you with an overview of the
functional differences between the Reference element and Reference Object.

Reference Element
 

Reference Object

An instructional element authored at the element level.
An object authored at the module, learning object, topic,
and group levels.

Ability to provide links to External Objects, URLs, and
content at any level(except course and module) within
the Repository.

Ability to provide links to URLs only; however, has the
ability to point to embedded External Objects within a
course.

Target types include (linked only): Learning Object,
Topic, Group, Element, URL, Assessment Object, External
Object, Reference Object, Media Object, and Survey
Object.

Target types include: Linked URLs and embedded objects
only.

Can include multiple links within one Reference element.
May only link to one URL or one embedded object
within one Reference Object.

Tip: Use the Reference Object when you wish to embed an External Object within your course, or if you
wish to have the link to a URL or embedded object appear to the learner as a separate object on the
module, learning object, topic, or group levels.

Reference Object Content View
The following image depicts the Reference Object Content view.

About this task

Note: The Reference Object Content view does not allow for the inclusion of a title or text; therefore, the
learner will only see the link through the Learning Portal.

PDF Parameters
When an Adobe PDF document is embedded in a Reference Object, the developer can configure the
document to open at a particular page or section. This is accomplished by entering a special URL in the
Parameters field.

About this task
v To open the PDF to a specific page, type #page=pagenumber. For example, to open at page 5, enter

#page=5.
v Opening the PDF to a specific section requires a little research. When a PDF is generated from

FrameMaker, document headings are saved as "destinations." When the PDF is opened in Acrobat, you
can scan the PDF for these destination IDs, then sort them according to page number. You can identify
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the appropriate destination ID by finding the appropriate section of the document, then double-clicking
on the destination IDs for that page until you identify the correct section.

To open the PDF to a specific section, enter #destinationID. For example, enter #G4.677852.

Note: PDFs generated from Word or FrameMaker can both be opened to a particular page. However,
only PDFs generated from FrameMaker contain destinations.

Reference Object Hierarchy
Like other LCMS Premier objects, Reference Objects can be expanded in the course treeview to view child
objects. When a Reference Object is expanded, the External Object within can be selected.

About this task

When the External Object is selected, you can modify the External Object in the Details pane. External
Objects can be expanded to view any dependent External Objects as well.

Authoring a New Reference Object
Perform the following steps to create a Reference Object.

Procedure
1. Create a new Reference element by dragging and dropping from the Object Palette or using the

right-select menu in your course treeview.
2. In the General view, enter a title in the Title field. After you save the content, this title displays in the

course treeview.
3. In the Content view, perform one of the following options.
v If you would like the Reference Object to link to an outside URL, select the Linked radio button in

the Type frame and continue with Step 4.
v If you would like to embed an External Object, select the Embedded radio button and proceed to

Step 5.
4. Enter a Web address in the URL field of the Target frame and proceed to Step 7.
5. Enter an External Object ID in the ID field of the Target frame, or browse for a content ID.
6. If you are embedding a PDF file and would like to launch the PDF on a specific page, type the link to

the page in the Parameters field. For example, #page=5.
7. Save your work.

Author Rich Media Elements
The following topics describe how to create elements that are centered around media and video.

Authoring a Media Element
The Media element provides the capability to display many different media types, as well as configure
functions of the players specific to those media types. If a Media Object can be played by more than one
media player, then all of the options are made available to you.
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About this task

Supported Formats:

The following table displays the media players that are used by the Media element, as well as all of the
media types supported by the players.

About this task

Table 19. Support media formats. The following table displays the media formats supported within LCMS Premier.

Player Supported Media Types

Image

v gif

v jpg

v jpeg

v png

Flash

v swf

v swa

v dcr

v flv

Shockwave v dcr

RealMedia
v ra

v ram

v rm

QuickTime

v mpg

v avi

v mov

v gt

v aiff

v aif

v mid

v png

v mpeg

Windows Media

v wma

v wmf

v wmv

v asf

v avi

v wav

v mid

v mp3

v mpg

v mpeg
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Table 19. Support media formats (continued). The following table displays the media formats supported within LCMS
Premier.

HTML5

v mp3

v wav

v m4a

v m4b

v m4r

v m4p

v m4v

v mp4

v ogg

v webm

Captivate v swf (Captivate file saved as SWF)

How the Media Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Media element Source view. It provides for the insertion of a Media
Object and multiple text areas whose position and alignment can be manipulated independently of one
another. You can also select, and configure attributes for, a media player.
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About this task

Parameters Window:

The Parameters Window provides a way for you to customize the functions of the Media player. The
available players and their functions automatically populate this window, and are dependent on the type
of media being presented.

About this task

The following image displays the Parameters Window for a .mov file. Refer to this image and table for
descriptions of the components.

Table 20. Components of the Parameters window.. The following table describes the components of the Parameters
window.

Frame Field Description

Media Configuration Player drop-down list
Contains all of the available media players for the media
selected

Media Configuration Height and Width Dimensions of the selected media

Media Configuration Maintain Ratio check box
When selected, keeps current proportions of the media
dimensions when either the height or width is changed.
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Table 20. Components of the Parameters window. (continued). The following table describes the components of the
Parameters window.

Parameters - Default Use check box
When selected, enables the corresponding media player
attribute

Parameters - Default Name
The default attributes available for the selected media
player

Parameters - Default Value drop-down list The values available for each media player attribute

Parameters - Custom Name
Enter the name of a custom attribute for this media
player. Custom attributes must be pre-programmed into
the media player.

Parameters - Custom Value
Enter the value for the custom attribute for this media
player. These values must be pre-programmed into the
media player.

Parameters - Custom Add and Delete buttons Adds or deletes custom parameters and their values.

Viewer Media Player Controls:

The Cobalt Non-Linear viewer and Reflection viewer contain audio and video player controls that enable
you to author media without player controls embedded in the media.

The controls apply themselves to the first video or audio object in the delivery window. For elements
where some or all controls do not apply, those controls is disabled. These controls can be added to other
custom viewers. The following functions are supported:
v Rewind
v Play/Pause
v Fast forward
v Closed Captioning off/on
v Mute
v Volume up/down
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Design View:

The Media element contains a Design view which can also be used to author the content of the element.
This view is an approximation of the actual content output, and provides the capability to apply HTML
directly using the HTML toolbar or shortcut keys.

About this task

You can do the following if you right-select on the image:
v Search for or import a new Media Object.
v Insert a media thumbnail.
v Maintain aspect ratio - This option keeps the width/height ratio constant while resizing the media.
v Enter alt text.
v Align the media.
v Insert text areas around the media.
v Access media player parameters.

Introduction 113



You can resize the media by clicking and dragging the handles on the media. Also, clicking on a handle
opens two floating text boxes, which allow you to enter exact height and width values.

If you select the Thumbnail check box in the Design view, a thumbnail placeholder will appear. You can
right-select on the placeholder image to search for, import, or request a Media Object, and enter Alt Text.
A thumbnail created in the Source view will also appear in this view.
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Text areas inserted around the media contain also contain a right-select menu, which provides the
capability to vertically and horizontally align the text area, and delete the text area.

Authoring a New Media Element:

Perform the following steps to create a Media element.

Procedure

1. Create a new Media element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field of the Content frame.
4. Enter the media label in the Label field of the Media frame, or search for the Media Object.
5. To configure the media player options, select the Advanced Media Parameters button and open the

Parameters window.
6. Select from the available media players in the Player drop-down list. You can specify the dimensions

(in pixels) of the media in the Height and Width fields. To keep the dimensions consistent when
making a change, select the Maintain Ratio check box.

7. The default parameters available for the player you selected will populate the Default frame. Select
the Use check box next to each parameter that you would like to enable, then select a value from the
Value drop-down list.

8. If there are custom parameters that you have built into the selected media player, you can enter
these parameters in the Name and Value field of the Custom frame. You can add custom parameter
fields by clicking the Add 

 
and Delete 

 
buttons.

9. Select OK.
10. In the Alt Text field of the Media frame, enter a description of the image - this is used in place of the

media in a 508 compliant environment.
11. Enter a short description of the image in the Caption field of the Media frame, and select the

preferred image alignment from the Alignment drop-down list.
12. To display thumbnail media that will link to the main media, select the Display as Thumbnail check

box. Enter the media label in the Thumbnail field of the Media frame, or search for the Media
Object. In the Thumbnail Alt Text field of the Media frame, enter a description of the media - this is
used in place of the media in a 508 compliant environment.

13. Enter a title for the text area in the Title field of the Text Area frame.
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14. Enter the text in the Text field. Use the drop-down lists in the Position and Alignment frames to
position the text area next to the image.

15. To add an additional text area, select the Add button and repeat Steps 13 and 14. You may add
multiple text areas to this element. To delete the current text area, select the Delete button.
Note: To view all text areas at once, select the Summary button 

 
. You may add, edit, and delete

text areas in this view.
16. Save your work.

Authoring an Image Map Element
The Image Map element combines the functionality of several elements to present information in an
interactive graphic format that hyperlinks to more information about components of the image.

About this task

How the Image Map Element Functions:

The Image Map element facilitates learning by providing a visual with hot spots that lead learners to
additional subject information.

About this task

This element is similar to the Mouseover element in that it responds to a mouse select. However, instead
of information appearing as a pop-up, the mouse select will send the learner to another piece of content
or URL for further information or resource material.

How the Image Map Element Renders:

The following image what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Image Map element Source view. It is almost identical to the Image
element in that it provides for the insertion of one image and multiple text areas whose position and
alignment can be manipulated independently of one another.
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About this task

Tip: The Image Map element contains a Summary button for launching the Summary dialog box in both
the Text Area frame in the Source view and the Area frame in the Map Areas dialog box.

Map Areas Dialog Box:

The Map Areas dialog box provides a way for you to define the interactive hotspot areas of the image.

About this task

Mapping is done over images so that a specific area of an image can be set as a target. Target areas create
hot spots. These hot spots can lead the learner to course content, Media Objects, External Objects, and
URLs. When the hot spot is clicked by the learner, the content to which it is linked is launched.

For More Information: For details on using shapes to create map areas, see Creating Shapes for Map
Areas

Authoring a New Image Map Element:

Perform the following steps to create an Image Map element.

Procedure

1. Create a new Image Map element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.
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2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field of the Content frame.
4. Select the Show Map Area Border check box if you would like to display the map areas configured

on the Map Areas window.
5. Enter the image label in the Label field of the Media frame, or search for the Media Object.
6. In the Alt Text field, enter a description of the image - this is used in place of the image in a 508

compliant environment.
7. Enter a short description of the image in the Caption field of the Media frame, and select the

preferred image alignment from the Alignment drop-down list.
8. Select the Map Areas button . The Map Areas dialog box appears.
9. The first map area shape is a rectangle, by default. Select on and drag the red indicator box to the

preferred drop area on the base image. You can resize the box by clicking the pointer on a corner of
the box and dragging the pointer.

Note: If you would like the first mapped area to be a shape other than a rectangle, you must create
the new shape first, then delete the original rectangle. New shapes are created by selecting the shape
type from the toolbar, clicking once to begin the map area, then clicking again to complete the map
area. For complete details on using shapes to create map areas, see Creating Shapes for Map Areas.

10. Enter a label for the area in the Label field.
11. Select a target type from the Type drop-down list. If you select a type of URL, enter a Web address

in the Target field. For all other selections, enter a content ID in the Target field, or browse for a
content ID.

12. If you are linking to a topic or element and would like the content to display in the current window,
clear the Launch in New Window check box.

13. To add an additional map area, select the Add button 
 

and repeat Steps 9 through 12. You may
add multiple map areas to this element. To delete the current map area, select the Delete button .
Note: To view all map areas at once, select the Summary button 

 
. You may add, edit, and delete

map areas in this view.
14. Select OK.
15. Enter a title for the first text area in the Title field of the Text Area frame.
16. Enter the text in the Text field. Use the drop-down lists in the Position and Alignment frames to

position the text area next to the image.
17. To add an additional text area, select the Add button and repeat Steps 15 and 16. You may add

multiple text areas to this element. To delete the current text area, select the Delete button.

Note: To view all text areas at once, select the Summary button. You may add, edit, and delete text
areas in this view.

18. Save your work.

Authoring a Video++ Element
The Video++ element enables video files to be paired with text file narrations of that video.

The text files can be time stamped in a way that enables it to be synched with points within the video
timeline. During playback, the user can select within the text document or player time line and jump
within the video and transcript.

The Video++ element supports these media types:
v f4v
v flv
v mp4
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The following image displays an example of an XML transcript file. Text is broken into small segments to
provide more accurate jumps to content in the video.

The following image depicts what the learner sees through the Learning Portal.

The following image depicts the Video++ element Source view. Multiple videos and transcripts can be
added.

Note: The Video++ element only supports .f4v and .mp4 file formats.

Authoring a New Video++ Element:

Perform the following steps to create a Video++ element.

Procedure

1. Create a new Video++ element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field of the Content frame.
4. Enter the media label for the video in the Video field, or search for the Media Object.
5. Enter the media label for the transcript in the Transcript field, or search for the Media Object.
6. Enter a title for the video in the Video Title field. This title appears underneath the video in delivery.
7. For reference purposes, you can enter the length of the video, in seconds, in the Video Length field.
8. To add another video and transcript, select the Add button 

 
and repeat Steps 4-7.
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9. Save your work.

Author Survey Elements
The following topics describe how to create elements that collect survey data..

Authoring a FreeForm Survey Element
The FreeForm Survey element provides you with a means to obtain qualitative feedback in the form of an
open-ended response via a statement or short answer.

About this task

How the FreeForm Survey Element Functions:

The Freeform Survey element appears to learners in the form of a question or statement that requires
them to respond with a short answer in the provided field.

About this task

How the FreeForm Survey Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Note: While Survey elements are authored inline with content, they are not displayed inline through the
Learning Portal. Survey elements must be made part of a Survey Object in order for them to appear to
the learner.

Source View:

The following image depicts the FreeForm Survey element Source view, where the content of the element
is configured.

About this task

Authoring a New FreeForm Survey Element:

Perform the following steps to create a FreeForm Survey element.
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Procedure

1. Create a new FreeForm Survey element by dragging and dropping from the Object Palette or using
the right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title in the Title field.
4. Enter a question or statement in the Text field.
5. Enter the number to which you would like to limit the length of the response in the Length field.
6. Save your work.

Authoring a Likert Survey Element
The Likert Survey element is designed to capture statistical information using the Likert Scale. The Likert
Scale provides a way for learners to quantify varying degrees of agreement or disagreement within a
given statement.

About this task

How the Likert Survey Element Functions:

The Likert Survey element appears to learners in the form of a question or statement that is attached to a
ratings scale. Learners is instructed to select the radio button that best matches their thoughts.

About this task

The ratings scale may be numerical, or may provide learners with selections such as Excellent, Fair, and
Poor.

How the Likert Survey Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Likert Survey element Source view, where the content of the element is
configured.

About this task
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Note: While Survey elements are authored inline with content, they are not displayed inline through the
Learning Portal. Survey elements must be made part of a Survey Object in order for them to appear to
the learner.

Authoring a New Likert Survey Element:

Perform the following steps to create a Likert Survey element.

Procedure

1. Create a new Likert Survey element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title in the Title field.
4. Enter the question in the Text field.
5. Enter the amount of radio buttons that you would like to display in the Choices field.
6. Enter labels in the Left, Center, and Right fields. These labels represent the scale for the radio buttons.

For example: Poor, Good, Excellent. If you would like the labels to be visible, select the Display Label
check box.

7. Save your work.

Authoring an Extended Survey Element
The Extended Survey element provides the capability to use an embedded Shockwave file as a Survey
element. The element contains an API that enables the developer to set the values required to
communicate answers between the Shockwave file and LCMS Premier.

About this task

Source View:

The following image depicts the Extended Survey element Source view. The Source view of the Extended
Survey element provides for the insertion of a Shockwave file and multiple text areas whose position and
alignment can be manipulated independently of one another. You can also configure attributes for the
Flash player.

About this task

122 IBM Kenexa® LCMS Premier Version 9.4: User's Guide August 2015



Survey Settings Dialog Box:

Developers of Extended Survey elements can configure how the answers are communicated between
LCMS Premier and the Shockwave file. These values are entered in the Survey Settings dialog box, which
is opened by clicking Settings in the Source view.

About this task

Refer to the following image and table for descriptions of the components of the Survey Settings dialog
box.

Table 21. Components of the Survey Settings dialog box. The following table describes the components of the
Survey Settings dialog box.

Authoring Field Description

End Settings

The end settings determine how the answers are retrieved by LCMS Premier. By
default, the Object will write settings to LCMS Premier radio button is selected. If the
LCMS Premier will read settings from object radio button is selected, then the
developer can enter custom values to communicate the answers and scores to LCMS
Premier.

End Settings - Id Function

The developer must enter JavaScript in the Id Function field that is called by LCMS
Premier to pass the element GUID to the Shockwave file. The Shockwave file must
pass this GUID back to LCMS Premier in the JavaScript API calls. An example would
be: setID($EVO_guid$)

Authoring a New Extended Survey Element:

Perform the following steps to create an Extended Survey element.

Procedure

1. Create a new Extended Survey element by dragging and dropping from the Object Palette or using
the right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field of the Content frame.
4. Enter the media label in the Label field of the Extended Survey frame, or search for the Shockwave

file.
5. To configure answer settings, select Settings to open the Assessment Settings dialog box.
6. Configure end settings, and select OK.
7. To configure the media player options, select the Advanced Media Parameters button and open the

Parameters window.
8. Select from the available media players in the Player drop-down list.
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9. The default parameters available for the player you selected will populate the Default frame. Select
the Use check box next to each parameter that you would like to enable, then select a value from the
Value drop-down list.

10. If there are custom parameters that you have built into the selected media player, you can enter
these parameters in the Name and Value field of the Custom frame. You can add custom parameter
fields by clicking the Add 

 
and Delete 

 
buttons.

11. Select OK.
12. In the Alt Text field of the Media frame, enter a description of the image - this is used in place of the

media in a 508 compliant environment.
13. You can specify the dimensions (in pixels) of the media in the Height and Width fields. To keep the

dimensions consistent when making a change, select the Maintain Ratio check box.
14. Enter a short description of the image in the Caption field of the Media frame, and select the

preferred image alignment from the Alignment drop-down list.
15. Enter a title for the text area in the Title field of the Text Area frame.
16. Enter the text in the Text field. Use the drop-down lists in the Position and Alignment frames to

position the text area next to the image.
17. To add an additional text area, select the Add button and repeat Steps 15 and 16. You may add

multiple text areas to this element. To delete the current text area, select the Delete button.
Note: To view all text areas at once, select the Summary button 

 
. You may add, edit, and delete

text areas in this view.
18. Save your work.

Author a Survey
Surveys are objects containing Survey elements, Assessment elements, and/or Instructional elements, and
are used to gather learner feedback.

The following image shows how a survey appears in the Objects view when authored.

Survey Objects
A Survey Object is the container for Survey Sections. You can create Survey Objects at the following
LCMS Premier hierarchy levels:

About this task
v Module
v Learning Object
v Topic
v Group

The level at which the Survey Object is created determines the use of the survey within the course. You
will want to create the Survey Object one level below its intended use so that the Survey becomes part of
that object and stays with it no matter where the object is imported, copied, or linked.
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When creating a Survey Object, there are several properties that affect the way it is presented to the
learner. These properties are entered in the fields of General view in the Details pane.

Survey Sections
Survey Objects must include at least one Survey Section. Sections are made up of Survey elements,
Assessment elements and/or Instructional elements from any assigned or unassigned module, learning
object, topic, or group. Several sections can be placed in a Survey Object.

About this task

The benefit of having multiple sections in a Survey Object is the ability to group survey questions
representing similar content together.

When creating a Survey Section, there are several properties that affect the way it is presented to the
learner. These properties are entered in the fields of General view in the Details pane.

The Survey Section List view provides a listview of the Survey elements, Assessment elements, and/or
Instructional elements contained within the Survey Section, and enables for general modifications to be
made to the elements.

Note: The columns available in the List view represent properties of Survey elements, Assessment
elements, and/or Instructional elements within a Survey Section. You can make specific element content
modifications in the List view of a Survey Section by double-clicking the elements.

Authoring a New Survey Object
Perform the following steps to create a Survey Object.

Procedure
1. Create a new Survey Object element by dragging and dropping from the Object Palette or using the

right-select menu in your course treeview.
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2. In the General view, enter a title in the Title field. After you save the content, this title displays in the
course treeview.

3. Save your work.
4. Create a new Survey section by dragging and dropping from the Object Palette or using the

right-select menu in your course treeview.
5. Enter a title in the Title field. After you save the content, this label will display in the course treeview.
6. Save your work and add more sections if needed.
7. Insert Survey elements, Assessment elements, and/or Instructional elements into each section.

Authoring Textual Elements
The following topics describe how to create elements whose main content is text.

Authoring a Bibliography Element
The Bibliography element presents bibliographic information for references cited in a course or for
suggested readings. By default, this element displays with a box around it that separates a Bibliography
element from the other content on the page.

About this task

How the Bibliography Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Bibliography element Source view, where the content of the element is
configured.

About this task

Design View:

The Bibliography element contains a Design view which can also be used to author the content of the
element. This view is an approximation of the content output, and enables you apply HTML directly
using the HTML toolbar or shortcut keys.
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About this task

Authoring a New Bibliography Element:

Perform the following steps to create a Bibliography element.

Procedure

1. Create a new Bibliography element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter the name of the author in the Author field of the Content frame.
4. Enter the title of the article in the Article Title field of the Content frame.
5. Enter the name of the publication in the Source Title field of the Content frame.
6. Select the type of publication from the Source Type drop-down list of the Content frame.
7. Enter the name of the publisher in the Publisher field of the Publication frame.
8. Enter the city and/or state of publication in the Location field of the Publication frame.
9. Enter the date of the article in the Date field of the Publication frame.

10. Save your work.

Authoring a Columns Element
The Columns element presents information in columns. This is useful to show comparisons between
several categories of information, or to display text in a brochure-like format. Columns could also be used
as a vertical list.

About this task

How the Columns Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Columns element Source view, where the content of the element is
configured.
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About this task

Summary Dialog Box:

In the Column frame of the Source view, columns are created in separate text fields with headings that
are numbered for ordering the columns. The Summary button launches the Summary dialog box.

About this task

This dialog box displays data in a vertical format, complete with buttons for inserting columns, deleting
columns, and launching the HTML Editor.

Design View:

The Columns element contains a Design view which can also be used to author the content of the
element. This view is an approximation of the actual content output, and enables you to apply HTML
directly using the HTML toolbar or shortcut keys.

About this task

You also can add, delete, or reposition columns by accessing the right-select menu on any column.

Authoring a New Columns Element:

Perform the following steps to create a Columns element.

Procedure

1. Create a new Columns element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.
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2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field of the Content frame.
4. Enter an introduction in the Text field of the Content frame.
5. Enter a title for the column in the Title field of the Column frame.
6. Enter the text of the column in the Text field of the Column frame.
7. To add an additional column, select the Add button 

 
and repeat Steps 5 and 6. You may add

multiple columns to this element. To delete the current column, select the Delete button 
 

.
Note: To view all columns at once, select the Summary button 

 
. You may add, edit, and delete

columns in this view.
8. Save your work.

Authoring a Description Element
The Description element provides the capability to display multiple text paragraphs.

About this task

How the Description Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Description element Source view, where the content of the element is
configured.

About this task

Design View:

The Description element contains a Design view which can also be used to author the content of the
element. This view is an approximation of the actual content output, and enables you to apply HTML
directly using the HTML toolbar or shortcut keys.
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About this task

Authoring a New Description Element:

Perform the following steps to create a Description element.

Procedure

1. Create a new Description element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field.
4. Enter a description in the Text field.
5. Save your work.

Authoring a Glossary Element
The Glossary element calls attention to an important term and its meaning. This element has the ability to
work much like an online dictionary where the learner is able to search for specific words within an
alphabetized list.

About this task

How the Glossary Element Renders:

The Glossary element renders as a box with a special icon that separates the text from other content on
the page.

About this task

The following image depicts what the learner sees through the Learning Portal.

Source View:

The following image depicts the Glossary element Source view, where the content of the element is
configured.
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About this task

Design View:

The Glossary element contains a Design view which can also be used to author the content of the
element. This view is an approximation of the actual content output, and enables you to apply HTML
directly using the HTML toolbar or shortcut keys.

About this task

Authoring a New Glossary Element:

Perform the following steps to create a Glossary element.

Procedure

1. Create a new Glossary element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a glossary term in the Term field.
4. Enter a definition in the Text field.
5. Save your work.

Authoring a List Element
The List element displays text in a list of bullets, numbers, or text items. Use this element to emphasize
major points, outline the steps in a process, or introduce information that needs a list format.

About this task

Source View:

The following image depicts the List element Source view, where the content of the element is
configured.
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How the List Element Renders:

The following image depicts what the learner sees through the Learning Portal.

Summary Dialog Box:

In the Item frame of the Source view, list contents are created in separate text fields that are numbered
for ordering. The Summary button launches the Summary dialog box. This dialog box displays all items
included in the list.

Design View:

The List element contains a Design view that can also be used to author the content of the element. This
view is an approximation of the actual content output, and provides the capability to apply HTML
directly by using the HTML toolbar or keyboard shortcuts.

You can also access a right-select menu to add or delete list items, configure bullets and numbering, and
configure animation for list items.

Animations:

Users can apply animation to list items in a List element. Animations can be created by clicking the
Animation button in the Source view and opening the Animation dialog box.

All list items are listed in the Animation dialog box. Entrance transitions can be applied to any list item
at Fast, Medium, or Slow speeds. You can require that the user manually loads each list item, or you can
configure the items to load automatically, with each item loading after a delay of 1 to 10 seconds.

Source View in the List Element

Figure 38. Sample List Element Rendering
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Note: Transition speed is measured in milliseconds. The speed can be changed to meet your exact needs
with the following theme parameters, available in the DELIVERY-RULES theme parm group in the
Theme Management category:
v Animation Speed - Fast (default = 200 milliseconds)
v Animation Speed - Medium (default = 400 milliseconds)
v Animation Speed - Slow (default = 600 milliseconds)

Authoring a List Element:

Use the following procedure to author a List element.

Procedure

1. Create a List element by dragging and dropping from the Object Palette or by using the right-select
menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field of the Content frame.
4. Enter an introduction in the text field of the Content frame.
5. Select the Blank, Bullets, Letters, or Numbers radio button, depending on how you would like the

list to display.
6. Enter the text for the list item in the Text field of the Item frame.
7. To add another list item, select the Add button and repeat Step 6. You can add multiple list items to

this element. To delete the current list item, select the Delete button.

Note:
Note: To view all list items at the same time, select the Summary button. You can add, edit, and
delete list items in this view.

8. Enter closing text in the Text field of the Bottom frame.
9. To add transitions to your list items and to configure transition settings, select the Animation button

to open the Animation dialog box.
10. Select one of the following options:

v The No Animation radio button to cancel any animation and load the List element normally
(default).

v The Advance on select radio button to require the user to load each list item manually by clicking
a button in the delivery viewer.

v The Advance automatically every ___ seconds radio button to load the list items automatically.
Select the number of seconds of delay between each list item from the drop-down list.

11. For each list item, select a Transition and the Speed for the transition. Transitions are not required
for all slides. To apply a transition to all slides, select that slide transition and select Apply to All.

12. Select OK.
13. Save your work.

Author a Message Box Element
The Message Box element emphasizes important information for the learner to remember. This element
displays with a box around it, including a special icon that separates the message box text from other
content on the page.

The icon that displays depends on the type of message box that you use. There are six standard default
message box types and 14 other message boxes that can be configured to meet your specific needs.
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How the Message Box Element Renders:

The following image depicts what the learner sees through the Learning Portal.

Source View:

The following image depicts the Message Box element Source view, where the content of the element is
configured.

Design View:

The Message Box element contains a Design view that can also be used to author the content of the
element. This view is an approximation of the actual content output, and provides the capability to apply
HTML directly by using the HTML toolbar or keyboard shortcuts.

The Content Manager comes with 16 default message box types that you can choose from for the
Message Box element.
1. For More Information
2. Hint
3. Alert
4. Caution
5. Warning
6. Danger
7. Good Points
8. Bad Points
9. For Example

10. Scenario
11. Job Aid
12. How To

Figure 39. Sample Message Box Rendering

Figure 40. Source View for the Message Box Element
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13. Time Permitting
14. Apply
15. Demonstration
16. Instructor Notes

Authoring a New Message Box Element:

Use this procedure to create a new Message Box element.

Procedure

1. Create a Message Box element by dragging and dropping from the Object Palette, or by using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field.
4. Enter the message in the Text field.
5. Select the appropriate type of message box from the Type drop-down list.
6. Save your work.

Author a Note Element
The Note element emphasizes important information for the learner to remember. This element displays
with a box around it, including a note icon that separates the note text from other content on the page.

How the Note Element Renders:

The following images depict what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Note element Source view, where the content of the element is
configured.

About this task

Design View:

The Note element contains a Design view which can also be used to author the content of the element.
This view is an approximation of the actual content output, and provides the capability to apply HTML
directly using the HTML toolbar or shortcut keys.
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About this task

Authoring a New Note Element:

Perform the following steps to create a Note element.

Procedure

1. Create a new Note element by dragging and dropping from the Object Palette or using the right-select
menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field.
4. Enter the message in the Text field.
5. Save your work.

Author a Parameter Element
The Parameter element provides a structure for describing command parameters, and behaves much the
same as term and definition. Parameters, their specific command, and their description display as a table.

How the Parameter Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Parameter element Source view, where the content of the element is
configured.
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Note: The heading of the second column in the parameter table reads, "Description." This heading
cannot be revised.

Summary Dialog Box:

In the Parameter frame of the Source view, parameters and their definitions are created in separate text
fields that are numbered for ordering the rows of the resulting parameter table. The Summary button
launches the Summary dialog box. This dialog box will display all available parameters and their
descriptions.

About this task

Design View:

The Parameter element contains a Design view which can also be used to author the content of the
element. This view is an approximation of the actual content output, and enables you to apply HTML
directly using the HTML toolbar or shortcut keys.

About this task

You also can add, delete, or reposition rows by accessing the right-select menu on any row.
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Authoring a New Parameter Element:

Perform the following steps to create a Parameter element.

Procedure

1. Create a new Parameter element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field of the Content frame.
4. Enter an introduction in the Text field of the Content frame.
5. Enter a heading for the parameters in the Heading field of the Content frame.
6. Enter a parameter name in the Parameter field of the Parameter frame.
7. Enter the parameter description in the Description field of the Parameter frame.
8. To add an additional parameter, select the Add button 

 
and repeat Steps 6 and 7. You may add

multiple parameters to this element. To delete the current parameter and its description, select the
Delete button 

 
.

Note: To view all parameters at once, select the Summary button 
 

. You may add, edit, and delete
parameters in this view.

9. Save your work.

Author a Quote Element
The Quote element provides the capability to format and document a quotation that can provide a nice
enhancement or add supporting context to your content.

How the Quote Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Quote element Source view, where the content of the element is
configured.
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About this task

Design View:

The Quote element contains a Design view which can also be used to author the content of the element.
This view is an approximation of the actual content output, and provides the capability to apply HTML
directly using the HTML toolbar or shortcut keys.

About this task

If you select the Thumbnail check box in the Design view, a thumbnail placeholder will appear. You can
right-select on the placeholder image to search for, import, or request a Media Object, and enter Alt Text.
A thumbnail created in the Source view will also appear in this view.

Authoring a New Quote Element:

Perform the following steps to create a Quote element.

Procedure

1. Create a new Quote element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter the quotation in the Quotation field.
4. Enter the name of the author in the Author field.
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5. If you choose to use a thumbnail image, enter the media label, or search for the Shockwave file.
6. In the Alt Text field, enter a description of the image - this is used in place of the image in a 508

compliant environment.
7. Enter the name of the publication in the Source Title field.
8. Enter the name of the publisher in the Publisher field.
9. Select the type of publication from the Source Type drop-down list.

10. Enter the date of the article in the Date field.
11. Enter the title of the article in the Article Title field.
12. Save your work.

Author a Summary Element
The Summary element emphasizes major points throughout a learning object for the learner to use to
review. This element displays information as a list with bullets, numbers, or indented paragraphs on a
shaded background whose color is theme driven.

The Summary element has many of the same style features as the List element. Keeping them separate
enables greater flexibility to customize and differentiate between the two types of content during delivery.

How the Summary Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Summary element Source view, where the content of the element is
configured.

About this task
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Summary Dialog Box:

In the Item frame of the Source view, summary contents are created in separate text fields that are
numbered for ordering. The Summary button launches the Summary dialog box. This dialog box displays
all items included in the summary.

About this task

Design View:

The Summary element contains a Design view which can also be used to author the content of the
element. This view is an approximation of the actual content output, and enables you to apply HTML
directly using the HTML toolbar or shortcut keys.

About this task

You can also access a right-select menu to add or delete list items, configure bullets and numbering, and
configure animation for list items.

Animations:

Users can apply animation to list items in a Summary element. Animations can be created by clicking the

Animation button 
 

in the Source view and opening the Animation dialog box.

About this task

All list items are listed in the Animation dialog box. Entrance transitions can be applied to any list item
at Fast, Medium, or Slow speeds. You can require that the user manually load each list item, or you can
configure the items to load automatically, with each item loading after a delay of 1 to 10 seconds.
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Note: Transition speed is measured in milliseconds. The speed can be changed to meet your exact needs
with the following theme parameters, available in the DELIVERY-RULES theme parm group in the
Theme Management category:
v Animation Speed - Fast (default = 200 milliseconds)
v Animation Speed - Medium (default = 400 milliseconds)
v Animation Speed - Slow (default = 600 milliseconds)

Authoring a New Summary Element:

Perform the following steps to create a Summary element.

Procedure

1. Create a new Summary element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field of the Content frame.
4. Enter an introduction in the text field of the Content frame.
5. Select the Blank, Bullets, Letters, or Numbers radio button, depending on how you would like the

summary to display.
6. Enter the text for the summary item in the Text field of the Item frame.
7. To add an additional summary item, select the Add button 

 
and repeat Step 6. You may add

multiple summary items to this element. To delete the current summary item, select the Delete
button .
Note: To view all summary items at once, select the Summary button 

 
. You may add, edit, and

delete summary items in this view.
8. Enter closing text in the Text field of the Bottom frame.
9. To add transitions to your list items and to configure transition settings, select the Animation button 

to open the Animation dialog box.
10. Select one of the following:

v The No Animation radio button to cancel any animation and load the Summary element normally
(default).

v The Advance on select radio button to require the user to load each list item manually by clicking
a button in the delivery viewer.

v The Advance automatically every ___ seconds radio button to load the list items automatically.
Select the number of seconds of delay between each list item from the drop-down list.

11. For each list item, select a Transition and the Speed for the transition. Transitions are not required for
all slides. To apply a transition to all slides, select that slide transition and select Apply to All.
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12. Select OK.
13. Save your work.

Author a Syntax Element
The Syntax element provides a structure for describing command syntax associated with a particular
procedure. This element displays formatted rows of commands and descriptions for each command.

How the Syntax Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Syntax element Source view, where the content of the element is
configured.

About this task

Note: The heading of neither column in the syntax table can be revised.

Summary Dialog Box:

In the Columns frame of the Source view, syntax commands and their descriptions are created in separate
text fields that represent ordered rows of the resulting syntax table. The Summary button launches the
Summary dialog box. This dialog box displays all available syntax commands and their descriptions.
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About this task

Design View:

The Syntax element contains a Design view which can also be used to author the content of the element.
This view is an approximation of the actual content output, and provides the capability to apply HTML
directly using the HTML toolbar or shortcut keys.

About this task

You also can add, delete, or reposition rows by accessing the right-select menu on any row.

Authoring a New Syntax Element:

Perform the following steps to create a Syntax element.

Procedure

1. Create a new Syntax element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. Select the Source view, enter a title for the element in the Title field of the Content frame.
4. Enter an introduction in the Text field of the Content frame.
5. Enter a command name in the Command field of the Columns frame.
6. Enter the syntax description in the Description field of the Columns frame.
7. To add an additional syntax item, select the Add button 

 
and repeat Steps 5 and 6. You may add

multiple syntax items to this element. To delete the current syntax item and its description, select the
Delete button 

 
.

Note: To view all syntax items at once, select the Summary button 
 

. You may add, edit, and delete
syntax items in this view.

8. Save your work.

Author a Table Element
The Table element provides "What You See Is What You Get" (WYSIWYG) authoring that displays the
table you are creating in an intuitive format through the Summary dialog box.
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It is useful for presenting processes, procedures, comparisons, characteristics, and definitions. The text
appears in defined rows and columns, with the options of hidden borders, table header shading, and
automatic numbering.

How the Table Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Table element Source view, where the content of the element is
configured.

About this task

Summary Dialog Box:

In the Table frame of the Source view, you must launch the Summary dialog box in order to author the
text that appears in the table rows and columns.

About this task

You can add table headings and content, and apply simple HTML formatting using HTML shortcut keys.
The toolbar contains buttons for inserting and deleting table rows and columns, aligning text, adjusting
column widths, and launching the HTML Editor are included.
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Design View:

The Table element contains a Design view which can also be used to author the content of the element.
This view is an approximation of the actual content output, and provides the capability to apply HTML
directly using the HTML toolbar or shortcut keys.

About this task

You can also access a right-select menu to perform the following functions:
v Insert rows and columns.
v Delete rows and columns.
v Split cells vertically and horizontally.
v Merge cells.
v Align text.
v Apply a border.
v Shade the headers.
v Number rows.
v Apply a number to the heading row.
v Access table properties.

You can resize table columns in the Design view by clicking and dragging the vertical divider between
the headers. Also, this opens floating text boxes (one for each column), which allow you to enter exact
widths for the columns.
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Authoring a New Table Element:

Perform the following steps to create a Table element.

Procedure

1. Create a new Table element by dragging and dropping from the Object Palette or using the
right-select menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field of the Content frame.
4. Enter an introduction in the Text field of the Content frame.
5. Select the Border check box in the Table frame if you would like the table and cell borders to be

visible.
6. Select the Shade Heading check box in the Table frame if you would like the table heading row to be

shaded.
7. Select the Number Rows check box in the Table frame if you would like the rows to be numbered.
8. If you selected the Number Rows check box, enter a heading for that column in the Number

Heading field of the Table frame.
9. In the Summary field, you can enter a description of the content that can be read by a screen reader

during delivery.
10. Select:

v the Fixed radio button if you would like column widths to be fixed.
v the Percent radio button if you would like the column widths to be based on a percent of the table

width.
v the Auto radio button if you would like LCMS Premier to automatically size the columns widths.

11. Select the Summary button 
 

in the Table frame. The New Table dialog box appears.
12. Enter or select the Number of columns and Number of rows for the table. If you select the Set as

default for new tables check box, future tables will contain this same number of columns and rows.
13. Select OK. The Summary dialog box appears.
14. Enter headings and table content. To add rows, select the Insert Row button. To add columns, select

the Insert Column button.
15. Align data and adjust columns using the appropriate toolbar buttons.
16. Select OK when content is complete.
17. Enter closing text in the Text field of the Bottom Text frame.
18. Save your work.

Author a Tip Element
The Tip element provides information that offers additional guidance to the learner. This element displays
with a box around it, including a tip icon that separates the tip from other content on the page.
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How the Tip Element Renders:

The following image depicts what the learner sees through the Learning Portal.

About this task

Source View:

The following image depicts the Tip element Source view, where the content of the element is configured.

About this task

Design View:

The Tip element contains a Design view which can also be used to author the content of the element.
This view is an approximation of the actual content output, and provides the capability to apply HTML
directly using the HTML toolbar or shortcut keys.

About this task

Authoring a New Tip Element:

Perform the following to create a Tip element.

Procedure

1. Create a new Tip element by dragging and dropping from the Object Palette or using the right-select
menu in your course treeview.

2. In the General view, enter a label in the Label field. After you save the content, this label displays in
the course treeview.

3. In the Source view, enter a title for the element in the Title field.
4. Enter the message in the Text field.
5. Save your work.

Reusing Content
The following topics describe how to use copies of objects and work with templates.
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Creating a Template
LCMS Premier templates are pieces of content structure that have been pre-developed for reasons of
productivity and consistent instructional design. They can be developed at any object level and then
made available to developers for use as required.

About this task

Templates provide an effective way for course developers to create new subject matter with
pre-established standards for structure, such as the layout and look of a course and its contents.

The Content Manager Structure pane provides you with two options for where you choose to author
templates:
1. Objects view
2. Templates view

Authoring Templates in the Templates View:

You can easily author templates in the Templates view of the Structure pane. The Templates view has
been designed to be consistent in form and functionality with the Objects view and the same
development processes apply. The main difference between the Objects view and the Templates view is
that the Templates view contains only templates, while the Objects view contains all developed content.

About this task

Authoring Templates in the Objects View:

You can also develop and/or identify content to be used as a template from the Objects view of the
Structure pane. By right-clicking and selecting More > Save As Template from the menu, the content
selected in the Objects view is copied as a template to the Templates view.

About this task
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Finding and Using a Template
You can search for, and access, templates in the Template Search view of the Utilities pane.

About this task

A template cannot be inserted into the Objects view or Workspace for development until the Status in the
General view has been changed to Production. At this stage you can drag the template from the Utilities
pane search results to the Structure pane. After a template is inserted, the Status of the template changes
to Development.

Copying and Pasting Content
LCMS Premier provides the capability to copy and paste content in a variety of ways, including deep
copying, and pasting linked versions of content.

Copying Content:

Content can be reused at any level from the module level to the element level. Content reuse is initiated
in one of the following ways:

About this task

v Select the Copy button 
 

on the Toolbar.
v Right-select on the content, either in the Structure pane or in the Utilities pane, and select Copy.

Pasting Content:

After copying, the content can be reused in the following ways.

About this task

v Paste
v Paste as Link

Paste:

The Paste option makes a copy of existing content that can be edited without affecting the original
content. When content is pasted, the new instance of the content is assigned a new GUID. This new
content can be modified, edited, or deleted without affecting the original content.
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About this task

Content is pasted by clicking the Paste button 
 

on the Toolbar or right-clicking and selecting Paste.

Note: You can copy and paste content within the Structure pane in one step by holding down the Ctrl
key and dragging and dropping an object.

Paste as Link:

The Paste as Link option ensures that updates and modifications made to content in one location is made
everywhere it is linked, greatly reducing development time. When content is linked, the GUID will
remain the same even though the content may be appearing in more than one location. This linked
content cannot be modified, edited, or deleted without affecting the original content.

About this task

Content is linked by clicking the Paste as Link button 
 

on the Toolbar or right-clicking and selecting
Paste as Link.

Instances of content that is pasted as a link is referred to as linked content. Linked content is indicated
with a red arrow in the Structure pane.

Note: You can link content in one step in one of the following ways:
v In the Structure pane, hold down the Ctrl and Shift keys and drag and drop an object.
v Drag and drop a search result from the Utilities pane to the Structure pane. The only exception to this

rule are templates; templates are inserted as a unique object.
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Deep Copy:

Lear how to do a deep copy of an object.

When copying an object that contains children, and the Paste option is used, a deep copy takes place. The
following rules pertain to deep copy:
v For content that is unique - there are no linked instances of the content - a new, unique object is

created.
v When an object is copied and pasted, and that object contains instances of a linked object within the

object being copied, those links are maintained in the copy. For example, if there are three learning
objects, each containing a linked reference to topics within the course being copied, then the copy of
the learning object will contain the same linked references to the topics.

v If an object included in a copy/paste operation includes an embedded link to another object also
included in the copy/paste, the link is updated to target the new object, not the original.

v When an object is deep copied, users have a record of the original object. For the new object, the More
dialog box accessed on the object's General tab now contains an Originating ID field which displays
the GUID of the original object.

Note: The deep copy functionality as described is enabled by default. The old deep copy functionality
can be enabled by setting the "Enable Deep Copy Maintain Links" site parameter to "false". With the old
functionality, unique objects are created for all objects in a deep copy, and embedded links are not
updated.

Archiving Content
LCMS Premier developers can create archives, or backups, of course content. An archive is identical to
the content export rendered in the Export category of the Learning Portal containing the following:

About this task
v Content
v External Content
v Media
v Layout definitions
v Metadata dictionary

Creating Archives:

Archives can be created for any object appearing in the Objects view of the Structure pane. You can create
archives in two different ways:

Figure 41. Deep Copy
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About this task

1. Manually
2. Automatically

Manually Creating an Archive:

Archives can be created manually by right-clicking on the object and selecting More > Create Archive.

About this task

You are then required to name the archive. You can specify the length of time before the archive expires,
and you can select the Hold check box to override the duration time specified and prevent the deletion of
the archive (Delete buttons is disabled).

Automatically Creating an Archive:

You can trigger the automatic creation of an archive in the Administration Manager category of the
Learning Portal. Select the Status link and select the Archive check box for each status that you would
like to trigger archive creation. When a developer sets an object to that status, the archive is created.

About this task

Note: When an archive is generated, the task displays in the Process Monitor category. If the user
cancels the archive task, the system will have created an archive "container" without the archive file.

Introduction 153



Manually Creating an Archive:

Perform the following steps to create an archive.

Procedure

1. Right-select on the object in the Objects view to archive and select More > Create Archive.
2. Enter a name for the archive in the Label field.
3. Enter the number of months until the archive will expire in the Retention Duration field.
4. To override the expiration date, select the Hold check box.
5. Select Next.
6. Enter any necessary metadata, if available.
7. Select Finish.

Access Archives:

After an archive is created, you can access the archive in two different places.

About this task

1. Archives view
2. Archives utility

For every object in the Objects view, there is an Archives view in the Details pane that contains all
archives for that object. In this view, users can download, delete, or modify archives through the
right-select menu.

Archives Utility:

The Utilities pane contains an Archives utility that enables users to search for and manage utilities. In this
utility, users can find content to which the archive belongs, and can also find, download, delete, or
modify archives through the right-select menu.

About this task

Note: Archive properties contain a Data view and Task view, allowing you to tag the archive with
metadata and create tasks to associate with the archive.

For More Information: To learn more about using the search utilities, see Searching for Content.

Figure 42. Archives View
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Deleting an Archive:

When you delete an archive, you can choose between two different options:

Procedure

1. Remove the content archive - This option removes the archive package but leaves the archive record
intact. The user ID is inserted into the Deleted By field.

2. Remove the content archive and all its tracking data - This option removes the archive package and
the archive record.

For More Information: You can configure a notification message to send to users when their archives
expire. See Configuring Archive Retention Expiry.

Authoring Tools and Settings
The following topics describe how to use tools and utilities located throughout the Content Manager.

Performing a Spell Check
Spell Check is an LCMS Premier tool that validates and checks all spelling within a content object. While
focused on a content object in the Structure pane, select Tools > Validators > Spelling from the Toolbar.
Spell Check will automatically begin checking all words within that content object.

About this task

Note: You can multi-select objects for spell check by holding down the Ctrl key. This provides the
capability to search within multiple course objects at the same time without having to include other
objects in the hierarchy that do not apply to the search.

Spell Check Options:

LCMS Premier provides the capability to set up pre-defined spell check criteria by selecting Tools >
Validators > Options from the Toolbar. Any spell check tasks performed will operate using this criteria.
Spelling is checked only for the language specified.

About this task

You can also add or remove words from your personal dictionary and, if you have the privilege to do so,
the shared dictionary that is accessed by the spell checker for all users. Your personal dictionary is
accessible only by yourself during a spell check.
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Performing a Spell Check:

When performing a spell check, LCMS Premier will stop at any word not in the dictionary. Each time it
stops, a Spell Check dialog will offer alternate suggestions, action options, and the ability to add the
word to the dictionary.

About this task

You have the choice of several action options for words. These are:
v Change to - Enter an alternative word.
v Suggestions - Select an alternative word.
v Ignore - Ignore the word and make no change.
v Ignore All - Ignore all instances of the word and make no change.
v Change - Change the word to that in the Change to field.
v Change All - Change all instances of the word to the text in the Change to field.
v Delete - Delete the word.
v Add to Dictionary - Add the word to the selected dictionary.

Note: When adding a word to a dictionary, you have the option of adding to the Shared dictionary or
the Personal dictionary. The Shared dictionary is the global dictionary used by all developers in the
system. The Personal dictionary is only for yourself.

Spell Check Context:

Each time the Spell Check stops at a word, the Content Manager will also go to the content object
containing the word. This provides the capability to see exactly where the word is within the context it
was written. The following context can be accessed:
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About this task

v The Structure pane displays the object containing the word.
v A content object displays the view in which the error was found.
v A content element displays in the view in which the error was found.

Validate HTML
The Content Manager provides an option for checking and validating HTML for accuracy at the element
level.

If you author with HTML, the validation tool will ensure the HTML tags are accurate for output.
Validating HTML minimizes challenges encountered when exporting content for the purpose of
delivering content in a print, CD, or PDF format. If HTML is not correct, the content export may fail.

HTML validation is initiated by selecting Tools > Validators > HTML on the Toolbar.

Note: You can multi-select objects for HTML validation by holding down the Ctrl key. This provides the
capability to search within multiple course objects at the same time without having to include other
objects in the hierarchy that do not apply to the search.

When the validator encounters problems in the HTML, it displays the HTML along with a warning or
error message. It also recommends valid HTML that you can accept by clicking Replace. Or, you can edit
the HTML manually and then select Validate to recheck it.

Configuring Options:

You can set validation rules by selecting Tools > Validators > Options from the Toolbar and selecting the
HTML tab. The validator always checks the Source view of content, but you can choose to skip the
General, Source and Data views. Selecting the Deep Validation check box is required if you want to
validate the contents of a container object.

About this task

The validator displays warnings in addition to actual errors in the HTML. These warnings are sometimes
frequent and will lengthen the process. To ignore the warning messages, select the Ignore Warning
Messages check box.
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Tip: You can change options during validation by clicking Options in the validation dialog box.

Finding and Replacing Text
Find and Replace provides the capability to find and replace instances of a word or a phrase within a
content object. While focused on a content object in the Structure pane, select Tools > Find from the
Toolbar.

About this task

The Find dialog box opens, allowing you to enter the find and replace term and select the required
options. Any instance of the text string is found, even if it is only a part of a word. For example, if the
search string is "it", then that string is found in "itself".

Note: You many also use the Find tool to just find content, without replacing.

You can multi-select objects for Find and Replace by holding down the Ctrl key. This provides the
capability to search within multiple course objects at the same time without having to include other
objects in the hierarchy that do not apply to the search.

Find Options:

LCMS Premier provides the capability to set up the find and replace criteria. The find and replace process
will operate using this criteria.

About this task

v Match Case - The Find process will only find words and phrases matching the exact upper or lower
case specified in the Find what field.

v Ignore General Properties - The Find process will ignore any words in the General view of any content
objects.

v Ignore Metadata Properties - The Find process will ignore any words in the Data view of any content
objects.

v Ignore Element Source - The Find process will ignore any words in the Source view of any elements.
v Ignore History Properties - The Find process will ignore any words in the History view of any content

objects.
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Find Context:

Each time the Find process stops at a word or phrase, the Content Manager will also go to the content
object containing the word. This provides the capability to see exactly where the word is within the
context it was written. The following context can be accessed:

About this task

v The Structure pane displays the object containing the word.
v A content object displays the view in which the word was found.
v A content element displays in the view in which the word was found.

Opening a New Content Manager
Opening more than one Content Manager at a time is useful, especially for dual-screen setups. You can
open multiple instances of the Content Manager and move content between them.

About this task

To open a second Content Manger, select Tools > Window > New from the Toolbar.

Configuring Content Manager Preferences
The Preferences menu provides the capability to configure personal settings for the Content Manager, and
is accessed by selecting Tools > Preferences from the Toolbar.

About this task

The following preferences can be configured.
v Bypass Save Confirm
v Persist Active View
v Skins
v Hover

Bypass Save Confirm:

When Bypass Save Confirm is selected, content is automatically saved. You are not required to select the
Save button on the Toolbar, and if you change focus before saving, there is no popup window asking you
if you would like to save.

About this task

Note: Bypass Save Confirm is disabled by default.
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Persist Active View:

When Persist Active View is selected, your view in the Details pane is retained hierarchically. For
example, if you are in the List view at a topic level, then navigate in your Structure pane to a group
level, your Details pane would remain in the List view. If this setting was turned off, then your Details
pane would be in the last view you visited at the group level.

About this task

Note: Persist Active View is enabled by default.

Skins:

Skins allow you to customize the look of your Content Manager, much like themes in the Learning
Portal.

About this task

The following skins are available:
v Classic
v Horizon (default)
v Magnum
v Sand

Note: Skins are created with Cascading Style Sheets (CSS) and are located in the installation directory on
the application server at \appweb\evsfiles\styles\author\skins. Those with access to these files and with
knowledge of CSS can modify these skins or create new skins.

Hover:

Developers can configure a hover feature that show either an object preview or details when the cursor is
placed over an object in the Utilities pane or Structure pane. There are three types of Hover available:

About this task

1. Hover Disabled (default)
2. Hover Thumbnail
3. Hover Info
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Hover Thumbnail displays a preview of the actual object. You can use the navigation arrows to browse
through each media file in the Media Object - the media type is indicated for each media file. Below is a
thumbnail of a Media Object in the Utilities pane.

Configuring Utility Pane Settings
There are two options specific to the Utilities pane:

About this task
1. View
2. Page Size

View:

The View determines the size of thumbnails within the Utility pane.

About this task

There are four views:
v Details - displays the details of the content
v Small - displays a small thumbnail of the content
v Medium - displays a medium thumbnail of the content
v Large - displays a large thumbnail of the content

Below is the Utility pane with the View set to Large.

Page Size:

The Page Size determines how many search results displays on each page within the Utility pane.
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About this task

There are six sizes available:
v 5
v 10
v 15
v 20
v 25
v 50

Creating and Using Property Sets
A Property Set is a criteria-based object that provides the capability to apply many properties to one or
more course objects at once. Property Sets are created by clicking Create/Edit Property Sets in the
Property Assignment view of the Utilities pane.

About this task

Property sets are configured with the filtering interface so that you can specify as many properties as you
need. The selected Property Set below would select the "Instructor Guide" and "Student Guide" metadata
values in the Print Product metadata tag for any object in the course hierarchy that you drag the Property
Set onto.

Property Set Criteria:

Depending on the object level, available properties that can be added to Property Sets and applied to
content include the following:

About this task

v Any metadata tags in the system
v Object Title
v Object Description
v Object Comments
v Search Keys
v Layouts
v Development Status
v Output Types
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Applying Property Sets:

After Property Sets have been created, there are three ways of applying them to content. Each process has
a different purpose.

Procedure

1. Applying Property Sets to a single content object - Select the content object in the Structure pane, then
drag the Property Set/Metadata tag from the Property Assignment view to the object.

2. Applying Property Sets to multiple content objects - Multi-select the content objects in the Structure
pane, then drag the Property Set/Metadata tag from the Property Assignment view to any of the
selected objects.

3. Applying Property Sets for "deep" assignment to all subservient objects within a parent object - Select
the content object in the Structure pane, then while holding down the Ctrl key, drag the Property
Set/Metadata tag from the Property Assignment view to the object. The property values is applied to
all content objects within the selected object.

Metadata Tags:

If needing to apply single metadata tag values to content, you can apply these straight from the Property
Assignment view, without having to create a Property Set.

About this task

Simply find the required metadata tag value in the Property Assignment view and drag it to the required
object in the Structure pane. The value for the metadata tag is populated and applied to the content. You
can apply metadata in the same three ways listed above for Property Sets.

Toggling Panes
The five panes of the Content Manager can be opened and closed as needed to suit your authoring
needs. Panes are toggled from the Panes menu on the right side of the Toolbar.

About this task

Cloning Panes
Cloning duplicates a pane in a separate window, allowing you to organize panes as you like. Changes
made in the cloned pane are updated in the Content Manager.
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About this task

A pane is cloned by selecting Clone Pane from the Options menu of the pane.

Creating and Using Filters
As content is developed, the number of objects in the Repository will continue to grow. LCMS
Premier provides the capability to filter through content and reduce the number of objects that appear.

About this task

LCMS Premier provides the capability to create filters for several reasons. Two of the most common are:
1. Filtering the content that appears in the Structure pane.
2. Filtering using metadata criteria for content export.

All filter management tasks are initiated by selecting Manage Filters from the Filters menu.

In Filter Administration, you can create, edit, delete, and copy filters. This view provides the capability to
see the criteria for each filter.

Add and Edit Filters:

Learn how to add and edit filters.

Select New or Edit to open a dialog box where the general filter information is entered, such as the Label
and Description. You can select the Public check box to make the filter visible to, and usable, by all users
with access to filters. Otherwise, the filter is only visible to you.

Here, you also must define the relationship between your criteria by selecting the appropriate radio
button.
v And - Filter displays only items that meet all of the identified filter criteria statements.
v Or - Filter displays items that meet at least one of the identified filter criteria statements.
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Select New or Edit to open the Criteria Detail dialog box, where you create a rule for the filter. After
completing the rule and selecting OK, you can select New again to create another rule. You can create as
many rules as necessary.

Rules can be created for every LCMS Premier object that can exist in a course hierarchy. The different
drop-down lists in the Criteria Detail dialog box give you many attributes from which to choose. The
options available in each drop-down list are dependent on the selection made in the preceding one.

Number of References:

When creating a filter for any Object Type except for course or module, where the Record Type equals
"General," there is a selection in the Property drop-down list entitled "Number of References." The
number of times that content is referenced is an indication of whether the content is assigned,
unassigned, and/or linked, as follows:

About this task

v If content is referenced zero times, then it is unassigned.
v If content is referenced once, then it is assigned, but used in only one course.
v If content is referenced more than once, then it is assigned and linked into different objects.

When the Number of References filter criteria is selected, the subsequent values in the Operator
drop-down list and Value field results in a filter that displays either assigned or unassigned content. The
possibilities are outlined in the following matrix:

Table 22. Content reference filter definitions. The following table displays filtering values as they relate to content
references.

Value = Operator = Greater Than Operator = Less Than

0 assigned content used once or more N/A

1 assigned content that is linked at least once unassigned content

2 assigned content that is linked at least twice
assigned content used once, and unassigned
content

Figure 43. Add a Filter for Objects

Figure 44. Creating a Rule: Criteria Detail Dialog Box
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Tip: You can also use the "Number of References" property when conducting an advanced content search
in the Utilities pane.

Filtering Content:

After a filter is created, you can apply it to the content in the Objects view and your Workspace. If a
container object does not contain any content matching the criteria, then the container appears empty.

About this task

Filters are applied by accessing the Filters menu and selecting a filter from either the Private Filters
option or Public Filters option. Select Clear Filter to restore the hierarchy to its normal state.

Filtering Exports:

The filter in the previous image can be selected when exporting content in the Learning Portal. Only
content that meets the criteria in the "Document" filter is exported.

About this task

Creating a Workspace
LCMS Premier gives you the ability to organize your own private workspace in the Structure pane. This
provides the capability to see only the content that you are working on, providing an un-cluttered
working environment.

About this task

You can access your workspace by selecting Workspace from the Structure pane Views menu. Because
you can add objects from any level, all objects appear at the same hierarchal level. The following image
shows a workspace containing a learning object, course, and group.

166 IBM Kenexa® LCMS Premier Version 9.4: User's Guide August 2015



Add Existing Content to a Workspace:

Existing content can be added to a workspace from two different places:
1. Structure Pane (Objects view)
2. Utilities Pane (Content Search)

Structure Pane:

Content can be added to a workspace from the Structure Pane as follows.

Procedure

1. Select the content in the Objects view of the Structure pane.
2. In the right-select menu, select More > Add to Workspace.

Utilities Pane:

Content search results can be added to a workspace in two different ways.

About this task

The first way is to drag and drop the search result into the workspace from the search results.

The second way is to right-select on the search result and select Add To Workspace.
v For Content Search results, right-select on the search result and select Add to Workspace.
v For Template Search results, right-select on the search result and select Copy Template to Workspace.

Templates must be set to production.
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Note: Elements and Reference Objects cannot be added to a workspace.

Adding New Content to a Workspace:

Developers can add new content to a workspace by dragging and dropping the object from the Object
Palette. Note that any objects added other than the course object are unassigned until they are added to a
course.

About this task

Content Search
The ability to find all types of content within the Content Manager is vitally important to your
development process. LCMS Premier provides multiple ways of searching for content, both within the
Utilities pane, and contextual searches within the Source views of several content types.

Searching for Content
Search types available as views in the Utilities pane are:

About this task
v Media Search
v Media Requests
v Content Search
v External Content Search
v Template Search
v Review Comments
v Layouts
v Archives
v Publishing Profiles
v Resources
v Substitution Profiles
v Substitution Variables
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Searching for Content Using the Utilities Pane:

All search views look the same when selected in the Utilities pane, however, they are designed to search
just for the content type selected. Clicking on the Search button down-arrow provides the capability to
perform an Advanced Search with more specific criteria, and also has options for managing searches.

About this task

The following objects can be specified for content and template searches:
v Course
v Module
v Learning Object
v Topic
v Group
v Element
v Assessment Object
v Assessment Section
v Survey Object
v Survey Section
v Reference Object

Object types are selected by clicking on the Search down-down arrow in the Utilities pane, selecting
Configuration > Object Types, and selecting the object type.

Simple Search:

Simple search can search on any string (textual entry) in the General and Data views of the object, which
includes the following criteria:

Introduction 169



About this task

v Title
v Description
v Comments
v Search Keys
v GUID

For simple search, you can also choose to include metadata in the search parameters. The search engine
will search all metadata for the search string entered. You can include metadata by clicking on the
Options drop-down arrow and selecting Configuration > Include Metadata.

Metadata can be used with the following searches:
v Content Search
v Media Search
v Media Requests
v External Object Search
v Template Search
v Layout Search

Allow Partial Words:

Developers can configure searching to allow only full words, or to allow partial words as well. Searching
by full word only will typically result in a shorter search duration. These options are accessed by clicking
on the Options drop-down arrow and selecting Configuration > Search Type.

About this task

Advanced Search:

Advanced Search searches against any other object criteria, and the criteria is dependent on the Search
type. In addition, child criteria options change according to the parent option selected.
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About this task

Advanced Search operates on a series of drop-down list selections, and the options available in each
depend on those selected previously.

Tip: LCMS Premier remembers the criteria for your most recent search. You can repeat that same search
by selecting Repeat Last Search from the Search menu.

Performing a Simple Search:

Perform the following steps to perform a simple search.

Procedure

1. In the Utilities pane, select the applicable Search view.
2. In the Search field, enter a simple search criteria.
3. Select Search.
4. The search results appears in the Utilities pane.

Performing an Advanced Search:

Perform the following steps to perform an advanced search.

Procedure

1. In the Utilities pane, select the applicable Search view.
2. Select the Search button down-arrow, and select Advanced Search.
3. Select New.
4. Beginning with the first criteria drop-down list, make selections according to your requirements.
5. Select OK.
6. Select Search.
7. The search results appears in the Utilities pane.

Note: After a system action, e.g., importing an external object, or creating a media request, the
system must index the item. It generally takes a few minutes before the item is included in search
results.
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Options for Search Results:

After a search has returned search results, there are several options for what you can actually do with the
results. Again, these options are dependent on the type of search performed. Search results options are
accessed by right-clicking on one of the items in the results list.

About this task

In addition to the options listed below, you have the ability to use any item in the search results list by
dragging it to other panes, as is applicable for the content type. For example, you can drag a content
element to a specific location in the Structure pane, and also to the Preview.

Other options available are:
v Content Search options

– Find - This will find the selected content within the Structure pane, and display the properties in the
Details pane.

– Copy - This will allow you to copy the selected content.
– Add to Workspace - This will add the content to your workspace.
– Properties - This will open the Properties dialog box for the selected content.

v Media Search options
– Import - This will allow you to import more media files into the selected Media Object.
– Export - This will allow you to export the selected media.
– Preview - This will open a Preview window for the selected media.
– Copy - This will allow you to copy the selected media.
– Delete - This will allow you to delete the selected media.
– Properties - This will open the Properties dialog box for the selected media.

v External Object Search options
– Import - This will allow you to import an external object to replace the selected external object.
– Export - This will allow you to export the selected external object.
– Delete - This will allow you to delete the selected external object.
– Properties - This will open the Properties dialog box for the selected external object.

v Template Search options
– Find - This will find the selected template in the Templates view of the Structure pane, and display

the Properties in the Details pane.
– Copy - This will copy the selected template.
– Properties - This will open the Properties dialog box for the selected template.

v Layouts options
– Export - This will export the selected layout.
– Copy - This will copy the selected layout.
– Paste - This will paste the selected layout for the creation of another unique layout.
– Delete - This will delete the selected layout.
– Properties - This will open the Properties dialog box for the selected layout.

v Publishing Profiles options
– Copy - This will copy the selected profile.
– Paste - This will paste the selected layout for the creation of another unique profile.
– Delete - This will delete the selected profile.
– Properties - This will open the Properties dialog box for the selected profile.

v Resources options
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– Copy - This will copy the selected resource.
– Paste - This will paste the selected layout for the creation of another unique resource.
– Delete - This will delete the selected resource.
– Properties - This will open the Properties dialog box for the selected resource.

v Archives options
– Find - This will find the selected content within the Structure pane, and display the properties in the

Details pane.
– Download - This will allow you to export the selected archive.
– Delete - This will allow you to delete the selected archive.
– Properties - This will open the Properties dialog box for the selected archive.

v Substitution Profiles options
– Copy - This will copy the selected substitution profile.
– Paste - This will paste the selected substitution profile for the creation of another unique substitution

profile.
– Delete - This will delete the selected substitution profile.
– Properties - This will open the Properties dialog box for the selected substitution profile.

v Substitution Variables options
– Copy - This will copy the selected substitution variable.
– Paste - This will paste the selected substitution variable for the creation of another unique

substitution variable.
– Delete - This will delete the selected substitution variable.
– Properties - This will open the Properties dialog box for the selected substitution variable.

Contextual Searching:

Searching for content doesn't always need to happen from the Utilities pane. Wherever you see the
Search button, contextual searching may be implemented.

About this task

For example, the following image shows the Search button available in the Source view of a Media
element. This provides the capability to search for media directly from within the element properties.
Clicking Search opens a Search dialog with the same options as in the Utilities pane.

Contextual searching is available in the Source view of other applicable elements, and also within dialog
boxes for various tasks.

Using Saved Searches
As it often happens with content development, developers may use the same search criteria over and
over. LCMS Premier provides the capability to save commonly used search criteria, for fast and easy
searches.
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About this task

To create a saved search, select Saved Searches from the Utilities pane Search menu.

The search is created in the same way as an advanced search, and it is saved in the same way as a filter.
You must specify a name, and you can make the search Public for others to use. Like advanced search,
criteria will vary based on the type of content for which you are searching.

For More Information: For information on the filtering interface, see Creating and Using Filters.

To use a saved search, select Saved Searches from the Utility pane Search menu. Select a saved search
and select Search.

In the following image, note that once you saved your search, the criteria values can be modified directly
in the criteria area in the bottom half of the window. When you make a change, the area changed is
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highlighted in red. Values are automatically saved, but you can change back to the previous values by
clicking Revert.

Grouping Search Results
Performing a search may sometimes return too many results for realistic finding of required content. In
this case, you can group your search results using specific criteria by selecting Group By from the
Utilities pane Options menu. The criteria changes depending on the search type, but common criteria
includes:

About this task
v People
v Date
v Search Keys
v Metadata

Some of these criteria have criteria subsets that further narrow down your search results.

HTML Editor
LCMS Premier provides an HTML Editor. Even if you are not familiar with HTML, you can still use this
feature to customize text by changing text styles and alignment, in addition to inserting media,
hyperlinks, and tables.

Note: After using the HTML Editor, the resulting HTML Tags appears in the Source tab field.

Launching the HTML Editor
Perform the following steps to launch the HTML Editor.

Procedure
1. Select the field on the Source tab that you would like to edit.
2. Perform one of the following.
v If you are in a Summary dialog box, such as for a List or Table element, select the Editor button 

on the toolbar.
v If there is no Editor button available, press and hold CTRL + E.
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Note: The HTML Editor can only be launched from Source tab fields longer than one row. If you
attempt to launch the HTML Editor from a Source tab field one row or shorter, you launches a Text
Editor instead.

The HTML Editor window is resizable.

HTML Editor Views
There are two methods for viewing content in the HTML Editor:
v Normal view
v HTML view

The Normal view enables those unfamiliar with HTML authoring and tags to create and format text, as
well as to insert media, hyperlinks, and tables.

The HTML view is for those who want to manually edit the HTML. Select the HTML check box to
display the HTML markup.

Note: Content that includes ALT + Character codes, that is copied and pasted into the Content Manager
from Word, may not render correctly through the Learning Portal or in print. Use the HTML view if you
wish to include symbols within your course. Some of the more popular HTML numeric codes are:
v &#169; = © (Copyright)
v &#174; = ® (Registered trademark)
v &#153;= ™ (Trademark)

You may also enter the HTML numeric codes directly in the field on the Source tab.

Important: When copying text from a Word, or similar document, paste it into the appropriate field on
the Source tab. If the text is pasted into the HTML Editor, all initial formatting, including proprietary
tags, will carry over with the text, making editing difficult, and possibly affecting print export generation
to a FrameMaker document.

Embedding Media
The HTML Editor provides you with the option of inserting images in any element as an alternative to
using the Rich Media elements. You may wish to include an image to enhance a Description element, or
you may wish to include images within a Table element.

176 IBM Kenexa® LCMS Premier Version 9.4: User's Guide August 2015



About this task

Inserting Images with the HTML Editor:

You can insert images via the HTML Editor as an alternative to the Image element. Here you can search
for, request, and import media, just as in the Media Search view.

About this task

The Insert Media button, on the Toolkit, launches the Media dialog box.

Note: You can also map images added through the HTML Editor, just as you map an Image Map
element.

Embedding Hyperlinks
The HTML Editor provides you with the option of creating hyperlinks to URLs or to Content Manager
objects. You can use this feature as an alternate to creating Reference elements or Reference Objects.

About this task

Inserting Links with the HTML Editor:

You can insert a link using the Toolkit of the HTML Editor. The Insert Link button launches a Link dialog
box where you can indicate details for the link. Link targets can either be a URL or LCMS Premier
content.

About this task

When configuring a link, you can configure the window used to deliver the target content. There are
three types of windows that can be used:
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1. Dialog
2. Current
3. New

If Current is chosen as the Window type, the content will load in the content window. If the Window
type is New or Dialog, content launches in a separate window, and you can customize the window by

clicking the Properties button 
 

next to the Window drop-down list. The configuration options depend
on the type of window selected.

A Dialog is a window that is contained within the content window and cannot be resized once it is
launched. If you scroll in the main content window, the Floating window will remain visible. The
following can be configured for a Floating window:
v Title - The title that displays at the top of the window
v Top - The vertical distance (in pixels) that the top-left corner of the window is positioned from the

top-left of the element
v Left - The horizontal distance (in pixels) that the left of the window is positioned from the left of the

element
v Height - Height of the window (in pixels)
v Width - Width of the window (in pixels)
v Modal - When set to "true" (default), the user must interact with the Floating window before returning

to the main delivery window
v Fixed Center - When set to "true" (default), the window will return to its original position if the user

drags the window to another position

A New window is a completely separate browser window with the following properties that can be
configured.
v Top - The vertical distance (in pixels) that the top-left corner of the window is positioned from the

top-left of the main delivery window
v Left - The horizontal distance (in pixels) that the left of the window is positioned from the left of the

main delivery window
v Height - Height of the window (in pixels)
v Width - Width of the window (in pixels)
v Resizable - When set to "true" (default), the resizing controls in the browser window are active
v Location - When set to "false" (default), the browser address bar will not appear at the top of the

browser window
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v Menu - When set to "false" (default), the browser menu will not appear at the top of the browser
window

v Scrollbars - When set to "true" (default), the vertical and horizontal scroll bars are visible
v Status - When set to "false" (default), the status bar will not appear at the bottom of the browser

window
v Toolbar - When set to "false" (default), the command bar will not appear at the top of the browser

window

Publish Content
The following topics describe how to publish content from the Content Manager, as well as manage the
resources and profiles used in publishing.

Exporting Content from the Content Manager
Developers can export content from the Content Manager as a content export or to any of the export
generator types by right-clicking on the content and selecting Export.

About this task

In the following image, you will notice a horizontal dividing line in the final menu. Options above the
line are Publishing Profiles, which contain preconfigured options for export.

You can then select from the export generators, which are categorized as follows:
v For E-Learning

– AICC
– SCORM 1.2
– SCORM 2004
– Static HTML
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v For M-Learning
– Mobile server

v For Printing
– Print
– PDF
– Word
– Assessment

v For Presenting
– Presentation
– PowerPoint

v For Transporting
– Content Export
– Content XML

Note: The export types available to you depend on the object level at which you are exporting.

For More Information: For detailed information on each export generator, see the Export Generator
Category section.

For detailed information on content and data export, see the Export Category section.

When you initiate an export, a Publishing Wizard launches that walks you through the process of
exporting content. The options presented in the wizard depend on the export type selected.

The following details the publishing process for a Static HTML export.

The first screen to appear is the Rules screen, where you can select options for the export. The options
available depend on the export type being used.

Note: You can select Back to go to the Type and Content screens, where you can change the export type
and the content selected for export.

The Scheduling screen provides the capability to set dates and times for the export to take place.
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The Confirmation screen displays your export details before you proceed with the export.

After an export has been triggered, you can view the export progress in the Process Monitor, which
launches automatically. You can manually launch the Process Monitor anytime by selecting Tools >
Process Monitor from the menu bar.

For More Information: For detailed information about using the Process Monitor, see the Process Monitor
Category section.

Importing and Managing Resources
LCMS Premier enables the import and management of resources. Resources are objects containing files
used during the publishing of content to various formats. For example, a Word template is a resource file
used for Word export. Below are a list of export generators and the resource types used for each:

About this task
v Assessment

– Template file (.dot)
– Mapping file

v PDF
– Template

v PowerPoint
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– Template file (.pot)
– Mapping file

v Print
– Template

v Word
– Template file (.dot)
– Mapping file

Resource files can be imported through the Resources utility in the Utilities pane by clicking Create.
Users are then led through more screens where they choose their resource file and enter properties for the
resource.

Creating a Resource:

Perform the following steps to create a resource.

Procedure

1. Select the Resources view in the Utilities pane.
2. Select Create.
3. Select the type of resource file from the Type drop-down list.
4. Select Browse to find the resource file.
5. Select Next.
6. Enter a name for the resource in the Label field.
7. Select Next.
8. Enter any necessary metadata, if available.
9. Select Finish.

Managing Resources:

The Resources utility is also used to search for and manage resources. You can copy/paste, delete, and
modify resources in this view.

About this task
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Note: To learn more about using the search utilities, see Content Search.

Updating a Resource File:

After creating a resource, you can update the file within the resource without having to create a new
resource. Just search for the resource, right-select and select Properties, and select the File view. Then
select Upload to select the appropriate file.

About this task

Creating and Managing Publishing Profiles
When using export generators, users select options such as filters, personalization profiles, templates, and
mapping files. Sometimes these same options are repeated frequently for numerous exports. LCMS
Premier provides the capability to create Publishing Profiles, or preconfigured export criteria that allow
you to skip the process of selecting options.

About this task

Personalization profiles are created by clicking Create in the Publishing Profiles view of the Utilities pane.
Users can then pick the type of export for which they are creating the profile, and then choose options
accordingly.

Creating a Publishing Profile:

Perform the following steps to create a publishing profile.

Procedure

1. Select the Publishing Profiles view in the Utilities pane.
2. Select Create.
3. Enter a name for the profile in the Label field.
4. Select the type of export for which you are creating the profile from the Type drop-down list.
5. Select Next.
6. Select the options for the export.
7. Select Next.
8. Enter any necessary metadata, if available.
9. Select Finish.
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After a profile is selected, it is automatically inserted into the appropriate publishing menu. For
example, in the following image, established profiles for Word, PDF, and FrameMaker export are
inserted into the Print publishing menu.
To publish content with a profile, simply select the profile from the right-select menu, and you are
directed to the last step of the Publishing Wizard, where you select Finish to publish the content.

Managing Publishing Profiles:

The Publishing Profiles utility is also used to search for and manage resources. You can copy/paste,
delete, and modify publishing profiles in this view.

About this task

For More Information: To learn more about using the search utilities, see Content Search.

Work with Media, External Content, and Metadata
The following topics describe how to work with media, external content, and metadata.

Using Media
The following topics describe how to create and manage media used in creating content.

Creating a Media Object
Media objects are creating by importing one or more new media files into a new media container. You
can do this by clicking the Create New Media Object link under Media Tasks within the Media Search
view of the Utilities pane.
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About this task

You can also create new media by clicking the Search drop-down arrow anywhere that media searching is
allowed and selecting Create New Media Request.

In the New: Media Object dialog box, you can add as many media files as you like, selecting the Media
Type for each one. The Media Type determines which file is used for different outputs, such as web
delivery or print. File Type is normally Single File, unless you are creating a multi-file Flash object (see
end of this topic). You can also specify the DPI of the media.

The next step of the import process is to enter a label for the Media Object. This is the label that appears
in your search results and that you will enter in any media Label fields. Your Media Object label does not
have to match the names of any media files you are importing.

For organizational purposes, select a Category in which to place your Media Object.

Note: When selecting Media Type, you should be aware that any content output will first search for its
own output type for media, and default to Web if it doesn't find it. A good rule-of-thumb to use is:

If you want an image (for example) to be available for Print only, select Print as the Media Type. If you
believe that this image may also be used for Web, select Web as the Media Type.

Creating a Media Object:

Perform the following steps to create a Media Object.
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Procedure

1. Initiate the media import by clicking the Create New Media Object link in the Media Search view of
the Utilities pane, or by clicking the Search drop-down arrow in the Source view of an element and
selecting Create New Media Object.

2. Select the Media Type for the media file. Enter DPI if desired.
3. Select Browse, and locate the media to be imported.
4. Select Next, and enter/select required information.
5. Select Next, and apply metadata as required.
6. Select Finish.

Importing Multi-File Flash:

LCMS Premier supports both single-file and multi-file Flash media. While single-file Flash objects can be
imported in the same manner as images, multi-file Flash involves a different process.

About this task

When selecting the file to import, you must select a ZIP file containing the Flash files, then select
Multi-File Interaction as the File Type.

With multiple files, you must select the start file in order for the media to play. This is done by
right-clicking the multi-file container in the Files view of the created Media Object, selecting Properties,
then right clicking the desired file and selecting Set as Start File.

Importing and Configuring Multi-File Flash:

Perform the following steps to import multi-file Flash.

Procedure

1. Initiate the media import by clicking the Create New Media Object link in the Media Search view of
the Utilities pane, or by clicking the Search drop-down arrow in the Source view of the Media
element and selecting Create New Media Object.

2. Select the Web Media Type for the media file.
3. Select Browse, and locate the multi-file flash ZIP file to be imported.
4. Select Next, and enter/select required information.
5. Select Next, and apply metadata as required.
6. Select Finish.
7. Save your work.
8. In the Media Search view of the Utilities pane, search for your Media Object.
9. Double-select on the Media Object to open Properties.

10. Select the Files view, then right-select on the media file and select Properties.
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11. In the Files view, right-select on the start file and select Set as Start File.
12. Select OK, then select OK again.

Requesting a Media Object
It is often necessary for developers to add media placeholders to content. This might mean that you are
waiting on media to be designed, or that you are importing the actual media at a later time.

About this task

In either scenario, you have the ability of creating the media placeholder, adding properties, and creating
a task associated with the request.

Media requests can be initiated from several different places.

You can also select the Search drop-down arrow anywhere that media searching is allowed and selecting
Create New Media Request.

Add a Media Request:

Learn how to add a media request.

Enter a Label for the media request. This is the label that appears in your search results and that you will
enter in any media Label fields. For organizational purposes, select a Category in which to place your
Media Object.

In addition to the general property selections shown in the previous image, you can select Nextto enter
metadata, if required. After the media request is complete, a placeholder is created, which will exist until
the media has been imported.

Requesting Media:

Perform the following steps to request a Media Object.

Figure 45. Add a Media Request
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Procedure

1. Initiate the media import by clicking the Create New Media Request link in the Media Search view or
Media Requests view of the Utilities pane, or by clicking the Search drop-down arrow in the Source
view of an element and selecting Create New Media Request.

2. Enter and a category for the media, and other information as needed.
3. Select Next, and apply metadata as required.
4. Select Finish.

Note: 
 

This icon displays in search results for all media that has been requested but not fulfilled.

Previewing Media
Each Media Object in the Utilities pane includes a small thumbnail of the image. After finding a Media
Object, you can preview the media by right-clicking on the thumbnail and selecting Preview. The media
will open in a separate window.

About this task

If you have Hover Thumbnail enabled, holding the mouse over the media file displays a larger view of
the media. You can use the navigation arrows to browse through each media file in the Media Object -
the media type is indicated for each media file.

Users can also select a default media type to be used for media search results in the Utilities pane by
selecting Media Types from the Options menu. In the Utilities pane, the thumbnail for each search result
displays the media file for that media type.

Replacing, Adding, or Deleting a Media File within a Media Object
After creating a Media Object, you can add new files and replace existing files as well. You can add new
files in two different ways.
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About this task

Right-select on a media search result and select Import.

You can also add or replace a media file by accessing the Media Object Properties File view, then
right-clicking on a media file and selecting the appropriate option.

Note that when replacing a media file, the Media Type drop-down list is disabled to ensure that the new
image is the same Media Type.

Note: You can also delete media files from the Media Object while in the Media Object Files view.

Adding a Media File within a Media Object:

Learn how to add a media file to a Media Object.

Procedure

1. In the Media Search view of the Utilities pane, select the Media Object.
2. In the right-select menu, select Properties.
3. In the Object Properties Dialog Box, select the Files view.
4. In the Options menu, select Add File.
5. Select the Media Type.
6. Select the Browse button and select the file to upload on your computer.
7. Select the file type.
8. Select Upload.
9. Select OK.

Replacing a Media File within a Media Object:

Perform the following steps to replace a media file.
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Procedure

1. In the Media Search view of the Utilities pane, select the Media Object.
2. In the right-select menu, select Properties.
3. In the Object Properties Dialog Box, select the Files view.
4. Select the file you would like to replace.
5. Right-select and select Update File.
6. Select the Browse button and select the file to upload on your computer.
7. Select the file type.
8. Select Upload.
9. Select OK.

Locking a Media Object
Perform the following steps to lock a Media Object.

Procedure
1. In the General view of any media-related element, select the Lock check box.
2. Save your work.

Exporting Media
Media can easily be exported from the Repository. You can export both single Media Objects, as well as
groups of Media Objects.

About this task

Exporting a Single Media Object:

You can export a single Media Object by right-clicking on a media object, selecting Export, then saving
the ZIP file. The ZIP file will contain all of the media files within the Media Object.

About this task

Exporting Search Results:

You can export all Media Objects displayed in search results by clicking the Export Search Results link
underneath your Media Object search results. The export is a single ZIP file with individual directories
for each Media Object.
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About this task

Importing Bulk Media
Many times, graphic artists need to upload large quantities of media to LCMS Premier. Importing these
files one by one would take much too long. For this, LCMS Premier enables you to bulk import media.
You can initiate this process by clicking the Import Bulk Media link in the Media Search view of the
Utilities pane.

About this task

When bulk importing media, you must place all media files in the same ZIP file - they can be of different
media extensions. You can also designate certain media extensions for certain Media Types by entering
the comma-delimited extensions, e.g., "gif, jpg".

Importing Bulk Media:

Perform the following steps to import multiple Media Objects.

Procedure

1. Select the Import Bulk Media link in the Media Search view of the Utilities pane.
2. Browse for the ZIP file containing the media.
3. Select the Overwrite files when labels match check box to replace any Media Objects with the same

label.
4. Enter your mappings for the media file extensions, e.g., "png, tif", in the Map File Extensions field

and select the Media Type for those files.
5. Select Add to map more media extensions.
6. Select Next to select a Media Category and enter other relevant information.

Note: The Label field is disabled because there are multiple labels involved.
7. Select Next, and apply metadata as required.
8. Select Finish.
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Using Multiple Media Types
Administrators can specify media types to use for different output types within a theme. This enables
different media files within the same Media Object to be used for the same output type, thus
single-sourcing Media Objects and reducing the number of Media Objects stored in the repository.

About this task

The media type(s) used for each output type is set with theme parameters. There are five theme
parameters in the DELIVERY_RULES parm group for this purpose:
1. Preferred Media Type(s) for CD default
2. Preferred Media Type(s) for CHM default
3. Preferred Media Type(s) for Print default
4. Preferred Media Type(s) for Slides default
5. Preferred Media Type(s) for Web

If no media type is selected for an output type, then the default media type is used, e.g., Web output type
is used for Web output.

Multiple media types can be used for each output type. You can select an additional media type from the
bottom drop-down list and select the Add New Value link. The order of media types in this list will
determine the media type used for that output type.

For example, a company has one course that they would like to output in both French and German. The
company creates two new media types:
1. Web_French
2. Web_German

When a Media Object is created in the content for each language, different media files for each language
for different output types are imported into the Media Object. The appropriate media type is assigned to
each media file. In the example below, the Media Object would be IT_Overview with each media file
specifying the language.
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When the course is to be output to a particular output type for a specific language, the administrator sets
the correct theme parameter to the appropriate media type. If the course is output to Web in German,
then the Preferred Media Type(s) for Web parm is set to Web_German. Likewise, if the course is output to
Web in French, then the Preferred Media Type(s) for Web parm is set to Web_French.

Note: When internally previewing media embedded in the HTML Editor, the default media type is used.

Using External Content
The following topics describe how to import and manage external content used in courses.

Importing and Configuring External Content
External content is easily imported into LCMS Premier. Single-file content, such as a document, can be
imported as is, while multiple-file content, such as a web-page should be imported within a zip file.

About this task

Similar to Media, external content utilizes both External Objects and external files. An External Object is a
container that stores external files. In some cases, an External Object may contain one file, such as a
Microsoft Word document. In others, it may contain several associated files, such as HTML pages.

Importing External Content:

To begin importing external content, select Import in the External Object Search view of the Utilities pane.
The content is imported in the New External Object dialog box.

About this task

Start Files:

If you import external content with multiple files, such as a web page, you must specify the file that is
used to launch the object. This Start File is specified in the Files view of the External Object Properties by
right-clicking on the appropriate file and selecting Set as Start File.
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About this task

Importing an External Object:

Perform the following steps to import an external object.

Procedure

1. In the External Object Search view of the Utilities pane, select Import.
2. Select Browse, and locate the external content to be imported. If there are multiple files, they must be

in a ZIP file. You can select Finish now, or select Next rename the object, select a media category, or
assign search keys.

3. You can select Finish now, or select Next assign metadata tags to the content.
4. Select Finish to import the content.
5. If you imported a ZIP file, search for the External Object in the Utilities pane. Right-select on the

object and select Properties. In the dialog box, select the Files view. Right-select on the file that is used
to launch the object and select Set as Start File.

6. Select OK.

Using External Content:

After external content has been imported, there are several ways in which you can provide learner access
to the content.

About this task

v Reference Objects provide you with an option for using larger pieces of external content that may
contain a lesson, or even a chapter, that would be a beneficial addition to your content. Reference
Objects can be authored at the module, learning object, topic, and group levels. When authored, a
Reference Object appears as a hyperlink that launches the external content.

v The Reference element provides the capability to refer to relevant supporting content by creating
hyperlinks to content within the repository, External Objects, and external URLs.

v The HTML Editor can be used to create hyperlinks to launch external content. The HTML Editor can
be used within any content element.

Exporting External Content
You can export an External Object by right-clicking on the object in the Utilities pane, then selecting
Export. You are then prompted to save the file to your local machine.
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About this task

Add External Files to an External Object
You can add external files to an External Object without having to import the entire object again.

This is done by right-clicking on the External Object in the Utilities pane and selecting Import. Browse
for the file you want to add, then select Upload.

Replacing External Files in an External Object
In the event that any files within your External Object are updated outside of LCMS Premier, you can
replace those files in LCMS Premier. This is done by right-clicking on the file in the Files view and
selecting Replace.

About this task

Replacing an External File:

Perform the following steps to replace an external file.

Procedure

1. After finding the External Object, right-select on the object in the Utilities pane and select Properties.
2. In Properties, switch to the Files view.
3. Right-select on the file you are replacing and select Replace.
4. Browse for the new file, then select Upload.

Using Metadata
The following topics describe how to create, manage the different types of metadata used in creating
content.

Creating and Assigning Metadata Groups and Tags
Metadata groups and tags are created in the Metadata Dictionary. The groups act as containers and
categories for holding and organizing metadata tags. Metadata groups can be created new or can be
reused like other content.

About this task

Metadata groups and their tags can be assigned to multiple metadata categories that serve different
purposes. For example, the metadata assigned to the Course category in the following image appears in
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the Data view of all Course objects and can be populated by the developer. Metadata assigned to the
Users category near the bottom of the image is used in member accounts and personalization.

You can copy and paste metadata in the same way as with course objects in your course.

You can create metadata groups and tags by right-clicking on any object in the Metadata Dictionary and
select Insert. The options provided depend on your level of focus in the treeview.

Metadata Groups:

After inserting a metadata group, you can enter a label and description for the new metadata group in
the General view.

About this task

Metadata Tags:

Metadata tags are contained within metadata groups. When developing metadata tags, you are provided
with nine edit types to configure how they appears for use by course developers:

About this task

1. Checkbox - supports the multiple selection of data that appear with check boxes.
2. Date - supports the selection of a date from a calendar.
3. Drop-Down Listbox - supports the individual selection of data that appear within a drop-down list.
4. Multi Select Listbox - supports the multiple selection of data that appear in a scroll-list format.
5. Number - supports the input of any number.
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6. Radio Button - supports the individual selection of data that appear with radio buttons.
7. Structured List - supports the selection of nested metadata from drop-down lists.
8. Text Field - supports the input of data within a one line text area.
9. Text Area - supports the input of data within a multiple line text area.

Authoring Metadata Tags:

After inserting a metadata tag, you can enter a label and description for the new metadata tag in the
General view. This view provides you with options for labeling and identifying the type of metadata tag
being authored.

About this task

Add Domains:

Learn how to add domains.

After you create a metadata tag, you can create domain values next. Domain values are the items that are
populated by users. Domains are added in the Details pane Domain view of a metadata tag. Just select
Add Item , select the domain, and enter the text. You can also add domain values through the
right-select menu. To reorder domain values in the list, select a domain value and use the Up and Down
arrows.

Note: Domains do not apply to the following metadata types:
v Date
v Number
v Text Field
v Text Area

Multiple Tag Instances:

Metadata tags can be configured so that developers can create multiple instances of the tag and assign
different values to each instance. This configuration is achieved by selecting the Allow Multiple check box
that corresponds with the metadata tag in the List view of the metadata group.

Figure 46. Add a Domain
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About this task

Note: When linking a metadata tag into other groups, the selection of the Allow Multiple check box is
unique to each instance. If you link a tag that has this check box selected and you would like the check
box to be selected in the new context, you must go to the new context and select the check box.

Creating Structured Metadata
Sometimes, metadata is detailed enough that it can be broken down into multiple subcategories. To
support this, LCMS Premier provides structured, or nested, metadata. When the Structured List metadata
tag type is selected, the user can create domains that contain subdomains.

About this task

You can add a subdomain by clicking Insert Item
 

with focus on the Domain. Clicking Insert Item
again will branch the metadata even further. To create another base domain, you must place focus on an
existing base domain and select Add Item 

 
.

Assigning Metadata to Content
Metadata is assigned to content in the Data view of the Details pane, or if configured, the General view
of the Details pane.

About this task

For More Information: To learn how to assign multiple metadata values to multiple objects at once, see
Creating and Using Property Sets.
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Using Element and System Metadata
The Metadata Dictionary contains two types of metadata that behave differently than standard metadata.
These types of metadata are:

About this task
1. Element metadata
2. System metadata

Element Metadata:

The Metadata Dictionary provides the capability to author unique metadata for each element type.
However, if you want to assign a metadata group to every element type, you can author the metadata at
the element level. While this metadata will not appear in each element type node, it will automatically
appear on the Data view for all element types.

About this task

In the figure below, the Educational metadata groups belong to the element level, and are therefore
applied to all of the element types. The Type metadata group is applied to the Description element type.
Therefore, the Type, Educational, and Audience metadata groups appears on the data tab of all
Description elements.

System Metadata:

The Metadata Dictionary contains system metadata, or metadata groups and tags that cannot be moved,
linked, copied, or modified in any way. System metadata is used to store and configure runtime data for
imported SCORM and AICC content.

About this task

The system metadata tags are indicated with a blue icon in the treeview as shown in the following image.
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Properties of System metadata cannot be modified. The non-editable fields are disabled, as shown in the
following image.

SCORM and AICC imports generate both External Objects and Reference Objects. System metadata will
populate the Data views of these objects accordingly.

Table 23. AICC Import Types. The following table shows the various AICC import types and the resulting LCMS
Premier objects.

Type of Import Resulting Object(s) Data tab populated on...

AICC HACP Remote Reference Object Reference Object

AICC HACP Local
External Object

Reference Object

External Object

Reference Object

AICC API Local
External Object

Reference Object

External Object

Reference Object

SCORM
External Objects

Reference Objects

External Objects

Reference Objects

After an import is complete, you can modify the metadata values in the Data view to change the way the
objects behave within a course and promote reusability. System metadata for a Reference Object will
always override the system metadata for the External Object within it.

Example:

The "max_time_allowed" system metadata tag controls the maximum amount of time, in minutes, that a
learner has available to complete a SCO. Changing this value in the Data view of the Reference Object
will change the amount of time allowed to complete an External Object (SCO). By changing the system
metadata for the Reference Object instead of the External Object, the door is left open to link that
External Object into a different Reference Object with its original metadata intact.

About this task

AICC System Metadata:

The AICC Assignable Unit Runtime Data metadata group contains AICC system metadata. AICC
Assignable Unit Runtime Data tags are populated on the following during import:
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About this task

v External Objects
v Reference Objects

Table 24. AICC System metadata tags. The following table shows the AICC system metadata tags and their
descriptions.

Tag Description

Type Category/classification of AU (information purposes only).

System ID ID of the object in the package, supplied by the authoring system (info purposes only).

Max Score Maximum score user can receive when experiencing all interactions.

System Vendor Authoring system used to create AICC package.

Core Vendor
Unique information required by the lesson design. Without this information, a lesson may
not execute.

Web Launch Lesson specific launch parameters.

Assignable Unit
Password

Optional feature that enables additional security. The password is AU specific and may be
sent with HACP messages so that the LMS can authenticate the AU making the request.

SCORM System Metadata Groups:

LCMS Premier contains the following two metadata groups for SCORM.

About this task

1. CMI Runtime Data
2. SCORM

CMI Runtime Data:

CMI Runtime Data tags are populated on the following during import:

About this task

v External Objects
v Reference Objects

Table 25. CMI Runtime Data system metadata tags. The following table shows the CMI Runtime Data system
metadata tags and their descriptions.

Tag Description

Credit
When the SCO is launched, it may request the credit from the LMS and change behavior
based on this setting.

Completion Threshold
The value against which the measure of progress the learner has made toward completing
the SCO can be compared to determine if the SCO should be considered completed.

Mastery Score Minimum score required to pass a SCO

Max Time Allowed Maximum time allowed for a SCO

Time Limit Action Tells the LMS/SCO what to do if max_time_allowed is exceeded

Lesson Mode
Determines how the SCO will behave when launched. Possible values are Browse, Review,
and Normal.

Launch Data
A freeform field for passing data from the LMS to the SCO. The author of the SCO would
need to inform the LMS what can go in this field.

Comments From LMS
A freeform field for passing data from the LMS to the SCO. The LMS can send any data it
desires to the SCO using this field.
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SCORM:

SCORM tags are populated on the following during import:

About this task

v Course
v Module
v Learning Object
v Topic
v Group
v Element
v Media Object
v External Object
v Reference Object

The following table shows the SCORM system metadata tags and their descriptions.

Table 26. SCORM system metadata tags. The following table shows the SCORM system metadata tags and their
descriptions.

Tag Description

SCORM Manifest
Identifier

The ID for objects referenced within the manifest

Manifest Identifier is
Globally Unique

This will contain a value of "true" or "false", depending on whether the user selects the
Assume Global ID's check box on import. If that option is selected, and an identifier in a
future import matches, the content is overwritten.

Objectives Global to
System

This will contain a value of "true" or "false", depending on the value in the manifest. It
determines whether all of the objects in the course should share their objective state
information with other courses in the system.

Assigning Metadata for Use in LCMS Premier
In addition to authoring metadata groups and tags, the Data view provides the capability to assign them
for use within LCMS Premier. Metadata groups and tags can be used to gather information about users,
to perform advanced searches through the Learning Portal, and to populate Aggregate elements.

About this task

Assigning User Metadata:

Metadata groups authored within the Users object in the Structure pane can be used for the following:

About this task

v Collecting data on the Additional Information tab of the Member Registration page.
v Advanced member searches.
v Personalization.

The following image shows a metadata group assigned to Users in the Structure pane and how it appears
on the Additional Information tab of the Member Registration page.
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Note: In order to view user metadata groups through the Additional Information tab and Advanced
Search page, the metadata tags within them must be configured to display (see next).

Using Metadata through the Learning Portal:

Metadata can be used to collect additional member information and perform advanced content and
member searches through the Learning Portal. You can make metadata available for this use at the
metadata group level by selecting the Show on Learning Portal check boxes associated with the desired
tags in the List view in the Details pane.

About this task

Note: When linking a metadata tag into other groups, the selection of the Show on Learning Portal
check box is unique to each instance. If you link a tag that has this check box selected and you would
like the check box to be selected in the new context, you must go to the new context and select the check
box.

Using Metadata with Aggregate Elements:

Metadata can be used by course developers to dynamically populate Aggregate elements. You can make
metadata available for this use at the metadata group level by selecting the Aggregate check boxes
associated with the desired tags in the List view in the Details pane.

About this task

The Aggregate check boxes are only available for metadata at the following content levels:
v Module
v Learning Object
v Topic
v Group
v Element
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Note: When linking a metadata tag into other groups, the selection of the Aggregate check box is unique
to each instance. If you link a tag that has this check box selected and you would like the check box to be
selected in the new context, you must go to the new context and select the check box.

Using Metadata on the General View of Content:

During course development, there are metadata tags that are used more frequently than others. Selected
tags can be made available in the General view of content. You can make metadata available for this use
at any level by selecting the Show in General view check boxes associated with the desired tags in the
List view in the Details pane.

About this task

When displaying tags on the General view the sequence for the tags is based on the sequence of their
relative groups and then their explicit sequence within the groups.

Note: Metadata tags which have the Show in General View check box selected displays in the General
view in the Content Manager. The tags will still be displayed on the Data view as well. A modification on
either tab view will update in both locations.

When linking a metadata tag into other groups, the selection of the Show in General View check box is
unique to each instance. If you link a tag that has this check box selected and you would like the check
box to be selected in the new context, you must go to the new context and select the check box.

Managing Metadata
The Metadata Dictionary provides the capability to manage metadata in the same way the Content
Manager provides the capability to manage content. Using either the Toolbar or the right-select menu,
you can do the following for both metadata groups and tags:

About this task
v Move (cut and paste)
v Copy and paste
v Copy and paste as link
v Remove link
v Delete
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v Access properties

For More Information: For more information on these functions, see the sections Course Creation Tasks
and Reusing Content.

Filtering Metadata
LCMS Premier authors can use filters to display only specific metadata in the Data view of different
object types. For companies with large numbers of metadata, this enables quick access to only the
metadata that is needed for a particular object type.

About this task

Metadata filters are customized and accessed in the Data view of each object type, using the standard
filtering interface. Filtering options are accessed from the Options menu in the Data view. This metadata
filtering is available for all Data views.

When a filter is applied in the Data view, the name of the filter displays at the top-right of the Data view.

Metadata can now be applied to metadata groups and tags in the Metadata Dictionary. This enables
metadata to be used as criteria when creating filters for metadata. Two new metadata categories have
been created for this purpose:
1. Metadata Groups
2. Metadata Tags
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To allow for tagging of metadata groups and tags in the Metadata Dictionary, a Data view has been
added to the Details pane of all metadata groups and tags. The metadata filtering capabilities are also
available in this Data view.

Note: When a change is made to metadata groups and tags within the Metadata Groups and Metadata
Tags metadata categories, the Data view must be refreshed before those changes are visible.

When creating a filter for the Data view, there are two Property Types available.
1. General - User can filter on ID, Label, and Number of References.

2. Metadata - User can filter on metadata groups and tags created in the Metadata Groups and Metadata
Tags metadata categories.
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Learning Portal: General Information

Welcome and News Categories
The Welcome and News categories provide a location for HTML files created outside of the LCMS
Premier platform to be displayed. These two categories are function identically but can serve different
purposes depending upon where the category is set to display during the member's Learning Portal
experience.

Uploading Welcome and News Files
The Welcome and News categories both provide information to users upon login.

About this task

The Welcome category is typically a greeting that gives basic login instructions or an overview of the
LCMS site.

The News category provides members with important information and updates for development. This
information could include the status of current projects, as well as hyperlinks to download plug-ins
needed to view media. The News category is typically provided after login.

Creating Welcome and New Messages:

There are two ways to create welcome and news messages.

About this task

1. Upload Welcome or News HTML pages to the File Manager.
2. Reference an internal or external URL.
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Using the File Manager for News and Welcome Messages:

News and welcomes can be created by uploading HTML pages to the File Manager. The File Manager
contains the files that make up LCMS themes, and is accessed by clicking the File Manager link within
the Theme Management category.

About this task

The HTML file can contain any number of things, including images and links to web pages or necessary
downloads. Media within the HTML file can be referenced in two ways:
1. File Manager - with this method, the media is uploaded into the File Manager, and the media is

referenced within the HTML file, e.g., img src="[@@]evo_ug_plugin_splash.jpg". Note that the
characters [@@] must be placed inside the quotes before the image name when referenced from the
File Manager.

2. URL - With this method, the media is not uploaded to the File Manager, but is referenced on a web
page or on the server, e.g., img src="http://epdg/epdgfiles/themes/primaryangles/
pria_portal_header3b.gif".

Uploading a Welcome or News Message:

Perform the following steps to upload a welcome or news message.

Procedure

1. In any Web page editor, create an HTML page and save the file on your local machine.

Note: Welcome.html is the default filename for the welcome, and Message.html is the default
filename for the news. If you would like to save your welcome under a different filename, you must
change this setting. Select on the PORTAL-RULES link in the Theme Management category and do the
following:
v For the welcome, select on the "HTML Welcome Category Filename or URL" parm. Enter the new

filename and select Update.
v For the news, select on the "HTML Message Category Filename or URL" parm. Enter the new

filename and select Update.
2. In the Theme Management Category, select File Manager.
3. Select Browse. The Choose file dialog box appears.
4. Select the HTML file to upload and select Open.
5. Select Submit.
6. If your HTML file references media from the File Manager, then select Browse, select the media, and

select Submit to upload the media. Repeat this step for all remaining media.

Configuring a URL as the News/Welcome:

The News and Welcome categories can also take the form of a web page that is linked to with a URL. To
do this, you must modify the appropriate theme parameters in the PORTAL-RULES theme parm group in
the Member Management category, as follows:

About this task

v For the News category, open the "HTML Message Category Filename or URL" parm and enter the web
URL. Select Update.
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v For the Welcome category, open the "HTML Welcome Category Filename or URL" parm and enter the
web URL. Select Update.

Enabling a Welcome or News on the Login Page
After uploading welcome or news messages, you can configure your Welcome and/or News categories to
appear on the login page of any theme, before the member logs in.

About this task

Each LCMS Premier theme is automatically assigned an account and layout in the Member Management
category. For example, the Learning theme is assigned the member name "Learning Default".

When logged into a theme, if you select on the Edit link for that theme account in the Layout column in
Member Management, you will see a Login Page tab in the layout. On this tab, you can select the
Welcome and/or News categories to display on the login page.

Inserting News/Welcome on the Login Page:

Perform the following steps to insert a news or welcome message on the login page.

Procedure

1. Log into the theme that you would like to have news or a welcome on the login page.
2. In the Member Management category of the Learning Portal, select the Edit tab in the Layout column

for the theme's account, e.g., "Default, theme name".
3. Select on the Login page tab and select the Welcome and/or News check boxes. Select Update.

Member Links and System Links Categories
The Member Links and System Links categories allow for the creation of systemwide and personal links.

Creating and Deleting Member Links
The Member Links category displays private hyperlinks created by each member for their own account.
These member links are visible only to the member that creates them.
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About this task

Member links are created by clicking on the Personalize link in the System Links category.

You can create up to 11 links to be displayed in the Member Links category. The Label is the actual text
that displays for the link, and the Description displays when the user mouses over the label. You can
reorder links with the Sequence drop-down list, and delete links by selecting the appropriate check box
and clicking Delete.

Creating and Deleting System Links
System links are links that can be displayed for a particular role on a site or theme level. These links are
created and listed in the System Links category. Clicking the Edit System Links link in the System Links
category opens the System Link Editor.

About this task

You can create an unlimited number of system links. The Label is the actual text that displays for the
link, and the Description displays when the user mouses over the label. You can reorder links with the
Sequence drop-down list, and delete links by selecting the appropriate check box and clicking Delete.

The value in the Visibility drop-down list determines the number of members that can view each link.
You can select from the following:
v Everyone on the site
v Everyone in the current theme
v Everyone on the site assigned to one role
v Everyone in the current theme assigned to one role
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Learning Portal: Delivery

Table of Contents Category
The Table of Contents category provides you with an interface for navigating through the available
courses and launching content in a delivery viewer, Assessment Window, or Survey Window. This
category also shares information about your access history to content.

Using and Configuring the Table of Contents
Content is launched by expanding the course objects and clicking on the link of the content you wish to
launch.

About this task

Alternate Table of Contents:

When configured by a theme parameter, Learning Portal members can expand the Table of Contents
category down to the group level. Content can then be launched from the module, learning object, topic,
or group level.

About this task

The data in the Completion and Last Accessed columns for topics and groups is tracked and displayed in
the same manner as the modules and learning objects. When accessed, the Table of Contents category will
expand to the last object previously selected by the member.

When content is launched:
v at the topic level, the member is navigated to the first group within the selected topic.
v at the group level, the member is navigated to the selected group within the current topic.

The following image shows the alternate TOC expanded to the group level.
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Note: The "Object Level to Display Table of Contents" theme parm in the PORTAL-RULES parm group
controls the level to which the treeview in the Table of Contents category will expand. Possible values
are:
v lo (default)
v topic
v group

Taking and Configuring Assessments
Assessments are launched from the Table of Contents category if authored at the module or learning
object level, or in the delivery window if authored at the topic or group level. Assessments provide
valuable feedback and learning prescription.

About this task

Clicking on an assessment link opens the Assessment Launch Window. This window provides
information regarding the assessment that is about to be launched. Assessment Duration is in minutes,
and the Assessment Results drop-down list provides the capability to view details of your past attempts
at the assessment.

When you launch an assessment, the assessment displays in the Assessment Delivery Window. To toggle
between pages, you can use the Next and Previous arrows or select on a page number link to go to the
appropriate page in the assessment. When you have completed the assessment, select Score Test to grade
the assessment and receive prescription and details.
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You can exit an assessment early and resume later by clicking Save, and you can also take an assessment
offline by clicking Download. For offline assessments, you must have a connection to the internet
established in order for scoring information to be returned.

When enabled by an administrator, a Save button is available in the Assessment delivery window that
provides the capability to save an assessment. If you previously saved and exited an assessment before
completion, and selected the link for the assessment in the Table of Contents category, you will see a
modified version of the Assessment Launch Window. Since you did not complete the assessment earlier,
you are now given the option to resume by clicking Continue.

You can also view past results for the assessment by selecting the date and time of the assessment from
the Assessment Results drop-down list and clicking Go.

Note: The Assessment Sections and related Assessment elements, as well as weights for scoring, are
determined by content developers and authored in the Content Manager.

Assessment Prescription:

When you select Score Test in the Assessment Delivery Window, the Assessment Prescription Window
launches. Here, you are provided a score and a learning prescription based on incorrect answers.

About this task

The content links on the left launch course objects recommended for review based upon incorrect
answers. The number of correct and incorrect answers displays on the right. The incorrect answers
displays as links that launches the questions you answered incorrectly. These links can be disabled with a
theme parameter.
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Assessment Details:

The Assessment Details Window provides an in-depth look at how a learner scored on each individual
assessment element.

About this task

The Raw column displays the actual number of correct answer choices per question, along with the total
number of answer choices per question. This shows you full and partial credit you received. The
Weighted column shows the points awarded based on the question weight.

For More Information: The Exam Results and Review Materials links only apply to metadata-based
prescription and are only visible if enabled by an administrator. See Configuring Metadata-Based
Prescription for more details.

Configuring the LO Toolbar
You can customize the LO Toolbar and CBT Toolbar by adding and removing buttons, and repositioning
the buttons and toolbar. This is done by clicking on the Button Layout link in the Theme Management
category.
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About this task

Note: Of the viewers provided by default with LCMS Premier, only the Classic-LO and Classic-CBT
Viewers are affected by changes to button layout. However, button layout functionality can be built into
custom viewers of your own.

On the Button Layout page, you can change the order in which buttons appear (Button Sequence),
configure the positioning and spacing between buttons (Button Space Width), and decide whether or not
to display buttons (Show?).

Note: If the name of a button needs to be changed, you can do so by uploading new button images
through the File Manager and associating that image with the button parameters in the
CLASSIC-LO-CBT-IMAGES theme parameter category.

Configuring Button Layout:

Perform the following steps to configure delivery window button layout.

Procedure

1. In the Theme Management category, select the theme for which you would like to configure button
layout from the drop-down list.

2. Select on the Button Layout link. The Button Layout page appears.
3. For each button, select the Yes or No radio button in the Show? column, depending on whether or not

you would like the button to appear.
4. Type the sequence in which you would like the buttons to appear in the Button Sequence fields.
5. The values in the Button Space Width fields represent the distance (in pixels) between a button and

the previous button in the sequence. Enter these values accordingly.

Note: For the first button in the sequence, the Button Space Width is the distance (in pixels) from the
left of the frame.

6. In the Alt Text column, enter the text that you would like learners to see when they mouseover each
of the buttons.

7. Select Update to apply the button layout information to the theme.

Note: By default, the Generate PDA Output button does not display in the LO Delivery Window. If
you want this functionality to be available to the learner, you will have to select the Yes radio button
on the Button Layout page.
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Configuring TOC Prescription
LCMS Premier provides prescription in the Table of Contents for a more robust learning process.
Depending on the progress of a learner, content can be removed or marked with visual indicators to
show which content is completed, or which content is not. Different levels of prescription are applied to
the following areas of the Learning Portal:

About this task
v Table of Contents category
v Classic-LO viewer
v Classic-CBT viewer

Satisfying Content:

Prescription is based on the concept of satisfying content. Depending on your settings, satisfaction is
achieved by either passing assessments or navigating content.

About this task

Satisfaction by Assessment:

When an assessment is scored, the object containing each Assessment element is evaluated at the group
level. If all Assessment elements within a group are considered satisfied, then the group is also
considered satisfied. All groups within the topic are then used to determine whether or not the topic is
satisfied. This process continues up the course structure until the Assessment Object is reached. The
Assessment Object is then only satisfied if the percentage of satisfied questions meets the passing
threshold value specified in the "Prescriptive passing threshold" theme site parameter.

About this task

Rules of Satisfaction by Assessment:

About this task

v An Assessment element is considered satisfied if it is answered correctly by the learner.
v An object is considered satisfied if at least one child object is satisfied and the rest of the child objects

are either "not available" or satisfied by "equivalency".
v A child object is "not available" if there are no Assessment elements within the object.
v "Equivalency" means that there is an Assessment element present in an object, but the Assessment

element was not used in the assessment due to randomization.
v An object is considered not satisfied if:

– Any child object is not satisfied.
– Any child object is not attempted.

Satisfaction by Navigation:

With this method, an object is satisfied if all child objects have been navigated. The course is satisfied
when all modules within the course are satisfied.

About this task

Prescription Settings:

There are five different settings for prescription. Settings 2-4 apply to the assessment prescription method
only.
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About this task

1. None: No prescription is applied.
2. Identify based on assessment: Objects displays in a designated color based on learner's assessment.

The Table of Contents category also contains a check mark next to the satisfied object.
3. Disable based on assessment: Objects displays in a designated color, and the hyperlink is disabled

based on learner's assessment.
4. Remove based on assessment: Objects will not appear based on learner's assessment. The Classic-CBT

viewer only supports the "remove satisfied" behavior.
5. Identify based on navigation: Objects navigated by the learner displays in a designated color. The

Table of Contents category also contains a check mark next to the satisfied object.

Note: Prescription settings are configured with the "Satisfaction Flag" theme parm in the
PORTAL-RULES parm group. The possible values are as follows:
v 0 = None
v 1 = Identify based on assessment
v 2 = Disable based on assessment
v 3 = Remove based on assessment

Disable Satisfied:

With this behavior, objects satisfied by the learner displays in a designated color, and the object links are
disabled. The Table of Contents objects cannot be expanded or accessed.

About this task

The following image displays disabled content in the LO Delivery Window. The "satisfied" color indicated
the satisfied topic and group objects, but the objects cannot be accessed because the links are disabled.

Remove Satisfied:

With this behavior, objects satisfied by the learner is completely removed from the course hierarchy. All
that remains is unsatisfied content.
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About this task

Making an Assessment Available for Prescription:

The Assessment must be made available for prescription in order for prescription to be applied. This is
done by selecting the Available for Prescription check box in the General view of the Assessment Object
in the Content Manager.

About this task

Using the Sequencing Table of Contents
LCMS Premier provides a Sequencing Table of Contents category in the Learning Portal that enables
members to launch content that behaves according to sequencing rules configured on the Sequencing
view of content in the Content Manager.

About this task

Sequencing Viewer:

Content is launched in the Sequencing Viewer. Content appears in the right pane, with the table of
contents in the left pane. Depending on administrative settings (see parm below), SCOs is at the learning
object, topic, or group level. Content appears as SCOs even if the content being viewed is not a SCO. This
enables developers to test content that they are developing for SCORM. Lower content levels can be
navigated in the right-pane.
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About this task

The Sequencing Viewer has four possible buttons located at the top-left corner:
1. Exit
2. Table of Contents
3. Previous
4. Continue

The Previous or Continue buttons are active for a session only if they are activated in the Navigation
Interface section in the Sequencing view of the learning object, Assessment Object, or SCO in the Content
Manager. The content treeview may or may not be expandable, depending on the Control settings for the
course.

In short, the behavior of content in the Sequencing Viewer depends on the way that sequencing is
configured in the Content Manager. In this viewer, sequencing rules apply to all content, not just SCORM
content.

Reviewing Content
When reviewing content through the Learning Portal, reviewers can add comments by clicking on the
add a new review comment link that follows each element. The number in parentheses represents the
number of review comments that already exist for this content.
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About this task

The add a new review comment link launches the New Comment window where comments pertaining to
the content can be added. Additionally, a priority status, comment type designation, and supporting
attachments can be added. Any previous comments can be viewed by selecting the Previous Comments
tab. If you made changes directly to the content in delivery, these displays in the Suggested Change field.

Note: Only media, such as images, video, and audio, can be used as attachments for review comments.
External content, such as Word documents, is not supported.

On the Previous Comments tab, users can delete their own review comments from this screen, and not
those of other reviewers. In the following image, the current user st_platform_admin can delete the top
review comment, but not the bottom one.

Direct Editing:

Reviewers can also suggest text changes by clicking the content in the viewer and adding, deleting, or
modifying text directly on the page. After changes are made, you are required to select the add a new
review comment link and add a comment for the changes. If you try to go to other content with clicking
the link, the Add Review Comment window will open automatically.
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About this task

Note that when making changes in this manner, the changes you have made are highlighted on the New
Comment tab.

After entering and saving the review comment, your changes will not be visible in the viewer window.
However, below the window, there are now two new links. One link shows the date and time of your
review comment, and the other link is show current version. Clicking the date and time link will show
your changes (highlighted) in the viewer window. Then, clicking the show current version link will
return the content to the original view.

For More Information: Changes made directly in the viewer window are not automatically applied to
content. They are intended as "suggested changes" for the developer. When viewing review comments,
the developer can choose to accept or reject those changes. See Finding and Implementing Review
Comments for more details.

Slide Presentation Category
The Slide Presentation category provides you with an instant slide presentation of selected content. Only
elements with Slides output selected in the element General view are available for slide presentation.

Launching and Configuring a Slide Presentation
The Slide Presentation category provides you with an instant slide presentation of selected content. Only
elements with Slides output selected in the element General view are available for slide presentation.

About this task

The Slide Presentation format provides the capability to launch a presentation at the course level through
the Slide Presentation category.
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Presentation Window:

A Presentation Window opens when Launch is clicked in the Slide Presentation category.

About this task

The interface includes two panes that enable you to locate the slides you wish to present. These panes
are:
v Treeview pane - provides a list of the modules within the course. These modules can be expanded for

navigation to individual learning objects. Selecting a learning object will populate the Slides pane with
the slides available for presentation.

v Slides pane - provides hyperlinks to the available slides contained in the learning object selected in the
TreeView pane. Available slides include learning object, topic, and group title slides as well as content
slides for those elements that have been identified for Slides output in the Content Manager. Clicking a
slide hyperlink launches a separate Slide Window.

Slide Window:

The Slide Window displays the slide you selected from the Slides pane of the Presentation Window. This
window provides a navigation bar for moving through the presentation. The navigation bar also provides
the capability to print slides and launch the LO Delivery Window for the current slide content.

About this task
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Print Category

Printing a Learning Object
You can print selected learning objects by utilizing the Print category. This category is used when you
want to quickly print the web version of course content - not to be confused with Print export, Word
export, or PDF export in the Export Generator category.

About this task

The following procedure will help you to print a learning object in an HTML format.

Procedure
1. In the Print Category, select a course from the Course drop-down list.
2. Select Find. The course modules are listed.
3. Select on the module hyperlink containing the learning object that you would like to print.
4. Select on the learning object hyperlink. A dialog box appears containing the learning object.
5. Right-select in the dialog box, and select Print. The Print dialog box appears.
6. Configure your print settings, and select Print.

Surveys Category

Taking Surveys
The Surveys category provides you with links to course evaluations and/or surveys related to course
content or to the Learning Portal. To launch a Survey, select on the link provided.

Survey Object Properties:

A Survey Object appears in the Survey Category only if the Display in List check box is selected in the
Survey Object General view in the Content Manager. If the Anonymous check box is selected, the
member ID will not be returned with the survey results. Surveys are removed from the Survey Category
when the survey expires.

About this task
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Direct Content Access Options Category

Configure Direct Content Access
Users of LMS's and other external systems can directly access LCMS Premier content. An API can be
configured to launch any object in an LCMS Premier site's repository from other applications. The content
available for launch must be configured within the API.

There are two ways in which content can be accessed using the API:
1. Anonymous Use - If the API is configured for anonymous use, the user is seamlessly logged in, with

no action required by the user.
2. Authenticated Use - If the API is configured for authenticated use, the user is prompted for a valid

LCMS Premier member ID and password.

The Direct Content Access Options category enables users to configure direct content access.

Anonymous Use Options:

For anonymous use, users can do the following.

About this task

v Select the All Content Available radio button to make all content listed in the API available to
anonymous users.

v Select the Anonymous Use radio button, and select the link, to create rules that displays only certain
content listed in the API to anonymous users. If this option is selected, but no criteria are created, then
no content can be accessed.

v Enter the member account to use for anonymous login in the Anonymous Use ID field. The default is
st_learner.

Authenticated Use Options:

For authenticated use, users can do the following.

About this task

v Select the All Content Available radio button to make all content listed in the API available to
authenticated users.

v Select the Direct Access Availability radio button, and select the link, to create rules that displays only
certain content listed in the API to authenticated users. If this option is selected, but no criteria are
created, then no content can be accessed.
For More Information: For details on creating filters, see Creating and Using Filters.

Note: The Direct Content Access Options category is not included in any default layouts. This
category must be added by editing member tab layouts. In addition, the "Direct Content Access
Category" action must be selected for the member's role in Role Administration in order for the
category to appear.

Learning Portal: Developer Tools

Search in the Learning Portal
Users can search for specific content objects in the Learning Portal, as well as search for text within
content.
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Searching for Content in the Learning Portal
You can use the Search category to locate a specific learning object, topic, or group. The Search function
uses search keys assigned in the General view of content to retrieve data.

About this task

If the regular search does not return the results needed, you can use the advanced search feature. Fill in
the appropriate search keys, select the content level, and select Advanced. You can then populate
metadata tags, and the Advanced Search will retrieve the content that has been tagged with that
metadata.

Note: Metadata tags appear in the Advanced Search Window only if they are designated for use in the
Metadata Dictionary.

Performing a Content Search:

Perform the following steps to search for content.

Procedure

1. In the Search category, enter a search key for the object in the Search Key field.
2. Select Learning Object, Topic, or Group from the drop-down list, depending on what type of object

you are trying to find. To enter advanced search criteria, select Advanced and continue with Step 3.
Otherwise, proceed to Step 5.

3. Enter the metadata by which you are defining your search in the fields provided.
4. Select Find and proceed to Step 6.
5. Select Search.
6. The search results appear in the Search category. Select the links to access the content.

Search Feature Theme Parameters:

There are theme parameters available that control the functionality of the Search category.

About this task

Table 27. Search theme parameters. The following table described the available Search category theme parameters.

Parm Label Parm Group Parm Description
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Table 27. Search theme parameters (continued). The following table described the available Search category theme
parameters.

Allow Advanced Meta Search PORTAL-RULES

Controls whether or not an Advanced button is
present, allowing learners to perform advanced
metadata searches in the Search category and
Member Management category.

Allow Meta Search At
Grouping Level

PORTAL-RULES
Controls whether or not learners can perform
content searches at the group level

Searching for Text within Courses
LCMS Premier contains a new search feature that provides the capability to find text strings within one
or all courses in your current partition. This feature is available through the Search Course Context
category in the Learning Portal.

About this task

Note: The Search Course Context category is not visible by default. It must be added to the member
layout through the Member Management category.

When you enter a text string in the Search for field and select Search, the hierarchies for all courses
containing the text displays. If you select the Current Course Only check box, then only the course
currently displayed in the Table of Contents category is searched.

Each hierarchy is expandable down to the group level, and next to each object is the number of instances
of the text in that object, including the rolled-up instances from that object's children. The content can be
launched at the learning object, topic, or group level.

Business Rules:

About this task

v When multiple words are separated by a space, objects containing any of the words are returned.
v When multiple words are separated by a comma, objects containing all of the words are returned.
v When multiple words are enclosed with double quotes, objects containing the exact text string are

returned.
v The following objects are not searched:

– Assessments
– Surveys
– External Objects
– Unassigned Objects

v The following object properties are included in the search:
– Search keys
– Title
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– Body of element
v Searching is not case-sensitive.

Advanced Search:

By clicking Advanced, users can select from more search options. Multiple words can be typed, separated
only by spaces, the search will conduct itself based on the field in which the words are typed. This
provides the capability to search for objects containing the exact phrase, all of the words, or any of the
words.

About this task

You can narrow the search results even more by only returning objects that do not contain certain words.
For example, in the following image, results is returned for objects that contain the word "gagne" AND
do not contain the word "application". The same punctuation rules apply in the without the words field
as in the general search.

When you conduct an Advanced Search, the advanced criteria displays and highlighted in the main
category, and the results are accessed in the same manner as the general search.

Searching for Text in a Course:

Perform the following steps to search for text within a course.

Procedure

1. In the Search Tree category of the Learning Portal, select the Current Course Only check box if you
only want to search the course that is currently selected in the Table of Contents category. Otherwise,
all courses in your partition is searched.

2. Perform one of the following:
v For a basic search: If you are performing a basic search for a text string, type the word(s) in the

Search for field and select Search. Results is returned for objects containing any of the words. To
search for the exact text string, enclose the text string in double quotes. To search for objects
containing all words anywhere within each object, separate the words with commas. Continue to
Step 5.

v If you would like to create a conditional search, select Advanced and continue with Step 3.

Note: Search keys for LCMS content are included in the search.
3. In the Advanced Search dialog box, perform one of the following:
v If you want to find all objects containing an exact text string, select the with the exact phrase radio

button and type the word(s) in the corresponding field.
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v If you want to find all objects containing all of the specified words anywhere with each object,
select the with all of the words radio button and type the word(s) in the corresponding field.

v If you want to find all objects containing any of the specified words anywhere with each object,
select the with any of the words radio button and type the word(s) in the corresponding field.

4. If you would like to find objects that do not contain certain words, enter the words, separated by a
space, e.g., "red blue". Results will returned for objects meeting this criteria AND the criteria selected
in Step 3.

5. Select Search. The Table of Contents for the course(s) containing the search criteria appears. The
numbers next to each object indicate the number of times that the text appears in each object. Expand
the tree to select and view the objects.

Preview Content
Users can preview both online course objects and PDF exports in the Learning Portal.

Preview Content Delivery
The Delivery Launch category enables Developers to preview the delivery of a selected LCMS Premier
object in different contexts to aid in the development of custom viewers.

The Developer must enter the GUID or title of the course, module, learning object, topic, group, element,
Assessment Object, or Survey Object and then select the output type, viewer, and theme to apply to the
object. When you enter the title of an object, a list of objects that match the text that is entered displays
for selection.

This category is for preview only, and cannot be used for student learning and scoring. Content that is
launched appears as it does in the authoring Preview, for example, hidden content is visible.

Note: Selection of a theme affects the look of the Classic-LO and Classic-CBT viewers. For the
Cobalt-Non-Linear viewer, selection of a theme affects only the icons and labels that are used in the
Message Box, Note, Tip, and Glossary elements.

Preview PDF Output
You can use the PDF Preview category to output content to PDF without using the PDF export generator.

For organizations that use PDF output regularly, this category enables multiple users to output to PDF at
the same time without having to wait to exports in the Process Monitor to complete. The resulting PDF
opens automatically in your default PDF viewer, where you can save the PDF to your local machine.

After you choose the Object Type, the user must enter the GUID or title of the course, module, learning
object, topic, group, element, Assessment Object, or Survey Object and then select the template and
filter/personalization profile to apply to the object. When you enter the title of an object, a list of objects
that match the text that is entered displays for selection.

Reporting Category
The Reporting category enables the administration of reports and the generation of reports.

Create, Assign, and Delete Report Groups
Report groups are used to organize reports into logical collections. LCMS provides the following report
groups by default:
v Administrative - Information about member logon and access history
v Assessment - Assessment performance details, including the assessment, learner, date taken, and score
v Content Development - Content development details, such as object status, authoring history, and

development progress
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v Development Management - Content development details, such as developer statistics, content history,
and object status

v Learning Management - Learner progress and performance details, such as assessment performance,
learner access, and course completion

v Learning Progress - Information about how you are progressing through the course material that was
assigned to you

v Media - Information about media requests and usage within the Content Manager
v Metadata - Information about the metadata schema design in the Content Manager
v Proctoring Activity - Proctoring activity for assessments by proctor and course
v Review Process - Review details, including reviewers for specific content, reviewer details, and

reviewer role details
v Survey - Information about submitted survey results, aggregated survey answers, and specific member

survey answers

You can configure reports groups through the Report Administration page, which is accessed by selecting
Edit in the Reporting category.

In the Report Group Administration frame, select New to create a new report group, or select an existing
report group and select Edit or Delete to do these respective concepts.

Note: You must remove all reports from a report group before you delete the report group.

The same page is used for creating and assigning report groups. For a report group to be available to a
user, the group must be assigned to the user's role. By default, standard LCMS roles already have certain
report groups that are assigned to them based on the usefulness of the report to each role.

You can assign or unassign a selected report group by editing the group and selecting the check box next
to each role that should be able to access the reports in that group. You can also change the report group
title and description in this view.

Assigning a Report Group to a Role:

Use this procedure to assign a report group to a role.

Procedure

1. Select the report group to be edited from the Select drop-down list in the Reporting category.
2. Select Edit.
3. On the Reporting Administration page, select Edit in the Report Group Administration frame.
4. On the Report Group Edit page, select the roles that you want to have access to the report group.
5. Select Update to return to the Reporting Administration page.
6. Select Back to return to the Reporting category.

Generate a Report
LCMS Premier provides more than 40 reports that you can dynamically generate.

The reports available to you depend on the report groups that are assigned to your role and the reports
that are assigned to each report group. Reports generation is initiated by selecting the appropriate report
group in the Reporting category and selecting the link for the report.

Each report has varying amounts of criteria to specify - the criteria depends on the type of report. The
following image displays an Authoring History by Member report, which requires that you select one or
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more members and specify the date range for the report. Other reports require criteria such as content
status, course objects, media categories, and partitions. For all reports, you can select from the following
formats:
v HTML
v Text file
v Excel spreadsheet

LCMS Premier reports are asynchronous in that they can be scheduled to run at any time, in a single
instance or in a recurring fashion. The completed report is available through the Process Monitor or
Report Monitor, where the report can be downloaded, viewed, or e-mailed.

Generating a Report:

Use this procedure to generate a report in LCMS Premier.

Procedure

1. In the Reporting category of the Learning Portal, select the appropriate report group from the Select
drop-down list.

2. Select the link of the report you want to generate. This opens the report configuration page.
3. Configure the criteria for the report. Some criteria include:
v Member
v Course
v Date Range
v Media Object
v Media Category

4. Select the report format that you want from the Format drop-down list.
5. To run the export as soon as possible, select the Immediate check box and proceed to Step 11. To

schedule the export for later, continue with Step 6.
6. Clear the Immediate check box and select Schedule. The Scheduling dialog box appears.
7. Select Start Date and select the date (from the calendar) on which you would like to start the export.
8. If you would like this export to recur regularly, select the Weekly, Daily, or Monthly radio button,

depending on your need. If you select the Monthly radio button, the End of Month check box
becomes enabled. Selecting this check box causes the export to run at the end of the month only.
Select End Date and select the date (from the calendar) on which you want to end the export
recurrences.

9. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the export.
10. Select Submit.
11. Select Create Report to generate the report. If you receive a message that states the report has no

data, then the report does not contain data that matches the criteria that you selected.
12. When the report requested is submitted, a dialog box appears to show you that the request was

successful. You can close this dialog box and monitor the progress of the report in the Report
Monitor or Process Monitor. Select the refresh every check box and select a time frame from the
seconds drop-down list. When the Status of the report is completed, select the report link to save the
report file.

Assigning a Report
Use this procedure to assign a report.
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About this task

You can do report administration through the Report Administration page, which is accessed by selecting
Edit in the Reporting category.

Procedure
1. Select the report group in the Report Group Administration frame
2. Select or clear the check box in the Assigned for a report
3. Select Update to save changes.

Deleting a Report
Use this procedure to delete a report.

Procedure
1. Select the check box in the Delete column for a report.
2. Select Delete in the Report Assignment and Administration frame.

Discussion Forums Category

Create and Use Discussion Forums
The Discussion Forums category displays a list of learning objects that are put up for discussion by
course developers.

Learning objects do not appear in this category by default. In order for a learning object to be available
for discussion, the word “forum” must be added to the Search Keys field in the General view of a
learning object in the Content Manager.

After you select one of the learning object links in the Discussion Forums category, the Discussion Forum
window appears. In this window, you can post topics and replies, search for topics, and view particular
topics.

You can also create and reply to Discussion Forums while you view a learning object in the LO Delivery
Window. Select Discussion on the LO Toolbar.

Note: Discussion forums that are created through the LO Delivery Window do not appear as links in the
Discussion Forums category.

Learning Portal: Export Generators

Export Generator Category
You can use the Export Generator category to output content to various formats, including static web,
print, online help, SCORM, AICC, and presentation.

Using the Publishing Wizard
LCMS Premier provides a Publishing Wizard that walks you through the process of exporting content
with any of the export generators. The Publishing Wizard launches when any of the links in the Export
Generator category are clicked, and the options presented in the wizard depend on the export generator
selected.

The following slideshow details the publishing process for a Static HTML export.

The first screen is the Content screen, where the content for export is selected. To find content, select an
object type from the drop-down list and search by object Label.
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Note: To change the type of export before proceeding, select Back to open the Type screen.

On the Rules screen, you can select options for the export. The options available depend on the type of
export generator being used.

Note: The graphics that appear in Glossary, Message Box, Note, Quote, and Tip elements are part of a
theme. The graphics used will depend on the Theme chosen on this screen.

The Scheduling screen provides the capability to set dates and times for the export to take place.

The Confirmation screen displays your export details before you proceed with the export.
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Export AICC Files
The AICC (Aviation Industry Computer-Based Training Committee) generator produces a package of files
that provide information about a course for the purpose of accessing the course from an outside LMS
(Learning Management System). When the course is accessed from the LMS, you can view the LCMS
Premier course content, as well as take assessments.

The LCMS Premier dynamic delivery engine communicates using AICC HACP (HTTP AICC CMI
Protocol) Level 1 delivery APIs (Application Programming Interfaces). This enables LCMS Premier to
communicate learner assessment results directly with any AICC compliant LMS, providing easier
integration with a customer's existing LMS. The following objects can be selected for AICC export:
v Course
v Module
v Learning Object
v Topic
v Group
v Assessment Object
v Survey Object
v Reference Object

AICC export can be accessed through the Export Generator category.

When a course is exported using the AICC generator, the exported package contains four required files:
1. CRS (Course description) - The CRS contains information about the course as a whole. If offers

information that relates to more than just a single element in the course. The CRS file consists of three
groups:
v Course
v Course Behavior
v Course Description
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2. AU (Assignable unit) - The AU file describes the course information. The assignable unit is the
smallest unit the CMI (Computer Managed Instruction) system assigns and tracks. Results must be
reported back to the CMI system to correspond to these assignable units.

3. DES (Descriptor) - This file contains a complete list of every element in the course. It is used as the
basic cross-reference file showing the correspondence of system generated ID's with user-defined ID's
for every element.

4. CST (Course Structure) - The CST File contains the basic data on the structure of the course. It
includes all of the assignable units and blocks in the course.

After export, the above files are integrated into the system that the LMS has in place to launch the
Learning Portal. When you select on the course link in the LMS, the Learning Portal launches without
any manual login on your part.

The Learning Portal launches with a default member account used for AICC purposes. The Table of
Contents category will contain only the course for which you generated the AICC files.

For More Information: An overview of the AICC is available at www.aicc.org.

AU Levels:

When you export an AICC package, you can select the Assignable Unit (AU) in an export (the AU is the
object level at which content is launched from the LMS).

This enables users to launch and track data at different object levels without changing the object level of
the export. Users select the AU for an export from the Assignable Unit (AU) drop-down list in the AICC
Output Generator Wizard.

The following objects can be designated as the AU:
v Course
v Module
v Learning Object
v Topic
v Assessment Object
v Survey Object
v Reference Object

Although all of the above can be the AU in an export, there are limitations. The AU selected must be at
or below the root block level (the "root block" is the object that is selected for export).

For example, if a module is selected for export, then module, learning object or topic can be selected as
the AU.

Possible AUs for Each Possible Root Block:

For each possible block of content, there are specific objects that can be specified as the AU.

Table 28. Possible AUs for Each Content Block. The following table displays the objects that can be specified as AUs
for each content block.

Root Block Objects Allowed as AU
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Table 28. Possible AUs for Each Content Block (continued). The following table displays the objects that can be
specified as AUs for each content block.

Course

v Course

v Module

v Learning Object

v Topic

Module
v Module

v Learning Object

v Topic

Learning Object
v Learning Object

v Topic

Topic v Topic only

Assessment Object v Assessment Object only

Reference Object v Reference Object only

Survey Object v Survey Object only

As shown in the previous table, if a topic, Assessment Object, Survey Object, or Reference Object is
selected for AICC export, then only that object level can be the AU. However, an Assessment Object,
Survey Object, or Reference Object can also become an AU if:
v It exists at the same hierarchical level as the selected AU.
v It exists at a level between the root block and the selected AU.

Note: If an AU selection is not allowed for the root block selected, then it is disabled in the Assignable
Unit (AU) drop-down list. Assessments at the same level or higher than the selected AU do not
provide prescription and do not display prescription results.

Data Tracking:

LCMS Premier AICC exports track certain data elements when launched through a third-party LMS. The
data elements contain valuable information about the learner and content.

Table 29. AICC Data Element. The following table displays the data elements that are tracked for AICC when
launched from an LMS.

Data Element Usage

session_id Unique session identifier

session_instance_id New object GUID

lesson_mode

Indicates course behavior after launch - possible values are:

v normal - Required to take assessments and return score (default)

v browse - Assessments are disabled, and status of "browsed" returned

v review - Assessments are disabled, and no status returned
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Table 29. AICC Data Element (continued). The following table displays the data elements that are tracked for AICC
when launched from an LMS.

credit

Indicates whether the student receives credit for the session performance -
possible values are:

v credit (default) - Courses with assessments return a score and a value of
“pass” or “fail”. Courses without assessments return no score and a value of
"complete" or "incomplete". Note: The site parm "AICC Student Assessments
Results" determines the score that is returned, with the following possible
values:

v best - The best score for the learner is returned

v last - The last score for the learner is returned (default).

v No credit - If passing threshold is achieved, a value of "complete" is returned.
If passing threshold is not achieved, a value of "incomplete" is returned.

session_instance_begin Date and time of AICC launch

session_instance_end Date and time of AICC finish, posted back to LMS

Assessment Logout:

The following describe what happens if the user closes the Assessment window without logging out.
v If a user closes the browser without logging out, the unload event of the browser opens a dialog box to

execute the AICC log out routine, which then passes back data and finalize commands.
v If a user closes the browser without logging out, and the data and finalize command are yet to be sent

to the LMS, the server issues the finalize command when the session expires.

Exporting an AICC Package:

Use this procedure to export content to AICC.

Procedure

1. In the Export Generator category, select the AICC link to open the Publishing Wizard.
2. In the Content screen, select content for export by expanding the treeview, or select an object type

from the drop-down list and search by object Label.
3. Select Next.
4. In the Rules screen, select the object level at which content is launched and tracked from the

Assignable Unit (AU) drop-down list.
5. Select the viewer in which content is launched from the Viewer drop-down list. If you do not select

a viewer, the default viewer for Web set in the DELIVERY-RULES theme parameter group is used.
6. Select a theme from the Theme drop-down list to apply to the selected viewer. If you do not select a

theme, your default theme is used.

Note: Selection of a theme affects the look and behavior of the Classic-LO and Classic-CBT viewers.
For the Cobalt-Non-Linear and Accessibility viewers, selection of a theme affects only the icons and
labels that are used in the Message Box, Note, Tip, and Glossary elements. If you create a custom
viewer, the chosen theme has no effect on the look and feel unless the custom viewer is tied to any
theme parms.

7. If you are sending this package to a PENS server, select the PENS server from the Destination
drop-down list. See Adding a PENS Server for information on configuring PENS.

8. If you are exporting at the course level, the Portal Mode check box is enabled. Select this check box
if you would like to activate the AICC functions from prior versions of LCMS Premier. In Portal
Mode, launched content is accessed through the Table of Contents category in the Learning Portal,
with the ClassicLO Viewer.

236 IBM Kenexa® LCMS Premier Version 9.4: User's Guide August 2015



9. Select Next.
10. To run the export as soon as possible, select the Immediate radio button and proceed to Step 15. To

schedule the export for later, continue with Step 11.
11. Select the Scheduled radio button.
12. Select Start Date and select the date (from the calendar) on which you would like to start the export.
13. If you would like this export to recur regularly, select the Weekly, Daily, or Monthly radio button,

depending on your need. If you select the Monthly radio button, the End of Month check box
becomes enabled. Selecting this check box causes the export to run at the end of the month only.
Select End Date and select the date (from the calendar) on which you would like to end the export
recurrences.

14. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the export.
15. Select Next.
16. Select Finish.
17. The content that you are exporting appears in the queue with a Status of “requested.” To see the

most current version of the export status, close the dialog box and go to the Process Monitor
category. Refresh until the status is completed, then select the content link to download. If the status
is failed, select on the failed link to open the log file and troubleshoot the error.

Show AICC URL:

An alternative to exporting an AICC package is to select the export options and then select Show AICC
URL instead of Generate. The AICC URL displays in a new window. This URL can be embedded in an
LMS and used to launch the AICC content in LCMS Premier. This is helpful when an LMS does not
support AICC import.

One link is provided for each Assignable Unit so that each unit can be launched independently. If the
Assignable Unit is the same object level as the exported object, then only one link is generated. However,
if the Assignable Unit is at a lower object level than the exported object, one link for each Assignable
Unit is provided.

The following image shows the AICC URLs for a course level export with Assignable Units at the
learning object level.
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Export Assessments to Microsoft Word
You can use the Assessment export generator to export a selected Assessment Object and answer key to
Microsoft Word. Assessment Objects at all object levels can be generated.

Supported Assessment Elements:

The following elements are supported for Assessment export.
v TrueFalse
v Multiple Choice-Single Answer
v Multiple Choice-Multiple Answer
v Fill in the Blank
v Ordering
v Matching

Exported Assessment:

An Assessment Export package is a compressed file that contains any content images, along with the
following two Word files:
1. Assessment exam
2. Assessment answer key

The following image is an example of an Assessment that is exported with the default mapping file and
no template. The document contains the Assessment title, the titles of all Assessment Sections, the
question numbers, question text, and any applicable answer choices.

Figure 47. AICC URLs for a Course Level Exports
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The following image displays the answer key for the exported assessment. For this export, the Answer
and complete question radio button was selected to provide the most detail.

Exporting an Assessment to Print:

Use this procedure to export an Assessment to MS Word.

Figure 48. Sample Assessment Exported With Default Mapping and No o Template

Figure 49. Answer Key for Exported Assessment
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Procedure

1. In the Export Generator category, select the Assessment link to open the Publishing Wizard.
2. In the Content screen, select content for export by expanding the treeview, or select an object type

from the drop-down list and search by object Label.
3. Select Next.
4. Select a theme from the Theme drop-down list to apply to the export. If you do not select a theme,

your default theme is used.
5. Enter the path to the template file that you would like to apply to the Word document in the

Template File field, or browse for the template file by clicking Browse. If you do not have a
template file, select the Download button to the right of the Browse button and save the default
template file to your local machine.

6. Select a filter or personalization profile from the Rule drop-down list to export content that meets
specific criteria.

7. Select one of the Exam Key Options radio buttons, basing your selection on the amount of detail
you would like in the document.

8. Select a mapping file from the Mapping File drop-down list.
9. Select a Substitution Profile if your content contains substitution variables.

10. Select Next.
11. To run the export as soon as possible, select the Immediate radio button and proceed to Step 16. To

schedule the export for later, continue with Step 12.
12. Select the Scheduled radio button.
13. Select Start Date and select the date (from the calendar) on which you would like to start the export.
14. If you would like this export to recur on a regular basis, select the Weekly, Daily, or Monthly radio

button, depending on your need. If you select the Monthly radio button, the End of Month check
box becomes enabled. Selecting this check box will cause the export to run at the end of the month
only. Select End Date and select the date (from the calendar) on which you would like to end the
export recurrences.

15. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the import.
16. Select Next.
17. Select Finish.
18. The content you are exporting will now appear in the queue with a Status of requested. To see the

most current version of the export status, close the dialog box and go to the Process Monitor
category. Refresh until the status is completed, then select the content link to download. If the status
is failed, select on the failed link to open the log file and troubleshoot the error.

Export Content as Compiled Help
The Compiled Help export generator renders LCMS Premier content in a help format (.chm file),
complete with a table of contents and index. Content for export is selected from the Output Generator
Wizard, and can be generated at the following levels:
v Course
v Module
v Learning object
v Topic
v Group

Note: The Compiled Help generator appears in the Export Generator category by default ONLY if the
Microsoft HTML Help Workshop is installed on the Application Server before the LCMS Premier service
is created. This is explained in detail in a later topic.
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Elements are only generated to compiled help if they are selected by the developer for CHM output. This
selection is made in the General view for all elements.

Note: The Compiled Help export generator supports all objects and elements except for Assessment
Objects and Survey Objects.

CHM Export Scenarios:

The creation of a .chm file requires the use of the Microsoft HTML Workshop. The way content is
exported to the help format depends on how you configure this workshop.

Microsoft HTML Workshop is available at http://msdn2.microsoft.com/en-us/library/ms669985.aspx.
There are three possible scenarios:
1. You install the HTML Help Workshop on the application server before you install the LCMS Premier

service. In this way, the workshop is integrated with the server, the Compiled Help link appears by
default in the Export Generator category, and the help files are compiled during the export. The
resulting export is a compressed file that contains a .chm file.

2. You install the HTML Help Workshop on the application server after you install the LCMS Premier
service. This requires that you configure the following:
v You must direct the Compiled Help generator to the hhc.exe file, which launches the HTML Help

Workshop to compile the help files. This is done by setting the CHM_EXE property in the
lcms.properties file on the application server. For example, if you install the HTML Workshop at
the default location, you would set this property to "CHM_EXE=C:\\Program Files\\HTML Help
Workshop\\hhc.exe".

v You must set the Enable CHM Generator parm in the Site Configuration category to true in order
for the Compiled Help link to appear in the Export Generator category.

3. You install the HTML Help Workshop on your local machine. In this case, you must do the following:
v Set the Enable CHM Generator parm in the Site Configuration category to true in order for the

Compiled Help link to appear in the Export Generator category.
v After export, your resulting compressed file does not contain a .chm file because the HTML Help

Workshop is not installed on the application server. Instead, the compressed file contains multiple
files. You have to extract these files and run them through the HTML Help Workshop to compile
the .chm file.

Note: If you are running a non-Windows server, then you must use the third scenario.

Compiled Help Components:

A CHM export contains the following three components.
v Table of Contents
v Index
v Search

Table of Contents:

The first tab in the compiled help interface is the Contents tab. This tab is modeled after the hierarchy of
the content you export.

The content in the following image was exported at the course level; therefore, the table of contents
contains folders from the module level to the topic level. The right pane contains the element content
from each topic.
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Index:

The second tab in the compiled help interface is the Index tab. You can use this to access content based
on keywords.

The keywords in the index are taken from search keys that are entered on the topic, group, and element
level General views in the Content Manager. When you select a keyword and select Display, a dialog box
appears, listing all of the topics, groups, and elements that contain that search key. When you select
content from the list and select Display in the dialog box, the topic, group, or element displays.

Tip: Because content in compiled help displays at the topic level, it is recommended to enter search keys
for online help only at the topic level.

Search:

The third tab in the compiled help interface is the Search tab. You can use this tab to find all topics that
contain a specific text string. When you launch one of those topics, all instances of the text string in the
topic is highlighted.

Home Help Graphic:

In the previous images of the help system, the IBM logo is used as the default home graphic when the
help is launched. You can replace the image by going to your site's viewer template folder for CHM.

Example: \appweb\evsfiles\templates\viewers\chm\default\images\

Replace the existing image with one of that has the same file name.

Exporting Compiled Help:

Use this procedure to export content to compiled help.

Procedure

1. In the Export Generator category, select the Compiled Help link to open the Publishing Wizard.
2. In the Content screen, select content for export by expanding the treeview, or select an object type

from the drop-down list and search by object Label.
3. Select Next.
4. Select the viewer in which content is launched from the Viewer drop-down list. If you do not select

a viewer, the default viewer for CHM set in the DELIVERY-RULES theme parameter group is used.
5. Select a theme from the Theme drop-down list to apply to the selected viewer. If you do not select a

theme, your default theme is used.

Note: For the CHM viewer, selection of a theme affects only the icons and labels that are used in
the Message Box, Note, Tip, and Glossary elements. If you create a custom viewer, the chosen theme
has no effect on the look and feel unless the custom viewer is tied to any theme parms.

6. Select the Cache Export check box if you would like to save the final export package on the server
for future linking from content.

7. Select a filter or personalization profile from the Rule drop-down list to export content that meets
specific criteria.

8. Select a Substitution Profile if your content contains substitution variables.
9. Select Next.

10. To run the export as soon as possible, select the Immediate radio button and proceed to Step 15. To
schedule the export for later, continue with Step 11.
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11. Select the Scheduled radio button.
12. Select Start Date and select the date (from the calendar) on which you would like to start the export.
13. If you would like this export to recur regularly, select the Weekly, Daily, or Monthly radio button,

depending on your need. If you select the Monthly radio button, the End of Month check box
becomes enabled. Selecting this check box causes the export to run at the end of the month only.
Select End Date and select the date (from the calendar) on which you would like to end the export
recurrences.

14. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the export.
15. Select Next.
16. Select Finish.
17. The content that you are exporting appears in the queue with a Status of requested. To see the most

current version of the export status, close the dialog box and go to the Process Monitor category.
Refresh until the status is completed, then select the content link to download. If the status is failed,
select on the failed link to open the log file and troubleshoot the error.

Note: If your compressed file contains more than a single .chm file, then you have to manually run
the collection of files through the Microsoft HTML Help Workshop to produce the .chm file.

Export Content as Content XML
LCMS Premier users can export content in a Content XML format. This XML format differs from the XML
contained in LCMS data movement exports in that it is a representation of the actual content, rather than
an expression of database objects.

After exported, the XML can be modified according to a provided XSD schema. This enables users to
develop content offline in a basic text editor and then later import the content back into LCMS Premier.

Note: All elements are supported for Content XML export.

Export Contents:

A content XML export contains the following components.
v Media - Any images, video, or audio within the content.
v Metadata - Because Content XML was created as a standardized content model, the IEEE LOM

metadata model (SCORM 2004) is used. One XML metadata file is exported for every object or element,
even if these metadata groups and tags do not exist in LCMS Premier.

v Evsmanifest.xml - This is the actual XML content. References are made to the media and metadata that
is contained in the export package.

Exporting Content XML:

Perform the following steps to export content to content XML.
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Procedure

1. In the Export Generator category, select the Content XML link to open the Publishing Wizard.
2. In the Content screen, select content for export by expanding the treeview, or select an object type

from the drop-down list and search by object Label.
3. Select Next. Because there are no rules for Content XML, select Next again.
4. To run the export as soon as possible, select the Immediate radio button and proceed to Step 9. To

schedule the export for later, continue with Step 5.
5. Select the Scheduled radio button.
6. Select Start Date and select the date (from the calendar) on which you would like to start the export.
7. If you would like this export to recur regularly, select the Weekly, Daily, or Monthly radio button,

depending on your need. If you select the Monthly radio button, the End of Month check box
becomes enabled. Selecting this check box causes the export to run at the end of the month only.
Select End Date and select the date (from the calendar) on which you would like to end the export
recurrences.

8. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the export.
9. Select Next.

10. Select Finish.
11. The content that you are exporting appears in the queue with a Status of “requested.” To see the

most current version of the export status, close the dialog box and go to the Process Monitor
category. Refresh until the status is completed, then select the content link to download. If the status
is failed, select on the failed link to open the log file and troubleshoot the error.

Export Content to Mobile Delivery
The Mobile Server export generator provides the capability to export content in a mobile delivery format
to IBM Kenexa Hot Lava. Content can be displayed on any mobile device, and no changes to content are
necessary; Hot Lava adjusts content as needed based on the type of mobile device.

Mobile server export is available through the Export Generator category.

Note: You must have a license for Hot Lava to use this feature.

Elements are only generated for Mobile output if they are selected by the developer for Mobile output.
This selection is made in the General view for all elements.

Supported Elements:

The following elements are supported for Mobile server export. If there are any unsupported elements in
the object that is selected for export, the export fails.
v Description
v Table
v Columns
v Summary
v Syntax
v Glossary
v Bibliography
v Quote
v Note
v List
v HTML
v Message Box
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v Media
v Tip
v Parameter
v Animation
v TrueFalse
v Multiple Choice-Multiple Answer
v Multiple Choice-Single Answer
v Fill in the Blank
v Matching
v Ordering
v Freeform

Site Parms:

To properly publish mobile content to Hot Lava, the Hot Lava account information needs to be entered.
The following Site parms exist for this purpose:
v Hot Lava Mobile URL - The URL should be without "login.html", for example, http://

epdg.domain.com/companyname
v Hot Lava Username
v Hot Lava Password

Exporting to Hot Lava:

Perform the following steps to export content to Hot Lava mobile.

Procedure

1. In the Export Generator category, select the Mobile server link to open the Publishing Wizard.
2. In the Content screen, select content for export by expanding the treeview, or select an object type

from the drop-down list and search by object Label.
3. Select Next.
4. Select a filter or personalization profile from the Rule drop-down list to export content that meets

specific criteria.
5. Select a Substitution Profile if your content contains substitution variables.
6. Select Next.
7. To run the export as soon as possible, select the Immediate check box and proceed to Step 13. To

schedule the export for later, continue with Step 8.
8. Clear the Immediate check box and select Schedule. The Scheduling dialog box appears.
9. Select Start Date and select the date (from the calendar) on which you would like to start the export.

10. If you would like this export to recur regularly, select the Weekly, Daily, or Monthly radio button,
depending on your need. If you select the Monthly radio button, the End of Month check box
becomes enabled. Selecting this check box causes the export to run at the end of the month only.
Select End Date and select the date (from the calendar) on which you would like to end the export
recurrences.

11. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the export.
12. Select Next.
13. Select Finish.
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14. The content that you are exporting appears in the queue with a Status of requested. To see the most
current version of the export status, close the dialog box and go to the Process Monitor category.
Refresh until the status is completed. If the status is failed, select on the failed link to open the log
file and troubleshoot the error.

Export Content to PDF
The PDF generator exports course content directly to PDF format. The PDF export generator is available
at the following levels:
v Course
v Module
v Learning Object
v Topic
v Group

Elements are only generated for PDF output if they are selected by the developer for Print output. This
selection is made in the General view for all elements.

Exporting to PDF:

Use this procedure to export content to PDF.

Procedure

1. In the Export Generator category, select the PDF link to open the Publishing Wizard.
2. In the Content screen, select content for export by expanding the treeview, or select an object type

from the drop-down list and search by object Label.
3. Select Next.
4. Select a template to apply to the exported document from the Template Collection drop-down list.
5. Select a filter or personalization profile from the Rule drop-down list to export content that meets

specific criteria.
6. Select a Substitution Profile if your content contains substitution variables.
7. Select Next.
8. To run the export as soon as possible, select the Immediate radio button and proceed to Step 13. To

schedule the export for later, continue with Step 9.
9. Select the Scheduled radio button.

10. Select Start Date and select the date (from the calendar) on which you would like to start the export.
11. If you would like this export to recur regularly, select the Weekly, Daily, or Monthly radio button,

depending on your need. If you select the Monthly radio button, the End of Month check box
becomes enabled. Selecting this check box causes the export to run at the end of the month only.
Select End Date and select the date (from the calendar) on which you would like to end the export
recurrences.

12. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the export.
13. Select Next.
14. Select Finish.
15. The content that you are exporting appears in the queue with a Status of “requested.” To see the

most current version of the export status, close the dialog box and go to the Process Monitor
category. Refresh until the status is completed, then select the content link to download. If the status
is failed, select on the failed link to open the log file and troubleshoot the error.
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Exporting Content to Microsoft PowerPoint
The Microsoft PowerPoint export feature provides the capability to quickly and easily convert LCMS
Premier content to a PowerPoint presentation. PowerPoint export takes place in the Export Generators
category through the Learning Portal and is supported at the course, module, learning object, topic, and
group levels.

Note: In the Content Manager, the Slide output type must be selected in the General view of each
element to be exported as content for PowerPoint slides. The Presentation Notes output type must be
selected for elements to be exported as slide notes.

PowerPoint Export Rendering:

Depending on your selection in the Output Generator Wizard, each slide will contain either one element,
or all of the elements within an entire group.

The following image shows the resulting export of a Description element. The export was configured to
contain one element per slide.

Element Types Supported:

The following element types are supported for PowerPoint export.
v Aggregate
v Animation
v Bibliography
v Columns
v Description
v Fill in the Blank
v FreeForm
v Glossary
v Likert
v List
v Matching
v Media
v Message Box
v Multiple Choice - Multiple Answer
v Multiple Choice - Single Answer
v Note
v Ordering
v Quote

Figure 50. Description Element Export
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v Reference
v Slideshow
v Summary
v Table
v Tip
v TrueFalse

Elements are only generated for PPT output if they are selected by the developer for Slides output. This
selection is made in the General view for all elements.

Note: When you export the Reference element, links to the following types are not supported:
v Assessment Objects
v Reference Objects
v Survey Objects

Mapping File:

A mapping file, ppt_mapping.xml, can be downloaded from the Output Generator Wizard. The mapping
file contains properties that can be modified to change the way PPT content is exported. After you
rename the modified mapping file and select it during export, that file is uploaded and stored so that you
can select it from the drop-down list in the future.

PPT export shares many export mapping properties with Word export, but some properties are exclusive
to PPT export, which is shown in the following image.

The PowerPoint export generator supports animations for the following elements:
v Animation
v List
v Summary
v Aggregate

The mapping.xsl file contains a mapping section for animations. These properties allow the developer to
map the element transitions to PowerPoint transitions. By default, the animations in LCMS Premier map
to the closest PowerPoint equivalent.

Table 30. PowerPoint Export Mapping Properties. The following table describes the mapping property exclusive to
PPT export.

Mapping Property Description Possible Values

Figure 51. Export Mapping Properties
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Table 30. PowerPoint Export Mapping Properties (continued). The following table describes the mapping property
exclusive to PPT export.

<MasterTextBoxPos> Determines the position of elements without
a title

v Fixed - When an element has no
title, the element is placed on the
slide according to the master slide
layout.

v No value (empty tag) - When an
element has no title, the element is
pushed to the top of the slide.

<labelfontsize> Controls the font size of element's icon label Any number greater than zero

For details of all of the other export mapping properties, see the document “Exporting Content to MS
Word”.

Exporting an Object as a PowerPoint Presentation:

Perform the following steps to export content to MS PowerPoint.

Procedure

1. In the Export Generator category, select the PowerPoint link to open the Publishing Wizard.
2. In the Content screen, select content for export by expanding the treeview, or select an object type

from the drop-down list and search by object Label.
3. Select Next.
4. Select the Include Notes check box to include elements that are designated as slide notes.

Note: The Presentation Notes output type must be selected in the General view of the elements you
want to export as notes.

5. Select a theme from the Theme drop-down list to apply to the export. If you do not select a theme,
your default theme is used.

6. Select a template file from the Template File (.pot) drop-down list.
7. To narrow the content that is generated, select a filter or personalization profile from the Rule

drop-down list.

Note: The Rule drop-down list contains filters that are created in the Content Manager.
Personalization profiles are created in the Personalization Profile Manager category in the Learning
Portal.

8. Choose, as follows:
v Select the Group radio button if you want all content within each group to appear on a single

slide.
v Select the Element radio button if you would like only one element to appear on each slide.

9. Select a mapping file from the Mapping File drop-down list.
10. Select a Substitution Profile if your content contains substitution variables.
11. Select Next.
12. To run the export as soon as possible, select the Immediate radio button and proceed to Step 17. To

schedule the export for later, continue with Step 13.
13. Select the Scheduled radio button.
14. Select Start Date and select the date (from the calendar) on which you would like to start the export.
15. If you would like this export to recur regularly, select the Weekly, Daily, or Monthly radio button,

depending on your need. If you select the Monthly radio button, the End of Month check box
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becomes enabled. Selecting this check box causes the export to run at the end of the month only.
Select End Date and select the date (from the calendar) on which you would like to end the export
recurrences.

16. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the import.
17. Select Next.
18. Select Finish.
19. The content that you are exporting appears in the queue with a Status of “requested.” To see the

most current version of the export status, close the dialog box and go to the Task Monitor category.
Select the refresh every check box and select a time frame from the seconds drop-down list. When
the status changes to “running”, your content is exporting. When the status changes to “completed,”
continue with Step 20.

20. Select the link for your content. The File Download dialog box appears.
21. Save the file to your local machine.
22. Extract the file to access the files it contains.

Export Content as a Slide Presentation
The Presentation generator renders in a slideshow format, which you can use to generate and save
presentations of LCMS Premier content. Presentations can be generated at the course, module, and
learning object levels.

The following figure depicts the outcome of content that was exported to generate a slide presentation.

Elements are only generated for Presentation output if they are selected by the developer for Slides
output. This selection is made in the General view for all elements.

Note: The Presentation generator supports all LCMS Premier content except for Survey Objects and
Survey elements.

Exporting Content as a Slide Presentation:

Perform the following steps to export content as a slide presentation.

Procedure

1. In the Export Generator category, select the Presentation link to open the Publishing Wizard.
2. In the Content screen, select content for export by expanding the treeview, or select an object type

from the drop-down list and search by object Label.
3. Select Next.

Figure 52. Exporting Content as a Slide Presentation
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4. Select the viewer in which content is launched from the Viewer drop-down list. If you do not choose
a viewer, the default viewer for Presentation set in the DELIVERY-RULES theme parameter group is
used.

5. Select a theme from the Theme drop-down list to apply to the selected viewer.

Note: Themes apply only to the Classic Presentation viewer. If you create a custom viewer, the
chosen theme has no effect on the look and feel unless the custom viewer is tied to any theme
parms.

6. Select the Cache Export check box if you would like to save the final export package on the server
for future linking from content.

7. Select the Include SCORM Adapter for Reference Objects check box if you have Sharable Content
Objects (SCOs) in your content.

8. Select a filter or personalization profile from the Rule drop-down list to export content that meets
specific criteria.

9. Select a Substitution Profile if your content contains substitution variables.
10. Select Next.
11. To run the export as soon as possible, select the Immediate radio button and proceed to Step 16. To

schedule the export for later, continue with Step 12.
12. Select the Scheduled radio button
13. Select Start Date and select the date (from the calendar) on which you would like to start the export.
14. If you would like this export to recur regularly, select the Weekly, Daily, or Monthly radio button,

depending on your need. If you select the Monthly radio button, the End of Month check box
becomes enabled. Selecting this check box causes the export to run at the end of the month only.
Select End Date and select the date (from the calendar) on which you would like to end the export
recurrences.

15. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the export.
16. Select Next.
17. Select Finish.
18. The content that you are exporting appears in the queue with a Status of requested. To see the most

current version of the export status, close the dialog box and go to the Process Monitor category.
Refresh until the status is completed, then select the content link to download. If the status is failed,
select the failed link to open the log file and troubleshoot the error.

Export Content to Adobe FrameMaker
The Print generator renders LCMS Premier content in an Adobe FrameMaker file. By combining multiple
print exports, you can assemble an Adobe FrameMaker book, complete with a table of contents and
index.

Print exports can be generated at the following levels:
v Course
v Module
v Learning object
v Topic
v Group

Tip: For best results when you are assembling a FrameMaker book, it is recommended that print exports
be generated at the module level. The modules can then be assembled as chapters in the FrameMaker
book. The default template is designed to export at the module level.
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The following figure depicts the outcome of content that was exported to an Adobe FrameMaker print
document.

Supported Element Types:

The following element types are supported for Print export.
v Description
v Note
v List
v Summary
v Table
v Syntax
v Glossary
v Media (Image)
v Aggregate
v Message Box
v Tip
v Bibliography
v Reference
v Column
v Quote
v Parameter
v Slideshow
v TrueFalse
v Multiple Choice-Multiple Answer
v Multiple Choice-Single Answer
v Fill in the Blank
v Matching
v Ordering

Elements are only generated for Print output if they are selected by the developer for Print output. This
selection is made in the General view for all elements.

Figure 53. Export to Adobe FrameMaker

252 IBM Kenexa® LCMS Premier Version 9.4: User's Guide August 2015



Note: The Print generator does not support tables that are embedded within tables. Therefore, you
cannot embed a table in any element that renders as a table in FrameMaker, such as the Table, Note, Tip,
Glossary, and Columns element. For every search key entered in the content, an index marker is placed
with that content in the exported document. You can manually generate an index from these markers.

Exporting a FrameMaker Print Document:

Perform the following steps to export content to Adobe FrameMaker.

Procedure

1. In the Export Generator category, select the Print link to open the Publishing Wizard.
2. In the Content screen, select content for export by expanding the treeview, or select an object type

from the drop-down list and search by object Label.
3. Select Next.
4. Select a template to apply to the exported document from the Template Collection drop-down list.
5. Select a filter or personalization profile from the Rule drop-down list to export content that meets

specific criteria.
6. Select a Substitution Profile if your content contains substitution variables.
7. Select Next.
8. To run the export as soon as possible, select the Immediate radio button and proceed to Step 13. To

schedule the export for later, continue with Step 9.
9. Select the Scheduled radio button.

10. Select Start Date and select the date (from the calendar) on which you would like to start the export.
11. If you would like this export to recur regularly, select the Weekly, Daily, or Monthly radio button,

depending on your need. If you select the Monthly radio button, the End of Month check box
becomes enabled. Selecting this check box causes the export to run at the end of the month only.
Select End Date and select the date (from the calendar) on which you would like to end the export
recurrences.

12. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the export.
13. Select Next.
14. Select Finish.
15. The content that you are exporting appears in the queue with a Status of “requested.” To see the

most current version of the export status, close the dialog box and go to the Process Monitor
category. Refresh until the status is completed, then select the content link to download. If the status
is failed, select on the failed link to open the log file and troubleshoot the error.

Tip: All HTML must be valid in order for content to successfully export to print. If the Task Monitor
displays a "failed" status for the print export, the content that is selected might contain invalid
HTML. If the log file verifies this, validate the HTML in the content before you do another export.
For best practices on exporting to FrameMaker see the document “Print Export Generator: Best
Practices”. For instructions on creating custom templates, see the technical document “Print
Generator Modification - Configuring and Adding Templates”.

Exporting Content in SCORM 1.2 or SCORM 2004 Format
The SCORM (Sharable Content Object Reference Model) export generators render LCMS Premier content
in a universal format that can be launched and reused by any LMS that complies with the appropriate
SCORM standard.

Content for export is selected from the Output Generator Wizard, and can be generated at the following
levels:
v Course
v Module
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v Learning Object
v Topic
v Group

The following image provides an overview of the process through which content moves during an export
to SCORM 1.2 format.

Elements are only generated for SCORM output if they are selected by the course developer for CD
output. This selection is made in the General view for all elements.

SCO Levels:

During a SCORM export, you can specify the object level at which the SCOs are generated by selecting
learning object, topic, or group from the Export Level Options drop-down list.

The objects that can become SCOs depend on the object that is selected for export. For example, if a topic
is selected for export, then only topics or groups can be chosen as the SCO.

The following are objects that can be chosen for export and their available SCO levels:
v Course (SCO = Module, Learning Object, Topic, or Group)
v Module (SCO = Module, Learning Object, Topic, or Group)
v Learning Object (SCO = Learning Object, Topic, or Group)
v Topic (SCO = Topic or Group)
v Group (SCO = Group)

For information on SCORM data tracking, the behavior of LCMS Premier content, key differences
between SCORM 1.2 and 2004, and best practices, see the technical document Using SCORM with
LCMS Premier.

Exporting a SCORM 1.2 or 2004 Package:

Perform the following steps to export content to SCORM 1.2 or 2004.

Procedure

1. In the Export Generator category, select the SCORM 1.2 or SCORM 2004 link to launch the
Publishing Wizard.

Figure 54. Content to SCROM 1.2 Export PRocess
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2. In the Content screen, select content for export by expanding the treeview, or select an object type
from the drop-down list and search by object Label.

3. Select Next.
4. Select the viewer in which content is launched from the Viewer drop-down list. If you do not select

a viewer, the default viewer for CD set in the DELIVERY-RULES theme parameter group is used.
5. Select a theme from the Theme drop-down list to apply to the selected viewer. If you do not select a

theme, your default theme is used.

Note: Selection of a theme affects the look and behavior of the Classic-LO and Classic-CBT viewers.
For the Cobalt-Non-Linear and Accessibility viewers, selection of a theme affects only the icons and
labels that are used in the Message Box, Note, Tip, and Glossary elements. If you create a custom
viewer, the chosen theme has no effect on the look and feel unless the custom viewer is tied to any
theme parms.

6. If you are sending this package to a PENS server, select the PENS server from the Destination
drop-down list. See Adding a PENS Server for information on configuring PENS.

7. Select the Cache Export check box if you would like to save the final export package on the server
for future linking from content.

8. Select a filter or personalization profile from the Rule drop-down list to export content that meets
specific criteria.

9. If the exported SCORM package is delivered through a server separate from the LMS, enter the
domain name for the server holding the SCORM content in the Javascript Domain field, for example,
"design.domain.com".

10. Select the LCMS object type that you would like to package as SCOs in this export from the Export
Level Options drop-down list.

11. If you are exporting to SCORM 2004, select the SCORM edition to would like from the Edition
drop-down list.

12. Select a Substitution Profile if your content contains substitution variables.
13. Select Next.
14. To run the export as soon as possible, select the Immediate radio button and proceed to Step 19. To

schedule the export for later, continue with Step 15.
15. Select the Schedule radio button.
16. Select Start Date and select the date (from the calendar) on which you would like to start the export.
17. If you would like this export to recur regularly, select the Weekly, Daily, or Monthly radio button,

depending on your need. If you select the Monthly radio button, the End of Month check box
becomes enabled. Selecting this check box causes the export to run at the end of the month only.
Select End Date and select the date (from the calendar) on which you would like to end the export
recurrences.

18. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the export.
19. Select Next.
20. Select Finish.
21. The content that you are exporting appears in the queue with a Status of requested. To see the most

current version of the export status, close the dialog box and go to the Process Monitor category.
Refresh until the status is completed, then select the content link to download. If the status is failed,
select on the failed link to open the log file and troubleshoot the error.

Export Content as Static HTML
The Static HTML generator produces an offline, HTML version of content. When you launch static HTML
content from your local machine, the content appears exactly as it does through the Learning Portal.

Static HTML can be generated at the course, module, and learning object levels.
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The following figure depicts the outcome of content that is exported to generate Static HTML.

Note: The Static HTML generator supports all LCMS Premier content except for Survey Objects and
Survey elements. Assessment results are generated, but are only available for offline use.

Exporting Static HTML:

Perform the following steps to export content to Static HTML.

Procedure

1. In the Export Generator category, select the Static HTML link to open the Publishing Wizard.
2. In the Content screen, select content for export by expanding the treeview, or select an object type

from the drop-down list and search by object Label.
3. Select Next.
4. Select the viewer in which content is launched from the Viewer drop-down list. If you do not select

a viewer, the default viewer for CD set in the DELIVERY-RULES theme parameter group is used.
5. Select a theme from the Theme drop-down list to apply to the selected viewer. If you do not select a

theme, your default theme is used.

Note: Selection of a theme affects the look and behavior of the Classic-LO and Classic-CBT viewers.
For the Cobalt-Non-Linear and Accessibility viewers, selection of a theme affects only the icons and
labels that are used in the Message Box, Note, Tip, and Glossary elements. If you create a custom
viewer, the chosen theme has no effect on the look and feel unless the custom viewer is tied to any
theme parms.

6. Select the Cache Export check box if you would like to save the final export package on the server
for future linking from content.

7. Select the Include SCORM Adapter for Reference Objects check box if you have Sharable Content
Objects (SCOs) in your content.

8. Select a filter or personalization profile from the Rule drop-down list to export content that meets
specific criteria.

9. Select a Substitution Profile if your content contains substitution variables.
10. Select Next.
11. To run the export as soon as possible, select the Immediate radio button and proceed to Step 16. To

schedule the export for later, continue with Step 12.
12. Select the Scheduled radio button.
13. Select Start Date and select the date (from the calendar) on which you would like to start the export.
14. If you would like this export to recur regularly, select the Weekly, Daily, or Monthly radio button,

depending on your need. If you select the Monthly radio button, the End of Month check box
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becomes enabled. Selecting this check box causes the export to run at the end of the month only.
Select End Date and select the date (from the calendar) on which you would like to end the export
recurrences.

15. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the export.
16. Select Next.
17. Select Finish.
18. The content that you are exporting appears in the queue with a Status of “requested.” To see the

most current version of the export status, close the dialog box and go to the Process Monitor
category. Refresh until the status is completed, then select the content link to download. If the status
is failed, select on the failed link to open the log file and troubleshoot the error.

Export Content to Microsoft Word
You can use the Microsoft Word export feature to quickly and easily convert LCMS Premier content to a
Word document. Word export takes place in the Export Generator category through the Learning Portal
and is supported at the course, module, learning object, topic, and group levels.

Note: In the Content Manager, the Print output type must be selected in the General view of each
element that is to be exported to a Word document.

Word Export Rendering:

When LCMS Premier content is exported to a Word document, content is rendered in Word according to
settings in a configurable XML file that maps object titles and text to styles in a Word template. Multiple
mapping files and Word templates can be added to the export generator for selection at the time of
export.

The following image depicts the resulting output of a topic that was exported to Word.
v The Topic title renders as a Heading 2 Style.
v The Group title renders as a Heading 3 Style.
v The Element titles render as a Heading 4 Style.
v The element text renders as Normal Style.

Element Types Supported:

The following element types are supported for Word export.
v Aggregate
v Animation (Static graphic of completed animation)
v Bibliography

Figure 55. Topic Exported to Microsoft Word
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v Columns
v Description
v Fill in the Blank
v FreeForm
v Glossary
v Likert
v List
v Matching
v Media (images only)
v Message Box
v Multiple Choice - Multiple Answer
v Multiple Choice - Single Answer
v Note
v Ordering
v Quote
v Reference
v Slideshow
v Summary
v Table
v Tip
v TrueFalse

Note: When you export the Reference element, links to the following types are not supported:
v Assessment Objects
v Reference Objects
v Survey Objects

Elements are only generated for Word output if they are selected by the developer for Print output. This
selection is made in the General view for all elements.

Exporting an Object as a Word Document:

Perform the following steps to export content to MS Word.

Procedure

1. In the Export Generator category, select the Word link to open the Publishing Wizard.
2. In the Content screen, select content for export by expanding the treeview, or select an object type

from the drop-down list and search by object Label.
3. Select Next.
4. Select a theme from the Theme drop-down list to apply to the export. If you do not select a theme,

your default theme is used.
5. Select a template file from the Template File (.dot) drop-down list.
6. To narrow the content that is generated, select a filter or personalization profile from the Rule

drop-down list.

Note: The Rule drop-down list contains filters that are created in the Content Manager.
Personalization profiles are created in the Personalization Profile Manager category in the Learning
Portal.

7. Select a mapping file from the Mapping File drop-down list.
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8. Select a Substitution Profile if your content contains substitution variables.
9. Select Next.

10. To run the export as soon as possible, select the Immediate radio button and proceed to Step 15. To
schedule the export for later, continue with Step 11.

11. Select the Scheduled radio button.
12. Select Start Date and select the date (from the calendar) on which you would like to start the export.
13. If you would like this export to recur regularly, select the Weekly, Daily, or Monthly radio button,

depending on your need. If you select the Monthly radio button, the End of Month check box
becomes enabled. Selecting this check box will cause the export to run at the end of the month only.
Select End Date and select the date (from the calendar) on which you would like to end the export
recurrences.

14. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the import.
15. Select Next.
16. Select Finish.
17. The content that you are exporting appears in the queue with a Status of “requested.” To see the

most current version of the export status, close the dialog box and go to the Task Monitor category.
Select the refresh every check box and select a time frame from the seconds drop-down list. When
the status changes to running, your content is exporting. When the status changes to “completed,”
continue with Step 18.

18. Select on the link for your content. The File Download dialog box appears.
19. Save the compressed file to your local machine.
20. Extract the file to access the files it contains.

For more details and best practices on exporting to Word, see the technical document “Exporting
Content to MS Word”.

Add a PENS Server
LCMS Premier supports Package Exchange Notification Services (PENS).

Users can export LCMS Premier content to a PENS server in a SCORM or AICC package, or receive
SCORM and AICC content from a PENS server. Upon export from the source server, the package is
placed at an intermediate location through HTTP or FTP, then downloaded by the recipient to the
destination server.

When you export content to SCORM 1.2, SCORM 2004, or AICC, the destination server is selected in the
Publishing Wizard.

For a destination server to appear in the Destination drop-down list, the server details must be entered
in a configuration file. This file, publish.xml, is located in the installation directory on the application
server at appweb\evsfiles\properties.

Figure 56. publish.xml Configuration File
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To configure a new destination instance, copy and paste the contents of an existing destination
(everything inside of, and including, the “destination” tags) and then enter the new server information.
The XML tags are used as follows:
v ID: The unique ID of this destination instance. This ID is used to distinguish the destination between

different instances in the configuration file.
v LABEL: The label of the destination server that appears in the Destination drop-down list in the

Output Generator Wizard.
v URL: The URL of the destination server, which is used by the source server to submit PENS commands

to the destination servers.
v STANDARD: The communication standard to use for content exchange. This should be set to pens

since only the PENS standard is supported.
v TRANSPORT_LOCATION: A URL that points to the repository location on the source server where the

content package is published. The source server must be configured in such a way that the destination
servers can access to this location to retrieve the content package during the PENS process.

v TRANSPORT_USERID: The user ID that can be used to access the TRANSPORT_LOCATION on the
source server. If not specified, the destination servers retrieve the content package by using an
anonymous user ID. This field is optional and can be left blank.

v TRANSPORT_ACCOUNT: The account that can be used to access the TRANSPORT_LOCATION on the
source server. If not specified, the destination servers retrieve the content package by using an
anonymous account. This field is optional and can be left blank.

v TRANSPORT_PASSWORD: The user password that can be used (together with the
TRANSPORT_USERID) to access the TRANSPORT_LOCATION on the source server. This field is
optional and can be left blank.

v SYSTEM_USERID: The user ID that can be used to communicate with the source servers. This is
required if the source server requires authentication for PENS communication. This field is optional
and can be left blank.

v SYSTEM_PASSWORD: The user password that can be used (together with the SYSTEM_USERID) to
communicate with the source servers. This is required if the source server requires authentication for
PENS communication. This field is optional and can be left blank.

Note: When LCMS Premier is the destination server for a PENS package, the import is seamless and
displays in the Process Monitor.

Note: The theme parameter PENS Authentication Flag in the PORTAL-RULES parm category controls
whether authentication is required for PENS requests. Possible values are as follows:
v 0 - Authentication is not required (default)
v 1 - Authentication is required

Learning Portal: Data Movement

Process Monitor Category
When you view the Process Monitor category, you are able to see data movement in to and out of the
LCMS Premier Repository. You can download content files, view log files, and delete processes and data.

Note: The number of processes you are able to view in the Process Monitor depends on the actions that
are assigned to your role in the Role Administration category. The following actions are available:
v View All Processes
v View Personal Processes
v View Processes for Same Role
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Tip: Processes in the Process Monitor can be sorted by clicking the column headers that appear as
hyperlinks. You can sort by:
v Status
v User
v Priority
v Schedule

Process Status
You can use the Process Monitor category to view the progress of data movement and other processes.
The Status column of the Process Monitor displays one of four statuses for each process:
1. Requested - The process is in the queue and waiting for the completion of processes that are

requested before it, or for the scheduled time for the process to occur.
2. Started - The process is being prepared for execution.
3. Running - The process is now running.
4. Completed - The process is finished running and the file is ready for download.
5. Failed - The process was unable to complete successfully.

Downloading a File from the Process Monitor
Perform the following steps to download a file from the Process Monitor.

Procedure
1. In the Process Monitor category, select on the hyperlink in the Object column that is associated with

the file you want to download.
2. When the File Download dialog box appears, select Save.
3. After the Save As window appears, choose a folder location for the file, enter a filename for the

compressed file, and select Save.

Log File
The log file can be viewed upon selection of the link in the Status field of the Process Monitor. This file
displays a log of the data movement. If the concept failed, the log file can provide a useful indicator to
why it happened.

Delete Processes
All processes remain on the Process Monitor until they are selected for deletion. Selecting the check box
for each process marks it for deletion when the Delete button is selected. When you delete a process
from the Process Monitor:

Figure 57. Log File
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v Process content packages (compressed files) and process log files are deleted.
v Processes with requested status are removed from the Process Monitor. These processes have no

associated files to be deleted.
v Processes that are running are marked for deletion when the process stops. When a running process is

deleted, the process continues to run. A message is sent to the Concept Broker to cancel the operation.
When the process stops running, the content package and log file is deleted.

v Processes that are completed or failed have the Content package and log files deleted.

Note: If you delete a requested process from the Process Monitor for a recurring process, there are no
more recurrences of the process - the entire series is deleted.

Tip: To ensure maximum performance of the Process Monitor, it is suggested that processes be deleted
regularly.

Reschedule Processes
If a process is started, you can reschedule the process by selecting the corresponding clock icon in the
Edit column of the Process Monitor to open theConcept Maintenance dialog box.

When you select Reschedule, the original Scheduling dialog box appears, and you can modify the
settings as necessary.

Rescheduling a Process:

Perform the following steps to reschedule a process.

Procedure

1. In the Edit column of the Process Monitor category, select the clock icon that corresponds with the
process you would like to reschedule. The Task Maintenance dialog box appears.

2. Select Rescheduling. The Scheduling dialog box appears.
3. Modify the process schedule as needed and select Submit. Remember only exports and

media/external content caches can be configured as recurring processes.
4. Select Update to save the changes.

Change the Priority of a Process
Each process that appears in the Process Monitor is assigned a priority from one to five, with one being
the highest priority.

Processes in the queue with higher priority are always run first. For example, if a requested process in
the Process Monitor has a priority of three, and a process is added later with a priority of two, the
process with the priority of two runs first.

You can modify process priority in the following ways:
v Change the default priority of each type of process in the concepts .xml file, which is on the

application server in the installation directory at appweb\evsfiles\properties.
v Change the current priority of any process in the Process Monitor with a status of “requested” by

accessing the Process Maintenance dialog box and selecting a priority in the Priority drop-down list.

Changing the Priority of a Process:

Perform the following steps to change a process's priority.

Procedure

1. In the Edit column of the Process Monitor category, select the clock icon that corresponds with the
process you would like to reprioritize. The Process Maintenance dialog box appears.
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2. Select the new priority from the Priority drop-down list.
3. Select Update to save the changes.

View Concept Broker Diagnostics
The Concept Broker manages and distributes the load put on the server by concepts that are initiated
from the Import, Export, Export Generator, and Media Cache categories.

You can view information on the configuration and status of the Concept Broker by selecting the View
Diagnostics link in the Process Monitor category. This feature provides more advanced descriptions than
can be seen from the Status column hyperlinks of the Process Monitor.

Concept Broker Diagnostics:

The Concept Broker service enables managing and distributing server load for processes such as import,
export, and delivery output generation.

Since this service can be configured to optimize performance on each server installation, it is important
for users to be able to view this configuration. The Concept Broker Diagnostics window enables users to
view information about the configuration and status of the Concept Broker service, and provides users
with read-only access to configuration information, status of running processes, completed and failed
processes, and the ability to view Concept Broker log files.

The data that appears at the top of the Concept Broker Diagnostics window aggregates all Running
Concepts, Completed Concepts, and Failed Concepts for all users since the inception of the database. The
Property column displays all properties corresponding to entries in the lcms.properties configuration
file. Properties that are listed in this column are generally defaults, unless they are modified by an
Implementation Consultant to optimize your installation.

The Concept Broker service creates a new log file each time the service is restarted, or when the log file
reaches its maximum size. The View Log drop-down list provides an option to view aggregated log files
for the Concept Broker service, and includes relative information about the run by the service. Options
available for viewing within the View Log drop-down list always defaults to the most current log file,
generally for the service that is running.

Task Broker Diagnostic Settings:

When initially prepared for use, the Task Broker settings should be configured for optimal performance
by modifying the lcms.properties file located in the installation directory at "appcfg\configfiles".

About this task

Table 31. Task Broker Properties. The following table displays the default properties of the task broker properties.

Property Value

POLLING_SERVICE_INTERVAL 1800000 (in milliseconds)

REMOTE_IMPORT_CONFIRM_SLEEPTIME 10 (in minutes)

REMOTE_IMPORT_CONFIRM_MAXTRIES 100

Import Category
The Import category enables the import of native LCMS Premier content and data, SCORM packages,
AICC content, and Content XML.
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Import Content
You can use the Import category to import compressed files of LCMS content that were previously
exported through the Export Wizard in the Export Category. Content imports are initiated by selecting
Import Wizard.

Note: The Import category imports XML that was exported from the Export category of LCMS Premier
versions 2.0 or higher only.

Content packages are selected for import by browsing and selecting them locally. If you want the
imported object to be placed in an existing container object, you can select an object from the treeview in
the left pane of the Import Wizard. If you do not select a container object, the content is imported as
unassigned content, unless the content imported is a course.

Tip: For the most efficient movement of content from one database to another, export the metadata
dictionary first. Then, import the metadata dictionary into the new database. After that is complete,
export and import the content at the level you want.

Importing Content:

Perform the following steps to import native LCMS Premier content.

Procedure

1. In the Import category, select Import Wizard. The Import Wizard appears.
2. In the left pane of the Import Wizard, select on the link for the object into which you would like to

import the content (you can expand the treeview just as you would in the Content Manager). If you
do not choose a parent object, the content is imported as unassigned content.

3. Enter the path to the compressed file to be imported in the Select file field, or select Browse to
choose the file.

4. To run the import as soon as possible, select the Immediate check box and proceed to Step 9. To
schedule the import for later, continue with Step 5.

5. Clear the Immediate check box and select Schedule. The Scheduling dialog box appears.
6. Select Start Date and select the date (from the calendar) on which you would like to start the

import.
7. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the import.
8. Select Submit.
9. Select Import.

10. The content that you are importing appears in the queue with a Status of requested. To see the most
current version of the import status, close the dialog box and go to the Task Monitor category. Select
the refresh every check box and select a time frame from the seconds drop-down list. When the
status changes to running, your content is importing. When the status changes to “completed,”
refresh the Structure pane in the Content Manager and your content appears.

Import Site Data
The Import category provides you with 12 types of site data that can be imported into the Repository.

The site data that is being imported must be in a compressed file format, and must be the actual site data
packages that are exported from the Export category of an LCMS Premier site.

Table 32. Import Data Types. The following table describes the contents of each data import.

Data Type Description

External Content Use to import External Objects into the Repository

Media Object Use to import Media Objects into the Repository
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Table 32. Import Data Types (continued). The following table describes the contents of each data import.

Data Type Description

Metadata Dictionary Use to import the metadata dictionary into the Repository

Review Comments Use to import details of review comments into the Repository

Admin Definitions Use to import administrative configurations (except for Media
Categories) defined in the Administration Manager

Content Configuration Use to import:

v Learning paths

v System filters

v Partitions

v Personalization profiles

v Publishing profiles

v Resources

v Substitution Variables, Profile, and values.

Site Configuration Use to import site parms and their settings

User Configuration Use to export member data, including, but not limited to:

v Theme

v Tab Layout

v Course Assignment

v Rolesa

v Personal Filters

ThemeTab layoutCourse assignmentRolesPersonal filters

User History Use to export the following member history data:

v Assessment results

v Survey results

v member access details

v Prescription data

v CMI (SCORM and AICC) data

Discussion Use to import Discussion Forum data

Task Management Use to import:

v Tasks

v Messages

Note: For efficient content movement, the Metadata Dictionary must be imported into an LCMS Premier
Repository before you import content.

Importing Site Data:

Use this procedure to import site data.

Procedure

1. In the Import category, select the radio button for the data type you would like to import.
2. Enter the path to the compressed file to be imported in the Select file field, or select Browse to locate

the file.
3. To run the import as soon as possible, select the Immediate check box and proceed to Step 8. To

schedule the import for later, continue with Step 4.
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4. Clear the Immediate check box and select Schedule. The Scheduling dialog box appears.
5. Select Start Date and select the date (from the calendar) on which you would like to start the import.
6. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the import.
7. Select Submit.
8. Select Start Import.
9. The content that you are importing appears in the queue with a status of “requested.” To see the most

current version of the import status, close the dialog box and go to the Task Monitor category. Select
the refresh every check box and select a time frame from the seconds drop-down list. When the
status changes to running, your data is importing. When the status changes to “completed,” your
import is finished.

Import SCORM 1.2 or 2004 Content
All SCOs are imported into a course. For example, if legacy content contains a single SCO with no
hierarchy, LCMS Premier creates a container course with a SCO at the Module level. SCORM 1.2 and
2004 packages can be imported though the Import category of the Learning Portal.

The following image shows an imported SCORM package with SCOs at the learning object level and two
parent nodes. In any case, Reference Objects contain the SCOs, and the SCOs can be expanded to view
questions.

SCORM 1.2 and 2004 packages can be imported though the Import category of the Learning Portal.

After a SCORM package is imported into LCMS Premier, SCORM data, such as CMI runtime data is
stored as system metadata on the Data tab of every Reference Object (SCO) and their Reference Objects.
See Using Element and System Metadata for details.

Strict Mode:

SCORM packages can be imported in “strict mode” by selecting the Strict Mode check box. When this
check box is selected, all files in the SCORM package are imported. When this check box is cleared, only
the files that are referenced in the imsmanifest.xml file are imported. Although a manifest might be valid,
it might not reference every file that is required for a SCO to run properly.

The Strict Mode check box is selected by default.

Tip: Some SCOs require all files even if those files are not referenced in the manifest. If you are uncertain
about the type or structure of the SCO, select the Strict Mode check box when you import.

Media:

Upon import of a SCORM package into LCMS Premier, media assets are stored in the
scorm_media_category. The media assets are stored as individual Media Objects and can be reused with
other LCMS Premier content.

Figure 58. Imported SCROM Package with SCOs
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You can configure the types of SCORM media that are allowed to be imported into LCMS Premier. The
configurable file that contains the list of supported file extensions is in the sco_media_formats.properties
file on the application server in the installation directory at appweb\evsfiles\properties. If a file
extension is supported by LCMS Premier, it can be included in the sco_media_formats.properties file.

To find out more about SCORM import for LCMS Premier and the differences between SCORM 1.2 and
2004, see the technical document “Using SCORM with LCMS Premier”.

Importing a SCORM 1.2 Package:

Use this procedure to import a SCORM 1.2 package.

Procedure

1. In the Import category, select the SCORM 1.2 radio button.
2. The Strict Mode check box is selected by default. Strict mode imports all of the files in the SCORM

package. Clear this check box if you want to import the files that are referenced in the
imsmanifest.xml file.

3. Select the Assume Global Id's check box if you determine the SCO identifiers in this package to be
unique. If this is selected, and SCORM content with the same IDs is later imported, then the content
is overwritten.

4. Enter the path to the compressed file to be imported in the Select file field, or select Browse to
locate the file.

5. To run the import as soon as possible, select the Immediate check box and proceed to Step 10. To
schedule the import for later, continue with Step 6.

6. Clear the Immediate check box and select Schedule. The Scheduling dialog box appears.
7. Select Start Date and select the date (from the calendar) on which you would like to start the

import.
8. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the import.
9. Select Submit.

10. Select Start Import.
11. The content that you are importing appears in the queue with a status of “requested.” To see the

most current version of the import status, close the dialog box and go to the Task Monitor category.
Select the refresh every check box and select a time frame from the seconds drop-down list. When
the status changes to running, your content is importing. When the status changes to “completed,”
refresh the Structure pane in the Content Manager and your content appears.

Important: Before you import a SCORM package into LCMS Premier, you must first import the
LCMS Premier SCORM metadata dictionary. For any metadata in the SCORM package, the
corresponding group/tag combination must exist in LCMS Premier, or the data are lost. This
metadata dictionary is available on your LCMS Premier installation CD.

Importing SCORM through the Content Manager:

LCMS Premier developers can import SCORM 1.2 and SCORM 2004 packages from the Content Manager
Structure pane. This is accomplished by right-selecting the course into which you want to import the
SCORM package and selecting Import > SCORM 1.2/SCORM 2004.

Import AICC Content
AICC packages can be imported into the Repository and reused within LCMS Premier. The AICC import
function is accessed through the Import category of the Learning Portal. LCMS Premier imports two
types of AICC packages:
1. AICC HACP (HTTP AICC Communication Protocol)
2. AICC API (Application Program Interface)
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AICC HACP:

AICC HACP packages launch course content through an HTTP link.

There are two types of AICC HACP packages:
1. AICC HACP Remote
2. AICC HACP Local

AICC HACP Remote packages access the content with a remote link. When a package of this type is
imported into LCMS Premier, it becomes a Reference Object in a container course. Because the content is
accessed with a remote link, there is no External Object that is associated with the Reference Object, and
the HACP Remote radio button is selected in the Content view of the Reference Object.

Note: LCMS Premier AICC exports are of type HACP Remote.

AICC HACP Local packages access the content by embedding the content. When a package of this type is
imported into LCMS Premier, it becomes a Reference Object in a container course. Because content files
are included in the import, there is an External Object that is associated with the Reference Object, and
the Embedded radio button is selected in the Content view of the Reference Object.

HACP Local External Objects are stored in the aicc_media_category. This media category is automatically
created during the AICC import.

Note: Trainer and Studio AICC exports are of the type HACP Local.

AICC API:

AICC API packages communicate with a Learning Management System (LMS) through an API, similar to
SCORM packages. This type of AICC packaging is rare, as SCORM provides better content packaging.

AICC API Local is the only type of package available for this format. When a package of this type is
imported into LCMS Premier, it becomes a Reference Object in a container course. Because the content
files are included in the import, there is an External Object that is associated with the Reference Object,
and the Embedded radio button is selected in the Content view of the Reference Object.

API Local External Objects are stored in the aicc_media_category. This media category is automatically
created during the AICC import.

Importing an AICC Package:

Perform the following steps to import an AICC package.

Procedure

1. In the Import category, select the AICC HACP or AICC API radio button, depending on the type of
AICC package you are importing.

2. Enter the path to the compressed file to be imported in the Select file field, or select Browse to locate
the file.

3. To run the import as soon as possible, select the Immediate check box and proceed to Step 8. To
schedule the import for later, continue with Step 4.

4. Clear the Immediate check box and select Schedule. The Scheduling dialog box appears.
5. Select Start Date and select the date (from the calendar) on which you would like to start the import.
6. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the import.
7. Select Submit.
8. Select Start Import.
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9. The content that you are importing appear in the queue with a Status of requested. To see the most
current version of the export status, close the dialog box and go to the Task Monitor category. Select
the refresh every check box and select a time frame from the “seconds” drop-down list. When the
status changes to running, your content is exporting. When the status changes to “completed,” refresh
the Structure pane in the Content Manager and your content will appear.
LCMS Premier provides CMI data that is requested by AICC imports, when launched. For details on
these data elements, see the technical document “SCORM and AICC Data Tracking”.
After an AICC package is imported into LCMS Premier, AICC assignable unit runtime data is stored
as system metadata in the Data view of the resulting External Object and/or Reference Object. See
Using Element and System Metadata for details.

Import Content XML
LCMS Premier users can import Content XML through the Import category.

Note: For an overview of Content XML, see Exporting Content as Content XML.

Importing a Content XML Package:

Perform the following steps to import a content XML package.

Procedure

1. In the Import category, select the Content XML radio button.
2. Enter the path to the compressed file to be imported in the Select file field, or select Browse to locate

the file.
3. To run the import as soon as possible, select the Immediate check box and proceed to Step 8. To

schedule the import for later, continue with Step 4.
4. Clear the Immediate check box and select Schedule. The Scheduling dialog box appears.
5. Select Start Date and select the date (from the calendar) on which you would like to start the import.
6. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the import.
7. Select Submit.
8. Select Start Import.
9. The content that you are importing appears in the queue with a Status of requested. To see the most

current version of the import status, close the dialog box and go to the Task Monitor category. Select
the refresh every check box and select a time frame from the seconds drop-down list. When the status
changes to running, your data is importing. When the status changes to “completed,” your import is
finished. If the import fails, select the failed link to access the transaction log. This log displays any
errors in the XML, and on which lines of your XML the errors exist.

Export Category
You can use the Export category to export native LCMS Premier content and site data.

Export Content
The Export category is where you can export course content from the LCMS Premier Repository to your
local machine, or to another server that is configured as part of a content distribution network. Content
exports are initiated by selecting Export Wizard.
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Export Wizard:

The left pane of the Export Wizard contains all of the courses in the Repository that are available for
export. You can navigate through the treeview to select the content you want to export.

You can use right pane to choose content attributes that you want packaged with the content. You can
also choose a different server destination (if configured) or schedule the export.

Content attributes are exported as follows for the selected object:
v External Content - All External Objects within the object
v Media Object - All Media Objects within the object
v Layout Definitions - All layouts for all elements within the object
v Metadata Dictionary - The entire metadata schema
v Review Comments - All review comments that are made within the object
v Content Version - All existing versions of all content within the object
v Discussion - All discussion forum topics for all learning objects within the object; if the export level is

topic or lower, this check box is disabled.
v Concept - All concepts that are created for all content within the object
v Archives - All archives for all content within the object

Tip: For the most efficient movement of content from one database to another, export the metadata
dictionary first. Then, import the metadata dictionary into the new database. After that is complete,
export and import the content at the level you want.

Figure 59. Export Category
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Exporting Content:

Perform the following steps to export native LCMS Premier content.

Procedure

1. In the Export category, select Export Wizard. The Export Wizard appears.
2. In the left pane of the Export Wizard, select on the link for the content that you would like to export

(you can expand the treeview just as you would in the Content Manager).
3. In the right pane, select the check box next to each of the components that you would like to include

in this export.
4. Select a server destination from the select Export Destination drop-down list. See Configuring a

Data Distribution Network for information on configuring a server destination.
5. To run the export as soon as possible, select the Immediate check box and proceed to Step 12. To

schedule the export for later, continue with Step 6.
6. Clear the Immediate check box and select Schedule. The Scheduling dialog box appears.
7. Select Start Date and select the date (from the calendar) on which you would like to start the export.
8. If you would like this export to recur regularly, select the Weekly, Daily, or Monthly radio button,

depending on your need. If you select the Monthly radio button, the End of Month check box
becomes enabled. Selecting this check box causes the export to run at the end of the month only.
Select End Date and select the date (from the calendar) on which you would like to end the export
recurrences.

9. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the export.
10. Select Submit.
11. Select the Encrypt Data check box if you want security for the content data that is being exported.
12. Select Request Export.
13. The content that you are exporting appears in the queue with a status of requested. To see the most

current version of the export status, close the dialog and go to the Task Monitor category. Select the
refresh every check box and select a time frame from the Seconds drop-down list. When the status
changes to running, your content is exporting. When the status changes to “completed,” continue
with Step 14.

14. Select on the link for your content. The File Download dialog box appears.
15. Select Save. The Save As dialog box appears.
16. Choose a folder location for the file, enter a filename for the compressed file, and select Save.

Exporting Site Data
You can use the Export category to export data from the Repository into a packaged XML format. The
benefit of exporting data in this method is that you are able to export the data for the entire Repository,
not just the data that is associated with a particular object. For example, you might want to export all
External Objects within the database, or the entire metadata dictionary.

The following table describes the data types available for export.

Table 33. Export Data Types. The following table displays the contents of each data export.

Data Type Description

External Content Use to export all External Objects residing in the Repository

Media Object Use to export all Media Objects residing in the Repository

Metadata Dictionary Use to export the metadata dictionary that resides in the Repository

Review Comments Use to export details of all review comments that reside in the Repository
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Table 33. Export Data Types (continued). The following table displays the contents of each data export.

Admin Definitions Use to export all administrative configurations (except Media Categories) that are
defined in the Administration Manager

Content Configuration Use to export:

v Learning paths

v System filters

v Partitions

v Personalization system settings

v Personalization profiles

v Publishing profiles

v Resources

v Substitution Variables, Profiles, and values

Site Configuration Use to export site parms and their settings

User Configuration Use to export member data, including:

v Member accounts

v Theme

v Tab layout

v Course assignment

v Roles

v Personal filters

User History Use to export the following member history data:

v Assessment results

v Survey results

v Member access details

v Prescription data

v CMI (SCORM and AICC) data

Discussion Use to export all Discussion Forum data

Concept Management Use to export details of:

v Concepts

v Messages

Exporting Site Data:

Use this procedure to export site data.

Procedure

1. In the Export category, select the radio button for the data type you would like to export.
2. To export only specific data, select a filter from the Filter drop-down list (if enabled), or select New

to create a new filter.
3. Select a server destination from the select Export Destination drop-down list. See Configuring a

Data Distribution Network for information on configuring a server destination.
4. Select the Encrypt Data check box if you would like security for the content data that is being

exported.
5. To run the export as soon as possible, select the Immediate check box and proceed to Step 11. To

schedule the export for later, continue with Step 6.
6. Clear the Immediate check box and select Schedule. The Scheduling dialog box appears.
7. Select Start Date and select the date (from the calendar) on which you would like to start the export.
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8. If you would like this export to recur regularly, select the Weekly, Daily, or Monthly radio button,
depending on your need. If you select the Monthly radio button, the End of Month check box
becomes enabled. Selecting this check box causes the export to run at the end of the month only.
Select End Date and select the date (from the calendar) on which you want to end the export
recurrences.

9. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the export.
10. Select Submit.
11. Select Request Export.
12. When the dialog box appears asking you to confirm the export, select OK.
13. The content that you are exporting appears in the queue with a Status of requested. To see the most

current version of the export status, close the dialog and go to the Task Monitor category. Select the
refresh every check box and select a time frame from the seconds drop-down list. When the status
changes to running, your content is exporting. When the status changes to “completed,” continue
with Step 14.

14. Select the link for your content. The File Download dialog box appears.
15. Select Save. The Save As dialog box appears.
16. Choose a folder location for the file, enter a filename for the compressed file, and select Save.

Media Cache Category

Caching Media and External Content
The Media Cache category provides a way for you to keep media on the file system, eliminating the time
needed to retrieve media from the Content Manager when content is launched.

On the Media and External Cache page, you can cache all media that are contained within the database,
or just media that are contained within a specific media category.

Four Types of Caching
The Media Cache feature enables four types of caching. You can set parameters for media caching within
the lcms.properties file, which is on the application server.

Table 34. Media Cache Types. The following table describes the available media cache types.

Media Cache Type Description

None
No caching is done, and the Media Cache category does not function, as all media are
pulled directly from the database.

Dynamic
Media are cached to a local drive upon user demand. After the media is cached, it is not
retrieved from the database.

Static
Media is moved automatically to the cache after an import, or administratively through
the concept scheduler. Media is retrieved from the file system on the local Web server.

Remote

There are two types of remote media caching:

1. Intranet Remote - Functions similar to the static cache; however, the cache is
populated through a shared network file system.

2. Internet Remote - Functions similar to the static cache; however, the cache is
populated through an FTP transfer.

Note: External content is not affected by any cache settings in the lcms.properties file. There is no
remote mode for external content caching, nor can external content caching be turned off. Media caching
settings are configured in the lcms.properties file. For information about configuring media caching, see
the technical document LCMS Premier Media Caching.
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Caching Media or External Content
Use this procedure to cache media or external content.

Procedure
1. In the Media Cache category, select the media category from the drop-down list for which you want

to cache media.
2. Choose of the following options:
v Select the External Content radio button to cache External Objects.
v Select the Media Object radio button to cache Media Objects.

3. Choose one of the following options:
v Select the Uncached radio button to refresh only media that was not previously.
v Select the All radio button to refresh all media.

4. To run the cache as soon as possible, select the Immediate check box and proceed to Step 10. To
schedule the cache for later, continue with Step 5.

5. Clear the Immediate check box and select Schedule. The Scheduling dialog box appears.
6. Select Start Date and select the date (from the calendar) you want to start the cache.
7. If you want the cache to recur regularly, select the Weekly, Daily, or Monthly radio button,

depending on your need. If you select the Monthly radio button, the End of Month check box
becomes enabled. Selecting this check box causes the cache to run at the end of the month only.
Select End Date and select the date (from the calendar) on which you would like to end the cache
recurrences.

8. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the cache.
9. Select Submit.

10. Select Start. The Task Monitor appears, and your media cache appears in the queue with a Status of
requested. To see the most current version of the status, select the refresh every check box and select
a time frame from the seconds drop-down list. When the status changes to running, your media is
caching. When the status changes to “completed”, the media is cached.

Note: A change in the type of Media Caching being used requires a reboot of the Webserver.

Server Configurations

Servers Category
LCMS Premier enables the export of data to other LCMS Premier sites, and data synchronization between
servers.

Before any data distribution or synchronization can take place, the connections between servers must be
established. This information is entered in the Servers category in the Learning Portal. This category
provides a central location for managing all of your server configurations.

By default, the Servers category contains an entry for the Localhost, which is the server on which LCMS
Premier is installed. The Localhost is configured as a connected LCMS Premier server and cannot be
modified.

Note: The Servers category is not included in any default layouts. This category must be added by
editing member tab layouts.

Configure a Data Distribution Network
Data distribution works by interconnecting distribution peers through a common distribution server.
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v A distribution peer is an installation of the LCMS Premier server platform that can be uniquely
identified by using machine name and servlet application mapping.

v A distribution server is a simple FTP server that acts as a point of exchange for distribution peers. A
distribution server can also be a distribution peer.

The Data Distribution Network Process
The following steps describe the data distribution process.

Procedure
1. On initiating the process from Peer Server 1, the data is packaged and tagged for delivery to Peer

Server 2.
2. The packaged data is exported to the distribution server, which acts similarly to an FTP server.
3. After the data is exported to the distribution server, it confirms delivery to Peer Server 1.
4. Peer Server 2 detects that there is data on the distribution server that is “tagged” for delivery to it.
5. Peer Server 2 retrieves and imports the tagged data from the distribution server.
6. Peer Server 2 confirms delivery to Peer Server 1 through the distribution server.

A Data Distribution Network might resemble the following figure. The application framework
supports any number of distribution servers per Distribution Network.

Configure and Use the Data Distribution Network
There are three main processes to configure and use the Content Distribution Network.
v Configuring a New Distribution Server
v Configuring a Distribution Peer
v Exporting content to another server

Figure 60. Data Distribution Network Process
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The processes all take place in the Export Category of the Learning Portal.

Distribution Server
A distribution server is simply an FTP service.

As long as the FTP server conforms to RFC 959 (http://www.w3.org/Protocols/rfc959/), it can be used.
The service can run on a dedicated server, or on a server that is also being used as a distribution peer.

The FTP service can be configured to use an anonymous account, or a user account. This service can also
be configured to use a home directory, or it can store all files in the root location that is bound to the user
account.

Distribution Peer
A distribution peer is an instance of the LCMS Premier server that serves either as the sender or recipient
of the data distribution. Distribution peers are created automatically by the system after the distribution
server has been created.

About this task

The following image displays an example of a distribution peer configuration in the Server dialog box.

Configuring a New Distribution Server
Use this procedure to configure a distribution server.

Procedure
1. In the Servers category, select Add to open the Server dialog box.
2. Enter a name for the distribution server in the Label field, and enter a description in the Description

field.
3. Select Distribution Server from the Host Type drop-down list.

Figure 61. Distribution Server Configuration in the Server Dialog Box

Figure 62. Distribution Peer Configuration in the Server Dialog Box
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4. Enter the name of the FTP server in the FTP URL field.
5. Enter a user name in the Username field. This user name must be an accepted user name of the FTP

server.
6. Enter a password in the Password field. This password must be an accepted password of the FTP

server.
7. If you would like to store data movement directories in a different place than the root FTP folder,

enter the relative path in the Home Directory field. Otherwise, enter a forward slash (/).
8. Select OK.
9. Repeat Steps 1-8 for all servers in the distribution network, pointing to the same distribution server.

Verify Distribution Peers
After you configure the distribution server, you must open each peer configuration and make sure that it
is set to allow imports and exports as needed. In the following image, the configuring peer is the second
in the list.

Configuring Distribution Peers
Perform the following steps to configure a distribution peer.

Procedure
1. Open the Distribution Peer in the Servers category on the peer server.
2. Select the Allow Import check box if you would like this peer to appear in the Select Destination

drop-down list in the Export category.
3. Select the Allow Export check box if you would like this peer to be able to import data that is

exported from another Distribution Server.
4. Select OK.
5. Repeat Steps 1-4 for all distribution peers.

After you configure your Data Distribution Network, you have distribution peers as choices for
destinations. By choosing one of these destinations, you are implementing data movement to another
server. Destinations can be selected for any selections in the Export category.

Export Content to another Server
After starting an export to a distribution peer, notice that the Process Monitor contains different actions
than with a local export. In the first concept, the data is exported. In the second concept, the data is
moved to the distribution peer server. In the third concept, the distribution peer import is confirmed.

Figure 63. Verify Distribution Peers
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For the party on the receiving end of the transfer, the Process Monitor contains different concepts than
the source Process Monitor. In the first concept, the content is moved from the distribution peer server. In
the second concept, the content is imported into the destination peer server. In the third concept, the
confirmation of import is confirmed with the source peer server.

Configure Synchronization
You can use LCMS Premier to synchronize data between different servers. This enables multiple LCMS
Premier servers to be networked for enabling different data sharing needs.

For example, data on a production server might be automatically updated on consumption servers,
review servers, and other production servers. This synchronization is achieved by defining activities that
identify the servers that are used and the content that is delivered from one server to another.

Note: The categories that are involved in synchronization are not included in any default layouts. These
categories must be added by editing member tab layouts.

Two Learning Portal categories are involved in the synchronization process:
1. Synchronization Activities
2. Synchronization Monitor

Synchronization Peer
The synchronization peer can be any server that is running on a separate database from the producer, or
localhost server. The following image displays an example of a synchronization peer configuration in the
Server dialog box. You must configure this on each site by using the other site as the peer.

Figure 64. Export Content Source Process Monitor

Export Content Receive Process Monitor

Figure 65. Configure Synchronization
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Configuring a Synchronization Peer:

Perform the following steps to configure a synchronization peer.

Procedure

1. In the Servers category, select Add to open the Server dialog box.
2. Enter a name for the peer in the Label field.
3. Enter the purpose of this peer in the Description field.
4. Select Synchronization Peer from the Host Type drop-down list.
5. Enter the LCMS Premier site URL of the synchronization peer in the Site URL field.
6. Select OK.
7. Now, on the other server, repeat Steps 1-6, using the information for the site you were just on.

Synchronization Activities Category
After the synchronization peer server is configured, synchronization activities can be created and
generated. You can create and generate synchronization activities through the Synchronization Activities
category.

Activity Dialog Box:

Activities are created by selecting Add and opening the Activity dialog box. The Activity dialog box
contains four tabs:
1. General

2. Consumers

3. Rules

4. Data

The General tab is where the activity is given a name, and a time is picked for the activity to run. If no
specific time is selected, the activity runs when Run is selected in the Synchronization Activities category.

Rules Tab:

The Rules tab is where the filters are configured. The filter determines what data is synchronized with
the peer server. You can also delete the following types of data from the peer server if the data is not
used:
v Content Objects
v External Objects
v Media Objects
v Metadata Groups and Tags

Figure 66. Sample Synchronization Peer Configuration in the Server Dialog Box
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Data Tab:

The Data tab is where you assign metadata to the activity. For metadata to appear on this tab, it must be
assigned to the Activities category in the Metadata Dictionary.

Synchronization Monitor:

After an activity is scheduled, it appears in the Synchronization Monitor. The Synchronization Monitor
displays the activity schedule, its completion status, and when the activity began running.

After an activity is run, a new “requested” process appears in the Process Monitor category of the
synchronization peer. The synchronization activity runs at midnight, unless the process time is edited on
the synchronization peer.

Creating a Synchronization Activity:

Perform the following steps to create a synchronization activity.

Procedure

1. In the Synchronization Activities category, select Add to open the Activity dialog box.
2. On the General tab, enter a name for the activity in the Label field.
3. To schedule this activity for a specific time, select Schedule and select the date, time, and any

recurrences of the activity. To activate the scheduling, select the Enabled check box.
4. Select the Consumers tab and select Yes when prompted to save.
5. Select the check boxes next to the peers with whom you want to synchronize data.
6. Select the Rules tab and select Yes when prompted to save.
7. Select a filter from the Label drop-down list, or create a new filter with the criteria necessary to

synchronize the correct data.
8. At the bottom of the Rules tab, select the check boxes for the unused data that you want deleted

from the peer server after the activity is run.
9. Select the Data tab and select Yes when prompted to save.

10. Populate any metadata tags associated with the activity.
11. Select OK.
12. If you did not schedule a time for the activity to run, and would like to run the activity now, select

Run. You can view the progress of the activity in the Synchronization monitor category, and select
on the activity link to view details and the log file.

Learning Portal: Administration Tools

Administration Manager Category
Administrators can use the Administration Manager category to manage several items that are used by
authors in the Content Manager.

Figure 67. Data Tab
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Modify Action Descriptions
Selecting the Action Descriptions link in the Administration Manager category opens the Edit Action
Descriptions page.

Here, you can edit the names of the Actions that appear on the Action tab of roles in the Role
Administration category.

Add, Modify, and Delete Element Categories
Element categories are used to group element types in the Content view and Templates view.

When you select the Element Categories link in the Administration Manager category, the Element
Categories Configuration page appears. The following fields on this page are used to add or modify
element categories:
v Palette Label - The name that appears in the Category Bars on the Object Palette
v Category Label - The name that appears in the Type drop-down list in the General view of all elements

If the field in the Category Label column is left blank, the information that is entered for the Palette
Label is used by default in the Type drop-down list in the General view of all elements in the Content
Manager and Templates view.

Note: To view changes that are made to the element categories, you must refresh the panes in the
Content Manager where the element categories are visible.

Element categories with elements assigned to them cannot be deleted, and a prompt appears to cancel the
action. Elements must be reassigned to a different element category by using the Element Types option in
the Administration Manager before you delete the element category.

Hide and Assign Element Types
Use the Element Type option to control the availability of elements, relabel element types, and assign
elements to element categories for use in the Content Manager and Templates view.

Figure 68. Element Categories
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When you select on the Element Type link in the Administration Manager category, the Element Type
Configuration page appears. The following properties on the Element Type Configuration page are
available for modification:
v Hide - Makes the element unavailable in the Content Manager
v Alternate Label - Overrides the Label column and appears in the Content Manager
v Category - Assigns the element to an element category. Elements belonging to the Assessment Group

and Survey Group categories cannot be reassigned to another category. You also cannot assign other
elements to the Assessment Group and Survey Group categories.

Note: To view the changes that are made to the element types, you must refresh the panes in the
Content Manager where the element types are visible.

Adding, Modifying, and Deleting Media Categories
Media categories are used to group media in the Media Search view and External Object Search view.

About this task

You can add, modify, and delete media categories with the Media Categories option in the
Administration Manager. Categories that are created with the Media Categories option are used to group
objects in the Media Search view and External Object Search view. When you select on the Media
Categories link, the Media Categories Configuration page appears. The following fields on this page are
available for modification:
v Category - The category label that appears when grouping objects in the Search view and External

Object Search view
v Description - A description of the category that can be viewed in the Administration Manager

Note: To view the changes that are made to the media categories, you must refresh the panes in the
Content Manager where the media categories are visible.

Figure 69. Element Types Example

Figure 70. Media Categories
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Categories containing Media Objects and External Objects cannot be deleted. One or both of the following
two actions must take place to delete a category:

Procedure
1. In the Media Search view, reassign the Media Objects within the category to a different category, or

delete the Media Objects within the category from the Content Manager.
2. In the External Object view, reassign the External Objects within the category to a different category,

or delete the External Objects within the category from the Content Manager.

Add, Modify, and Delete Media Types
Media Types are used to classify different media files within Media Objects in the Media Search view.

When you select the Media Types link in the Administration Manager category, the Media Types
Configuration page appears, where you can add, modify, or delete media types. The following properties
on this page are available for modification:
v Label - The name that appears in the Media Type drop-down list in the Media Import dialog box and

in the Files view of a Media Object.
v Description - A description of the media type that can be viewed in the Administration Manager.

Pre-configured Media Types:

LCMS Premier offers six pre-configured media types that can be assigned to Media Files in the Media
view. Of these six media types, three have rules attached that designate them for use with a specific
output. The preconfigured media types are as follows:
v Web*
v Print*
v PDA*
v CD
v Source
v Thumbnail

*When you export content to these formats, the Media Files whose media type matches the selected
export format are used. If there is no Media File in the Media Object that matches the selected export
format, the Web media type is used in its place.

For example, if you export a course in Word format, the Media File pulled from the Media Object is the
one set to Print. If there is no Print Media File, the Web Media File is used.

Note: Any custom media types that are added are not associated with any export generators.

Media types that are assigned to Media Files cannot be deleted. You must do one of the following in the
Media Search view:
v Reassign the Media Files to a different media type.
v Delete the Media Files that are assigned to the media type from the Content Manager.

Figure 71. Media Types

Introduction 283



Modify and Hide Message Boxes
You can use the Message Boxes option in the Administration Manager to modify and hide the message
box types that are available to course developers in the Content Manager and Templates view.

The following message box types are in the Message Box element in the Content Manager.

Note: All 20 Message Boxes are available for modification.

When you select the Message Boxes link in the Administration Manager category, the Message Boxes
Configuration page appears. The following properties on the Message Boxes Configuration page are
available for modification:
v Label - The name that appears in the Content Manager and Templates view when you select a Message

Box type. The label does NOT affect the text that is in the Message Box in delivery.
v Description - A description of the Message Box that can be viewed in the Administration Manager
v Hide - Makes the Message Box unavailable in the Content Manager and Templates view

Changes that are made to Message Boxes by using the Administration Manager affect only their use in
the Content Manager. To modify their appearance, such as icons, borders, and text, you must change the
appropriate Message Box parameters in the Theme Management category through the Learning Portal.

Modify Object Type Labels
Use the Object Type Labels option to modify the object labels that appear in the Content Manager.

A label is pre-configured for each object, but can be changed by using this option.

When you select the Object Type Labels link in the Administration Manager category, the Object Type
Labels Configuration page appears. The following properties on this page are available for modification:

Figure 72. Message Box Types

Figure 73. Object Type Labels
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v Label - The label that appears when the object is referenced in the Content Manager.
v Plural Label - The label that appears when the plural form of the object is referenced in the Content

Manager.

Note: To view the changes that are made to the object type labels, you must refresh the panes in the
Content Manager where the object types are visible.

Modify Output Type Labels
Use the Output Type Labels to modify the label that appears when the Output buttons are moused over
in the General view of an element.

About this task

A label is preconfigured for each output, but can be changed by using this option.

When you select the Output Type Labels link in the Administration Manager category, the Output Type
Labels Configuration page appears. The Label column on the page enables the configuration of the name
of the label that appears upon mouseover of the Output buttons in the Content Manager.

If the Label column is left blank, no label appears when the corresponding Output button is moused
over in the Content Manager.

Note: To view changes that are made to the output type labels, you must refresh the panes in the
Content Manager where the output types are visible.

Add and Delete Search Keys
Learn how to add and delete search keys.

In addition to content searches, search keys are used for indexing in FrameMaker and CHM exports.

Figure 74. Output Type Labels
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When you select the Search Keys link in the Administration Manager category, the Search Keys
Configuration page appears.

Note: When a search key is deleted from the Administration Manager category, it is removed from the
available list of search keys in the Content Manager. However, if the search key is assigned to content, it
still appears in the Search Keys field in the General view of the content.

Add, Hide, and Set a Status
Use the Status option to configure the statuses that appear in the Status drop-down list in the General
view of content.

You can use this option to configure an unlimited number of statuses.

Status Properties:

When you select the Status link in the Administration Manager category, the Status Configuration page
appears.

The following properties on this page are available for modification:
v Default - Identifies the default status assigned to content authored in the Content Manager
v Label - This name appears in the Content Manager.
v Description - Allows for the inclusion of descriptive text with regard to the status
v Hide - When this check box is selected, the status is unavailable in the Content Manager. The status set

to default cannot be hidden.
v Trigger Lock - When this check box is selected, any content set to this status will automatically be

locked.
v Production - When this check box is selected, the status takes on the properties of the default

Production status.
v Order - Determines the order in which the statuses appear in the Content Manager
v Archive - When this check box is selected, a change in an object's status will trigger production of an

archive for that object.
v Delete - Removes the status permanently

Note: The Content Manager must be closed and re-opened to view the changes made to the statuses in
the Administration Manager.

Figure 75. Add Search Keys
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Pre-configured Statuses:

LCMS Premier offers four pre-configured statuses. These statuses have rules that are associated with
them that cannot be modified. These rules control how content is used in the development cycle. The
pre-configured statuses are as follows:
1. Development
2. Editorial Review
3. Content Review
4. Production

Modifying the labels of the pre-configured statuses has no effect on the rules that are associated with
them for controlling content.

Theme Management Category
System administrators can use the Theme Management category to configure themes that are used for
authoring preview, online delivery, and exported content.

Copy, Delete, or Switch Themes
Describes how to copy, delete, and switch themes in the Theme Management category:
v Copy a theme by selecting an existing theme, selecting the Copy link, and renaming the theme. You

can then modify the theme copy to create a new theme.
v Delete a theme by selecting the theme and selecting on the Delete link.
v Switch themes by selecting a theme and selecting on the Log In link.

Important: The deletion of themes should be taken into careful consideration. When a theme is deleted,
the theme's file manager folder is also deleted. Unlike in the Content Manager, Media Files for themes are
not retained in a common directory.

Import or Export a Theme
In the Theme Management category, administrators can export a theme from one LCMS Premier
Repository and import the theme for use in another repository.

To export a theme, select the theme, select the Export link, then download the compressed file.

To import a theme, select the Import link, select the compressed file for a theme, and select Load.

Note: If you are importing a theme whose name exists, you are given the option of overwriting the
existing theme or renaming the imported theme.

Set a Default Theme
You can choose a default theme for new members by selecting a theme and selecting the Set as Default
link in the Theme Management category.

Members must be assigned to this default theme to log in to the default site URL.

When you change the default theme you are given the option of reassigning members of the old default
theme to the new default theme. If you do not reassign these members, the default site URL no longer
applies to them and they must log in with a modified URL.

For example, your default URL is “http://server:8080/site/index.htm” and you and other members are
assigned to the default theme “learning.” If you change the default theme to “sepia,” but do not assign
yourself and other members to the sepia theme, they must log in with “http://server:8080/site/
learning.htm” to access the learning theme.
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Note: After you change the default theme for a site, you must restart the Concept Service must.

Manage Theme Files
Files that are used by themes are stored in the File Manager, accessed by selecting the File Manager link
in the Theme Management category.

The File Manager is used to upload HTML and associated media for the News and Welcome categories
on the Learning Portal. The page includes options to delete and rename the items within the File
Manager, but these options should be used only for files that relate to the News and Welcome categories.
If an image in a theme needs to be changed, go to the appropriate theme parameter and use its Browse
button to upload a new image.

For More Information: See Uploading Welcome and News Files.

Modify Theme Parameters
Theme properties can be modified by using theme parameters. The LCMS Premier platform offers
thousands of theme parameters that allow administrators to customize the look, feel, and functionality of
the theme to meet the needs of their enterprise.

To make it easier to navigate the parameters, they are divided into various types depending on their
function. The name of the types reflects the area the parameters influence.

When you select the link for a theme parameter type, the Theme Editor page opens. You use the Theme
Editor to change the attributes of parameters within this group.

When you select the link for a theme parameter, the Theme Editor loads for that particular parameter.
The editor varies in functionality, depending on whether the parameter is an image, a style, or a
functionality toggle.

For some theme parameters, such as those that control display settings, only certain acceptable values can
be used. For such parms, the choices are listed for convenience.

Note: All image theme parameters have an Alt Text field. The text that is entered in this field serves as
a description of the image in a 508 compliant browser environment.

Multiple Values:

Some theme parameters can contain multiple values. You can add and delete values for these theme
parameters.

For example, the following image of the “Presentation Viewer Size Choices” parm contains four default
resolutions. These values appear in the Presentation Size drop-down list in the Slide Presentation
category.

For detailed information about theme parameters, see the Viewer and Theme Administration Guide.

Figure 76. Multiple Values Example
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Site Manager Category
Administrators can use the Site Manager category to configure site-wide properties that affect all
members, regardless of theme.

Configure Content Expiry
Users can schedule a concept to be created for a content developer any time content that is owned or
updated by the developer is out of date or requires maintenance.

Metadata of type date must be assigned to the content and populated with the desired expiration date.
That metadata tag must also be selected as criteria when you are configuring the expiration. When the
selected date arrives, the concept is created for the developer and delivered to them through the Message
List category.

To schedule content expiration, select the Content Expiry link in the Site Manager category. Refer to the
following image of the components of the Content Expiry page.

Configuring Content Expiry:

Use this procedure to configure content expiry.

Procedure

1. In the Site Manager category of the Learning Portal, select on the Content Expiry link to open the
Content Expiry page.

2. Select the recipient of the message from the Owner is drop-down list. You can choose to notify:
v The original creator of content.
v The last user to modify the content.

3. Select the date, time, and any recurrence of the message by clicking Schedule. The date that you select
must be after the date specified on the date metadata tag for the content. After you schedule the
delivery time, select Submit.

4. Select Select next to the Metadata Tag ID to use for expiry date is field. Select the date metadata tag
to use as criteria for expired content and select Update.

Note: Any content that you would like to flag for expiry must have this same metadata tag that is
populated in the Data view of the content.

5. Select a message priority of Low, Normal, or High from the Priority drop-down list.
6. Enter the subject of the message in the Subject field.
7. Type instructions for the developer. The instructions tell the developer what to do with the expired

content.
8. Select Update.

Note: The “Send email when a system message is created” site parm in the Site Manager category
controls whether an e-mail is sent to a user when a task is generated or content expires.

For more information about the Message List category, see Using Tasks.

Configure a Media Request Notification
Administrators can configure a concept to automatically generate whenever a media request is created.
This can help graphic artists to keep better track of media requests.

To configure automatic concept generation, select the Media Request link in the Site Manager category.
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Configuring Automatic Task Generation for Media Requests:

Perform the following steps to configure automatic task generation.

Procedure

1. In the Site Manager category of the Learning Portal, select on the Media Request link to open the
Media Request page.

2. Select the owner of all media request tasks from the Owner drop-down list. The “owner” is the
person who is handling the media requests.

3. Select a media request priority of Low, Normal, or High from the Priority drop-down list.
4. Enter the subject of the task in the Subject field.
5. Type instructions for the task owner in the text area.
6. Select Update.

For detailed information on tasks, see Configuring Tasks.

Configure Archive Retention Expiry
Users can configure a message to be sent to the owner of an archive after the archive expires by selecting
the Archive Retention Expiry link in the Site Manager category.

You must enter your message and select a date for the notification. The system checks for any archives
that expired before that date, and the owner of the archives receives the following:
v A deletion concept in the Concept List category
v A notification e-mail

Configuring Automatic Task Generation for Archive Expiration:

Use this procedure to configure automatic task generation for archive expiration.

Procedure

1. In the Site Manager category of the Learning Portal, select the Archive Retention Expiry link to open
the Archive Retention Expiry page.

2. Select the Enable check box.
3. Select the date, time, and any recurrence of the message by selecting Schedule. The date that you

select must be after the date specified on the date metadata tag for the content. After you schedule the
delivery time, select Submit.

4. Select a task priority of Low, Normal, or High from the Priority drop-down list.
5. Enter the subject of the task in the Subject field.
6. Type instructions for the task owner in the text area.
7. Select Update.

For information on archiving content, see Archiving Content. For detailed information on tasks, see
Configuring Tasks.

Setting up Password and Login Rules
Administrators can configure rules for member passwords and the login process.

This configuration is done on the Password and Log In Rules page, which is accessed by selecting the
Password and Log In Rules link in the Site Manager category.

Configuring Rules for Passwords and Login:

Perform the following steps to configure login and password rules.
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Procedure

1. In the Site Manager category of the Learning Portal, select on the Password and Log In Rules link to
open the Password and Log In Rules page.

2. Select the Passwords expire check box to set a time limit for passwords, and enter the number of
days that you would like passwords to remain valid.

3. Select the Notify student when password is about to expire check box to warn students that their
password is about to expire, and enter the number days before the password expiration that you
would like to issue to warning.

4. Select the Set minimum length check box to require a minimum character length for passwords, and
enter the minimum length.

5. Select the Passwords must include numbers or special characters check box to require that
passwords contain at least one number. Then enter the minimum string length for special characters,
numbers, lower case letters, and/or upper case letters. There is no restriction on the types of special
characters that can be used.

6. Select the Remember old passwords check box to prevent members from reusing passwords, and
enter the number of recent passwords that you would like to remember.

7. Select the Forces users to change their password on initial login check box to require users to
change their password after they log in for the first time.

8. Enter the number of times that a member can attempt login (before they are locked out) in the
Maximum number of attempts field. An entry of zero enables an infinite number of tries.

9. In the Login Period field, specify the amount of time, in minutes, that a user can attempt to log in
before the account is locked. For example, if the Maximum number of attempts is set to 3, and the
Login Period is set to 10 minutes, then the user cannot exceed 3 login attempts in 10 minutes. After
10 minutes, the user will have another 3 login attempts to use.

10. If the maximum number of login tries is greater than zero, then you must configure lockout options.
Select:
v The Lock Account radio button to lock a member account after the maximum number of login

tries is exceeded.
v The Lock out account for length of time radio button to specify the length of lockout, then enter

the lockout time, in hours, in the corresponding field.
11. Select Update.

Locked Accounts:

When a member exceeds the number of login tries, the account is locked. The member is not allowed to
attempt another login until an administrator unlocks the account. Administrators can unlock an account
by clearing the Account Locked check box in the member account.

Unlocking a Member Account:

Use this procedure to unlock a member account.

Procedure

1. In the Member Management category of the Learning Portal, select on the name of the member whose
account you want to unlock.

2. In the Member Name section, clear the Account Locked check box.
3. Select Next.
4. Select Update.

Introduction 291



Configure Site Parameters
Administrators can configure site parameters, which allow control of things such as:
v Turning certain site features off or on.
v Assessment settings.
v Database settings.
v File mappings.

Site parameters can be accessed by selecting the System Settings link in the Site Manager category of the
Learning Portal.

For detailed descriptions of all site parms, see the Viewer and Theme Administration Guide.

Important: Many site parameters affect the overall operation of LCMS Premier and should be modified
only by an experienced site administrator.

Partition Administration Category
Use the Partition Administration category to create and manage partitions.

With partitions, content, media, and members within one LCMS Premier Content Manager can be filtered,
displaying different data for different members. This is helpful when multiple organizations within a
company share a repository.

Note: The Partition Administration category is not included in any default layouts. This category must
be added by editing member tab layouts.

For partitioning to function correctly, you must complete a process. This process is as follows:
1. Assign metadata for filtering (if you are using metadata in the filter).
2. Create the partition.
3. Assign the partition.
4. Activate the partition.

Partitioning Process Overview
Use the Partition Administration category to create and manage partitions.

With partitions, content, media, and members within one LCMS Premier Content Manager can be filtered,
displaying different data for different members. This is helpful when multiple organizations within a
company share a repository.

Note: The Partition Administration category is not included in any default layouts. This category must be
added by editing member tab layouts.

For partitioning to function correctly, you must complete a process, as follows:
v Assign metadata for filtering (if you are using metadata in the filter).
v Create the partition.
v Assign the partition.
v Activate the partition.

Assign Metadata for Filtering
Partitions are filter-based, meaning that content or members displays in a partition only if they meet
certain criteria. Content displays only if:
v The content is tagged with metadata values that match the partition filter criteria OR
v The content is not tagged with any metadata from the metadata group included in the filter criteria.
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Content is excluded only from a partition if it contains opposing metadata in the same group that is
specified in the filter criteria.

For an overview of partitioning, see Partitioning Process Overview.

Metadata Assignment:

As with any metadata, the group/tag combinations must be assigned in the Metadata Dictionary to the
objects that are tagged to reside in the partition. The content itself must then be tagged for inclusion in
the partition.

For example, if a metadata group is linked to the course level, the developer must populate the Data
view (in the Content Manager) on any courses to be displayed in the partition. The metadata values in
the Data view must also match the partition filter criteria.

New Partition Content:

When you author within a partition, the following behaviors apply:
v When new content is created within a partition, that content is automatically tagged with the

appropriate metadata. If the content is created at a level that is not supported by the partition criteria,
such as unassigned content, that content still belongs to the partition.

v When you are working in the Content Manager within any partition, the metadata for that partition is
not available in any Data views. This is to prevent developers from changing partition metadata and
deleting content from the partition.

Create a Partition
After you assign metadata for partition filtering, you can create your partition by selecting New in the
Partition Administration category and opening the Partition dialog box.

The Partition dialog box contains four tabs:
1. General
2. User
3. Data
4. Rules

For an overview of partitioning, see Partitioning Process Overview.

General Tab:

The General tab is where you enter the name of the partition, along with an optional description,
comments, or search keys that are related to the partition.

The User tab is used to assign a partition to members after it is created. See Assigning and Activating the
Partition on “Creating a Partition” on page 294 for details.

Data Tab:

The Data tab is used only to view the metadata that is assigned to the Partitions metadata category in the
Metadata Dictionary. Populating the Data tab here does not affect the partition in any way, but you can
view metadata that is used for the partition.

Rules Tab:

The Rules tab is where you define the filter that determines:
v Which content resides in the partition.
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v Which members are visible through the Member Management category.

These filters are specifically for partitioning and cannot be used throughout the rest of the Learning
Portal or Content Manager.

Select Edit on the Rules tab opens the Rules dialog box, where you can add or modify filter criteria for a
partition. The Rules dialog box contains two tabs:
1. General tab
2. Data tab

The General tab displays any partition filter criteria that is not metadata related. This criteria can include:
v General content criteria (content ID)
v General user criteria (partition and theme)

Criteria on the General tab has “and/or” relationship - that is, only one of the criteria will need to match.
General criteria is stored on the General tab even if it is created with focus on the Data tab.

The Data tab displays any partition filter criteria that is metadata related. This criteria can include:
v Content metadata criteria
v User metadata criteria

Criteria on the Metadata tab has an “and/or” relationship - that is, you can require that any or all of the
criteria must match. Metadata criteria is stored on the Data tab even if it is created with focus on the
General tab.

Note: Partition filter criteria has an “and” relationship between the General and Data tabs - that is, the
separate criteria on both tabs must both be true.

Content Filtering:

When you create a partition filter by using LCMS Premier objects as filter criteria, the options are the
same as when you are creating a content filter in the Content Manager. Filter criteria for content can be
created only by using metadata as the Property Type.

User Filtering:

When the Object Type selected for the filter criteria is User, the following Property Types are available:
v General
v Metadata

If a Property Type of Metadata is selected, then the criteria for users is based on member metadata that is
assigned to the Additional Information tab of member accounts. However, if a Property Type of General
is selected, then the criteria can be based on the active partition for a member, or an active member
theme.

Creating a Partition:

Use this procedure to create a partition.

About this task

Note: Before you create a partition, you need the filtering metadata that is linked to the appropriate
objects in the Metadata Dictionary.
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Procedure

1. In the Partition Administration category of the Learning Portal, select New to open the Partition
dialog box.

2. Enter a label in the Label field. This is the name of the partition.
3. Select the Data tab and select Yes when prompted to save changes. Any metadata that is linked to the

Partitions metadata category appears on the Data tab. While the metadata is not required to be visible
on the Data tab, it can be helpful in keeping track of the metadata used for the partition.

4. Select the Rules tab and select Yes when prompted to save changes. Select Edit to create a new filter.
After you create a filter, select OK.

Note: For a metadata-based partition to be effective, the metadata criteria that are defined in the
filter must match the metadata values on the appropriate content or users.

You can make any partition the default partition for new members by selecting the Default radio
button next to the partition link.

Assign and Activate the Partition
After you create the partition, you can assign the partition to members and activate it for use.

For an overview of partitioning, see Partitioning Process Overview.

Assign a Partition:

A partition must be assigned to a member before it can be activated. There are two locations where
partitions can be assigned:
1. User tab
2. Member Management category

User Tab:

Use the User tab to assign the partition to members. You can add members by selecting Add and by
using the Search dialog box, and deactivate members by selecting the appropriate check boxes and
selecting Delete. By assigning a partition on this tab, you can assign multiple members to one partition.

Member Management Category:

Partitions can also be assigned to members through the Member Management category.

In the Partition Information section of each member account, you can select partitions and use the left
and right arrows to assign or unassign partitions. When you assign partitions through the Member
Management category, you can assign multiple partitions to one member.

Note: When a member with no active partitions is assigned to a partition, that partition automatically
becomes active.

Assigning a Partition:

Use this procedure to assign a partition to one or more members.

Procedure

1. To assign a single partition to one or more members, select on the partition label in the Partition
Administration category. Select the User tab; then, select Add to open the Search window and find
members. After all members are added, select OK.
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2. To assign one or more partitions to a single member, select the name of the member in the Member
Management category to open the account. In the Partition Information section, select an available
partition on the left, then select the right arrow button to move it to the Assigned Partitions box. You
can select and assign multiple partitions at the same time by holding down the Ctrl key and selecting
each selection. When you are finished assigning the partitions, select Next, then Update.

Activate a Partition:

A partition must be activated in order for it to work. There are two locations where partitions can be
activated:
1. Personal Information category
2. Member Management category

If you have more than one partition that is assigned to you, a drop-down list that contains all assigned
partitions automatically appears in the Personal Information category. You can activate a partition by
selecting it from this drop-down list.

Member Management Category:

Partitions can also be activated through the Member Management category. In the Partition Information
section of each member account, you can select a partition from the Active Partition drop-down list.
Only assigned partitions are available from the Active Partition drop-down list.

Note: To deactivate all partitions, you must select None from the Active Partition drop-down list. This
is the only place where all partitioning can be deactivated.

Activating a Partition:

Learn how to activate a partition.

Procedure

1. In the Member Management category, select the name of the member in the Member Management
category to open the account.

2. In the Partition Information drop-down list, select the partition that you would like activated from
the Active Partition drop-down list.

3. Select Next.
4. Select Update.

Task Management
Tasks are events that are created and assigned for completion by the creator or other Learning Portal
members. Tasks can be attached to specific content, and provide a means by which content maintenance
can be scheduled and managed.

Configure Concepts
When a concept is created, the concept can be attached to specific LCMS Premier content. All members to
whom the concept is assigned are responsible for the concept in some capacity.

There are two areas where concepts can be created:
1. Concept List category
2. Concept views in the Content Manager
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Concept List Category:

Concepts are generally created in the Concept List category. Concepts are attached to specific LCMS
Premier content, and all members to whom the concept is assigned are responsible for the concept in
some capacity.

Any concept in the Concept List category can be modified by the concept owner by selecting the link.
You can filter concepts in the list by specifying Priority, Status, Object, and Owner, and selecting Search.

Note: The Concept List category is not included in any default layouts. This category must be added by
editing member tab layouts.

Concept View:

Concepts can also be added in the various Concept views of content throughout the Content Manager.

By adding concepts, developers can create concepts for content that they are working on. Concept views
are available for all LCMS Premier authoring objects in the Objects view, External Objects Search view,
and Media Search view.

Concept Creation:

You create concepts by selecting Add in the Concept List category or by selecting Create Concept from
the Details pane Options menu in the Concept view for an object in the Content Manager. The Concept
dialog box contains the following tabs:
v General tab
v Participants tab

In the General view, the user enters a title for the concept, a start date and due date, and a priority for
the concept. The user must also select the content for which this concept is being created. This is done by
selecting the Browse for Object button, which is located to the right of the Content field, and searching
for the content.

Concept Participants:

There are two types of participants for concepts:
1. Owner - The owner of a concept is responsible for doing the concept, and is responsible for updating

the status of a concept by clicking the concept link in the Concept List category. The owner can also
modify other concept properties in this way, including reassigning the concept to a new owner. All
concepts must have at least one owner - if a concept is given more than one owner, then the concept
is duplicated so that each member owns their own concept.

2. Manager - The manager of a concept is responsible for continually viewing the status of a concept to
ensure that it is successfully completed. Managers have read-only access to concepts and cannot
modify concept properties.

Note: Of the default platform roles, only administrators can view all concepts in the Concept List
category. Other roles can view concepts only where the member is either the owner or manager.

Creating a Task:

Use this procedure to create a task.

Procedure

1. In the Task List category of the Learning Portal, select Add to open the Task dialog box. Or, if in the
Task view of the Content Manager, select Create Task from the Details pane Options Menu.
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2. In the General tab, type the title of the task in the Subject field.
3. Select Browse for Object to open the Search window. Select the object type to which this task is to be

attached, and select Next. Use the General, Path, Data, and Task tabs to narrow your criteria. After
you select the appropriate content, select OK in the Search window.

4. Use the calendars to select a Start Date and End Date for the task.
5. Select a Task priority from the Priority drop-down list.
6. Type a description, or instructions, for the task in the Description field.
7. Select the Participants tab. As the creator of the task, your name automatically appears (you can

delete yourself from this task, if necessary). Add members to the task as needed by selecting the Add
button and finding members with the General and Data tabs. After you add the required members,
assign each member as a task owner or manager. Remember every task must have at least one owner.

8. Select OK. The task now appears in the Task List category and appropriate Task tab for the owner,
manager, and administrators.

Note: The “Send email when a system message is created them” parm in the Site Manager category
controls whether a message is sent to a user, through the Message Category, when a task is generated
or content expires.

Tasks can be automatically generated whenever a media request is made. For more information, see
Configuring a Media Request Notification.

Use Concepts
After a concept is created, it can be carried out, monitored, and modified as necessary. Concepts can also
be deleted, and you can search for a specific concept or view concept history.

Message List Category:

Whenever a concept is assigned to you, whether you are the owner or manager of the concept, a message
is delivered to you through the Message List Category.

The message automatically specifies whether you are the owner or manager of the concept, or whether
one of your concepts was reassigned to another member. An email can also be delivered to the message
recipient so that they are aware of the message without being logged in to the Learning Portal. For the
email to be generated, the “Send email when a system message is created” site parm in the Site Manager
category must be set to true.

Note: The Message List category is not included in any default layouts. This category must be added by
editing member tab layouts.

When a message link is selected, the Message Detail dialog box appears. It contains read-only properties
of the concept, and the link to the concept properties.

Messages can be automatically generated for expired content. For more information, see Configuring
Content Expiry.

Figure 77. Message Detail Dialog Box
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Concept History:

As soon as a concept is created, the history for that concept is tracked. When any property of a concept is
modified, a history record is recorded.

When the Concept dialog box is accessed by selecting the concept link, you can view past changes to the
concept on the History tab.

Learning Portal: Learning Management

Learning Paths
Administrators can create learning paths that require students to complete courses and assessments in a
specific order, with predetermined conditions.

Create and Manage Learning Paths
Learning paths are created in the Learning Path Administration category by selecting Add.

When you are creating a learning path, each object that is chosen is a node. By using the drop-down lists
in the Type column, you can make each node optional, mandatory, or require a passing grade to continue
to the next node.

Adding a Learning Path:

Learn how to add a learning path.

Procedure

1. In the Learning Path Administration category, select Add.
2. Enter the name of the learning path in the Label field.
3. Enter a description of the learning path in the Description field. This text displays at the top of the

Learning Paths category.
4. Choose the first node from the Node drop-down list.
5. Select the type of node from the Type drop-down list.
6. Select Update.
7. To add a node, repeat Steps 4 - 6.
8. Select Close to return to the Learning Path Administration category.

Enroll Members in a Learning Path
After a learning path is created, you can enroll students in it by selecting the Enroll link and opening the
Member Enrollment page.

By default, the fields available in the Selection Criteria frame are Role, Student ID, Last Name, First
Name, Email, and Company. If more fields are required, you must create them as metadata in the Users
group in the Metadata Dictionary and set them to show in the Learning Portal.

Default Fields:

By default, the fields available in the Search Criteria frame are Role, Student ID, Last Name, First Name,
Email, and Company. If more fields are required, you must create them as metadata in the Users group
in the Metadata Dictionary and set them to show in the Learning Portal.

Enrolling Members in a Learning Path:

Use this procedure to enroll members in a Learning Path.
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Procedure

1. In the Learning Path Administration category, select the Enroll link of the learning path in which you
wish to enroll members.

2. Select criteria by using the fields of the Search Criteria frame to search for members to enroll.
3. Select Search.
4. The members that are found as the result of your search display in the Member frame. Select the

check boxes of the members you want to enroll, or select Select All to select the check boxes of all
members displayed.

5. Select Save Members.
6. Select Close to return to the Learning Path Administration category.

Tip: Clear the Search Criteria frame before you enter criteria for a new search by selecting Clear.

Configuring Selection Criteria to Auto Enroll New Members:

Use this procedure to configure selection criteria.

Procedure

1. In the Learning Path Administration category, select the Enroll link of the learning path in which you
wish to enroll members.

2. Select the Auto Enrollment check box.
3. Select criteria by using the fields of the Search Criteria frame.
4. Select Save Criteria. Any new Learning Portal members who match this selection criteria can access

this learning path.

Tip: Select Reload to load the last selection criteria saved.

Access Learning Paths
The Learning Paths category provides you with an interface for navigating through the learning paths in
which you are enrolled.

Learning paths are composed of nodes (courses, assessments) that you might or might not be required to
complete to proceed. This category also shares information about your access history to content.

For information about learning path enrollment, see Enrolling Members in a Learning Path

Node Types:

When a learning path is created, it is determined whether a node is mandatory or optional for learners as
they progress through the learning path.

Since nodes include courses and assessments, you can also require that learners pass an assessment
before they progress. Learners can determine the type of node by the node icon color.

Table 35. Learning Path Node Types. The following table describes the available node types for learning paths.

Item Description

Mandatory (blue)
Nodes (courses or assessments) which are required; learners must
complete before the next node becomes available.

Optional (yellow)
Nodes (courses or assessments) which are not required to complete the
learning path, but which have an added value to the learner.

Pass
Nodes (courses or assessments) which require a passing score; the passing
score is determined by the course developer. Learners must pass before
the next node becomes available.
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Viewing Content:

Perform the following steps to view content in a learning path.

Procedure

1. In the Learning Paths category, select a learning path from the Select drop-down list.
2. Select Find. The modules of the first node in the learning path are listed.
3. Select the module containing the learning object that you would like to view.
4. Select the learning object to launch the content.

View Learning Path Progress
The My Learning Paths category provides an interface for viewing all Learning Paths in which you are
enrolled and all Learning Paths that are created in your Learning Portal.

A benefit of seeing learning paths other than the ones in which you are enrolled is that you can
determine the completion progress of your Learning Path if you were enrolled.

An "E" in the Enrolled column indicates that you are enrolled in the Learning Path. If a node has a gray
background, then that node is not accessible until a prerequisite is completed.

For an explanation of node types, see Accessing Learning Paths.

Member Management Category
The Member Management category enables administrators to create and configure member accounts, and
manage their assigned courses and Learning Portal layout.

Add New Members
Since administrators are responsible for the management of Learning Portal members, a few decisions
need to be made before you add new members.

These considerations are as follows:
v Methods for adding new members
v Layouts that are assigned to new members

Methods for Adding New Members:

There are two methods for adding members to a theme of a Learning Portal:
v Members adding themselves
v Administrators adding members

Members Adding Themselves:

Members can add themselves to a theme of a Learning Portal by selecting the Not a Member Yet? link
when prompted to log in.

Figure 78. My Learning Path Category
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Member Registration Page:

When a user creates their own member account from the login screen, they see the following Member
Registration page. The page contains two tabs:
1. Member Information tab
2. Additional Information tab

The Member Information tab requests information such as name, password, and address. Users are only
required to complete the required information on the Member Information tab to successfully create an
account.

Character Limits:

When you enter member information, there is a limit to the number of characters that can be used. The
following table details the maximum number of characters that you can use for each of the fields on the
Member Information tab.

Table 36. Member Field Character Limits. The following table displays the character limits for various member
account fields.

Field Maximum # of Characters

First Name 25

Middle Initial 1

Last Name 36

Password 16

E-mail 50

Company 50

Address_1 50

Address_2 50

City 50

State/Province 50

Zip/Postal Code 15

Country 35

Phone 25

Fax 25

Note: The following special characters cannot be used in member IDs: [! # $ % ^ & * ( ) + = ` ~ { } | \ \
: ; < > , ? ' "]. Spaces also are not permitted in member IDs and passwords. The Additional Information
tab enables users to enter information that can be used for advanced member searches and
personalization.

Administrators Adding Members:

Administrators can add members to a theme of a Learning Portal by selecting the Add link in the
Member Management category. When you add a member in this way, the Member Registration page
enables administrators to enter more member details than through the login page.

The following additional details can be configured:
v Roles - Administrators can assign one or more available roles to the member, and can activate a role.

When a role is active and more than one role is assigned, members can toggle between roles through
the Personal Information category.
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v Partitions - Administrators can assign one or more available partitions to the member, and can activate
a partition. When a partition is active and more than one partition is assigned, members can toggle
between partitions through the Personal Information category.

v Substitution Variable Profiles - Administrators can assign one or more available substitution variable
profiles to the member, and can activate a profile. When a profile is active and more than one profile is
assigned, members can toggle between profiles through the Personal Information category.

Adding a Member:

Learn how to create a member account.

Procedure

1. In the Member Management category, select the Add link to open the Member Registration page.
2. Enter an ID in the Member ID field, and enter the first and last name of the member in the

appropriate fields.
3. In the Role Information section, select the role from the Available Roles multi-select list that you

want to be available to the member, and select the right arrow button to move these roles to the
Assigned Roles list box. Select the role that you would like activated from the Active Role
drop-down list.

4. In the Partition Information section, select the partition from the Available Partitions multi-select
list that you would like to be available to the member, and select the right arrow button to move
these partitions to the Assigned Partitions list box. Select the partition that you would like activated
from the Active Partition drop-down list.

5. In the Substitution Variable Profile Information section, select the substitution profile from the
Available Profiles multi-select list that you would like to be available to the member, and select the
right arrow button to move these profiles to the Assigned Profiles list box. Select the profile that
you would like activated from the Active Profile drop-down list.

6. Enter a password for the member in the Password field.
7. Enter the password again for verification in the Re-enter Password field.
8. Enter the email address for the member in the E-mail field.
9. All other fields on this page are optional. When you finish entering the information, select Next to

go to the Additional Information tab.
10. Complete the informational fields on this tab (optional) and select Add.

Assign Courses to a Member
If a role has the No Enrollment Required check box cleared on the Action tab of that role in Role
Administration, the courses must be assigned to any members with that role.

The Member Course Administrator page is accessed by selecting the link in the Courses column of the
Member Management category that is next to the appropriate member. The link displays as two numbers
that are seperated by a backslash. For example, if the link displays “0/3” that means zero courses are
assigned out of 3 available.

The Member Course Administrator page is where you select courses for the member. The ID of the
member to whom the courses selected are assigned displays at the top of the page.

The Member Course Administrator window provides you with an easy way to copy courses that are
assigned to one member to another member or all members of the Learning Portal. This window is
launched by selecting Copy on the Member Course Administrator page.

Assigning Courses to Members:

Perform the following steps to assign courses to a member.
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Procedure

1. In the Member Management category, select the link in the Courses column for the appropriate
member to open the Member Course Administrator page.

2. Select the check box next to each course that you would like to add to the member curriculum.
3. Select Update.
4. To copy this course list to other members, select Copy to open the Member Course Administrator

window.
5. Select the check box beside each member to which you would like to add the selected courses, or

select Select All to copy the courses to all members.
6. Select Update.

Search for Members
As an administrator, you can modify member accounts through the Member Management category. The
following features are suited to this purpose:
v Member search
v Advanced member search
v Modifying account information

Search:

The number of members in a theme can be large. When this is the case, administrators can narrow the
list with search criteria to find the appropriate members.

Use the Name field to enter the first name, last name, or ID of a member whom you would like to find.

Use the Role drop-down list to search for members by assigned role, and includes all roles available in
the Role Administration category. Use the Theme drop-down list to search for members by assigned
theme, and the Partition drop-down list to search for members by active partition.

The Search button begins a search of members based on the search criteria.

The Collapse link collapses the member list to show only your account.

Performing a Member Search:

Perform the following steps to search for a member.

Procedure

1. Locate the Member Management category. To search by name, enter the first name, last name, or ID of
the member you would like to find in the Name field.

Note: For a list of all member accounts, leave the Search field blank.
2. To search by member role, select a role from the Role drop-down list.
3. To search by member theme, select a theme from the Theme drop-down list.
4. To search by active partition, select a partition from the Partition drop-down list.
5. Select Search.

Note: After a search is complete, the member accounts can be sorted by selecting the links at the top
of the following columns:
v Member Name
v Member ID
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Advanced Search:

The Advanced Search feature is accessed by selecting the Advanced button in the Member Management
category. Use this feature to do an advanced member search with metadata.

Performing an Advanced Member Search:

Perform the following steps to do an advanced member search.

Procedure

1. In the Member Management category, select Advanced to open the Advanced Search page.
2. If you would like to narrow your search by name, enter the member first name, last name, or ID of

the member in the Search field.
3. If you would like to narrow your search by role, select a role from the Role drop-down list.
4. Select the:
v Match on any? (OR) radio button to return search results for member accounts that contain any of

the metadata that is used for the search query.
v Match on all? (AND) radio button to return search results for member accounts that contain all of

the metadata that is used for the search query.
5. Enter the metadata by which you are defining your search in the fields provided.

Note: For help with adding metadata fields to the Advanced Search page, see Assigning Metadata
for Use in LCMS Premier.

6. Select Find. The Advanced Search page closes, and the search results appear in the Member
Management category.

Note: After a search is complete, the member accounts can be sorted by selecting the links at the top
of the following columns:
v Member Name
v Member ID

Customizing Member Layouts
When a member account is created, a default layout is applied for their role. However, administrators can
customize the layout for each member, and copy layouts to members and roles.

Layouts Assigned to New Members:

Member layouts are not associated with member roles. Whenever a new member is created, regardless of
the role that is assigned, they are assigned the layout of the member that is named“default, (theme)”.

If the theme is bluesteel, the default member is named Default, bluesteel. The layout of the default
member is assigned to any new member of a theme regardless of the method of adding them.

For example, the layout that is assigned to the Default member might vary depending upon the needs of
most of the members of a Learning Portal. For example, on a Production server whose majority of users
are learners, the Default member layout should reflect the needs of learners. On a Development server
whose majority of users are developers, the Default member layout should reflect the needs of
developers.

Standard Members:

There are five standard members in the bluesteel theme.
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The tabs and categories that displays in the layouts of these members reflect the definition of the member
role and its abilities. The members can be moved to a new theme so that their layouts can be edited and
transferred to members of the new theme.

The five member accounts to which member layouts are assigned are as follows:
1. st_platform_admin - platform administrator
2. st_site_admin - site administrator
3. st_learn_port_admin - learning portal administrator
4. st_developer - developer
5. st_learner - content reviewer, editorial reviewer, learner

The layouts that are assigned to these members are there to serve as a suggestion. Layouts can be
configured to meet the needs of the members in your enterprise.

Note: Since learner, content reviewer, and external reviewer all share common rights, their basic layouts
are the same. Regarding standard member accounts in the bluesteel theme, those three roles are
combined into the st_learner member layout.

Member Layout Page:

Member layouts can be customized on the Member Layout page, which is accessed by selecting the Edit
link in the Layout column for the appropriate member.

The Member Layout Page is an provides you with an easy way to edit, add, and delete tabs, and to copy
a member's interface layout to another member or all members of the Learning Portal.

Modifying a Member Layout:

Perform the following steps to modify a member layout.

Procedure

1. In the Member Management category, select the Edit link in the Layout column to open the Member
Layout page.

2. For the current tab, select the Access check box beside each category to which you would like the
member to have access.

3. Select the L (left) or R (right) radio button for each category, depending on which side of the page
you would like each category to appear.

4. Order your categories by selecting a number for each from the Sequence drop-down list. This is the
order in which the categories appear from top to bottom through the Learning Portal.

5. Configure the categories for your remaining tabs by selecting the tabs at the top left and repeating
Steps 2 through 4.

6. Select Update.
7. Select Back.

Adding and Configuring Member Layout Tabs:

Learn how to configure Learning Portal tabs for a member.

Procedure

1. In the Member Management category, select the Edit link next to the appropriate member to open the
Member Layout page.

2. Select Edit Tabs to open the Member Tab Editor page.
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3. In the empty field, enter a name for the tab.
4. Select Update.
5. Repeat Steps 3 and 4 as necessary.
6. Configure the order of the tabs by selected a number for each tab from the Order drop-down list.
7. Select Back.

Deleting a Tab from a Member Layout:

Perform the following steps to delete a tab from a member layout.

Procedure

1. In the Member Management category, select the Edit link in the Layout column to open the Member
Layout page.

2. Select the Edit Tabs tab to open the Member Tab Editor page.
3. Select the Delete check box next to the tabs that you would like to delete.
4. Select Delete.
5. Select Back.

Layout Transfer:

You can transfer a layout to one or more members, or any default roles, by selecting either the Transfer
to Member or Transfer to Role button on the Member Layout page.

Note: Member layouts can be copied to the members selected only. Layouts cannot be copied to a
default member account (for example, st_developer) and propagated across all member accounts with
that role. When you transfer a member layout to one of the default roles, the layout is updated for all
members that are actively using that role. If the role is assigned to the member, but not active, the layout
is not updated.

Copying a Member Layout:

Do the following steps to copy a layout.

Procedure

1. In the Member Management category, select the appropriate Edit link in the Layout column to open
the Member Layout page.

2. Select one of the following choices:
v Transfer to Member to copy the layout to one or more member accounts.
v Transfer to Role to copy the layout to all members of a selected role.

3. Select Go to return all members/roles, or enter a name or member ID (for members) or a role (for
roles) and select Go.

4. Select the check box beside each member/role to which you want to copy the layout, or select the top
check box to select all members/roles.

5. Select Transfer.

Assessment Certification
Administrators can configure certification for assessments. This is helpful if you need to recertify learners
for certain skills. Use this enhancement to do the following actions:
v Reset the number of tries for a particular assessment.
v Restrict certified students from taking an assessment for a specified time period.

The assessment certification feature is disabled by default, and must be activated with site parms.
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Table 37. Assessment Certification Parms. The following table describes the site parms required to enable
assessment certification.

Parm Label Parm Group Parm Description Possible Values

Assessment
Certification Flag
(true/false)

Site Manager category
Turns the assessment certification
feature on and off

v True

v False - default

Assessment
Certification Duration
(number of months)

Site Manager category
Determines the time, in months, in
which a certification expires

Number greater than zero

When the certification feature is turned on, the following appear:
v Assessment Maintenance column in the Member Management category
v Schedule Assessment Maintenance Concept link in the Site Manager category.

When the feature is turned on, the Assessment Maintenance column appears in the Member Management
category

Each member is assigned an Assessment Maintenance link, in the form of an icon. When this icon is
selected, the Assessment Maintenance page loads. You can customize the certification settings for each
assessment available to the learner. Refer to the following image for descriptions of the components of
the Assessment Maintenance Page.

After the certification settings are configured, the assessment certification maintenance concept must be
run in order for the changes to take effect. To run the concept, select the Schedule Assessment
Maintenance Concept link to open the Concept Scheduling dialog box and schedule the concept.

After the certification concept is run, the certification settings remain active until the certification feature
is turned off. With the certification feature off, assessments function normally, with the number of tries
specified in the General view of the assessment.

Note: When a user is certified for an assessment for the amount of time that is specified in the
"Assessment Certification Duration" parm, the Certified check box on the Assessment Maintenance Page
clears when the maintenance concept is run.

Changing the Assessment Settings for a Member:

Perform the following steps to change assessment settings.

Procedure

1. In the Member Management category of the Learning Portal, select the button in the Assessment
Maintenance column that corresponds with the member whose assessment setting you want to
modify. The Assessment Maintenance page appears.

2. To reset the number of tries for an assessment, type a number in the Set Tries field for the
assessment. This number cannot exceed the number of tries in the General view of the Assessment
Object.

3. To certify the member for an assessment, select the Certified check box next to the assessment. To
require the member to re-certify for an assessment, clear the Certified check box.

4. Select Update.

Note: The new settings do not become active until you run the assessment maintenance task.
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Running the Assessment Maintenance Task:

Perform the following steps to run assessment maintenance.

Procedure

1. In the Site Manager category of the Learning Portal, select the Schedule Assessment Maintenance
Task link. The Scheduling dialog box appears.

2. Select Start Date and select the date (from the calendar) on which you would like to start the cache.
3. Use the Hour, Minute, and AM/PM drop-down lists to select the time of day to start the cache.
4. To run this task only once, select the After radio button and proceed to Step 6.
5. If you would like this cache to recur regularly, select the Weekly, Daily, or Monthly radio button,

depending on your need. If you select the Monthly radio button, the End of Month check box
becomes enabled. Selecting this check box causes the cache to run at the end of the month only. Select
End Date and select the date (from the calendar) on which you would like to end the cache
recurrences.

6. Select Submit.
7. Select Start. The Process Monitor appears, and your assessment maintenance task appears in the

queue with a Status of requested. To see the most current version of the status, select the refresh every
check box and select a time frame from the seconds drop-down list. When the status changes to
running, your process is running. When the status changes to completed, the assessment settings are
applied.

SuccessFactors Target Configuration Category
This feature provides LCMS users with the ability to publish courses directly to the SuccessFactors LMS.

LCMS content developers can now publish courses directly from the LCMS Web Authoring environment
to the SuccessFactors LMS. The publishing process is done through the LCMS Publishing Wizard, which
has been extended to support the SuccessFactors publish type.

The Publishing Wizard can be invoked in three ways:
v By selecting the SuccessFactors link in the Export Generators Tab in the Learning Portal
v From a course in Web Authoring by selecting the Export option in the context-sensitive menu, and then

selecting For E-learning > SuccessFactors
v From publishing profiles in Web Authoring

Before web authors can publish a course to the SuccessFactors LMS, an administrator must do the
following set-up:
v Enable the SuccessFactors category so that it appears in the Web portal, and assign user access to it

(that is, who can configure SuccessFactor targets).
v Configure the SuccessFactor targets. The SuccessFactor targets are STFP servers where the LCMS

published content is stored. When configured, the SuccessFactors targets are added to the Destination
drop-down list on the Rules screen in the Publishing Wizard.

Enabling the SuccessFactors Category
The following procedure describes how to enable the SuccessFactors category in the LCMS.

Procedure
1. Go to Administration Tools > > Portal Rules > Theme Editor.

2. Search for a label that is named Display SuccessFactors servers setup Configuration. By default, the
value for this label is set to “false”.

3. Select the link to open the label and change the value to “true” in the Value text box. After the value
is set to true, the SuccessFactors servers setup configuration becomes available in the LCMS.

Introduction 309



4. Choose the role that you want to give access to the SuccessFactors portal category (this role is given
the ability to configure SuccessFactor targets), and where you want it to display in LCMS (Learning
Management) by going to Learning Management > Member Management and selecting a role.

5. Select Edit for the role to open the Member Layout page.
6. Choose where in the LCMS where you want the SuccessFactor target configuration setup to display

(for example, Learning Management) by selecting a tab and checking the SuccessFactors Target
Configuration box.

7. Select a sequence from the Sequence drop-down list.
8. Select Update to save your changes.
9. You can verify that the SuccessFactors Target Configuration portal category is displayed where you

want it to be by going to the location you selected on the Member Layout page.

Configuring a SuccessFactors Server
To configure a SuccessFactors server:

Procedure
1. In the SuccessFactors Target Configuration category, select Add. The SuccessFactors Target

Configuration page opens.
2. Complete the page as follows:

Field Description

Label The name of the SuccessFactors SFTP server. The name
that is displayed in the Destination drop-down list on
the Rules page of the Publishing Wizard (required field).

Description Provide additional information about the SuccessFactors
server.

Tenant ID Identifies an instance on the SuccessFactors server. The
Tenent ID is provided by the client and becomes a part
of the file name (required field).

SFTP url The URL/IP Address of the SuccessFactors server
(required field).

Protocol The file transfer protocol: either SFTP or FTP. The default
is SFTP.

Port Number Corresponds to the selected file transfer protocol. SFTP =
22, FTP = 21.

User Name Your SuccessFactors server user name (required field).

Password Your SuccessFactors server password (required field).

Home Directory The directory on the SuccessFactors SFTP server where
you want the LCMS to publish the data (required field).

3. Configure the following two parameters in the Item Connector on the SuccessFactors server:
v This parameter allows the publish connector to accept more than one object that is published from

LCMS for each cycle.
v connector.input.file.name.tenant.suffix.enable=true

This parameter ensures that published files are explicitly targeted to, and imported on, a client's
instance of the SuccessFactors SFTP server.

Configure SuccessFactors Publishing Metadata
The configuration of SuccessFactors publishing metadata is very important to the success of a course
being published on the SuccessFactors LMS. You should be aware of the following considerations:
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v The label of the metadata, for example Item Type, must be configured to match the Header Name for
that field in one of the three files that are being transferred to the SuccessFactor LMS. The Header
Name is used to move data from the LCMS to the SuccessFactors LMS.

v You must provide values for all the fields in the SuccessFactors Publishing Metadata for a course. The
fields are mandatory but the LCMS does not currently enforce the mandatory requirement (although
some data validation occurs such as entering a value for the “Contact_Hours” field that is not in the
range of 1-99 a message that identifies the issue appears in a log file), so it is up to the user to make
sure that all the fields have values.

Note: If any values are missing, the publishing process still starts but does not complete on the
SuccessFactors LMS.

v The values in a SuccessFactors metadata field drop-down list must match the available values in the
corresponding SuccessFactors instance. You can verify that the values are correct by logging in to a
SuccessFactors instance and going to LMS Admin > References > Learning and select a field and
search for all references for that field.
The values that are listed for the field you selected should be the same values that are displayed in the
drop-down list for the field in the LCMS authoring environment. For example, if the “Item Type”
SuccessFactors Publishing metadata field shows two values:“ Brief” and “Course”, then those same
values should be included among the references for the “Item Type” field on the Reference page in the
SuccessFactors instance.

v The “Item Type” and “Online Status” SuccessFactors Publishing metadata fields have a dependency;
therefore, the values for both fields should match. For example, if you select Brief from the Item Type
drop-down list in the LCMS, you must also select Brief in the Online Status drop-down list.
Again, you can check the validity of the values in the metadata drop-down lists by logging in to an
SuccessFactors instance, searching for the field, and confirming that the value “Brief” is included
among the references. Selection of a value in the metadata drop-down list that does not correspond to
a reference value can cause the publish to fail.

Publishing a Course to the SuccessFactors LMS
The SuccessFactors publishing process involves publishing three text files with some additional
information that is configured as metadata. The three files are described later in this topic.

Procedure
1. In the LCMS authoring environment, go to the course that you want to publish to the SuccessFactors

LMS.
2. In the context-sensitive menu, select Export > For E-Learning > SuccessFactors. The Publishing

Wizard opens.
3. On the Rules page, select a viewer, a theme, and then select a SuccessFactors target that was

configured earlier from the Destination drop-down list.
4. Select Next.
5. On the Select Schedule page, choose whether you want to schedule the task to run it immediately.
6. On the Confirmation page, confirm your selections in the Publishing Wizard.
7. Select Finish. The Process Monitor opens and shows two tasks for the published course along with

their status: CourseTitle-export and CourseTitle-publish.
The CourseTitle-export task creates the three export text files and flags validation issues to a log file.
The CourseTitle-publish task starts after the export task completes, and copies the following files to
the SuccessFactors target:
v item_data_tenentID.txt

v content_module_data_tenentID.txt

v item_module_data_tenentID.txt
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Note: You can manually connect to the SuccessFactors SFTP server and open a folder that is named
“incoming” to verify that the three files were transferred. The folder also contains a README file.

Checking the SuccessFactors Connector Status
After a course is published from Web Authoring to the SuccessFactors LMS, users can check the
processing status of the SuccessFactors connector.

Procedure
1. Open an instance of the SuccessFactors LMS and go to LMS Admin > System Admin and select

Connectors in the navigation panel.
2. Scroll through the list of connectors and select Item Connector.
3. On the Item Connector page, view the status for Last Job Execution and Next Job Execution. By

default, the Item Connector is scheduled to run every hour.
4. Select View Results for the Item Connector to open the Item Connector Results page.
5. Check the status for the published course in the Completed Status column. A successful completion

status displays OK-SUCCESS. To view more information about the completion status, select View
Logs to open the Connector Log Details page.

6. Check the status for item_data_tenentID.txt, content_module_data_tenentID.txt, and
item_module_data_tenentID.txt. Each text file should display a STARTED and FINISHED status.

Note: Any errors that occur during the processing of the three files also are displayed on
theConnector Log Details page.

7. You can verify that the published course is on the SuccessFactors LMS instance by going to LMS
Admin > Content and search for the course that was published by entering all or some of the course
title in the Title field, and selecting a “search by” option in the drop-down list. If the course was
successfully published on the SuccessFactors LMS instance, it is displayed in the search results on the
page, displaying its GUID in the Object ID column, and the name of the course in the Title column.

Assigning Users and Launching the Published Course

Procedure

Role Administration Category
The Role Administration category enables administrators to configure feature and member access
permissions for preconfigured roles and create and configure new roles.

Create Roles
Roles are created by selecting New in the Role Administration category and opening the Role dialog
box. The Role dialog box contains six tabs:
v General
v User
v Data
v Action
v Status
v Role Access

General Tab:

The General tab is where you enter the name of the role, along with an optional description, comments,
or search keys that are related to the role.

The User tab is used to assign a role to members after it is created. See Assigning and Activating Roles
for details.
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Data Tab:

The Data tab is used only to view the metadata that is assigned to the Roles metadata category in the
Metadata Dictionary. Populating the Data tab here does not affect the role, but enables the viewing and
tracking of metadata that is used for this role.

Action Tab:

The Action tab is the heart of role administration. The Action tab is where you define the access
privileges for a role. Role actions are divided into five main categories:
1. Authoring Privileges
2. Data Export Privileges
3. Delivery Privileges
4. Export Generator Privileges
5. Portal Global Privileges

To assign privileges to a role, expand the treeview and select the check box next to each action that you
want to belong to the role. Selecting the check boxes for higher levels in the treeview will allow you to
later see in which general areas the role has privileges.

Role Access Tab:

Use the Role Access tab to determine which roles you have access to, and which roles have access to your
current role.

The Role Access tab determines the members that displays in certain areas, including:
v The member accounts visible in the Member Management category (works with any active user

partition).
v The members available when you transfer a member layout.

Creating a Role:

Use this procedure to create a role.

Procedure

1. In the Role Administration category of the Learning Portal, select New to open the Role dialog box.
2. Enter a label in the Label field. This is the name of the role.
3. Select the Action tab and select Yes when prompted to save changes. Expand the treeview to its

lowest levels and select the check boxes next to the actions that you would like assigned to the role.
4. Select the Status tab and select Yes when prompted to save changes. Select the check box for the

status that you want this role to have access to in the Content Manager and Learning Portal. Also,
you can select the radio button next to the status that you would like to be the default status for new
content.

5. Select the Role Access tab and select Yes when prompted to save changes. Select the check boxes next
to the roles that you want the selected role to be able to access. Also, select the check boxes next to
the roles that you want to be able to access the current role.

6. Select OK.
Use the Status tab to set the status to which members with this role have access in the Content
Manager and Learning Portal. For example, if the check boxes for Development and Production are
selected, then a member with that role can set courses in the Content Manager to Development or
Production (if they have authoring privileges), and that member can view courses in the Learning
Portal that are set to Development or Production.
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Assign and Activate Roles
After a role is created, the role can be assigned to members and activated for use.

Assign a Role:

A role must be assigned to a member before it can be activated. There are two locations where roles can
be assigned:
1. User tab
2. Member Management category

User Tab:

Use the User tab to assign a role to members.

You can add members by selecting Add and by using the Search dialog box, and deactivate members by
selecting the appropriate check boxes and selecting Delete. On the User tab, you can assign multiple
members to one role.

Member Management Category:

Roles can also be assigned to members through the Member Management category.

In the Role Information section of each member account, you can select roles and use the left and right
arrows to assign or unassign roles. When you assign roles through the Member Management category,
you can assign multiple roles to one member.

Note: When a role is assigned through the Member Management category, it is automatically activated.

Assigning a Role:

Use this procedure to assign a role to members.

Procedure

1. To assign a single role to one or more members, select on the role label in the Role Administration
category. Select the User tab, then select Add to open the Search window and find members. After all
members are added, select OK.

2. To assign one or more roles to a single member, select the name of the member in the Member
Management category to open the account. In the Role Information section, select an available role on
the left. Next, select the right arrow button to move it to the Assigned Roles box. You can select and
assign multiple roles at once by holding down the Ctrl key and selecting each selection. When you are
finished assigning the roles, select Next, then Update.

Activate a Role:

A role must be activated in order for it to take effect. There are two locations where roles can be
activated:
1. Personal Information category
2. Member Management category

If you have more than one role that is assigned to you, a drop-down list that contains all assigned roles
automatically appears in the Personal Information category. You can activate a role by selecting it from
this drop-down list.
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Member Management Category:

Roles can also be activated through the Member Management category. In the Role Information section of
each member account, you can select a role from the Active Role drop-down list. Only assigned roles are
available from the Active Role drop-down list.

Activating a Role:

Learn how to activate a role.

Procedure

1. In the Member Management category, select the name of the member in the Member Management
category to open the account.

2. In the Role Information drop-down list, select the role that you would like activated from the Active
Role drop-down list.

3. Select Next.
4. Select Update.

Set a Default Role
When a learner creates their own account at the Learning Portal login page, they are automatically
assigned the role that is designated as the default role.

You can set this default role in Role Administration by selecting the Default radio button next to the
theme and selecting Update.

Copy and Delete Roles
Existing roles can be copied or deleted by selecting the Del/Copy check box next to the role in Role
Administration, then selecting the Copy or Delete button.

By copying and modifying an existing role, you can create new roles without recreating all of the similar
information.

Note: When copying a role, selecting the When copying a Role, also copy the assigned Users to the
new Role check box takes all of the users from the original role and assign them to the copied role too. If
you want no users to be assigned to the copied role, leave this check box blank.

Personalization

Personalization Process Overview
LCMS Premier members can personalize content so that different members see different content in
delivery and export generation. This profile-based delivery matches metadata that is assigned to a user
account with metadata assigned to content, and filters out objects that do not meet preconfigured criteria.
v Personalization Settings category
v Personalization Profile Manager category
v Personalization view in Content Manager
v Export Generators

Note: The Personalization Settings category and Personalization Profile Manager category are not
included in any default layouts. These categories must be added by editing member tab layouts.

Personalization manifests itself in the following areas:

For personalization to function correctly, there is a process that must be completed. This process is as
follows:
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1. Create and assign metadata for criteria.
2. Select metadata tags for use.
3. Populate content metadata.
4. Populate user metadata.

Note: To enable personalization, the "Enable/disable system personalization engine" site parm must be
set to true.

Select and Populate Personalization Metadata
After the assignment of the personalization metadata, the next step in the personalization process is to
select and populate the metadata tags necessary to filter the content.

Select Metadata for Personalization:

After metadata is assigned in the Metadata Dictionary, you must select which tags you want to use. Tag
selection is done through the Personalization Settings category in the Learning Portal.

The following image shows the object levels and an example of tags available for personalization.

In this case, the “Department” metadata tag from the General User metadata group is chosen for
personalization of modules. Even though this metadata was linked to modules in the Metadata
Dictionary, the tags appear at the course level, showing that the modules within a course is personalized.
Even though other metadata tags exist in the Personalization category, they are not used unless selected.

Populate Personalization Metadata:

After you select the metadata tag or tags for personalization, the tags must be populated appropriately to
include or exclude content.

There are two areas where the metadata must be populated:
1. Additional Information tab in member account or accounts.
2. Data view in Content Manager

First, the members for whom you are personalizing content must have the proper metadata values
attached to their account. Because the metadata was assigned to Users in the Metadata Dictionary, the
metadata appears on the Additional Information tab of each member account in the Member
Management category. In this case, content is being personalized for a member in the EPDG group, so
this metadata is populated.

For example, a course contains two modules. For a certain member, the Department metadata tag domain
value “EPDG” is selected as the personalization metadata value (the other domain value is "QA"). The
first module is populated by selecting the “EPDG” domain value, and is visible in delivery. The second
module is visible in delivery also if the following conditions occur:
v The module is populated by selecting the “EPDG” domain value
v No metadata domain value is selected

Figure 79. Selecting Metadata for Personalization
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The second module is excluded from delivery only if another metadata tag is selected.

Selecting and Populating Personalization Metadata:

Perform the following steps to populate metadata for personalization.

Procedure

1. In the Personalization Settings category of the Learning Portal, select the metadata tag or tage that
you are using from the parent object of the content level you are personalizing.

2. Select Update.
3. In the Member Management category, select the member ID of the user for whom you are

personalizing content to open the Account Information page.
4. Select the Additional Information tab. If this tab is not visible, you must set the “Show Member

Metadata” theme parm in the PORTAL theme parm group to true.
5. Select the metadata value or values that you are populating for the content you would like this

member to see in delivery (if you assigned the metadata group to Users in the Metadata Dictionary,
and there is no metadata visible, you must make the metadata available to users. Select Update.

6. Repeat Steps 3-5 for any other users as necessary.
7. Open the Content Manager. In the course you are personalizing, open the parent of the objects that

contain the personalization metadata.
8. For each object, populate the metadata as needed so that each student sees the appropriate content.

Remember that for content to NOT appear to the student, it must be tagged with metadata values
different from the metadata values specified in their member account. Save all content after tagging.

9. Before you use personalization, be sure that the“ Enable/disable system personalization engine” site
parm is set to true.

Personalize the Export Generators
LCMS Premier users can create personalization profiles that can be used as filters when they export
content through the Export Generator category.

Personalization profiles are created through the Personalization Profile Manager category in the Learning
Portal. Members can create, modify, and delete personalization profiles.

Note: In order for a personalization profile to be effective, the personalization metadata must be
assigned to the Users metadata category and populated accordingly, and the personalization engine must
be enabled.

New personalization profiles are created by selecting Create New, and existing profiles can be modified
by selecting the link for the profile in the Edit column.

On the profile create/edit page, a label must be assigned to the profile, and the metadata values for the
profile must be populated.

After a personalization profile is created, it is automatically available in the Rule drop-down list of the
following export generators:
v Assessment
v Compiled Help
v Mobile server
v PDF
v PowerPoint
v Presentation
v Print
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v SCORM 1.2
v SCORM 2004
v Static HTML
v Word

Members can select one filter or one profile from the Rule drop-down list, but not both.

Creating a New Personalization Profile:

Perform the following steps to create a personalization profile.

Procedure

1. In the Personalization Profile Manager of the Learning Portal, select Create New.
2. Enter a name for the profile in the Profile Label field, along with a description in the Description

field.
3. Select the metadata values to match the content that you would like to be exported when the profile

is applied.
4. Select Save.

Assigning Personalization Metadata
Personalization begins in the Metadata Dictionary, where metadata for personalization is created and
assigned to specific objects. For personalization to function correctly, metadata must be assigned to the
following:

About this task
v Objects - Metadata must be assigned to the object(s) that you want to appear as a result of the

personalization filter. These objects include:
v Module
v Learning object
v Topic
v Group
v Elements
v Assessment Object
v Survey Object
v Reference Object
v Users
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For More Information: For an overview of personalization, see Personalization Process Overview.

Assigning Personalization Metadata:

Perform the following steps to assign metadata for personalization.

Procedure

1. In the Metadata Dictionary view, select the object level that you are personalizing. Create a metadata
group and tags, or reuse an existing metadata group and tags.

2. Select any other object levels that you are personalizing, and link the metadata group to the objects.
3. Select the Users metadata category, and link in the same metadata group.

Learning Portal: Bulk User Import
Users can now create or update multiple user accounts in the LCMS through a new bulk user import
function.

The bulk user import is an asynchronous process that is initiated through the task scheduler in the LCMS
web portal interface. Administrators can configure access to the bulk user import function through roles
and privileges in the Role Administration category in the Learning Portal. The LCMS provides two
methods for initiating a bulk user import to create and update user accounts in the LCMS:
v Internally through the Bulk User Interface web portal in the LCMS
v Externally through a public web API

Access to the bulk user import function is granted in the Role Administration category. Administrators
can select one or more roles and grant them access to the bulk user import function based on whether the
import is done manually, or by using a public web API.

To allow access to the bulk user import function in the web portal interface, administrators must check
the box for Bulk User Import Category in the Portal Category Privileges folder in the Action tab.

To allow access to the bulk user import function through a web API, administrators must check the Bulk
User Import box in the Import Category folder in the Action tab.

When using the web API method to import user accounts in to the LCMS, user authentication for the
selected roles that are requesting the import is required.

Schedule the Bulk User Import
When users are ready to schedule the import process, they can select the Bulk User Interface tab to open
the Learning Portal interface.
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From the interface, users are given the choice to browse for a comma-separated values (CSV) file to
import from a location on their computer, or download a template compressed file (zip file) that contains
a sample CSV file that is named BulkUserImportTemplate.csv, which lists all usable student field
columns. The template compressed file also contains a .CSV file that is named BUIMapping.csv that can be
used to map header row data to LCMS column names.

Through the task scheduler, users can choose to schedule the bulk user import as a one-time event
(immediately), or as a weekly or monthly recurring event. When scheduling the bulk user import as a
recurring event, users can select a start and end date, and a start time. The task scheduler automatically
assigns a priority level for the bulk user import task.

Email Notification
Email notification is sent to one or more designated users indicating one of several statues for the import
task, for example:
v BulkUserImport Success: The job completed successfully
v BulkUserImport Completed with Errors: The job completed with soft errors
v BulkUserImport Failed: The job had a hard failure
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Notices

This information was developed for products and services offered in the U.S.A. and other countries.

Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
5 Technology Park Drive
Westford Technology Park
Westford, MA 01886

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without
notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

Trademarks
These terms are trademarks of International Business Machines Corporation in the United States, other
countries, or both:
v IBM
v AIX®

v Sametime®

v WebSphere®

Java™ and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.
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Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States, other
countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.Other company,
product, or service names may be trademarks or service marks of others.

Other product and service names might be trademarks of IBM or other companies. A current list of IBM
trademarks is available on the Web at “Copyright and trademark information” at
www.ibm.com/legal/copytrade.shtml.
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